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About This Document
This manual provides data entry instructions and technical reference information for users of the following standalone  
software products that compose the Digital Evidence Series (DES) version 4.4.3:
• Digital Evidence PRO (DEP)
• Digital Evidence Agency (DEA) - DEA Agency and DEA Precinct
• Digital Evidence Viewer (DEV)
• Digital Evidence Forwarder (DEF)

This user guide is geared towards DES Administrator users and other supervisory users. If you are a DES Officer user or 
other non-supervisory user, refer to the DES Officer’s Guide instead .
For brevity, this user guide refers to all non-supervisory users as Officers and all supervisory users as System 
Administrators .

 NOTE: About DVRs

Any differences between Flashback, FOCUSTM H1, BodyVISION, BWX-100, VIEVU, and FOCUSTM X2 DVRs are clearly 
noted in this documentation. For additional information on your particular DVR, refer to that DVR’s User Guide, which is 
available for download from our Online Support Center (see Online Support link under Bookmarks menu option) .

Software Overview
DES software applications allow you to search for and view the video files recorded by your in-car and body-worn DVRs. You 
can also export and burn selected videos to disc.
DES applications were designed to run on server-class hardware. They are web-based applications, meaning that you 
access the software via a standard web browser. You can use either Internet Explorer or Mozilla Firefox to access DES 
applications .

DES Products Overview

Digital Evidence PRO (DEP)
DEP is a full-featured, server-class, network-based digital evidence management system.
An agency using the DEP application has the ability to securely access the evidence from any network-connected PC 
through a simple web browser and without special client PC software. The functions are designed to be simple and intuitive 
and the system contains the ability to perform a simple search for any video based on a number of search criteria. 

Digital Evidence Agency (DEA) - Agency and Precinct
DEA is a client/server application . The client side is DEA Precinct, a group of multi-user servers that ingest videos from the 
in-field DVRs. The server side is DEA Agency, a multi-user server that collects video data from the Precinct servers. Since 
DEA Agency does not communicate directly with the DVRs, all DVR records are maintained on the DEA Precinct servers .

Agency/Precinct Communication
In DEA, there is only one Agency server, but there can be multiple Precinct servers. Video data first downloads from the 
DVRs to the Precinct servers . It then transmits to the Agency server during night processing . The Agency and Precinct 
servers maintain separate administrative and backup settings, with the following exceptions:
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• User metadata fields
• Video categories
• Case notations
• Race types
• Subject types

The data listed above is maintained on the Agency server, then copied to the Precinct servers during server-to-server 
transmissions. Users on the Precinct servers can view, but not update, these fields.

Digital Evidence Forwarder (DEF)
DEF is designed to forward videos to a main DEP server, also referred to as the “parent” server . Agencies that choose this 
software/server configuration typically run DEP at one central location and run DEF on multiple servers at different precinct 
locations .
The only major functional difference between these two applications is that DEP includes the case and exporting 
functionality, whereas DEF does not . 
• Cases are a type of record used to store videos and other data that pertains to an incident, such as a motor vehicle 

accident . 
• Exporting is a system process used to copy video files, case files, and/or BodyVISION snapshots for the purpose of 

burning them to disc or downloading them to your PC.

Forwarding Videos to DEP
During night processing, DEF automatically forwards all newly ingested videos to the DEP server . This process does not 
require any action on your part . A copy of these videos will remain on your DEF server until those videos “age out” . The exact 
lifecycle for a video is determined by several factors, including the video’s category and your Online Lifecycle settings.
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Digital Evidence Viewer (DEV)
DEV is a PC application that users can access from other workstations via a standard web browser. You can use either 
Internet Explorer or Mozilla Firefox to access DEV .  
As with all the Mobile-Vision solutions, it supports wireless uploading and the web-based interface is easy to navigate and 
intuitive. The solution contains its own secure log-in, a simple to use key data search/access capability and versatile player, 
it also contains an embedded chain of custody module.

The Video Lifecycle
The video lifecycle consists of several stages, or phases .

Phase 1: Online Status
The server ingests a new video. The video’s status is online. Users can search for the video, play it from the server, export it, 
and/or change its associated data (i.e., video category, UMD fields, video notations, etc.). If the appropriate backup settings 
are selected, the system also archives the video during this phase .

Phase 2: Offline Status
The video reaches an age where its status changes from online to offline, as determined by the Days Online setting and 
other system settings. Users can still search for the video and view its record, but they cannot play the video or export it. 
During this phase, users can reactivate the video, assuming that there is a backup file available for that video. If the video is 
reactivated, it returns to Phase 1 . Otherwise it proceeds to Phase 3 .

Phase 3: Purging
The offline video reaches an age where it is too old to be reactivated. This is determined by the Days to enable restore of 
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backed-up media setting and other system settings . At that point, one of two things happens, depending on the following 
setting on the Life-Cycle tab:
• If the Enable Re-categorization of Media on Delete checkbox is selected, the system assigns the video a category of 

“Purged,” which returns it to an offline but restorable state on the server.
• If the Enable Re-categorization of Media on Delete checkbox is not selected, the system permanently removes the 

video from the server .

User Roles
In DES applications, users are granted access to various system functions by assigning them a user role. A user role is 
simply a group of permissions . Whenever a user logs into a DES application, the system will grant them access to various 
system functions according to the user role that’s assigned to their User ID. As a System Administrator, you are responsible 
for assigning permissions to each user role .
There are two types of user roles: system-defined and custom, as described below.

System-Defined User Roles
System-defined user roles are predefined user groups that come standard with your DES application. They include:
• Officer
• Display-only Case
• Display-only Video
• Supervisor Lvl 1
• Supervisor Lvl 2
• Internal Affairs
• Administrator . 

These roles are customizable. You can add or remove permissions from them as desired. However, the names of these 
roles cannot be changed, nor can they be deleted from the system.

Custom User Roles
Custom user roles are user-defined user groups that you can create and then assign any number of permissions to. You can 
add, change, or delete custom user roles as desired .

Logging in to the System for the First Time
This section describes how to log in to your DES application. During installation, your System Implementation Specialist 
(SIS) will provide you with the following application-specific login information:
• URL needed to access your server
• User ID
• User password (if needed) 

 

 NOTE: User password

If your organization is using the Active Directory Integration feature, you will not need a new password, as the 
application will be integrated with your existing Windows Active Directory or Novell eDirectory.

 NOTE: User roles availability
Depending on the application you are 
using, some or all of these roles will be 
available to you.
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To log in to your DES application:
1 . Double-click the Safe Fleet Mobile-Vision desktop icon or enter the provided URL into the browser's address bar. The 

Digital Evidence Series Login screen is displayed . 

 
If your organization is using the Active Directory Interface, a field labeled Domain will also be displayed beneath the 
Password field.

2 . Enter your user name in the User Name field. NOTE: For DEV enter mvadmin as a first-time user name.
3 . Enter your security password in the Password field. NOTE: For DEV enter mobile as a first-time password.

• If your organization is using the Active Directory Interface, this is the same password that you use to log in to your 
regular Windows network or Novell eDirectory.

• If your organization is not using the Active Directory Interface, this is the initial password that your System 
Implementation Specialist (SIS) provided you with .

4 . If the Domain field appears on your screen, select the correct domain name from the Domain drop-down list . 

5 . Click the Login button or press Enter. Your DES application's Welcome Home page is displayed . For a detailed 
description of this page, see DES Home Page on page 19 . 
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Changing Your Password
Unless your agency is using the Active Directory Integration feature, you should change your password the first time you log 
in to a DES application, as described below.
Please note that passwords are case-sensitive .
1 . Go to User Preferences and click Change Password . The Change Password pop-up is displayed .
2 . Enter your new password in the User Password field. For security reasons, your password will not be displayed as you 

type it . 

3 . Re-enter your new password in the Repeat User Password field.
4 . Click Save. A confirmation message is displayed at the top of the page.

Software Navigation

DES Home Page
The Welcome Home page is divided into two components: a Main Menu and a Message Board.

                                                                  

The Main Menu is the 
starting point for all system 
tasks, such as searching for 

a video or case .

The Message Board con-
tains information on recent 

burn requests and other 
system messages .
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Main Menu 

 NOTE: Menu items availability
Depending on the application you are using, some or all menu items will be 
available to you.

1 . View system messages .
2 . Search for video; play video; burn video to disc.
3 . Search for a case; add a new case; burn a case to disc.
4 . Transfer video from a storage card or external device to your DES application .
5 . Review shared digital evidence .
6 . Search the online help system .
7 . Advance to Mobile-Vision’s regular website.
8 . Advance to Mobile-Vision’s Online Support Center.
9 . Change your login password . 
10 . View a list of favorite cases .
11 . Copy your Flashback login information to a USB flash. 
12 . Configure the DES application; change system defaults.
13 . View system logs and statuses; access manuals and training videos .
14 . Check for system updates; update the server.
15 . Reassign videos to a different officer or DVR.
16 . Add/update DVR records and/or DVR Groups . 
17 . Assign body-worn DVRs to officers; configure new body-worn DVRs.
18 . Add/update system users .

Message Board
Whenever you log in to a DES application, the Message Board is displayed. It is divided into two parts:
• Inbox Messages . These are the messages that the system sent to you . As an administrative user, you will see 

messages related to system problems and administrative functions. If you selected the All Messages radio button, you 
will also see all messages that the system sent to other DES users .

• Sent Messages. These are the messages that you sent to the system, such as a burn request or download request. A 
burn request is a request to place a burn job in the backup PC’s burn queue. A download request is a request to export a 
selected video or case file to your PC.

Note the value in the State column under Sent Messages. This is the message’s current status. There are seven status 
types:
• Queued. The system has placed your request in a queue, which is a waiting list of system jobs.
• Working . The system is processing your request .
• Completed. The system has finished processing your request. If you requested a burn job, this means that your disc is 

ready. If you requested a file download, you will see a download icon  next to your request .
• Incoming. The system has discovered a new DVR on the network that does not have a DVR Group assigned to it yet.
• Requested. The system has forwarded your body-worn viewing request to your supervisor’s Inbox Messages list.
• Received. Your supervisor has received your body-worn viewing request and has either approved or denied that request.
• Failed. Your request could not be processed. Click the icon to retry the job.
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Beside some of your messages you will see icons in the Actions column. Click the icons to perform various actions, as 
described in the following table. Depending on the application you are using, some or all actions will be available to you.

Icon Description Icon Description

Download file or play quarantined video Resubmit job

• If selected from Inbox Messages: Delete a 
system message

• If selected from Sent Messages: Delete a 
queued job

Accept quarantined video into the system

Reject (i .e ., delete) quarantined video

Deny request View DVR troubleshooting materials

View export or video details Resolve a DVR naming conflict

Scrolling Through Multiple Records
Whenever you search for records in the application (videos, cases, users, etc.), your search results may yield a large number 
of records. The following navigation buttons are used to advance forward or backward through a results list.

Button Description

 Next page/Previous page . Used to scroll through the search results one page at a time .

 Fast forward/Fast rewind . Used to scroll through the search results ten pages at a time .

 First page/Last page. Used to advance to the first page or last page of the search results, respectively.

Sorting Multiple Records
Whenever you display a list of records, you have the option of changing the manner in which those records are sorted . For 
example, by default, the Case Search Results page is sorted by Incident Date . However, you can change that sort value to 
Display Name, Case Number, or Subject, as described in this section.

• To sort a list in ascending order—that is, from lowest value to highest value—click the new column header you want to 
sort by. An up arrow is displayed:   . 
– OR –

• To sort a list in descending order—that is, from highest value to lowest value—click twice on the new column header you 
want to sort by. A down arrow is displayed:   .
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Accessing Editable Row Options
If you right-click a row that is editable, the system will display an Edit Menu pop-up similar to this one .

You can also select these same options from the Action menu, as pictured here .

Interview Room
Interview Room is an optional module that is used to record officer/subject interviews at your precinct, and is available 
to users of the DEP and DEF applications . If your agency chose to purchase this module, you will have one or more DVRs 
set up in your agency’s interview room(s). All of the DES application features and functions for videos generated by these 
DVRs are the same as they are for videos generated by in-car units, with minor exceptions that are noted in the product 
documentation .
If your agency is interested in the Interview Room module, contact Mobile-Vision Sales at 1-800-336-8475.

Using the Online Help System
Your DES application comes with a searchable online help system that provides you with the same how-to steps and 
definitions that are covered in this manual. 
To access the online help system:
1 . Go to Home Menu and click User Help . The Help Contents page is displayed . 
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2 . Click the Show link at the top left corner of the screen to show navigation. 

3 . To search the topical index, click the Index tab.
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About Videos
This chapter describes how to search for, display, and view in-car videos, body-worn videos, and body-worn still images 
or “snapshots”. It also describes how to update and maintain those system settings that relate to videos, such as video 
categories and notations .
The in-car videos that an officer captures during each shift are automatically transmitted to the server whenever their 
vehicle comes within range of an access point (see Glossary) . Body-worn videos and snapshots, on the other hand, upload 
to the server after an officer places the body-worn DVR in a docking station that’s connected to the server. In the DEA 
Agency-DEA Precinct situation, during the next server-to-server communication, those videos and/or snapshot files then 
transmit from the Precinct server to the Agency server . 
Once a video or snapshot file resides on the server, you can access it by logging into the DES application from your PC 
workstation.

 NOTE: Snapshots vs. Video Frames
What’s the difference between a ‘snapshot’ and a ‘video frame’?  
Snapshots are still images that are captured from a body-worn DVR while a recording is in progress. They upload to 
the server as separate files (that is, separate from the video from which they were captured). Snapshots are similar to 
videos in that they can be searched on, notated with video notations, assigned user metadata, attached to cases, and/
or exported to DVD or other media . 
Video frames are also still images, but they are excerpted from a video after that video is already on the server. Unlike 
snapshots, video frames are not treated like videos in the system. They are standalone files that are separate and apart.

Video viewing privileges are associated with User IDs . When you create a User ID for a user, you set their viewing privileges 
to either private or public. If a user's viewing privileges are private, the only users who can view and/or notate their files are 
that user and users with edit permissions. If their viewing privileges are public, any user can view their files, but only that 
user and users with edit permissions can notate them .
Unless otherwise noted, all video procedures described in this chapter apply to both videos and body-worn snapshots. For 
brevity, the term "media file" is used to apply to both file types.

Searching and Viewing Media Files

Searching for Videos
You can search for videos by a number of different criteria. Your DES application provides you with two search methods: 
basic and advanced.

Search method Used to search for video by some or all of these criteria…

Basic • Date • DVR • System ID • Officer • Category

Advanced • After Date
• Before Date
• DVR
• DVR Type
• System ID

• Body Worn Mode
• Officer
• Category
• Assigned to Case
• Precinct (DEA 

Agency only)

• Status
• Tagged
• Latitude
• Record 

Trigger

• Longitude
• Speed Greater 

Than 
• Incident number
• UMD
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Button Description

Search Execute your search .

Advanced Search/ Basic Search Toggle back and forth between the Basic Search form and the Advanced Search form. 

Clear Remove all entries and selections from the Search form .

Performing a Basic Video Search
This section describes how to search for a video by the following criteria: date, DVR, System ID, owner, and/or category.
1 . Go to Home Menu and click Search Video . The Media Information pop-up is displayed. The fields on this pop-up are 

described in the corresponding table in Appendix 2 - Videos. 

2 . If you see the Basic Search button, click it. Otherwise proceed to the next step.
3 . Enter/select the field values you want to search on. 
4 . Click Search . All videos that match your selection criteria are displayed on the Video Search Results page . The 

components of this page are described in the corresponding table in Appendix 2 - Videos. 

 
The example above shows the default columns for the Video Search Results page . If desired, your agency can 
customize this screen, as described in Customizing the Video Search Results Page on page 30.

5 . To advance your search, perform one or more of the following tasks:
• To sort the results, click the column heading you want to sort by. By default, videos are sorted chronologically by the 

video’s start date/time. 
• If necessary, use the navigation buttons at the top of the video list to scroll through the search results.
• To further narrow your selection results, select a value from one or more of the drop-down lists at the top of the 

page . 
The system automatically narrows the video list to those videos that match your newly entered criteria . The total 
number of videos included in your search results is displayed at the top of the results list. 
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Performing an Advanced Video Search
This section describes how to search for a video using additional criteria.
1 . Go to Home Menu and click Search Video . The Media Information pop-up is displayed. The fields on this pop-up are 

described in the corresponding table in Appendix 2 - Videos. 

2 . If you see the Advanced Search button, click it. Otherwise proceed to the next step.
3 . Follow steps 3 - 7 of the Performing a Basic Video Search procedure .

Searching for Snapshots Associated with a Video
This section describes how to search for the snapshot files associated with a particular body-worn DVR. 
To search for snapshots:
1 . Follow steps 1 - 2 of the Performing an Advanced Video Search procedure .
2 . Select Body Worn from the DVR Type drop-down list, and then, if desired, enter/select additional search criteria .
3 . Click Search. All body-worn videos that match your selection criteria are displayed on the Video Search Results page . 
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4 . Click the Details icon  beside the video of interest, and then, in the displayed Video Details page, click the Snapshots 
tab. The list of snapshot(s) captured during this video is displayed. The columns on the Snapshots tab are described in 
the corresponding table in Appendix 2 - Videos. 

    

Customizing the Video Search Results Page
If desired, your agency can customize the Video Search Results page to display columns of your choosing . By default, the 
system is displayed the following columns:
• Owner
• DVR Name
• Category
• Duration
• Video Start (Date/Time)
• Notes

In addition, you may display some or all of the following columns:
• System ID
• DVR Officer Name
• Incident #
• Ingest Date
• Record Trigger
• Video End (Date/Time)

You can sort on all columns except for the Duration, Notes, and Incident # columns .
To customize the Video Search Results page:
1 . DEP and DEA users: go to Administration > System Setup > Video/Case . 

DEF and DEV users: go to Administration > System Setup > Video .

 TIP: Video  
snapshots

To determine if a 
body-worn video 
includes any 
snapshots, look for 
the  icon in the 
Notes column .
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2 . Make sure the Videos tab is selected, and then click the Columns tab. 

3 . Go to the Action menu and click Edit . The Edit Video Columns pop-up is displayed . 

4 . Proceed to the Visible column. Select checkboxes for all the column names you want to include on the video list and 
deselect all the column names you want to exclude from the video list . 
 

 TIP: Selecting columns

Since there is a limited amount of space in which to display this data, it is not advisable to select all columns. 
Carefully evaluate which information is most helpful to your agency, then select the appropriate columns .

5 . Click Save .
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Viewing Video Details
This section describes how to view videos other than body-worn snapshots, and their related information . Typically, you 
have access to your videos and any public videos. If you have the Edit All Data and/or Edit Private Data permissions, you will 
have access to other videos as well .
To view video details:
1 . Perform a basic or advanced search, as described in Searching for Videos on page 27. The Video Search Results 

page is displayed . 

2 . Click the Details icon  beside the video you want to view. The Video Details page is displayed . The components of 
this page are described in the corresponding table in Appendix 2 - Videos. 

 

This section is displayed 
only for longer videos that 
the system has subdivided 

into two or more files.
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3 . To view information about the video, perform one or more steps described in the following table. The components of 
each page are described in the corresponding tables in Appendix 2 - Videos. 

To... Do this...

View a video's logs • Click the Video Logs tab. The video’s log records are displayed. 

View the user metadata 
(UMD) that is saved 
as part of a video or 
snapshot’s record 

• Click the UMD tab. The UMD form is displayed. 

View a video's group 
information

• Click the Group Detail tab. Details for the video group are displayed. 
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Viewing a Video in Google Earth
This section describes how to use the Google Earth application to display an aerial view of a video’s route and its 
tracepoints, if applicable. To accomplish this, the system downloads GPS data into a KML file format that can be read by 
Google Earth .
You can download and install Google Earth from the Internet by going to:
http://www.google.com/earth/download/ge/agree.html

 NOTE: DEA Agency users

This workflow is not available to users of the DEA Agency application.

To view video in Google Earth:
1 . Search for and display the video you want to view in Google Earth . (If necessary, review Searching for Videos on page 

27)The Video Details page is displayed .
2 . Go to the Action menu and click Google Earth . NOTE: If Google Earth does not launch, it means that you either lack the 

proper permissions to perform this task or you do not have the Google Earth application installed on your PC.
3 . Perform one of the following steps:

• If a pop-up message is displayed, proceed to the next step .
• If an aerial view of the video’s route is displayed in red, skip to step 5 .

4 . Click Open. After a pause of a few seconds to a few minutes, an aerial view of the video’s route is displayed in red. Note 
that the beginning and end of the video route are marked by a green and red thumbtack icon, respectively. 

5 . To reposition the map and/or zoom in or out, use the Google Earth controls provided . For information on other Google 
Earth functions and features, refer to the Google Earth documentation .

6 . When you are ready to exit Google Earth, click the cross icon in the upper right corner of the window, then click Discard .

http://www.google.com/earth/download/ge/agree.html
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Viewing and Exporting Individual Snapshots
This section describes how to view the details for a body-worn DVR still image, referred to as a snapshot .
1 . Follow steps 1 - 2 of the Searching for Snapshots Associated with a Video procedure .
2 . Select Snapshots Only from the Body Worn Mode drop-down list that is displayed .
3 . Click Search. All body-worn snapshot files that match your selection criteria are displayed on the Video Search Results 

page . 

 

4 . Find the snapshot of interest in the displayed list using the navigation arrows, and then click its Details icon  . The 
Snapshot Details page is displayed. The fields on this page are described in the corresponding table in Appendix 2 - 
Videos. 

Body-worn DVR 
snapshots display the 
word “Image” in this 

column 
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5 . To view information about the snapshot, perform one or more steps described in the following table. The components 
of each page are described in the corresponding tables in Appendix 2 - Videos. 

To... Do this...

View logs of all the 
activities performed on 
this snapshot

• Click the Snapshot Logs tab. The log records are displayed. 

View any user 
metadata associated 
with this snapshot 
 

• Click the UMD tab. The UMD form is displayed. 

6 . To export a snapshot, go to the Action menu and click Export Image to PDF . A Windows message is displayed . 

7 . Click Open . The Captured Image Report is displayed . 
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8 . To print this report, click the printer icon, or press Ctrl+P . The Print pop-up is displayed . 

9 . Select your desired printer settings, then click Print. The report is directed to your active printer .
10 . When you are finished viewing/printing the report, click the cross icon in the upper right corner of the page to exit Adobe 

Reader .
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Playing Video and Exporting a Video Frame
This section describes how to play an online video (a video that is currently stored on your agency’s server) in the Flashback 
Player. Use this player to play, pause, stop, rewind, change cameras, and/or move between tracepoints. You can also view 
important information captured by the DVR during the recording, such as the active video and audio feeds, brake activation, 
and record trigger .
For information about Flashback Player components and their functions, refer to Appendix 2 - Videos.
This section also describes how to export and save a video frame (or a snapshot) of interest.
To play a video:
1 . Search for the video you want to play . (If necessary, review Searching for Videos on page 27) The Video Search 

Results page is displayed . 

2 . To launch a video, perform one of the following tasks:
• Go to the Play column and click the video’s thumbnail image.
–OR –

• Click the Details icon  beside the video thumbnail, then click the video’s thumbnail image.
–OR –

• Click the Details icon  to the left of the video, then go to the Action menu and click Play .
The Flashback Player is launched in a separate window and the video starts playing . NOTE: If the video is not launched 
automatically, click the  icon under the viewing window . 
 

 NOTE: Launching the Flashback Player

If a security pop-up is displayed, select the checkbox at the bottom of the pop-up, then click Allow. Next, select 
the checkbox at the bottom of the second pop-up, then click Run . 
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3 . To choose how you want to view the video, perform one of the following tasks: 

To... Do this...

View the video in full-
screen mode

• Press Ctrl + F. When you’re ready to exit full-screen mode, press Esc . 

View the video’s route 
on a Google map

• Press Ctrl + M. The GPS Mapper window is displayed. When you’re finished viewing the 
map, click the cross icon in the upper right corner of the GPS Mapper window to exit.

4 . Find a video frame that you want to export using the navigation buttons to advance to the desired segment, and then 
press Ctrl + S . The Snapshot pop-up is displayed .  
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5 . Make the following selections in the dialog box:
• Comment's Location. You can have the comment appear either at the top or at the bottom of the frame
• Snapshot Format. You have five file types available to save the frame.

6 . If desired, enter a comment in the Comments field. 
7 . Perform one of the following tasks: 

To... Do this...

Save the frame to your PC's clipboard • Select the Clipboard radio button.

Save this frame to your hard disk 1 . Click the ellipsis button  . The QBX Snapshot File Save pop-up is 
displayed .

2 . Navigate to the disk drive location where you want to save this file.
3 . Enter a new file name is desired, and then click Save to close the pop-up .

4 . Click OK to close the Snapshot pop-up. The frame is saved  to the location you have specified.
5 . To close the Flashback Player, do one of the following:

• Select File>Exit from the menu bar.
– OR –
• Click the cross icon in the upper right corner of the Flashback Player window.

Configuring Video Playback Options
This section describes how to change the manner in which the system delivers videos to users for viewing purposes. For 
example, you can choose to download and play videos on a PC, or stream the videos directly from the  server . The optimal 
playback method for your agency will depend on your networking environment and available bandwidth. If the default play-
back method, Stream–No Cache (SMB), isn’t working for you, consult with your agency’s IT specialist to determine which 
playback method might be preferable.
One advantage of the “download and play” methods is that you don’t have to wait for the entire video to download before 
you can begin viewing it. The system starts playing the video immediately after it buffers a small amount of video data.
The available playback methods are described in the corresponding table in Appendix 2 - Videos.
To configure playback options:
1 . Go to Administration > System Setup > System > Other, then go to the Action menu and click Edit . The Other pop-up is 

displayed . 

2 . Go to the Video Playback Method field and select a new value from the drop-down list. 
3 . Click Save .
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Configuring Speed Unit Display
This section describes how to change the GPS speed unit display on the Flashback Player and Video Details page . You can 
display a vehicle’s speed in either miles per hour (default) or kilometers per hour.

  
To configure the speed units:
1 . Go to Administration > System Setup > System > Other, then go to the Action menu and click Edit . The Other pop-up is 

displayed . 

 NOTE: Permissions for viewing speed

The Display MAX Speed permission is required to view speed information on the Video Details page; the Player Display 
Speed permission is required to view speed information on the Flashback Player while online (i.e., from the server); and 
the Export Display Speed permission is required to view speed information on the Flashback Player while offline (i.e., 
from an export disc or file). For more information, see Managing User Roles and Permissions on page 250 .

2 . Go to the Show Speed In field and select a new value from the drop-down list: US Standard (for miles per hour) or 
Metric (for kilometers per hour).

3 . Click Save . 

Speed unit display on Flashback Player

Speed unit 
display on 

Video Details 
page



© Safe Fleet | September 2021 | All rights reserved

Digital Evidence Series Administrator's Guide

42 Part # 700-8006 R3

Working with Media Files

Working with Media Files

Editing Media Files
This section describes how you can edit the attributes that define media files (a video or a body-worn snapshot):
• Change a video category
• Reassign a video to a different officer
• Add predefined user metadata
• Add predefined notations. 

To edit a media file:
1 . Search for and display the video you want to update . (If necessary, review Searching for Videos on page 27) The 

Video Details page is displayed . 

2 . Go to the Action menu and click Edit . The Edit Video pop-up is displayed .  

 NOTE: DEA Agency users

This workflow is not available to users of the 
DEA Agency application .
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3 . Perform one or more of the following tasks: 

To... Do this...

Change a video category
For more information on video categories, 
see Video Details Page on page 292.

• Select a new value from the Category drop-down list at the top of 
the form . 

Reassign the video to a different officer
For information on other ways to reassign 
videos, see Reassigning Videos to a 
Different Officer or DVR on page 43 .

• Select a new name from the Assign To Officer drop-down list .
NOTE: You cannot reassign video in the DEA Agency application .

Add predefined user metadata

NOTE: If you have a mobile data computer 
with the UMD Editor installed on it, you can 
attach UMD to an in-car video immediately 
after it is finished recording. Otherwise you 
can use this procedure to attach UMD back 
at the precinct .

• Enter your data in the appropriate fields.  
If you see a Mask field beside the data entry field, it indicates that 
your entry must adhere to a specific format.  
Alpha characters (a – z) are represented by an A, and numeric 
characters are represented by a pound sign (#) .  
For example, if you see ##-A#### next to a field labeled Citation 
No., it indicates that you must enter a citation number that starts 
with two numbers, followed by a hyphen, followed by a letter, ending 
with four numbers (e.g., 22-L5600).

Add predefined video notations • Select all Video Notation(s) checkboxes that apply.
NOTE: If no checkboxes are displayed on the Edit Video pop-up, it 
indicates one of two things:
• Your agency has not created any video notation records yet . For 

more information, see Adding a New Video Notation on page 74 .
• Your agency has created video notation records, but the feature 

is currently inactivated . For more information, see Turning Video 
Notations On/Off on page 74.

4 . Click Save to save the changes you've made.

Reassigning Videos to a Different Officer or DVR
Periodically, you may need to reassign video to a different officer or to a different DVR. This section describes how to 
reassign multiple videos to a different officer. For example, if an officer forgets to log in to their DVR one day, you can use 
this procedure to link that day’s videos to the correct officer. Once an officer owns a video, he has permission to view, notate, 
or tag that video, and/or add it to a case .

 NOTE: DEA Agency users

The workflow on reassigning videos is not available to users of the DEA Agency application.

For steps on how to reassign one video to a different officer, see Editing Media Files on page 42 .
To reassign videos to a different officer:
1 . Go to the Administration > Assign Videos .  

The Media Information pop-up is displayed . 
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2 . To search for videos, enter or select your search criteria in the displayed form (default), or click Advanced Search, and 
then enter or select your search criteria

3 . Click Search . The Assign Videos page is displayed. The components on this page are described in the corresponding 
table in Appendix 2 - Videos. 

 
 

 WARNING: Video assignments

Video assignments cannot be undone. Before you proceed, make sure you are reassigning the videos to the correct 
officer or DVR.

4 . Perform one of the following tasks: 

To... Do this...

Reassign videos to a different officer • Go to the To Officer field at the top of the page and select a 
new officer from the drop-down list.

Reassign videos to a different DVR • Go to the To DVR field at the top of the page and select a 
new DVR from the drop-down list .

Reassign videos to a different case • Go to the To Case field at the top of the page and enter the 
desired case number.

Remove the selected videos from other cases • Select the Remove from other cases checkbox.

5 . Perform one of the following tasks: 

To... Do this...

Reassign all of the videos in your search results 1 . Go to the Action menu and click Assign All ## Videos . 
2 . Click Yes in response to the confirmation message. 

Reassign some of the videos in your search results 1 . Either click the videos you want to reassign or go to the 
Action menu and click Select All on Page .

2 . Go to the Action menu and click Assign Selected . A 
confirmation message is displayed.
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Tagging and Untagging Videos
You can tag a video to add extra days to a video’s online life. 

 NOTE: DEA Agency users

This workflow is not available to users of the DEA Agency application.

Tagging directly relates to the value entered in the  Days to extend the life of tagged video field on the Life-Cycle form as 
pictured below. The system will archive a tagged video just as it archives other videos—according to your system settings .
Untagging removes the "tagged" flag from the video. To perform this task, the Enable Un-tagging check box must be 
selected on the Life-Cycle form . 
For instructions on how to access this form, see Changing the Online Lifecycle Settings on page 268. 

 
To tag or untag a video:
1 . Search for and display the video you want to tag or untag . (If necessary, review Searching for Videos on page 27) The 

Video Details page is displayed . 

 NOTE: Life-Cycle form
Depending on the DES application you are using, 
the Life-Cycle form may appear different .
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2 . To tag a video, go to the Action menu and click Tag Video. The word "Yes" is displayed in the Video Tagged field, 
indicating that the video is now tagged . 

3 . To untag a video, go to the Action menu and click Untag Video . The word “No” is displayed in the Video Tagged field, 
indicating that the video is no longer tagged . 

Generating a Chain of Custody Report for a Media File
This section describes how to generate a chain of custody report for a selected video or snapshot. To display this report, 
you must have the Adobe Reader installed on your PC.

 NOTE: About chain of custody reports
The chain of custody report contains a log of all operations that have been performed on a video or snapshot, such as 
the transfer of data from a vehicle to the server (i .e ., System Media Uploaded from Unit) . It shows the date and time at 
which each activity occurred, as well as the user ID of the officer who performed the action, if applicable. If the User 
field is blank, it indicates that the action listed was performed automatically by the system.

 NOTE: Windows users

This procedure is for Windows 10 users . If you have an earlier version of Windows, these steps may differ slightly . 

To generate and display the report:
1 . Search for and display the video or snapshot you want to generate a report for . (If necessary, review Searching for 

Videos on page 27 or Searching for Snapshots Associated with a Video on page 29) The Video Details page is 
displayed .

2 . Go to the Action menu and click Chain of Custody . The Chain of Custody Options pop-up is displayed . 

3 . Make your selection from the Chain of Custody Log Level drop-down list, and then click OK . The system downloads the 
report to your PC’s Downloads folder. 
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4 . Navigate to your Downloads folder, and then double-click the PDF report file. The report is displayed in Adobe Acrobat. 
 

5 . To print this report, click the Printer icon, or press Ctrl+P . The Print pop-up is displayed . 

6 . Select your desired printer settings, then click Print . The report is sent to your active printer .
7 . When you are finished viewing/printing the report, click the cross icon in the upper right corner of the page to close it.
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Accepting and Rejecting Quarantined Videos
A quarantined file is a video that is shorter than the Minimum File Duration value entered on the Life-Cycle tab. 
Typically, a quarantine file is a small “test” video that an officer makes at the beginning of each shift to test their equipment 
before going out into the field. The system automatically marks these short videos for review or disposal, depending on your 
system settings . 
If you selected the quarantine settings pictured on the screenshot below (Enable Quarantine checkbox selected; Auto 
Reject Quarantined files checkbox deselected), then all quarantine videos will be displayed on your home page. You will 
need to periodically review each of the quarantined videos and either accept or reject them, as described in this section.

For more information on quarantine settings, see Changing the Online Lifecycle Settings on page 268. 
To accept or reject a quarantined video:
1 . Make sure the Welcome Home page is displayed, and then locate the quarantined files on your Inbox Messages list . 

 NOTE: DEA Agency and DEV users

The workflow described in this section is not 
available to users of the DEA Agency and 
DEV applications .
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2 . Click the  icon beside the first file you want to review. The Flashback Player is  launched and the selected video plays.
3 . When you are finished reviewing the video, click the cross icon in the upper right corner of the Flashback Player to close 

it .
4 . Perform one of the following tasks: 

To... Do this...

Accept the new 
video into the 
system

1 . Click the  icon beside that record. The following pop-up is displayed. 

2 . Click Yes. A confirmation message is displayed: Video is being accepted into the server 
now .

To reject the new 
video

1 . Click the  icon beside that record. The following pop-up is displayed. 

2 . Click Yes . The video is permanently removed from the system .

5 . Repeat step 4 for all the quarantined files on your Inbox Messages list .

Exporting Video Activity to a Spreadsheet
This section describes how to export information on your video activity to a spreadsheet for use with another application, 
such as a custom reporting tool . This is referred to as the Media Activity report . It includes information such as the date and 
time of automatic video transmissions, the name of users who performed manual uploads, and video backup status. The 
system automatically updates this report once every day .
To export video activity:
1 . Go to Administration > System Status > Reports, and then click the Media Activity report to highlight it . 

   
2 . Go the Action menu and click Download Report. The system downloads the report to your PC’s Downloads folder .
3 . Navigate to your Downloads folder, and then double-click the CSV report file. The report is displayed in your default 

spreadsheet application, such as Microsoft Excel .     

 NOTE: Last  
refreshed date
Note the date in the Last 
Refreshed Date column . 
The Media Activity 
report you are about to 
download will contain 
all system video activity 
up to this date/time . If 
you prefer to report on 
all video activity up to 
the current time, go to 
the Action menu and 
click Refresh Report first 
before proceeding.
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Converting Videos for Use with Redaction Software
This section describes how to use the Flashback File Converter utility to convert selected video files into a format that can 
be used with redaction software. Specifically, you can convert QBX files into MP4 files.
To convert videos:
1 . If you have not done so already, install the Flashback File Converter on your PC, as described in Installing the Flashback 

File Converter on page 80.
2 . Go to your desktop and double-click the Flashback Converter icon . The Flashback Converter application opens . 

3 . Click the ellipsis icon  beside the Input File field, and then, in the displayed Flashback Converter Input File screen 
navigate to the disk drive location of the file you want to convert.

4 . If you are converting a VIEVU AVD file to AVI, select AVD from the Files of type drop-down list . Otherwise proceed to the 
next step .

5 . Click the file you want to convert, and then, if desired, enter a new name in the File name field. 
6 . Click Open. The selected file name is displayed in the Input File field.
7 . Click the ellipsis icon beside the Output Folder field. The Browse For Folder pop-up is displayed .
8 . Navigate to the folder in which you want to save the converted file, then click that folder.
9 . Click OK . The selected disc drive location is displayed in the Output Folder field.
10 . To change any of the default video/audio settings, select the appropriate radio button or checkbox in the following 

sections of the screen:
• Video Stream Selection
• AVD Audio Stream Selection
• QBX Audio Stream Selection .

11 . Click the Start button. The conversion begins. When the process is complete, a confirmation message is displayed.
12 . Click OK. When you’re ready to import the file into a third-party application, you will find it in your selected output folder.
13 . To convert another file, repeat steps 3 – 13 . Otherwise select File > Exit from the menu bar to exit the application.
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Requesting a No Transfer Video

 NOTE: DEA Agency users only

The workflow described in this section applies only to users of the DEA Agency application.

On the Video Categories screen, there is a field called Auto Transfer Enabled that determines whether or not standalone 
videos of a particular category will automatically transfer to the Agency server. For example, you may decide not to bother 
transferring “No Citation” videos from the Precinct servers to the Agency server, as videos of this category are typically low 
priority .
This section describes how to transmit a particular standalone video to the Agency server even through it has a “no transfer” 
category, you can use the following procedure to request that video .
To request a "no transfer" video: 
1 . Search for and display the video you wish to request . The Video Details page is displayed .
2 . Go to the Action menu and click Request Video. A confirmation message is displayed. 

A confirmation message will also be displayed on your Welcome Home page under Sent Messages . Once the video 
transfer is complete, a notification message will be displayed in your Inbox.
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Restoring Videos
This section describes how to restore videos that are offline or expired.

 NOTE: DEF users

Video restoration workflows are not available to users of the DEF application.

 NOTE: Offline and expired videos
An offline video is one that has been backed up but not completely removed from the server. You can view an offline 
video’s thumbnail image and its statistics (category, duration, record trigger, etc.), but not the video itself. If you want 
to view the video from the server again, you will have to restore or “reactivate” it from a backup disc or external backup 
device .
An expired video is one that is too old to be reactivated. You can tell that a video has exceeded its reactivation time limit 
when its thumbnail image and statistics are no longer displayed online. You can reimport expired video from either a 
Certified Backup Disc or a manual backup disc (also referred to as an “export” disc or a “user-requested certified copy”) 
that is in Data DVD format. Although this is not the recommended method for restoring videos, this procedure may be 
used in an emergency situation to reimport important data that is too old to be reactivated. 

The time period during which an offline video can be reactivated is set in the Days to enable restore of backed-up media 
field on the Life-Cycle tab, as pictured below. Videos that are older than the value in this field are expired. 
For instructions on changing this setting, see Changing the Online Lifecycle Settings on page 268. 

  

 NOTE: Reactivation of purged expired videos

If the Enable Re-categorization of Media on Delete option on the Life-Cycle tab is selected, the system reassigns all 
expired videos a category of “Purged”, which allows them to be reactivated at any time (assuming you have a backup 
disc) . 

If the video you want to 
restore has exceeded 

this time limit, you 
will have to use an 

alternate procedure to 
restore it, as described 

in Restoring Expired 
Videos on page 55.
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Restoring Offline Videos
This section describes how to reactivate, or restore, an offline video from a backup disc or device. Depending on your 
current Backup Mode setting, you can reactivate a video from one of the following storage options:
• Certified Backup Disc or manual backup disc (also referred to as an “export” disc or a “user-requested certified copy”) 

that is in Data DVD format
• External backup device, such as a tape drive.

To check or change your Backup Mode setting, see Setting Backup Options on page 152.

 NOTE: Restoring from NAS

If Network Attached Storage (NAS) is enabled at your agency, the system will ignore the backup mode setting and will 
restore evidence from the NAS device . Refer to the Enabling Network Attached Storage procedure for  details .

You can reactivate a video for your own use, or at the request of another user . Requests from other users are displayed on 
your Inbox Messages list, located on the Welcome Home page . 

Reactivating a Video from a Backup Disc
1 . Perform one of the following tasks: 

To... Do this...

Reactive a video for your own use • Search for and display the desired video . If necessary, review Searching for 
Videos on page 27.

Reactive a video for another user 1 . Go to the Home Menu and click Home .
2 . Locate the reactivation request on your Inbox Messages list, then click the 

View Video Detail icon  . 
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The Video Details page is displayed . 

2 . Go to the Action menu and click Reactivate Now, then perform one of the following tasks: 

If... Then...

The Reactivate Video pop-up is 
displayed

• Proceed to the next step .

A security pop-up is displayed • Select the checkbox at the bottom of the pop-up, then click Allow.
 
The Reactivate Video pop-up is displayed .      

 NOTE: Reactivate video pop-up

This pop-up may appear slightly different depending on whether this video was previously backed up to an Archive 
disc (Certified Backup Disc) or an Export disc (User-Requested Certified Backup).

3 . Perform one of the following tasks:

If... Then...

The center column reads DVD Label • Look at the number in the DVD Label column. This is the number of the 
Certified Backup Disc that contains the video you’re looking for. Locate 
this disc .

The center column reads File Size(MB) • Locate your backup disc.

4 . Insert the located disc in your PC’s CD/DVD tray. (This must be either a Certified Backup Disc or an Export disc that is in 
Data DVD format .) Give the computer a few seconds to read the DVD, then proceed to the next step . 

5 . Click Read DVD or Restore File(s) . After a momentary delay, the Video Details screen will redisplay, indicating that the 
video has been successfully restored. 

 TIP: Session timeouts

If your session “times out” during the reactivation, you need to increase your Session Timeouts setting . For 
instructions, see Managing User Roles and Permissions on page 250.
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Reactivating a Video from an External Backup Device

 NOTE: For EXTERNAL backup mode only

Use this procedure if your Backup Mode is set to EXTERNAL. To check or change your Backup Mode setting, see 
Setting Backup Options on page 152.

1 . Follow steps 1 - 2 of the Reactivating a Video from a Backup Disc procedure .
2 . Go to the Action menu and click Reactivate Now . The Reactivate from Tape pop-up is displayed . 

3 . Make a note of the directory or directories that are listed in the Server Path column, and then, using the software that 
came with your backup device (e.g., tape backup software), restore the directory(ies).

4 . Go to the Action menu and click Continue. After a momentary delay, a confirmation message is displayed at the top of 
the page .

Reactivating a Video from Network Attached Storage (NAS)
1 . Follow steps 1 - 2 of the Reactivating a Video from a Backup Disc procedure .
2 . Go to the Action menu and click Reactivate Now . The Reactivate from NAS pop-up is displayed . 

3 . Make sure that the directory listed in the Server Path column is the correct NAS directory, and then click the Reactivate 
Now button.

4 . Go to the Action menu and click Continue. After a momentary delay, a confirmation message is displayed at the top of 
the page .

Restoring Expired Videos
You can reimport expired video from either a Certified Backup Disc or a manual backup disc that is in Data DVD format. This 
procedure is not commonly performed .  

 NOTE: DEA Agency users

This workflow is not available to users of the DEA Agency application.
 

The reuploaded video is treated by the system as if it were a new record, rather than a “reactivation” of an existing record. 
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The video will therefore begin the same lifecycle as a new video that is downloaded to the server for the first time.
• If you are restoring video from an export disc (i.e., user-requested certified copy) rather than an archive disc (i.e., 

Certified Backup Disc), that disc must be in Data DVD format.
• If the Enable Re-categorization of Media on Delete option on the Life-Cycle tab is selected, you do not need to use this 

procedure. For more information, see the beginning of Restoring Videos on page 52.
To reimport a video:
1 . Insert the backup disc into your PC’s DVD/CD tray. This will either be an Archive disc (i.e., Certified Backup Disc) or an 

Export disc (i.e., User Requested Certified Copy). 
2 . Go to the Home Menu and click Media Reader, then perform one of the following tasks: 

If... Then...

The Automatic Upload pop-up is 
displayed (typical)

• Proceed to the next step .

A security pop-up is displayed 1 . Select the checkbox at the bottom of the pop-up, then click Allow . 
2 . Select the checkbox at the bottom of the second pop-up, then click Run .

The Automatic Upload pop-up is displayed . 

3 . Click the Manual tab at the top of the page, and then, using the Look in field, navigate to your PC’s CD/DVD drive. The 
files on the backup disc are displayed on-screen. 

4 . Click the video file you want to upload (must have an extension of QBX, MKV, MP4, or AVD). To select more than one 
video, hold the Ctrl key down while you click each video.
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5 . Click Upload Selected File(s) and then perform one of the following tasks: 

If... Then...

The Select a DVR for Assignment pop-up is 
displayed 

• Select a DVR unit from the drop-down list, then click OK . The 
Enter Reason pop-up is displayed . 

The Enter Reason pop-up is displayed • Proceed to the next step .

6 . Enter the reason for this video upload in the blank field provided, then click OK. A confirmation message is displayed. 

7 . Perform one of the following tasks: 

If... Then...

The displayed reason for the video upload is 
correct 

• Click Yes. The system begins uploading your video file(s). 
When the transmission is complete, a confirmation message is 
displayed, as pictured below. Click OK . 

The displayed reason for the video upload is 
not correct

1 . Click No . The Enter Reason pop-up is displayed . 
2 . Repeat step 6 .

 
The video is re-uploaded . 

Keeping Offline Video Records on the Server
Normally, when a video reaches the end of its online lifecycle, the system permanently removes its record from the server . 
If desired, you can change a system setting that will cause expired videos to remain in an offline but restorable state 
indefinitely. The system assigns such videos a category of “Purged.” As with all offline videos, you will still be able to search 
for the video and view its Video Details page, but you won’t be able to play it, export it, or edit it unless you reactivate it first. 

 NOTE: Videos that can be restored

You can only restore a video for which there is a backup file, such as on an archive or export disc.

To keep offline videos on the server:
1 . Go to Administration > System Setup > System > Life-Cycle, then go to the Action menu and click Edit . The Life-Cycle 

form is displayed, as pictured on the next page . 
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2 . Select the Enable Re-categorization of Media on Delete checkbox, and then click Save .

Generating the Purged Videos Report
This section describes how to generate the Purged Videos Report, which lists all videos with a system-assigned category 
of “Purged.” This category indicates that an expired video was reclassified as “purged” in order to remain in an offline but 
restorable state on the server. 

 NOTE: Windows users

This procedure is for Windows 10 users . If you have an earlier version of Windows, these steps may differ slightly . 

To generate a purged videos report:
1 . Go to Administration > System Status > Reports, and then click the Purged Videos report to highlight it . 
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2 . Go the Action menu and click Generate Report . The New Report pop-up is displayed . 

3 . Using the calendar pop-up, select a start date for the report .
4 . Enter the number of days you want to report on, starting from the date you just selected.
5 . Click Generate. The system generates the report and places it in your PC’s Downloads folder . 
6 . Navigate to your Downloads folder, and then double-click the CSV report file. The report is displayed in your default 

spreadsheet application, such as Microsoft Excel .
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Uploading and Downloading Videos
This section describes how to manually upload or download new videos, recorded by DVRs.
Typically, in-car videos are transmitted to the server automatically whenever your vehicle comes within about 300 feet of 
your precinct’s access points. However, if you can’t wait for the automatic file transfer to occur, or a problem has occurred 
that interfered with the wireless file transfer, you can manually upload videos instead. 
Manual uploads are also used to transmit videos captured with a body-worn DVR.

 NOTE: Uploading videos from body-worn DVRs 

To upload body-worn videos, simply place the body-worn DVR in your agency’s Uplink Station, which consists of a group 
of docking stations connected to your storage server. For more information, see the relevant sections in your body-worn 
DVR's user documentation. Both of these manuals are available for download from the Mobile-Vision Online Support 
Center accessible from the Bookmarks menu .

 NOTE: DEA Agency users

Workflows on manually uploading videos are not available to users of the DEA Agency application.

Manually Uploading In-Car Videos
This section describes how to manually upload new in-car videos from an SD Card (Flashback3/FlashbackHD or FOCUS H1) 
or CF Card (Flashback2).
To upload videos:
1 . Go to Home Menu and click Media Reader, then perform one of the following tasks: 

If... Then...

The Automatic Upload pop-up 
is displayed (typical)

• Proceed to the next step .

A security pop-up is displayed 1 . Select the checkbox at the bottom of the pop-up, then click Allow . 
2 . Select the checkbox at the bottom of the second pop-up, then click Run .

 
The Automatic Upload pop-up is displayed . 
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2 . If you have not done so already, remove the memory card from your in-car DVR, and then insert it into your PC's built-in 
card reader (i.e., CF slot for Flashback2s or SD slot for Flashback3s/FlashbackHDs or FOCUS H1), or the external card 
reader, connected to your PC .  

                                                           
3 . Click the Read & Upload button. The Enter Reason pop-up is displayed . 

4 . Enter the reason for this video upload in the blank field provided, then click OK. The system begins uploading your video 
files. This may take several seconds or several minutes, depending on the size of your files. When the transmission is 
complete, a confirmation message is displayed.

5 . Click OK . You may now remove the memory card from the PC or card reader and reinsert it in your in-car DVR .

Manually Uploading VIEVU Videos
This section describes how to upload new videos from a VIEVU— a small body worn DVR sold by Mobile-Vision. This 
procedure differs slightly depending on whether you have an LE2 or LE3 model VIEVU .

Manually Uploading Videos from a VIEVU LE2
This procedure must be performed by a non-admin user (typically a Supervisor Lvl 1 or Supervisor Lvl 2) who:
• Has a DVR Officer Name, and
• Is assigned the Media Reader permission . 

For instructions on viewing or updating user records, see Changing a User on page 246.
To upload videos:
1 . Log in to the DES application as a non-admin user who has a DVR Office Name and is assigned the Media Reader 

permission . 
2 . Connect the USB cable that comes with a VIEVU LE2 unit as follows:

• Insert the smaller USB plug into the VIEVU’s USB port, as pictured.
• Insert the remaining USB plugs into any two USB ports on the PC  

that you use to access your DES application . 
 
 

Sample CF/
SD card 
reader

Lift rubber 
flap to 

reveal USB 
port
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3 . Perform one of the following tasks: 

If... Then...

This is the first time you’ve connected the 
VIEVU to this PC and you are prompted to 
download the VIEVU drivers

• Proceed to the next step .

This is the first time you’ve connected the 
VIEVU to this PC and you are not prompted to 
download the VIEVU drivers

• You will have to manually download them before continuing. 
See Manually Installing the VIEVU Drivers on page 82 for 
instructions . Once the drivers are installed, proceed to step 7 .

This is not the first time you’ve used this PC to 
upload videos to the server (i .e ., this PC already 
has the VIEVU drivers installed on it)

• Skip to step 7 .

4 . Download and install the drivers. To do so:
a. Select the Yes, this time only button.
b. Click Next .
c. Click Next again .
d. Click Finish .
e. Repeat steps a - d .

5 . Disconnect the USB cables, reboot your PC, then plug the USB cables back in.
6 . Log back into your DES application as a non-admin user who has a DVR Office Name and is assigned the Media Reader 

permission .
7 . Push the VIEVU’s slide bar into the ON position . 

 
  
 
 
 
 
 

8 . Follow step 1 of the Manually Uploading In-Car Videos procedure . 

 CAUTION: Veripatrol users

If you are also using VIEVU’s Veripatrol software, make sure the Veripatrol application is closed before you proceed.

9 . Click the Read & Upload button. The Select Officer to Assign Video pop-up is displayed . 

10 . Select an officer name from the drop-down list, then click OK . The Enter Reason pop-up is displayed . 

On position
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11 . Type VIEVU video upload in the blank field provided, then click OK. Your entry is displayed for confirmation purposes. 
12 . Click Yes. The system begins uploading your video files. This may take several seconds or several minutes, depending 

on the size of your files. When the transmission is complete, click OK in the displayed confirmation message. 

Manually Uploading Videos from a VIEVU LE3
This procedure must be performed by a user who has the Media Reader permission, such as an Administrator or Supervisor .
To upload videos:
1 . Follow step 2 of the Manually Uploading Videos from a VIEVU LE2 procedure, using your LE3 cable. 

 

 NOTE: Use the correct USB cable

If you also have an LE2 model VIEVU, make sure you use the cable that came with the LE3, not the LE2.

2 . Perform one of the following tasks: 

If... Then...

This is the first time you’ve connected the VIEVU to this PC, the 
system will automatically begin downloading the VIEVU drivers.

Once the installation of the drivers is complete:
• Click Close in response to the system 

prompt, and then proceed to the next step .

This is not the first time you’ve connected the VIEVU to this PC 
(i .e ., the VIEVU drivers are already installed on this PC)

• Skip to step 7 .

3 . Navigate to your PC's Device Manager window, and then set the VIEVU’s COM port to COM9 or lower. To do so:
a. Double-click Ports (COM & LPT) .
b. Double-click USB Serial Port .
c. Click the Port Settings tab.
d. Click the Advanced button, and then select a new COM port from the COM Port Number drop-down list . You may 

select any unused port that is COM9 or lower .
4 . Follow step 5 of the Manually Uploading Videos from a VIEVU LE2 procedure .
5 . Log in to your DES application as an Administrator or Supervisor user .
6 . Follow step 8 of the Manually Uploading Videos from a VIEVU LE2 procedure .
7 . Click the Read & Upload button. The Confirm Officer Assignment pop-up is displayed . 



© Safe Fleet | September 2021 | All rights reserved

Digital Evidence Series Administrator's Guide

64 Part # 700-8006 R3

Uploading and Downloading Videos

8 . Perform one of the following tasks: 

If... Then...

You want to assign videos to the officer name displayed here • Click Yes . 

You do not want to assign videos to the officer displayed 
here

• Click No, and then perform step 10 of the 
Manually Uploading Videos from a VIEVU LE2 
procedure .

 The Enter Reason pop-up is displayed . 

9 . Follow steps 11 - 12 of the Manually Uploading Videos from a VIEVU LE2 procedure .

Downloading Video Files to Your PC
This section describes how to download selected videos to your PC. You can download videos in the following formats:
• Data DVD
• Interchange
• Uncompressed
• FOIA redacted .  

For more information on these formats, refer to the  Available File Formats for User-Requested DVDs table in Chapter 4. For 
a side-by-side comparison of the formats, see DVD File Formats in Appendix 4 .

Downloading Video to Your PC in Data DVD Format or Uncompressed Format
This section describes how to download standalone video information to your PC in a Data DVD or an Uncompressed 
Format . Standalone video is video that is not linked to a case.
Perform this procedure if you want to email video, put it on a USB drive or other device, play it back locally without burning 
it to a disc, and/or import the video into another software application . If you want to download video for the sole purpose of 
burning a DVD, see Burning Video to a Data DVD or an Uncompressed Format DVD on page 139 instead .

 WARNING: Video authenticity

Once a video has been downloaded in uncompressed format and then converted to MP4 and DV files, its authenticity 
can no longer be verified. Such video can be edited and tampered with using commercial video editing software.

A Data DVD or Uncomressed Format download will include:
• Selected videos
• General information associated with the videos (Officer Name, DVR, Start/End Times, System ID)
• The Chain of Custody Report
• A copy of the Flashback Player.

To download video in Data DVD format or Uncomressed format:
1 . If necessary, review Searching for Videos on page 27, and then perform one of the following tasks:

• To download one video, search for and display the desired video . The Video Details page is displayed .

 NOTE: DEF users

Workflows on downloading videos are not available to users of the DEF application.
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• To download more than one video, search for the desired videos . The Video Search Results page is displayed .
2 . Go to the Action menu and click Export . The Select Video(s) for Export page is displayed . 

 NOTE: Offline videos

If a video you're trying to export is offline, there will be no Export option in the Action menu, or the following 
message will be displayed at the top of the page: Media must be online to export.

3 . If in step 1 you have chosen to download multiple videos, click each of the videos you want to download; otherwise 
skip to the next step. NOTE: You can click any part of the record except the thumbnail image, as that will launch the 
Flashback Player. As you select each video, it will appear in the Selected Videos list at the bottom of the page. 

4 . Go to the Action menu and click Export Video(s) . The Export Video(s) page is displayed . 

5 . Select Data DVD from the Output Format drop-down list .
6 . Go to the Action menu and click Save . The Export Options pop-up is displayed as pictured on the next page . 
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7 . Select the Manual Export radio button, and then the ZIP radio button.
8 . Enter a description for this video download in the Video Description field.
9 . Make your selection from the Chain of Custody Log Level drop-down list .
10 . If a Video Player Options section is displayed in the lower left corner of the Export Options pop-up:

• Select the Show GPS checkbox to include GPS data with the Flashback Player in this download.
• Select the Show Speed checkbox to include vehicle speed data with the Flashback Player in this download. 

11 . Click Save. The system places your burn request in the burn queue and is displayed a status message on your Welcome 
Home page under Sent Messages .

12 . Go to your Inbox Messages, and then click the download icon next to the export confirmation message.  

 

 TIP: Download icon 

If you do not see the download icon, the system is still processing your request . Go to the Home Menu and click 
Home to refresh your screen . 

 
A Windows message is displayed . 

13 . Select Save As from the Save drop-down list . The Save As window is displayed .
14 . Navigate to the disk drive location where you want to temporarily save this file, and then, if desired, enter a new name in 

the File name field.
15 . Click Save. The system copies your file to the selected location. When the download is complete, a confirmation 

message is displayed . 

 NOTE: Export options
Depending on the application you are using, 
the Export Options pop-up may appear 
differently .

Depending on your
user permissions,

these checkboxes may
or may not be displayed
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Downloading Video to Your PC in Interchange Format
This section describes how to download selected standalone videos to your PC in interchange format. Standalone video is 
video that is not linked to a case.
Perform this procedure if you want to email video, put it on a USB drive or other device, play it back locally without burning 
it to a disc, and/or import the video into another software application . If you want to download video for the sole purpose of 
burning a DVD, see Burning Video to an Interchange Format DVD on page 142 instead .

 WARNING: Video authenticity

Once a video has been exported in interchange format, its authenticity can no longer be verified. Such video can be 
edited and tampered with using commercial video editing software .

 

To download video in Interchange format:
1 . Follow steps 1 - 4 of the Downloading Video to Your PC in Data DVD Format or Uncompressed Format procedure .
2 . Go to the Output Format field and select Interchange Format from the drop-down list. Two new columns are displayed: 

Video Source and Audio Source . 

3 . Perform one or more of the following tasks: 

If... Then...

The word Camera is displayed 
in both the Video Source  and 
Audio Source columns

• Proceed to the next step .

Checkboxes are displayed in the 
Video Source column

• Select the camera views you want to include for each video, as follows: 

Copy only the video recorded from Camera Channel 1 
(forward facing zoom camera) .

Copy only the video recorded from Camera Channel 2 
(Backseat and/or Bullet cameras).

Copy the video that was recorded from both Camera 
Channel 1 and Camera Channel 2 . NOTE: When you choose 
this option, the system will burn two separate video files 
on the DVD that will appear as separate menu items . This 
doubles your DVD space requirement.
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Checkboxes are displayed in the 
Audio Source column

• Select the audio sources that you want to include for each video . You may 
select up to two audio sources for each video, as described below. These 
audio tracks will play concurrently when watching the video.
• VLP1/In Car. The audio from the wireless microphone that’s connected to 

your Flashback’s VLP 1 port and the audio from your in-car microphone 
(default) . 

• VLP2. The audio from the wireless microphone that’s connected to your 
Flashback’s VLP 2 port, if applicable.

 NOTE: Audio Playback
If you choose the VLP1/In Car audio setting, you will be able to toggle back and forth between two audio streams: 
the stream from your first wireless microphone (VLP1) and the stream from your in-car microphone (In-car). On 
your DVD player, the VLP1 audio stream is available on the left stereo channel, and the In Car audio stream is 
available on the right stereo channel. You can use the balance controls on your DVD player to switch back and 
forth between these two streams.
If you choose the VLP2 audio setting, that audio stream will be available on your DVD player’s left stereo channel, 
and the right stereo channel will be mute.

4 . Go to the Action menu and click Save . The Export Options pop-up is displayed . 

5 . Follow steps 7 - 8, and then 10 - 14 of the Downloading Video to Your PC in Data DVD Format or Uncompressed Format 
procedure .

Downloading Video to Your PC in FOIA Redacted Format
This section describes how to download selected standalone videos to your PC in FOIA Redacted format. Standalone video 
is video that is not linked to a case.

 WARNING: Video authenticity

Once a video has been exported in FOIA Redacted format, its authenticity can no longer be verified. Such video can be 
edited and tampered with using commercial video editing software .

To download video in FOIA Redacted format:
1 . Follow steps 1 - 4 of the Downloading Video to Your PC in Data DVD Format or Uncompressed Format procedure .
2 . Select FOIA Redaction Format from the Output Format drop-down list. Three new columns are displayed: Video Source, 

Audio Source, and Redaction . 
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3 . Perform one or more of the following tasks: 

If... Then...

The word Camera is displayed 
in both the Video Source  and 
Audio Source columns

• Proceed to the next step .

Checkboxes are displayed in the 
Video Source column

• Select the camera views you want to include for each video, as follows: 

Copy only the video recorded from Camera Channel 1 
(forward facing zoom camera) .

Copy only the video recorded from Camera Channel 2 
(Backseat and/or Bullet cameras).

Copy the video that was recorded from both Camera 
Channel 1 and Camera Channel 2 . NOTE: When you choose 
this option, the system will burn two separate video files 
on the DVD that will appear as separate menu items . This 
doubles your DVD space requirement.

Checkboxes are displayed in the 
Audio Source column

• Select the audio sources that you want to include for each video . You may 
select up to two audio sources for each video, as described below. These 
audio tracks will play concurrently when watching the video.
• VLP1. The audio from the wireless microphone that’s connected to your 

Flashback’s VLP 1 port (default).
• VLP2. The audio from the wireless microphone that’s connected to your 

Flashback’s VLP 2 port, if applicable
• In Car . The audio from your in-car microphone .

4 . Go to the Redaction column and click one of the following buttons:
• Camera . Redact the video from a FOCUS H1, BodyVISION, BWX-100, or FOCUS X2 DVR . 
• Front. Redact the video from a Flashback’s Camera Channel 1. For in-car systems, this is the video captured with 

your forward facing zoom camera .
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• Rear. Redact the video from a Flashback’s Camera Channel 2. For in-car systems, this is the video captured with 
your Backseat camera and/or Bullet cameras. 
The Redaction Settings pop-up is displayed . For detailed description of redaction settings refer to the 
corresponding table in Appendix 2 - Videos. 

5 . To blur the entire video or video segment, select a Blur Level: Low, Med, or High .
6 . To export a video segment instead of the original full-length video, perform the following steps:

a. Select the Enable Trimming checkbox
b. Enter the beginning of the video date/time range in the Trim Start field. 
c. Enter the end of the video date/time range in the Trim Stop field. 

7 . Click Save, and then, if desired, repeat steps 4 – 7 to redact other videos that are included with this case DVD .
8 . Go to the Action menu and click Save . The Export Options pop-up is displayed . 

9 . Follow steps 7 - 8, and then 10 - 14 of the Downloading Video to Your PC in Data DVD Format or Uncompressed Format 
procedure . 
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Managing Video Attributes

Managing User Metadata
As a System Administrator, you have the ability to add, change, and/or delete user metadata fields at any time. These fields 
allow officers to notate their videos with custom data, such as a citation number or subject description. You can perform the 
following tasks:
• Add a new user metadata field
• Change or delete an existing user metadata field .

 NOTE: DEA Precinct users

DEA Precinct users can only view user metadata as described in step 1 of Adding a New User Metadata Field below.

Adding a New User Metadata Field
To add a user metadata field:
1 . Go to Administration > System Setup > System > UMD Types . A list of existing UMD records (if any) is displayed . 

     
2 . Go to the Action menu and click New . The New UMD Type 

form is displayed. The fields on this form are described in  
the corresponding table in Appendix 2 - Videos. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 NOTE: Changing 
display order
Click the up and down 
arrows to change the 
order in which the 
user metadata fields 
are displayed .
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3 . Perform one of the following tasks: 

If... Then...

This UMD will be a single line text field (default) • Proceed to the next step .

This UMD will be a text box • Select Text box from the Input Type drop-down list . The text 
box version of the New UMD Type pop-up is displayed . 

4 . Enter the following information:
• An ID code for this UMD in the Unique ID field
• The name of the UMD in the Label field. This is how the UMD field will appear on the actual data entry form.

5 . If you are creating a text box UMD, click Save to close the New UMD Type pop-up .
6 . To apply a mask to this UMD, enter a UMD mask in the Mask field using the appropriate characters (see on-screen list) .
7 . If you did not enter a value in the Mask field, enter the maximum length for this UMD in the Max Size field
8 . Click the Save button. The UMD Types list is displayed. Notice that the new record is displayed at the bottom of the list. 

Unless you move the record up or down, this is the order in which the new data field will appear on the video record. 

     

Changing or Deleting an Existing User Metadata Field
This section describes how to change or delete an existing user metadata field in your DES application.

 WARNING: Deleting a UMD field

 If you delete a UMD field that is currently attached to one or more videos, the system will permanently remove that 
UMD field from those videos.

 NOTE: Changing 
display order
Click the up and down 
arrows to change the 
order in which the 
user metadata fields 
are displayed .
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To change or delete a user metadata field:
1 . Follow step 1 of the Adding a New User Metadata Field procedure .
2 . Right-click the record of interest, and then perform one of the following tasks: 

To... Do this...

Change an existing 
UMD type

1 . Select Edit from the pop-up menu . The Edit UMD Type pop-up is displayed . 

       
2 . Enter/select your new field value(s), and then click Save .

Delete an existing 
UMD type

1 . Select Delete from the pop-up menu. A confirmation pop-up is displayed. 

2 . Click Yes . The system removes the selected record from the UMD list and from any videos 
that it is currently attached to .

Managing Video Notations
Video notations are custom pieces of information that you can use to classify and organize videos . Once the Video Notation 
feature is activated, any video notations you create will be displayed on the Edit Video form .  
You can perform the following tasks:
• Add a new video notation
• Change or delete an existing video notation
• Turn video notations on or off
• Export video notations activity to a spreadsheet . 

 NOTE: DEA Precinct users

Workflows described in this section are not 
available to users of the DEA Precinct application.

Single line version

Text box version
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Adding a New Video Notation
This section describes how to add a new video notation to the Video Details page .
To add a video notation:
1 . DEA Agency and your DEP users: go to Administration > System Setup > Video/Case > Videos > Notations. 

DEF and DEV users: go to Administration > System Setup > Video > Notations. 
Then go to the Action menu and click New . The New Video Notation pop-up is displayed . 

2 . Enter a name for the new video notation in the Notation field, and then click Save . The new notation is added to the 
Video Notations list .

Changing or deleting an Existing Video Notation 
This section describes how to update an existing video notation, or delete a video notation record that was previously 
created .
To change or delete a video notation:
1 . Follow step 1 of the Adding a New Video Notation procedure .
2 . Right-click the record of interest, and then perform one of the following tasks:

To... Do this...

Change, enable or 
disable an existing 
video notation

1 . Select Edit from the pop-up menu . The Edit Video Notation pop-up is displayed . 

2 . To change the name of this video notation, enter a new value in the Notation field.
3 . To change this video notation’s status, select a value from the Status drop-down list .
4 . Click Save .

Delete an existing 
video notation  NOTE: Deleting video notations

You can only delete those video notations that are not in use by a video. If you want to 
discontinue use of a notation but cannot delete it, you will have to disable it as described 
above.

1 . Select Delete from the pop-up menu. A confirmation pop-up is displayed. 

 
NOTE: If the selected notation is in use by an active case, the system will display an error 
message .

2 . Click Yes . The selected record is removed from the Video Notations list .
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Turning Video Notations On/Off
This section describes how to turn the video notations feature on or off. When this feature is ON, all predefined video 
notations will be displayed on the Edit Video form. When this feature is OFF, no video notations will be displayed on the Edit 
Video form .
To turn video notations on or off:
1 . Go to Administration > System Setup > System > Other, then go to the Action menu and click Edit . The Other pop-up is 

displayed . 

2 . To turn the video notations feature on or off, select or deselect the Enable Video Notations check box as desired, and 
then click Save .

Exporting Video Notations Activity to a Spreadsheet
This section describes how to export video notations activity to a spreadsheet for use with another application, such as a 
custom reporting tool. The export includes a list of all video notations that have been added or removed from a video or 
snapshot file during a selected time period.
To export video notations activity:
1 . Go to Administration > System Status > Reports, then click the Video Notations report to highlight it .
2 .  Go the Action menu and click Generate Report . The New Report pop-up is displayed . 

3 . Using the calendar icon beside the Start Date field, select the beginning of the date range for this report.
4 . Using the calendar icon beside the End Date field, select the end of the date range for this report.
5 . Click Generate. The system generates the report and places it in your PC’s Downloads folder .
6 . Navigate to your Downloads folder, and then double-click the CSV report file. The report is displayed in your default 

spreadsheet application, such as Microsoft Excel .
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Managing Video Categories
This section describes how to change or export the information associated with video categories. For a detailed description 
of video categories and how they are used in your DES application, see the Video Details Page table in Appendix 2 . 

 NOTE: DEA Precinct users

DEA Precinct users you can only view video categories as described in step 1 of Changing Video Category Information 
below.

Changing Video Category Information
This section describes how to change the following information for a video category: category name, backup status 
(enabled vs. disabled), usage status (in-use vs. disabled), days online (i.e., the number of days a video or snapshot of a 
certain category will remain online before it can be purged from the server).
To change video category information:
1 . DEA and DEP users: go to Administration > System Setup > Video/Case > Videos > Categories . 

DEF and DEV users: go to Administration > System Setup > Video > Categories . 
The current category list is displayed . 

2 . Right-click the category you want to change, then select Edit from the pop-up menu . The Edit Video Category pop-up is 
displayed. The fields on this pop-up are described in the corresponding table in Appendix 2 - Videos. 

 

 NOTE: Video category options

Depending on the application you are using, 
the options available to you in the Edit Video 
Category pop-up may be different.
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3 . Perform one or more of the following steps: 

To change... Do this...

The name of this category • Enter a new name in the Description field. NOTE: DEF users should only 
change this field value in coordination with the DEP System Administrator. 
Field values should match on both servers.

The number of days that a video 
or snapshot with this category 
will remain online before it can be 
purged

• Enter a new number in the Day(s) Online field

The Backup Enabled status for 
this category

• Select a new value from the Backup Enabled drop-down list .  NOTE: DEF 
users should not  change this field value unless instructed to do so by the 
DEF System Administrator

The In Use status for this category • Select a new value from the In Use drop-down list . NOTE: DEF users 
should only change this field value in coordination with the DEP System 
Administrator. Field values should match on both servers.

The Auto Transfer status for this 
category

• Select the new value from the Auto Transfer Enabled drop-down list .

4 . Click Save .
5 . To update another category, repeat steps 2 – 4 .

Manually Exporting Video Categories
Normally, when you change video categories on the server, that information is automatically transmitted to each DVR during 
the next server-to-DVR transmission . However, if your department does not use the wireless downloading feature, you can 
manually copy updated video categories from the server to a Flashback2 DVR, as described here.
To export video categories:
1 . Insert a USB drive in a USB port on your PC .
2 . Follow step 1 of the Changing Video Category Information procedure .
3 . Go to the Action menu and click Export Categories . A Windows message is displayed . 
4 . Select Save As from the Save drop-down list . The Save As window is displayed .
5 . Navigate to your USB drive, and then click Save .
6 . Take the USB drive and use it to load the config.xml file onto the in-car DVR, as described in Copying the config.xml File 

from a USB Drive to Your DVR in your Flashback2 User’s Guide .
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Installing Applications
You can install various applications that will help your organization manage videos and related data .
All applications are accessible from the Applications menu in the Tools tab pictured below, which you can open by going to 
Administration > System Status > Tools . 

Installing the UMD Editor on an Officer’s Mobile Data Computer
If your vehicles are equipped with mobile data computers (MDCs), officers have the option of assigning user metadata to 
their in-car videos immediately after they are finished recording. However, this option requires that you install an application 
called the UMD Editor on your mobile data computers. You will also need to configure your MDCs for Ethernet.
If your agency is using Vehicle Viewer or Vehicle Viewer Live, the UMD Editor is already included with those applications .

 NOTE: Windows users

This procedure is for Windows 10 users . If you have an earlier version of Windows, these steps may differ slightly . 

To install the UMD editor:
1 . If you have not done so already, configure each of your MDCs as an Ethernet network, as described in Configuring an 

In-Car DVR Not Assigned to a DVR Group on page 189 . NOTE: Using an Ethernet connection in the vehicle will not 
interfere with your wireless video transmission .

2 . Insert a USB flash drive into a USB port on your PC (i.e., the PC you use to connect to the your DES application).
3 . Go to Administration > System Status > Tools, and then click the User Meta Data Editor button. The system downloads 

the installation file to your PC’s Downloads folder.
4 . Navigate to your Downloads folder. Make sure the FBUMD_windows_2_4.exe file is selected, then press Ctrl + C to 

copy it to your clipboard.
5 . Navigate to your USB drive, then press Ctrl + V to copy the FBUMD_windows_2_4.exe file to that drive.
6 . Remove the USB drive from your PC, and then insert it into a USB port on the in-car mobile data computer.
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7 . Log in to the mobile data computer, and then navigate to the USB drive.
8 . Click the FBUMD_windows_2_4.exe file, then press Ctrl + C to copy it to your clipboard.
9 . Navigate to the PC directory where you want to install the UMD editor .
10 . Press Ctrl + V to copy the EXE file to the selected directory.
11 . Double-click the FBUMD_windows_2_4.exe file, and then click Run in the displayed security pop-up . 

After a momentary delay, the Install Wizard is displayed . 

12 . Click Next. The system begins installing the application on the mobile data computer. When the installation is complete, 
a confirmation message is displayed. 

13 . Click Finish, and then remove the USB stick from the USB port.
14 . Repeat steps 6 – 13 for all of the vehicles in your fleet. 

 NOTE:  Entering DVR's IP address

The first time you use the UMD Editor you will be prompted to enter the DVR’s IP address. If you don’t know the IP 
address, you can find it in the DVR’s record. For more information, see Searching for an Existing DVR or 8-Bay Dock on 
page 185.
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Installing the Flashback File Converter
This procedure describes how to install the Flashback File Converter utility on your PC. 

 NOTE: Windows users

This procedure is for Windows 10 users . If you have an earlier version of Windows, these steps may differ slightly . 

To install the Flashback file converter:
1 . Go to Administration > System Status > Tools, and then click the Flashback File Converter button. The system 

downloads the application to your PC’s Downloads folder .
2 . Navigate to your Downloads folder, and then double-click the FlashbackConverter-1.0.0.5.exe file. 
3 . Click Run in the displayed security pop-up . The Flashback Converter - InstallShield Wizard is displayed . 

4 . Click Next, and then select I accept the terms in the license agreement radio button in the License Agreement window .  
The Setup Type window is displayed . 

5 . Click Next, and then click Install in the displayed Ready to Install the Program window. The system begins installing the 
application. After the installation is complete, a confirmation message is displayed.

6 . Click Finish .
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Installing the Windows Codec Utility for AVI Videos
Occasionally, customers who have purchased a new PC or reimaged an existing PC may have difficulty playing or VIEVU 
videos on their PC. In this circumstance, we recommend that you install a utility called a “codec,” which restores the files 
that are necessary to play AVI files on a Windows PC. If this procedure does not solve your problem, please contact Mobile-
Vision Support for assistance .

 NOTE: Windows users

This procedure is for Windows 10 users . If you have an earlier version of Windows, these steps may differ slightly . 

To install the Windows Codec utility:
1 . Go to Administration > System Status > Tools, and then click the FB1 Windows Codec button. The system downloads 

the installation file to your PC’s Downloads folder .
2 . Navigate to your Downloads folder, and then double-click the WVIDInstall.exe file. 
3 . Click Run in the displayed security pop-up . The Installer Language pop-up is displayed . 

4 . Click OK . The WVID Filter pop-up is displayed . 

5 . Click Next, and then click Install. Once the installation is complete, a confirmation message is displayed.
6 . Click Close .
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Manually Installing the VIEVU Drivers
The VIEVU is a small body-worn DVR previously sold by Mobile-Vision. The first time you connect a VIEVU to your PC, you 
will typically be prompted to download two drivers that are required to operate the VIEVU. However, if your computer does 
not recognize the VIEVU cable or cannot automatically locate the drivers, you can manually download these drivers from the 
Tools tab.

 NOTE: Windows users

This procedure is for Windows 10 users . If you have an earlier version of Windows, these steps may differ slightly . 

To install VIEVU drivers:
1 . If the VIEVU is currently connected to your PC, disconnect the VIEVU’s two USB cables.
2 . Go to Administration > System Status > Tools, and then click the VieVu Drivers button. The system downloads the 

VIEVU drivers to your Downloads folder .
3 . Navigate to your Downloads folder, then right-click the VIEVU_DRIVERS.zip file and select Extract to VIEVU_DRIVERS\ 

from the drop-down list . 

4 . Double-click the new VIEVU_DRIVERS folder . The contents of the VIEVU_DRIVERS.zip file are displayed. 
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5 . If your PC has a 64-bit operating system, double-click DPInstx64.exe 
– OR – 
If your PC has a 32-bit operating system, double-click DPInst_Mon86.exe 
Once you double-click the appropriate file, a DOS screen will briefly flash on-screen, indicating that the drivers have been 
installed . 

 TIP: Your operating system

If you aren’t sure what type of operating system you have, double-click either DPInstx64.exe or DPInst_Mon86.exe . 
If you get an error message, you’ll know that you selected the wrong file.

6 . Go to the upper right corner of the page and click Logout to exit your DES application .
7 . Click the cross icon in the upper right corner of the page to close your browser.
8 . Reboot your PC, and the log back into your DES application.
9 . If you plan to upload VIEVU videos right now, plug the VIEVU’s USB cables back into your PC, then proceed to the 

appropriate topic:
• Manually Uploading Videos from a VIEVU LE2 on page 61, beginning with step 5,  

-OR-
• Manually Uploading Videos from a VIEVU LE3 on page 63, beginning with step 3 .

Manually Installing the Flashback Player
Typically, the Flashback Player launches automatically when you attempt to play a video from the server. However, if your 
agency prohibits the running of EXE files from the browser’s “temp” folder, you can manually download the Flashback Player 
from the Tools tab. The Flashback Player is installed like any other Windows 32-bit application—in the Windows Program 
Files folder .
There are two file options available for installing the Flashback Player:
• EXE file (Flashback Player Installer button)
• ZIP file (Flashback Player Installer Bundle button).

Both file options require Windows administrative privileges on the client workstation to install. Select the bundle option if 
you are an IT Administrator and you plan to install the Flashback Player through a Microsoft System Management Server 
(SMS) or a Microsoft System Center Configuration Manager (ConfigMgr). The bundled scripts will allow IT Administrators to 
install the Flashback Player silently.

 NOTE: Windows users

This procedure is for Windows 10 users . If you have an earlier version of Windows, these steps may differ slightly . 

To install the Flashback Player:
1 . Go to Administration > System Status > Tools, and then perform one of the following tasks: 

To... Do this...

Install the Flashback Player on your local PC • Click the Flashback Player Installer button. 

Install the Flashback Player through SMS or ConfigMgr 
(also referred to as a silent installation or update)

• Click the Flashback Player Installer Bundle button.

 
The system downloads the application to your PC’s Downloads folder .
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2 . Navigate to your PC’s Downloads folder, and then perform one of the following tasks:
• Double-click the FlashbackPlayer-4_0_3_9.exe file, and then click Run in the displayed security pop-up . 

-OR-
• Perform the following steps:

a. Right-click the FBPlayer-Bundle-4_0_3_8.zip file, then select Extract to FBPlayer-Bundle-4_0_3_8 from the drop-
down list .

b. Double-click the new FBPlayer-Bundle-4_0_3_8 folder to open it .
c. Double-click the FlashbackPlayer-4__0_3_8.exe file.

The Flashback Player - InstallShield Wizard is displayed . 

3 . Click Next, and then select I accept the terms in the license agreement radio button in the License Agreement window .  
The Ready to Install the Program window is displayed . 

4 . Click Install. The system begins installing the Flashback Player. Once the installation is complete, a confirmation 
message is displayed . 

5 . Click Finish, then click Logout in the upper right corner of the page to exit your DES application .
6 . Click the cross icon in the upper right corner of the page to close your browser.
7 . Open your browser and log back into your DES application. 
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Installing the FOCUS X2 Single-Bay Software
The X2 Single-Bay Software is an application that allows the X2 body-worn DVR inserted into a single-bay office dock to 
communicate with the server. The application is installed on an agency PC and when the office dock is connected to that PC 
via a USB cable, X2 and the server are able to exchange information, such as:
• Upload of recorded videos
• Configuration settings updates
• Firmware updates .

To install the X2 Single-Bay Software:
1 . Go to Administration > System Status > Tools, and then click the Single-Bay Software button. The system downloads 

the application to your PC’s Downloads folder .
2 . Navigate to your Downloads folder, and then double-click the dock-2.0.0.msi file. NOTE: If you get a system warning 

about an executable file, click OK .
3 . Click Run in the displayed security pop-up . The Single Bay Dock Setup window is displayed . 

4 . Click Next, then select I accept the terms in the License Agreement checkbox in the End-User License Agreement 
window, and click Next again .  The Ready to install Single Bay Dock window is displayed . 

5 . Click Install . Follow system prompts to advance through the installation . After the installation is complete, a 
confirmation message is displayed.

6 . Click Finish .
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Managing Body-Worn Viewing Requests
This section describes how your agency can limit access to body-worn videos by activating body-worn tracking functions, 
and how to manage viewing requests .
You can limit access to body-worn videos by activating the following functions:
• Track all body-worn videos . When this feature is on, your DES application will restrict the viewing of all body-worn 

videos unless a user has the Authorize Media Playback or Can View Body Worn Videos permission. Users who lack the 
required permissions will have to submit a viewing request to their supervisor. The supervisor, in turn, will subsequently 
approve or deny their subordinate’s viewing request as described in Approving/Denying Viewing Requests on page 
87.

• Track all body-worn videos with tags . When this feature is on, your DES application will restrict the viewing of body-
worn videos that have a tracepoint or video notation attached to them . The only exception is for users that have the 
Authorize Media Playback or Can View Body Worn Videos permission. Such users will be able to view all body-worn 
videos, regardless of whether a video has an embedded trace-point or video notation. Users who lack the required 
permissions will have to submit a viewing request to their supervisor.

Tracking Body-Worn Videos
This section describes how to activate (turn on) the two functions used to limit user access to body-worn videos.
To activate video tracking:
1 . Go to Administration > System Setup > System > Other, then go to the Action menu and click Edit . The Other pop-up is 

displayed . 

2 . Perform one of the following tasks: 

To... Do this...

Require that all users without proper permissions submit a viewing request 
to view any body-worn video

• Select the Track Body Worn Videos 
checkbox

Require that all users without proper permissions submit a viewing request 
to view a body-worn video that has an embedded tracepoint or video 
notation

• Select the Track Body Worn Videos 
with Tags checkbox

3 . Click Save .
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Approving/Denying Viewing Requests
This section describes how to approve or deny a request to view a body-worn video. Users submits such a request to the 
supervisor when they wants to view a particular body-worn video or snapshot image, but lack the required permissions to 
do so (i .e ., the Can View Body Worn Videos and/or Authorize Media Playback permission) .
To approve/deny viewing requests, you must have the Authorize Media Playback permission . 

   
To approve and deny viewing requests:
1 . Make sure the Welcome Home page is displayed, and then locate the viewing request on your Inbox Messages list . 

2 . To view the video before making a determination, click the  icon to the right of the request. Otherwise skip to step 5 . 
The Video Details page is displayed . 

3 . Click the video’s thumbnail image. The video launches in the Flashback Player.
4 . When you’ve finished viewing the video, close the Flashback Player, and then go to Home Menu and click Home . The 

Welcome Home page is displayed .
5 . Perform one of the following tasks: 

To... Do this...

Accept the viewing request • Click the  icon beside that request. 
A confirmation message is displayed at the top of the page: Request Approved . 
The system also sends an approval notice to the requestor’s Inbox Messages list .

Sample denial

Sample approval
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To... Do this...

Deny the viewing request 1 . Click the  icon . The Deny Request pop-up is displayed . 

2 . Enter the reason why you are denying this viewing request, and then click Save . 
The system sends a denial notice to the requestor’s Inbox Messages list . That user 
will have an opportunity to view your denial reason by clicking the  icon .

Reviewing and Revoking Active Viewing Requests
This section describes how to review all active viewing requests that you previously approved and how to revoke an active 
viewing request, which is an approval granted to an officer to view a body-worn video or snapshot record within a predefined 
time period. Once you grant a viewing request to a user, that request remains active for X number of days, where X is equal 
to the value of the Days to allow playback on approved requests field on the Other form . 

   
For example, let’s say that an officer submitted a viewing request to you on December 1st to view body-worn video 
number 241. You reviewed and approved the request, which would have remained in effect until December 30th according 
to your system settings. However, on December 15th, you received an email from your Chief stating that from now on, 
only Detectives can access video 241. In that instance, you could use this procedure to revoke that user’s video access 
permission .
To review and revoke viewing requests:
1 . Make sure the Welcome Home page is displayed, then go to the Action menu and click Manage Requests . The Manage 

Approved Media View Requests pop-up is displayed. The columns on this pop-up are described in the corresponding 
table in Appendix 2 - Videos. 

In this example, all 
viewing requests 

will remain in effect 
for 30 days after 
they are granted .



© Safe Fleet | September 2021 | All rights reserved

Digital Evidence Series Administrator's Guide

89 Part # 700-8006 R3

Managing Body-Worn Viewing Requests

2 . To revoke a user’s viewing permission, click the  icon to the right of that request . The Deny Request pop-up is 
displayed . 

3 . Enter the reason why you are revoking this user’s viewing approval, and the click Save . The system sends a denial notice 
to the requestor’s Inbox Messages list. That user will have an opportunity to view your denial reason by clicking the  
icon .

4 . Click the cross icon in the upper right corner to close this pop-up.

Exporting Viewing Request Activity to a Spreadsheet
This section describes how to export viewing request activity to a spreadsheet for use with another application, such as a 
custom reporting tool. This data includes a list of all body-worn viewing requests that have been made during a selected 
time period .
To export viewing request activity:
1 . Go to Administration > System Status > Reports, and then click the BW Video Requests report to highlight it . 

2 . Go the Action menu and click Generate Report . The New Report pop-up is displayed . 

3 . Using the Start Date and End Date fields, select a date range for your report, and then click Generate . The system 
generates the report and places it in your PC’s Downloads folder .

4 . Navigate to your Downloads folder, and then double-click the CSV report file.  The report is displayed in your default 
spreadsheet application, such as Microsoft Excel .
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Managing Viewing Request Reasons
This section describes how to add, change, and/or delete viewing request reasons, which are used to populate the Request 
Reason drop-down list on the Request Viewing pop-up .

These agency-defined reasons are used to help create viewing requests, which an officer submits to their supervisor in order 
to obtain permission to view a body-worn video or snapshot file.
To add, change or delete viewing request reasons:
1 . Go to Administration > System Setup > System > Request Reasons . A list of all existing viewing request reasons is 

displayed . 
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2 . Perform one of the following tasks: 

To... Do this...

Add a viewing request 
reason

1 . Go to the Action menu and click New. The New Request Reason pop-up is 
displayed . 

2 . Enter a name for the viewing request reason in the Description field, and then click 
Save . The new reason is added to the Request Reasons list .

Change, enable, or disable a 
viewing request reason

1 . Right-click the record you want to update, then select Edit from the pop-up menu . 
The Edit Request Reason pop-up is displayed . 

2 . To change the name of this request reason, enter a new value in the Description 
field. 

3 . To change the request reason’s status, select Enabled or Disabled from the Status 
drop-down list accordingly to activate or inactivate this request reason .

4 . Click Save .

Delete a viewing request 
reason  NOTE: Deleting request reasons

You can only delete those request reasons that are not in use by an active 
request. If you want to discontinue use of a request reason but cannot delete it, 
you will have to disable it as described above.

1 . Right-click the record you want to delete, then select Delete from the pop-up menu . 
A confirmation pop-up is displayed. 

 
NOTE: If the selected request reason is in use by an active request, the system will 
display an error message .

2 . Click Yes . The selected record is removed from the Request Reasons list .
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Changing the Expiration Date for Viewing Approvals
By default, all viewing approvals that you grant your staff members will remain in effect for 30 days. However, you can 
increase or decrease this number to meet your agency’s needs, as described in this section.
To change the expiration date:
1 . Go to Administration > System Setup > System > Other, then go to the Action menu and click Edit . The Other pop-up is 

displayed . 

2 . Enter a new number in the Days to allow playback on approved requests field, and then click Save .
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Working with Cases
This chapter describes how to work with cases in DES applications. 

 NOTE: DEF and DEV users

The contents of this chapter is not applicable to users of the DEF and DEV applications.

A case is a record that contains one or more videos and other data that pertains to an incident, such as a motor vehicle 
accident. This feature allows you to conveniently gather all of an incident’s evidence in one record, allowing for easy viewing 
and archiving of evidence .
Besides video, a case may contain other media files (such as photographs), subject names, comments, and general 
information relating to the incident .
If you have a case that you access frequently, you may add it to a list of favorite cases . This feature provides you with a 
quick and easy method to access those cases that you refer to frequently.

 NOTE: Cases in DEA applications

Cases can be created both on the Agency server and on the Precinct server(s). However, if a case is originally created 
on a Precinct server, you cannot update it on the Agency server unless you first request control of that case from the 
Precinct .
If you are a DEA Precinct user, occasionally, a user on the Agency server may request control of one of your case 
records. When that happens, you will no longer be able to update that case on the Precinct server. However, you will still 
be able to view, export, and/or generate a Chain of Custody Report for that case.

Creating Cases
This section describes how to enter a new case. There are two methods for creating a new case:
• Method 1: Open a new case and attach video(s) to it. This method is described in Creating a Regular Case and Creating 

a Restricted Case sections in this chapter . Restricted cases allow you to define which users will be allowed to access a 
case .

• Method 2: Open a video and create a new case to attach it to.

Creating a Regular Case
This section describes how to enter a new case that has the typical access privileges. In a DES application, this means that 
the case is either public or private. Public cases can be accessed by any DES user. Private cases can be accessed by the 
case’s owner and users who have edit permissions. If you prefer to create a case that grants access to a specific group of 
users, see Creating a Restricted Case on page 96 instead .
To create a regular case:
1 . Go to Home Menu and click Manage Cases . The Case Information pop-up is displayed . 
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2 . Click New Case . The New Case form is displayed. The fields on this form are described in the corresponding table in 
Appendix 3 - Cases. 

3 . Select the name of the officer who will be the owner of this case from the Owner drop-down list .
4 . Select Public or Private from the Visibility drop-down list to mark the case as public (viewable by all users) or private  

(only viewable by its owner and users with edit permissions).
5 . Enter the following information:

• A descriptive name for this case in the Display Name field. This is a required field.
• The case’s incident date in the Incident Date field. Observe mm/dd/yyyy format. This is a required field.
• Your agency’s case number in the Case Number field.

6 . If available, enter the following information associated with this case in the corresponding fields:
• A citation number
• A vehicle registration number
• A license plate number.

7 . If the Do Not Dispose checkbox is displayed, you can select it to keep this case available online even after the Auto 
Dispose Time has expired . NOTE: Once you select the Do Not Dispose checkbox, the system will not remove the case 
from the server until you deselect that checkbox.

8 . If there are any checkboxes to the right of the Notations field, select all that apply to this case. 
9 . Click Save. A confirmation message is displayed at the top of the Case Details page .

Creating a Restricted Case
This section describes how to enter a new case that is restricted. Restricted cases can only be accessed by a predefined list 
of users . This feature is particularly useful if you want to limit video access across multiple permission levels . 
For example, let’s say that you only want detectives to have access to Interview Room videos. In this scenario, you could 
create ONE restricted case called Restricted Viewing—Interview Room, then add all of your detectives to that case’s list of 
authorized users. Whenever there is a new Interview Room video available, you would then link that video to the Restricted 
Viewing—Interview Room case. In this manner, the Interview Room videos would always be hidden from unauthorized users 
on the system, even if those videos are linked to other cases.
You must have the proper permissions to perform this task. Typically, this capability is given to Internal Affairs detectives.
To create a restricted case:
1 . Follow steps 1 - 3 of the Creating a Regular Case procedure .
2 . Select the Restricted Viewing checkbox. The Visibility field becomes grayed out, and a new Authorized Users tab is 

displayed at the top of the form, as pictured on the next page . 
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3 . Follow steps 5 - 8 of the Creating a Regular Case procedure .
4 . Click the  Authorized Users tab. A list of system users is displayed. 

5 . Go to the Select Authorized Users column and click each of the users that you want to allow access to this case. 

 TIP: Navigating the list of users

 To scroll through a large user list, use the navigation arrows at the top of the column or enter a user name in the 
Search field.

6 . Once you’ve highlighted the desired users, click the  icon in the center column . The selected users are displayed in the 
Approved Users column . 

7 . Click Save. A confirmation message is displayed at the top of the Case Details page .
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Searching for Cases
You can search for videos by a number of different criteria. Your DES application provides you with two search methods: 
basic and advanced.

Search method Used to search for cases by some or all of these criteria…

Basic Case Information:
• Incident Date
• Citation Number
• Case Number
• Case Display Name
• Vehicle Registration #
• Owner
• Precinct

Subject Information:
• First Name
• Last Name

Additional advanced search criteria

Advanced Case Information:
• Creation Date
• After Incident Date
• Before Incident Date
• Vehicle Plate #
• Comments
• Notations

Subject Information:
• Driver’s License #
• Race
• Gender
• Date of Birth

Button Description

Search Execute your search .

Advanced Search/ Basic 
Search

Toggle back and forth between the Basic Search form and the Advanced Search form. 

Clear Remove all entries and selections from the search form .

New Case Enter a new case record .

Performing a Basic Case Search
This section describes how to search for a case by the following criteria: incident date, citation number, case number, case 
display name, vehicle registration number, owner, and subject first/last name.
1 . Go to Home Menu and click Manage Cases . The Case Information pop-up is displayed . 
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2 . If you see the Basic Search button, click it. Otherwise proceed to the next step.
3 . Enter/select the field values you want to search on. The fields on this form are described in the corresponding table in 

Appendix 3 - Cases.
4 . Click Search . All cases that match your selection criteria are displayed on the Case Search Results page . The total 

number of cases included in your search results is displayed at the top of the results list. The components on this page 
are described in the corresponding table in Appendix 3 - Cases. 

5 . By default, cases are sorted chronologically by the video’s start date/time. To sort the results differently, click the 
column heading you want to sort by.

6 . To view a case’s details, click the Details icon  beside that case. The Case Details page is displayed . The components 
on this page are described in the corresponding table in Appendix 3 - Cases.

Performing an Advanced Case Search
This section describes how to search for a case using additional criteria.
1 . Go to Home Menu and click Manage Cases . The Case Information pop-up is displayed.  The fields on this form are 

described in the corresponding table in Appendix 3 - Cases. 

2 . If you see the Advanced Search button, click it. Otherwise, follow steps 3 - 5 of the Performing a Basic Case Search 
procedure .  
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Viewing Case Details
This section describes how to view cases and related information. Typically, you have access to your cases and any public 
cases . Depending on your user role, however, you may have access to other cases as well .
1 . Perform a basic or advanced search, as described in Searching for Cases on page 98 . A list of cases is displayed . 

2 . Click the Details icon  beside the case you want to view. The Case Details page is displayed . 
The components on this page are described in the corresponding table in Appendix 3 - Cases.

3 . To view information about the case, perform one or more steps described in the following table. For more information 
on components on each of the tabs, see Appendix 3 - Cases. 

To... Do this...

View a case's videos 1 . Click the System Video tab. All videos that are currently linked to this case are displayed. 

2 . To view a video’s details, click the video’s Details icon  . 

3 . To play a video, click the video’s Play button . The Flashback Player launches in a 
separate window . For more information, see Flashback Player in Appendix 2 - Videos.

This table is continued on the next page.
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To... Do this...

View a case's media 
attachments

1 . Click the Attached Media tab. All media files that are currently linked to this case are 
displayed . 

2 . To view an attachment, click the folder icon in the Details column .

View a case's subjects • Click the Subjects tab. All subjects that are currently linked to this case are displayed. 

View a case's 
comments

• Click the Comments tab. All comments that are currently linked to this case are 
displayed . 

View a case's logs

NOTE: The case logs 
show who performed 
various actions on 
a case and when . 
The case logs can, 
for example, tell you 
who created, edited, 
reactivated, or added 
media attachments to 
a case and when .

• Click the Logs tab. The case’s log records are displayed. If necessary, use the navigation 
arrows at the top of the page to scroll through the list . 

View a restricted case's 
authorized users

• Click the Authorized Users tab. The list of authorized users for this case is displayed. 
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Requesting a Case's Media Files from a Remote Precinct

 NOTE: DEA Agency users only

This workflow is only applicable to users of the DEA Agency application.

When a case is originally created on a Precinct server, you may find that some of the case’s videos or media attachments 
are offline, that is, not viewable from the Agency server. In this instance, you can use the Request Media option to transmit 
that media from the Precinct server to the Agency server .
To request media files:
1 . Follow steps 1 - 2 of the Viewing Case Details procedure .
2 . Go to the Action menu and click Request Media. A confirmation message is displayed. 

The requested files will be transmitted to the Agency server during the next server-to-server communication.

Updating Cases
Periodically, you may need to add/remove data from a case, including videos, subject names, media attachments, and 
comments. Typically, you can only update cases that you own. Depending on your permissions, however, you may be able to 
update other cases as well .

Requesting Control of a Case from a Remote Precinct

 NOTE: DEA Agency users only

This workflow is only applicable to users of the DEA Agency application.

As a DEA Agency user, before you can update a case, you need to verify that you have control of that case. If the value of 
the Locked field is No, then you have control of the case . If the value of the Locked field is Yes, it indicates that the “source” 
precinct (that is, the precinct from which the case originated) currently has control of the case . In this instance, you will have 
to ask the system to give you control of the case before you can update it.

 CAUTION: Assuming control of a case

Do not perform this procedure unless you wish to assume full and permanent control over a case file. Once you 
assume control of a case, you can never transfer that control back to the original precinct.

To request control of a case:
1 . Follow steps 1 - 2 of the Viewing Case Details procedure .
2 . Go to the Action menu and click Request Control . You now have permanent control over the case . Precinct users can 

no longer update this case .

Adding or Removing Case Videos
To add or remove videos:
1 . Search for and display the case you want to add a video to . The Case Details page is displayed .
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2 . Go to the Action menu and click Add Video . The Choose Video to Add pop-up is displayed . The most recent video you 
viewed will be displayed on this pop-up. 

3 . DEA Precinct users: check the value of the Locked field. 

If... Then...

The value is Yes This case is controlled by the Agency server. You cannot update it. End of procedure.

The value is No This case is controlled by the Precinct server. You can update it as long as you have the proper 
permissions .

4 . To add the displayed video to the case, click Next, and then skip to step 5 .
5 . To search for a different video to add to the case, perform the following steps:

a. Select the Search for Video to add to Case radio button, and then click Next . The Media Information pop-up is 
displayed . 

b. Search for and display the video you want to add . (If necessary, review Searching for Videos on page 27)
c. Go to the Action menu and click Add To Case . The Add Video to Case pop-up is displayed . 

d. Click Next . The Case Details page is displayed .
6 . Click the System Video tab. The new video now is displayed on the case’s video list.
7 . To add another video to this case, repeat steps 2 - 5 .
8 . To remove a video from a case, locate it on the case's video list, then go to the Remove column and click the cross icon 

 . The system removes the selected video from the list .
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Adding or Removing Case Media Attachments
To add or remove media attachments:
1 . Search for and display the case you want to attach a file to. The Case Details page is displayed .
2 . DEA Precinct users: check the value of the Locked field. 

If... Then...

The value is Yes This case is controlled by the Agency server. You cannot update it. End of procedure.

The value is No This case is controlled by the Precinct server. You can update it as long as you have the proper 
permissions .

3 . Go to the Action menu and click Add Media . The Add External Media page is displayed . NOTE: If a security pop-up is 
displayed, select the checkbox at the bottom of the pop-up, then click Allow. Next, select the checkbox at the bottom of 
the second pop-up, then click Run . 

4 . Using the Look in: drop-down list, navigate to the disk drive location where the file is located.
5 . Click the file or files you want to link. To select more than one file, hold the Ctrl key down while you click each file.
6 . If the owner of this case is the same person who is responsible for collecting this evidence (default), skip to step 7 . 

Otherwise, proceed to the next step .
7 . Go to the Evidence Collected by field and select the name of the officer who is responsible for collecting this evidence.
8 . Click Upload Selected File(s). After the selected files are uploaded, a confirmation message is displayed. 
9 . Click OK, and then close the Add External Media pop-up . 
10 . Click the Attached Media tab. Your newly added files are displayed on the Attached Media list .

11 . To remove the attached media file, locate it on the list, then go to the Delete column and click the cross icon  . The 
system removes the selected file from the case’s Attached Media list .
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Adding, Removing, and Updating Case Subjects
To add, remove, or update a subject:
1 . Search for and display the case you want to add a subject to. The Case Details page is displayed .
2 . DEA Precinct users: check the value of the Locked field. 

If... Then...

The value is Yes This case is controlled by the Agency server. You cannot update it. End of procedure.

The value is No This case is controlled by the Precinct server. You can update it as long as you have the proper 
permissions .

3 . Go to the Action menu and click Add Subject . The Subject Information pop-up is displayed . 

4 . Enter/select the subject’s information in the corresponding fields and lists:
• First Name
• Last Name
• Middle Name, if applicable
• Prefix Name (Mr., Mrs., Ms., etc.)
• Suffix Name, if applicable (Jr., III, etc.)
• Date of birth. Observe mm/dd/yyyy format .
• Driver’s license number, if applicable.
• Race, if your agency is using the Race field. 
• Subject’s gender. 
• Type of subject, if your agency is using the Type field. 

5 . Click Save. A confirmation message is displayed.
6 . Click the Subjects tab. Your newly added subject is displayed.
7 . To add another subject to this case, repeat steps 2 – 4 .
8 . To remove a subject from the case, locate the subject's name on the list of subjects, then go to the Delete column and 

click the cross icon . The system removes the selected subject from the case’s Subjects list .

9 . To update a subject, locate the subject's name on the list of subjects, click the pencil icon  in the Edit column, and 
then enter/select your changes in the displayed Subject Information pop-up. Click Save to close the pop-up .
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Adding, Removing, and Updating Case Comments
To add, remove, or update comments:
1 . Search for and display the case you want to add a comment to . The Case Details page is displayed .
2 . DEA Precinct users: check the value of the Locked field. 

If... Then...

The value is Yes This case is controlled by the Agency server. You cannot update it. End of procedure.

The value is No This case is controlled by the Precinct server. You can update it as long as you have the proper 
permissions .

3 . Go to the Action menu and click Add Comment . The Please Add Your Comment Below pop-up is displayed . 

4 . Enter your comment in the space provided, then click Save .
5 . Click the Comments tab. The new comment is displayed on the Comments list .

6 . To remove a comment, locate it on the list of comments, then go to the Delete column and click the cross icon  . The 
system removes the selected comment from the case’s Comments list .

7 . To update a comment, locate it on the list of comments, then click the pencil icon  in the Edit column, and enter your 
changes in the displayed Comments box. Click Save to close the box. 

Adding and Removing Authorized Users of Restricted Cases
To add or remove users:
1 . Search for and display the  

restricted case you want to update . 
2 . Go to the Action menu and click Edit . 

The Edit Case form is displayed .  
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3 . Click the Authorized Users tab. 

4 . Perform one of the following tasks: 

To... Do this...

Add an authorized user 1 . Go to the Select Authorized Users column and click the user you want to allow 
access to this case. If the user name is not visible, use the navigation arrows at the 
top of the column to scroll through the list or enter the user’s name in the Search 
field at the top of the Authorized Users column .

2 . Once you’ve highlighted the appropriate user, click  in the center column . The 
selected user name moves to Approved Users column .

Remove an authorized user 1 . Go to the Approved Users column and click the user you want to remove.
2 . Once you’ve highlighted the correct user, click  in the center column . The selected 

user is removed from the Approved Users list .

5 . Click Save. A confirmation message is displayed at the top of the Case Details page .

Adding and Removing Favorite Cases
This section describes how to add or remove a case to or from your favorite cases list. This feature provides you with a 
quick and easy method to access those cases that you refer to frequently.
In order to add or remove a case to or from your favorite cases list, you must be the case’s owner or have edit permissions.
To add or remove a favorite case:
1 . Search for and display the case you want to add to your favorite cases list . The Case Details page is displayed .
2 . Go to the Action menu and click Add To Favorites . The Add Description for Favorite pop-up is displayed . 

3 . Enter a description for the case in the field provided, then click Save . The selected case is added to your favorite cases 
list . To view that list, go to User Preferences and click Favorite Cases .

4 . To remove a favorite case, locate it in the list, then go to the Delete column and click the cross icon  . The system 
removes the selected case from the favorite cases list .
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Marking Cases for Disposal
This section describes how to mark, or flag, a case for disposal. 

 NOTE: About cases for disposal
Disposal is the process of changing a case’s status from online to offline. Once a case is offline, you can still view 
the case record, but you can’t export it or add any new attachments to it (i.e., videos, media files, subjects, and/or 
comments). After a case goes offline, it enters a “countdown” period, after which it can no longer be restored to the 
server. For more information, see the definition of the Days to enable restore of Disposed Case setting in the Online 
Lifecycle Settings page: Life-Cycle Tab table in Appendix 7 - Utilities.

Perform this task when you no longer need to track a case online.
1 . Search for and display the case you want to dispose of . The Case Details page is displayed .
2 . Go to the Action menu and click Dispose . The value of the Status field changes to Offline . 

 NOTE: About the Dispose action

If the Dispose option is not displayed, it means that the dispose feature is not available for this case. Either the 
case is already offline, it is too young to be disposed of, or the case’s Do Not Dispose checkbox is selected. For 
more on the Do Not Dispose feature, see step 7 of Creating a Regular Case on page 95 .

Reactivating Offline Cases
An offline case is a case that you can view but not export or add attachments to (i.e., videos, media files, subjects, and 
comments). If you want to perform these tasks again, you will first have to reactivate the case. Reactivation is the process 
of restoring a case to the server from a backup disc or external backup device.
There is a limited time period in which you can reactivate an offline case. This time period depends on the Days to enable 
restore of backed-up media setting .

For instructions on changing this setting, see Changing the Online Lifecycle Settings on page 268.
You can tell that a case has exceeded this time limit when you can no longer view its record online .
You can reactivate a case for your own use, or at the request of another user (permissions required) . Requests from other 
users are displayed on your Inbox Messages list .
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Reactivating a Case from a Backup Disc
This section describes how to reactivate, or restore, an offline case from an archive or export disc.

 NOTE: About backup mode

If your backup mode is set to EXTERNAL, use the Reactivating a Case from an External Backup Device procedure . If 
you’re not sure what your backup mode is, see Setting Backup Options on page 152. 

To reactivate an offline case:
1 . Perform one of the following tasks: 

To... Do this...

Reactive a case for your own use • Search for and display the desired case .

Reactive a case for another user 1 . Go to Home Menu and click Home . The Welcome Home page is displayed . 

2 . Locate the reactivation request on your Inbox Messages list, then click the 
View Case Detail icon  .

The Case Details page is displayed .
2 . Go to the Action menu and click Reactivate Now .
3 . If a security pop-up is displayed, select the checkbox at the bottom of the pop-up, then click Allow . The Reactivate 

Case pop-up may appear slightly different depending on whether this case was previously backed up to an Archive disc 
(Certified Backup Disc) or an Export disc (User-Requested CertiBackup).

4 . Perform one of the following tasks: 

If... Then...

The center column reads DVD Label • Locate the Certified Backup disc whose number is listed in the DVD 
Label column .

The center column reads File 
Size(MB)

• Proceed to the next step .

5 . Insert the backup disc in your PC’s CD/DVD tray. (Must be either a Certified Backup Disc or an Export disc that is in Data 
DVD format .) Give the computer a few seconds to read the DVD, then proceed to the next step .
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6 . Click Read DVD or Restore File(s) . After a momentary delay, the Case Details screen will redisplay, indicating that the 
case has been successfully restored. 

 NOTE: Session timeout

 If your session “times out” during the reactivation, you need to adjust your Session Timeout setting . For further 
instructions, see Managing User Roles and Permissions on page 250.

Reactivating a Case from an External Backup Device
This section describes how to reactivate, or restore, an offline case from an external backup device, such as a tape drive. 
Use this procedure if your Backup Mode is set to EXTERNAL .

 NOTE: About backup mode

If your backup mode is set to something other than EXTERNAL, use the Reactivating a Case from a Backup Disc 
procedure. If you’re not sure what your backup mode is, see Setting Backup Options on page 152. 

To reactivate an offline case:
1 . Follow steps 1 - 2 of the Reactivating a Case from a Backup Disc procedure . The Directories to Restore for Reactivation 

page is displayed .
2 . Using the software that came with your backup device (e.g., tape backup software), restore the directory(ies) that are 

listed in the Server Path column .
3 . Go to the Action menu and click Continue. After a momentary delay, a confirmation message will be displayed.

Generating a Chain of Custody Report for a Case
This section describes how to generate a Chain of Custody Report for a selected case. 

 NOTE: About chain of custody reports
This report contains a log of all operations that have been performed on the case, such as Export of Case Completed. 
It shows the time and date on which an activity occurred, as well as the user name of the officer who performed the 
action, if applicable. If the User field is blank, it means that the system performed the action.

To view the Chain of Custody report, you must have Adobe Reader installed on your PC.
To generate and display the report:
1 . Search for and display the case you want to report on . (If necessary, review Searching for Cases on page 98) The 

Case Details page is displayed . 
2 . Go to the Action menu and click Chain of Custody . The Chain of Custody Options pop-up is displayed . 
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3 . Make your selection from the Chain of Custody Log Level drop-down list, and then click OK . The system downloads the 
report to your PC’s Downloads folder .

4 . Navigate to your Downloads folder, and then double-click the PDF report file. The Case Chain of Custody Report is 
displayed in Adobe Reader. (see next page) 

5 . To print this report, go to the Acrobat menu bar and click the printer icon in the upper left corner. The Print pop-up is 
displayed .

6 . Select your desired printer settings, then click Print . The report is sent to your active printer .
7 . Click the cross icon in the upper right corner of the page to exit Adobe Reader.

Downloading Case Files to Your PC
This section describes how to download selected cases and their associated videos to your PC. If you have the proper 
permissions, you can download a case and its associated videos in the following formats:
• Data DVD
• Interchange
• Uncompressed
• FOIA redacted

For more information on these formats, refer to Available File Formats for User-Requested DVDs on page 127 . For a side-
by-side comparison of the formats, see a corresponding table in Appendix 4 - Evidence Backup and Sharing.

Downloading a Case to Your PC in Data DVD Format or Uncompresssed Format
This section describes how to download a case record to your PC in Data DVD or uncompressed format. For a detailed 
description of this format, see Available File Formats for User-Requested DVDs on page 127.
Perform this procedure if you want to email a case’s video, put it on a USB drive or other external device, and/or play it back 
locally without having to burn it to a disc. If you want to download this case for the sole purpose of burning a DVD, see 
Burning a Case to a Data DVD or an Uncompressed Format DVD on page 131 instead .
A Data DVD or Uncompressed Format download will include some or all of the following:
• Selected videos from the case
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• General information associated with the case’s videos (Officer Name, DVR, Start/End Times, System ID)
• The Chain of Custody Report
• Selected media files attached to the case
• A copy of the Flashback Player.

In addition, the Play Menu for this type of download includes a button that allows you to convert the case’s videos into MP4 
and DV files.

 WARNING: Video authenticity

Once a video has been downloaded in uncompressed format and then converted to MP4 and DV files, its authenticity 
can no longer be verified. Such video can be edited and tampered with using commercial video editing software.

To download a case in Data DVD or uncompressed format:
1 . Search for and display the case you want to download . The Case Details page is displayed .
2 . Go to the Action menu and click Export . The Export Case page is displayed . 

3 . Deselect the checkboxes beside videos you want to exclude from this download. 
4 . Select Data DVD or Uncompressed Format from the Output Format drop-down list as needed .
5 . If you see the Attached Media tab, click it and then deselect the checkbox to the left of each file you want to exclude.
6 . Go to the Action menu and click Save . The Export Options pop-up is displayed . 

Depending on your 
user permissions, 
these checkboxes 
may or may not be 

displayed .
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7 . Select the Manual Export radio button, and then the ZIP radio button.
8 . Make your selection from the Chain of Custody Log Level drop-down list .
9 . If a Video Player Options section is displayed in the lower left corner of the Export Options pop-up:

• Select the Show GPS checkbox to include GPS data with the Flashback Player in this download.
• Select the Show Speed checkbox to include vehicle speed data with the Flashback Player in this download. 

10 . Click Save. The system begins processing your request. A copy of this request will be displayed on your Welcome 
Home page under Sent Messages. When processing is complete, a confirmation message will be displayed on your 
Welcome Home page under Inbox Messages .

11 . Go to your Inbox Messages and click the download icon next to the export confirmation message.  

 

 TIP: The Download icon 

If you do not see the download icon, the system is still processing your request . Go to Home Menu and click Home 
to refresh your screen .

 
A Windows message is displayed . 

12 . Select Save As from the Save drop-down list . The Save As pop-up is displayed .
13 . Navigate to the disk drive location where you want to temporarily save this file, and then, if desired, enter a new name in 

the File name field.
14 . Click Save. The system copies your file to the selected location. When the download is complete, a confirmation 

message is displayed . 

Downloading a Case to Your PC in Interchange Format
This section describes how to download selected videos from a case to your PC in interchange format. For a detailed 
description of this format, see  Available File Formats for User-Requested DVDs on page 127. 
Perform this procedure if you want to email a case’s video, put it on a USB drive or other external device, play it back locally 
without burning it to a disc, and/or import the video into another software application. If you want to download this case for 
the sole purpose of burning a DVD, see Burning a Case to an Interchange Format DVD instead .

 WARNING: Video authenticity

Once a video has been exported in interchange format, its authenticity can no longer be verified. Such video can be 
edited and tampered with using commercial video editing software .

 
To download a case in Interchange format:
1 . Follow steps 1 - 2 of the Downloading a Case to Your PC in Data DVD Format or Uncompresssed Format procedure .
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2 . Go to the Output Format field and select Interchange Format from the drop-down list .  
Two new columns are displayed: Video Source and Audio Source . 

3 . Deselect the checkboxes beside videos you want to exclude from this download. 
4 . Perform one or more of the following tasks: 

If... Then...

The word Camera is displayed 
in both the Video Source  and 
Audio Source columns

• Proceed to the next step .

Checkboxes are displayed in the 
Video Source column

• Select the camera views you want to include for each video, as follows: 

Copy only the video recorded from Camera Channel 1 
(forward facing zoom camera) .

Copy only the video recorded from Camera Channel 2 
(Backseat and/or Bullet cameras).

Copy the video that was recorded from both Camera 
Channel 1 and Camera Channel 2 . NOTE: When you choose 
this option, the system will burn two separate video files 
on the DVD that will appear as separate menu items . This 
doubles your DVD space requirement.

Checkboxes are displayed in the 
Audio Source column

• Select the audio sources that you want to include for each video . You may 
select up to two audio sources for each video, as described below. These 
audio tracks will play concurrently when watching the video.
• VLP1/In Car. The audio from the wireless microphone that’s connected to 

your Flashback’s VLP 1 port and the audio from your in-car microphone 
(default) . See note on the next page .

• VLP2. The audio from the wireless microphone that’s connected to your 
Flashback’s VLP 2 port, if applicable.
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5 . Go to the Action menu and click Save . The Export Options pop-up is displayed . 

6 . Follow steps 7 - 8, and then 10 - 14 of the Downloading a Case to Your PC in Data DVD Format or Uncompresssed 
Format procedure .

Downloading a Case to Your PC in FOIA Redacted Format
This section describes how to download selected videos from a case to your PC in FOIA redacted format. For a detailed 
description of this format, see Available File Formats for User-Requested DVDs on page 127.
Perform this procedure if you want to redact a case’s video(s) and then perform one of the following actions with it:
• Place the video on a USB drive or other external device
• Play the video back locally without burning it to a disc
• Import the video into another software application .

If you want to download a case’s video for the sole purpose of burning a DVD, see Burning a Case to an FOIA Redacted DVD 
via Your PC’s DVD Burner on page 137 instead . 

 WARNING: Video authenticity

Once a video has been exported in FOIA Redacted format, its authenticity can no longer be verified. Such video can be 
edited and tampered with using commercial video editing software .

To download a case in FOIA redacted format:
1 . Follow steps 1 - 3 of the Downloading a Case to Your PC in Data DVD Format or Uncompresssed Format procedure .
2 . Select FOIA Redacted Format from the Output Format drop-down list. Three new columns are displayed: Video Source, 

Audio Source, and Redaction . 
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3 . Deselect the checkboxes beside videos you want to exclude from this download. 
4 . Perform one or more of the following tasks: 

If... Then...

The word Camera is displayed 
in both the Video Source  and 
Audio Source columns

• Proceed to the next step .

Checkboxes are displayed in the 
Video Source column

• Select the camera views you want to include for each video, as follows: 

Copy only the video recorded from Camera Channel 1 
(forward facing zoom camera) .

Copy only the video recorded from Camera Channel 2 
(Backseat and/or Bullet cameras).

Copy the video that was recorded from both Camera 
Channel 1 and Camera Channel 2 . NOTE: When you choose 
this option, the system will burn two separate video files 
on the DVD that will appear as separate menu items . This 
doubles your DVD space requirement.

Checkboxes are displayed in the 
Audio Source column

• Select the audio sources that you want to include for each video . You may 
select up to two audio sources for each video, as described below. These 
audio tracks will play concurrently when watching the video.
• VLP1. The audio from the wireless microphone that’s connected to your 

Flashback’s VLP 1 port (default).
• VLP2. The audio from the wireless microphone that’s connected to your 

Flashback’s VLP 2 port, if applicable
• In Car . The audio from your in-car microphone .

5 . Go to the Redaction column and click one of the following buttons:
• Camera . Redact the video from a FOCUS H1, BodyVISION, BWX-100, or FOCUS X2 DVR. 
• Front. Redact the video from a Flashback’s Camera Channel 1. For in-car systems, this is the video captured with 

your forward facing zoom camera .
• Rear. Redact the video from a Flashback’s Camera Channel 2. For in-car systems, this is the video captured with 

your Backseat camera and/or Bullet cameras.
The Redaction Settings pop-up is displayed. Redaction settings are described in the corresponding table in Appendix 
2 - Videos. 

6 . To blur the entire video or video segment, select a Blur Level: Low, Med, or High .
7 . To export a video segment instead of the original full-length video, perform the following steps:

a. Select the Enable Trimming checkbox.
b. Enter the beginning of the video date/time range in the Trim Start field. 
c. Enter the end of the video date/time range in the Trim Stop field. 
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8 . Click Save, and then, if desired, repeat steps 5 – 7 to redact other videos that are included with this case download .
9 . Go to the Action menu and click Save . The Export Options pop-up is displayed . 

10 . Follow steps 7 - 8, and then 10 - 14 of the Downloading a Case to Your PC in Data DVD Format or Uncompresssed 
Format procedure .
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Managing Case Notations
Case notations are custom pieces of information that you can use to classify and organize cases . Once the Case Notation 
feature is activated, any case notations you create will be displayed at the bottom of the New Case and Edit Case forms .

You can perform the following tasks:
• Add a new case notation
• Change, delete, or disable an existing case notation

 NOTE: DEA Precinct users

The workflow described in this section is not available to users of the DEA Precinct application.

To add, change, delete, or disable a case notation:
1 . Go to Administration > System Setup > Video/Case > Cases > Notations . 
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2 . Perform one of the following tasks: 

To... Do this...

Add a new case 
notation

1 . Go to the Action menu and click New. The New Case Notation form is displayed . 

2 . Enter a name for the new notation in the Notation field. This is the value that will be 
displayed on the New Case and Edit Case forms .

3 . Click Save . The new notation is added to the Case Notations list .

Change, enable or  
disable an existing 
case notation

1 . Right-click the record of interest, and then select Edit from the pop-up menu . The Edit Case 
Notation pop-up is displayed . 

2 . To change the name of this case notation, enter a new value in the Notation field.
3 . To disable the notation, select DISABLED from the Status drop-down list .
4 . Click Save .

Delete an existing 
case notation  NOTE: Deleting case notations

You can only delete those notations that are not in use by an active case. If you want to 
discontinue use of a notation but cannot delete it, you will have to disable it.

1 . Right-click the record of interest, and then select Delete from the pop-up menu . A 
confirmation message is displayed. 

2 . Click Yes . The selected record is removed from the Case Notations list . 
NOTE: If the selected notation is in use by an active case, the system will display an error 
message .  
In this instance, you will have to disable the notation instead, as described above.

Managing Race Types
The Race field is displayed on the Case form . You can add, change, or delete the values in the Race drop-down list . You can 
also temporarily disable a race so that users cannot use it to notate a case.

 NOTE: DEF, DEV and DEA Precinct users

The workflow described in this section is not available to users of the DEF, DEV and DEA Precinct applications.
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To add, change, delete, or disable the race field:
1 . Go to Administration > System Setup > Video/Case > Cases > Race Types . 

2 . Perform one of the following tasks: 

To... Do this...

Add a new race type 1 . Go to the Action menu and click New . The New Race Type pop-up is displayed .

2 . Enter the race’s name in the Race Description field, and then click Save .

Change or disable 
an existing race type

1 . Right-click the value you wish to update, then select Edit from the pop-up menu . The Edit 
Race Type pop-up is displayed . 

2 . To change the race name, enter a new value in the Race Description field.
3 . To disable the race type, select Disabled from the Status drop-down list .
4 . Click Save .

Delete an existing 
race type

1 . Right click the race code you wish to delete, then select Delete from the pop-up menu . A 
confirmation pop-up is displayed. 

2 . Click Yes . The selected value is removed from the Race list .
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Managing Subject Types
Subject types are the field values that are displayed in the Type drop-down list on the Subject Information form . These user-
defined categories help you classify the subject names that you attach to your cases. 

   
You can perform the following tasks:
• Add a new subject type
• Change, delete, or disable an existing subject type.

 NOTE: DEA Precinct users

The workflow described in this section is not available to users of the DEA Precinct application.

To do so:
1 . Go to Administration > System Setup > Video/Case > Cases > Subject Types . 
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2 . Perform one of the following tasks: 

To... Do this...

Add a new subject 
type

1 . Go to the Action menu and click New . The New Subject Type pop-up is displayed . 

2 . Enter a name for the new subject type in the Subject Description field. This is the value that 
will be displayed on the Subject Information form .

3 . Click Save. The new subject type is displayed on the Subject Types list .

Change or disable 
an existing subject 
type

1 . Right-click the record of interest, and then select Edit from the pop-up menu . The Edit 
Subject Type pop-up is displayed .  

2 . To change the description for the Subject Type, enter a new value in the Subject 
Description field.

3 . To disable the subject type, select Disabled from the Status drop-down list .
4 . Click Save .

Delete an existing 
subject type  NOTE: Deleting subject types

You can only delete those subject types that are not in use by active cases. If you want 
to discontinue use of a particular subject type, you will have to disable it, so that users 
cannot attach it to any future cases .

1 . Right-click the record of interest, and then select Delete from the pop-up menu . A 
confirmation pop-up is displayed. 

2 . Click Yes . The selected record is removed from the Subject Types list . 
NOTE: If the selected notation is in use by an active case, the system will be displayed an 
error message .  
In this instance, you will have to disable the notation instead, as described above.
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Generating the Restricted Viewing Cases Report
This section describes how to download information on restricted cases to a .csv spreadsheet file. Restricted cases are 
those cases that can only be accessed by a specified group of users, as listed on the case’s Authorized Users tab.
To generate a report:
1 . Go to Administration > System Status > Reports, and then click the Restricted Viewing Cases report to highlight it . 

2 . Go the Action menu and click Generate Report. The New Report pop-up is displayed . 

3 . Using the Start Date and End Date fields, select a date range for your report. Alternatively, select the All Dates checkbox 
to generate reports for all dates .

4 . Click Generate. The system downloads the file to your PC’s Downloads folder .
5 . Navigate to your Downloads folder, and then double-click the report file. The report is displayed in your default 

spreadsheet application, such as Microsoft Excel . 
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About Evidence Backup and Sharing
This chapter describes how to back up evidence to DVD or Blu-ray media, and how to share digital evidence via a secure 
cloud .

About DVDs
You can create DVDs for backup and/or evidential purposes. This process may be either automatic (i.e., system-requested) 
or manual (i.e., user-requested). This chapter also describes how to update and maintain system settings that relate to 
DVDs . Unless otherwise noted, the term DVD is used throughout this chapter to refer to both DVD and Blu-ray discs.

 NOTE: DEF users

The workflows described in this chapter are not available to users of the DEF application.

Certified Backup Discs
Your DES software interfaces with a robotic DVD burner or Blu-ray burner. If archiving is enabled, the system uses this 
burner to create periodic backup discs based on rules that you set in the application. This process occurs automatically 
without any action on your part. The automatic archive discs that the disc burner generates are called Certified Backup 
Discs . The sole purpose of these discs is to restore system data at a later date, should the need arise .

User-Requested Certified Copies
User-requested certified copies are video and/or case files that you burn to DVD on an as-needed basis for evidential and/or 
backup purposes. The process of copying files for the purpose of creating a DVD is called exporting. Therefore this type of 
disc is sometimes referred to as an “export” disc . 

 NOTE: Disc capacity and burn times

• The storage capacity and burn times of your discs will vary depending on the type of disc you select. For more 
information refer to Appendix 4 - Evidence Backup and Sharing.

• The burn times refer to the time it takes to burn a disc once the job’s status changes from Queued to Working . If 
your server has a high maximum queue size and there are a number of queued DVD jobs ahead of your job, it could 
take hours for your job to even start.

• When burning discs, please leave approximately 5% of each disc free for system information. For example, if you 
are burning to a disc that has a maximum storage capacity of 8.5 gigabytes, the data you select for that disc should 
be approximately eight gigabytes or less.

Available File Formats for User-Requested DVDs
Refer to the following table for information on available file formats for user-requested DVDs. For a side-by-side comparison 
of DVD file formats, see the corresponding table in Appendix 4 - Evidence Backup and Sharing.
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File format Uses Advantages Disadvantages

Data DVD • Can be played 
on any PC DVD 
player using the 
Flashback Player.

• Listen to three audio streams
• View images from all cameras
• Automatically advance to "Trace Point" 

placeholders inserted in the video at the time 
it was recorded

• View general information associated with the 
videos

• View additional information that is displayed 
only on the Flashback Player, such as the 
active video and audio feeds, brake activation, 
and video trigger

• View the Chain of Custody Report
• View selected media files for a case

• Cannot be played 
in a standard 
consumer DVD 
player connected to 
a TV .

Consumer DVD • Can be played 
in any standard 
consumer DVD 
player that 
connects to a TV . 

• Useful for playing a 
video in court on a 
large screen TV for 
a jury to see . 

• Can also be played 
on a Windows 
PC equipped with 
a DVD player 
and appropriate 
software .

• Comes with a customizable DVD menu. • Lacks the special 
viewing options 
available with the 
Flashback Player.

• Requires the 
Consumer DVD 
module (available 
free of charge to all 
our customers) .

Interchange DVD • Allows to import 
videos into 
various third-party 
applications, such 
as video editing 
software .

• Lacks the special 
viewing options 
available with the 
Flashback Player.

• Anyone with access 
to the video could 
potentially tamper 
with it .

• Converting a video 
to interchange 
format effectively 
breaks the chain of 
custody .

This table is continued on the next page.
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File format Uses Advantages Disadvantages

Uncompressed 
(decompressed)
DVD

• Allows to convert 
each QBX file 
into raw video 
files (MP4 for 
most modern 
applications and 
DV for some older 
applications) that 
can be edited 
in third-party 
applications, such 
as video editing or 
redaction software

• Provides all the viewing options available with 
the Flashback Player. (see Data DVD above)

• Allows to export raw video into third-party 
applications, including older "legacy" software.

• Anyone with access 
to raw video could 
potentially tamper 
with it .

• Converting a video 
to uncompressed 
format effectively 
breaks the chain of 
custody .

FOIA Redacted 
DVD

• Gives you the 
ability to redact 
videos prior to 
downloading them 
to your PC or 
external storage 
device .

• Redacted videos 
cannot be burned 
via the robotic DVD 
burner.

About Digital Evidence
You can share digital evidence, such as videos and case information, from within DES via the secure Safe Fleet Cloud using 
the Cloud Courier feature. Digital evidence shared in this way becomes accessible to parties outside of your agency that 
requested the evidence . 
The following file types can be shared via the cloud:
• Video
• Still images
• Documents .

 NOTE: DEA Precinct, DEV, and DEF users

This feature is not available to users of the DEA Precinct, DEV, and DEF applications.

Burning DVDs
This section describes how to burn video and case records to a DVD. 

Installing a DVD Burning Application to Your PC
In order to burn a DVD on your PC, you need to have DVD burning software installed, such as Roxio Creator. If you don’t have 
such an application, you can download one called cdrtools. This section provides an overview of steps you need to take to 
download and install this application. The appearance and content of the dialog boxes and prompts that you will encounter 
in each step depend on the Windows version and web browser installed on your PC.
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To download and install the application:
1 . Go to Administration > System Status > Tools, and then click the DVD Image Burner (ISO) button. The system 

downloads the installation file to your PC’s Downloads folder .
2 . Navigate to your Downloads folder, and then right-click the cdrtfe-1.3.5.zip file and select Extract to cdrtfe-1.3.5\ from 

the drop-down list . 

3 . Double-click the new cdrtfe-1.3.5 folder, and then double-click the cdrtfe-1.3.5.exe file. The Select Setup Language pop-
up is displayed . 

4 . Click OK, and then click Next in the  Setup - cdrtools Frontend setup wizard that is displayed .
5 . Select the I accept the agreement radio button in the displayed Licensed Agreement window, and then click Next .
6 . Continue to click the Next button in response to each of the system prompts until the Ready to Install window is 

displayed, then click Install. The system begins installing the disc burner software. When the installation is complete, a 
confirmation message is displayed. 

7 . Click Finish . The cdrtools application screen is displayed .

Burning Case Records to DVDs
To burn an evidential or backup DVD, also referred to as an “export” disc, you must forward a burn request to the Backup 
PC’s job queue. For more information on backup options, see Setting Backup Options on page 152. 

 NOTE: DEV users

The workflows described in this section are not available to users of the DEV application.

When you burn a case in Data DVD format, the disc may include some or all of the following:
• Selected videos from the case
• General information associated with the case’s videos*
• The Chain of Custody Report
• Selected media files attached to the case
• A copy of the Flashback Player (if videos are included).
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Burning a Case to a Data DVD or an Uncompressed Format DVD
This section describes how to burn case information to a Data DVD or an Uncompressed Format DVD using either your 
agency’s robotic DVD burner, or your PC's DVD burner. 
An Uncompressed Format DVD will include the same information found on a Data DVD . In addition, this type of DVD 
includes a link that allows you to convert the included videos into MP4 and DV files.

 WARNING: Video authenticity

Once a video has been downloaded in uncompressed format and then converted to MP4 and DV files, its authenticity 
can no longer be verified. Such video can be edited and tampered with using commercial video editing software.

To burn a case to a Data DVD or an Uncompressed Format DVD:
1 . Search for and display the case you want to burn. (If necessary, review Searching for Cases on page 98) The Case 

Details page is displayed . 

2 . Go to the Action menu and click Export . The Export Case page is displayed . 

 
 

 NOTE: Missing data

If any of the file names are “grayed out”, it indicates that the media file is missing. That data will therefore not be 
included in your export .

3 . To include some, but not all, of the case’s videos on your DVD, deselect the checkbox beside each video you want to 
exclude .

4 . Select Data DVD or Uncompressed Format as needed from the Output Format drop-down list .
5 . If you see the Attached Media tab, click it and then deselect the checkbox to the left of each file you want to exclude.
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6 . Go to the Action menu and click Save . The Export Options pop-up is displayed . 

 
7 . Perform one of the following tasks: 

If... Then...

You are using a robotic DVD burner 1 . Select the Backup PC radio button.
2 . Select a new backup PC from the drop-down list if your agency has more 

than one robotic DVD burner and you do not want to use the backup PC 
displayed in the Name field; otherwise, proceed to the next step.

3 . Enter the desired quantity in the Num Copies field.
4 . If you see the Subject on Disc Label drop-down list, select a name from the 

list. This is the name that will print on the disc label.

You are using your PC's DVD burner 1 . Select the Manual Export radio button.
2 . To export this data for the sole purpose of burning a DVD, select ISO; 

otherwise, select ZIP.  
NOTE: Selecting a ZIP radio button will copy your videos and any metadata 
to a folder first. 

 

 NOTE: Backup PC selection

Whenever you submit a request to burn an export disc, the system will automatically analyze your backup PC 
resources to determine which backup PC has the fewest number of jobs in its queue. It then displays that backup 
PC in the Name field on the Export Options pop-up . Although you can override this selection if desired, the system 
choice will typically give you the fastest burn time.

8 . Make your selection from the Chain of Custody Log Level drop-down list .
9 . If a Video Player Options section is displayed in the lower left corner of the Export Options pop-up:

• Select the Show GPS checkbox to include GPS data with the Flashback Player in this case/video export.
• Select the Show Speed checkbox to include vehicle speed data with the Flashback Player in this case/video export.

Depending on your
user permissions,

these checkboxes may
or may not be displayed.

This workflow continues on the next page.
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10 . Click Save. The system places your burn request in the burn queue and displays a status message on your Welcome 
Home page under Sent Messages .  

If... Then...

You are using a robotic DVD burner, it will automatically burn 
the DVD when your request reaches the top of the list . A status 
message will then appear on your Welcome Home page under 
Inbox Messages notifying you that the job is complete. 

• Once you see the Completed message in 
your Inbox, you may retrieve the disc from 
your burner’s output tray. End of procedure.

You are using your PC's DVD burner, a confirmation message will 
be displayed on your Welcome Home page under Inbox Messages, 
once the system finishes processing your request.

• Proceed to the next step .

11 . Go to your Inbox Messages and click the download icon next to the export confirmation message.  

 
 

 TIP: The Download icon 

If you do not see the download icon, the system is still processing your request . Go to Home Menu and click Home 
to refresh your screen .

 
A Windows message is displayed . 

12 . Select Save As from the Save drop-down list . The Save As pop-up is displayed .
13 . Navigate to the disk drive location where you want to temporarily save this file, and then, if desired, enter a new name in 

the File name field.
14 . Click Save. The system copies your file to the selected location. When the download is complete, a confirmation 

message is displayed . 

15 . Use the Windows Disc Image Burner or other commercial disc burning software to burn the case to DVD.

Burning a Case to a Consumer DVD
This section describes how to burn selected videos from a case to a Consumer DVD. Your burn time will be approximately 
three hours per 120 minutes of video .

 NOTE: Burning Consumer DVDs

• You can only create Consumer DVDs using single- or double-layer DVDs, not Blu-ray discs.
• Consumer DVDs  are usually burned using your agency’s robotic DVD burner. 
• Alternatively, you can first export the case file in Interchange format by following the steps of the Downloading a 

Case to Your PC in Interchange Format procedure, then extract the files from the exported ZIP file and convert them 
into a format that can be played on a consumer DVD player prior to burning them, using commercial DVD burning 
software or video editing software . 
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To burn a case to a Consumer DVD:
1 . Follow steps 1 - 3 of the Burning a Case to a Data DVD or an Uncompressed Format DVD procedure .
2 . Select Consumer DVD from the Output Format drop-down list. Two new columns are displayed: Video Source and 

Audio Source. (see no. 1 below). 

 
Notice the message in the upper right corner (see no. 2 above). This display indicates what the current and maximum 
length for your DVD is .

3 . Perform one or more of the following tasks:

If... Then...

The word Camera is 
displayed in both the Video 
Source  and Audio Source 
columns

• Proceed to the next step .

Checkboxes are displayed 
in the Video Source column

• Select the camera views you want to include for each video, as follows: 

Copy only the video recorded from Camera Channel 1 (forward 
facing zoom camera) .

Copy only the video recorded from Camera Channel 2 (Backseat 
and/or Bullet cameras) .

Copy the video that was recorded from both Camera Channel 
1 and Camera Channel 2 . NOTE: When you choose this option, 
the system will burn two separate video files on the DVD that will 
appear as separate menu items. This doubles your DVD space 
requirement .

Checkboxes are displayed 
in the Audio Source column

• Select the audio sources that you want to include for each video . You may select 
up to two audio sources for each video, as described below. These audio tracks will 
play concurrently when watching the video .
• VLP1. The audio from the wireless microphone that’s connected to your 

Flashback’s VLP 1 port (default).
• VLP2. The audio from the wireless microphone that’s connected to your 

Flashback’s VLP 2 port, if applicable
• In Car . The audio from your in-car microphone .
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4 . Go to the Action menu and click Save . The Export Options pop-up is displayed . 

5 . Select a new backup PC from the drop-down list if your agency has more than one robotic DVD burner and you do not 
want to use the backup PC displayed in the Name field; otherwise, proceed to the next step. 

 NOTE: Backup PC selection

Whenever you submit a request to burn an export disc, the system will automatically analyze your backup PC 
resources to determine which backup PC has the fewest number of jobs in its queue. It then is displayed that 
backup PC in the Name field on the Export Options pop-up . Although you can override this selection if desired, the 
system choice will typically give you the fastest burn time.

6 . Enter the desired quantity in the Num Copies field.
7 . If you see the Subject on Disc Label drop-down list, select a name from the list . This is the name that will print on the 

disc label.
8 . Click Save. The system places your burn request in the burn queue and displays a status message on your Welcome 

Home page under Sent Messages . 
When your request reaches the top of the list, the robotic DVD burner will automatically burn the DVD. A status message 
will then appear on your Welcome Home page under Inbox Messages notifying you that the job is complete. 
Once you see the Completed message in your Inbox, you may retrieve the disc from your burner’s output tray.

Burning a Case to an Interchange Format DVD
This section describes how to burn selected videos from a case to an Interchange Format DVD using your agency’s robotic 
DVD burner, or your PC's DVD burner.

 WARNING: Video authenticity

Once a video has been exported in interchange format, its authenticity can no longer be verified. Such video can be 
edited and tampered with using commercial video editing software .

To burn a case to an Interchange Format DVD:
1 . Follow steps 1 - 3 of the  Burning a Case to a Data DVD or an Uncompressed Format DVD procedure .
2 . Select Interchange Format from the Output Format drop-down list. Two new columns are displayed: Video Source and 

Audio Source . See the screenshot on the next page . 
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3 . Perform one or more of the following tasks:

If... Then...

The word Camera is 
displayed in both the Video 
Source  and Audio Source 
columns

• Proceed to the next step .

Checkboxes are displayed 
in the Video Source column

• Select the camera views you want to include for each video, as follows: 

Copy only the video recorded from Camera Channel 1 (forward 
facing zoom camera) .

Copy only the video recorded from Camera Channel 2 (Backseat 
and/or Bullet cameras) .

Copy the video that was recorded from both Camera Channel 
1 and Camera Channel 2 . NOTE: When you choose this option, 
the system will burn two separate video files on the DVD that will 
appear as separate menu items. This doubles your DVD space 
requirement .

Checkboxes are displayed 
in the Audio Source column

• Select the audio sources that you want to include for each video . You may select 
up to two audio sources for each video, as described below. These audio tracks will 
play concurrently when watching the video .
• VLP1/In-car. The audio from the wireless microphone that’s connected to your 

Flashback’s VLP 1 port and the audio from your in-car microphone (default).
• VLP2. The audio from the wireless microphone that’s connected to your 

Flashback’s VLP 2 port, if applicable.
 
 

This workflow continues on the next page.
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 NOTE: Flashback audio playback

• If you choose the VLP1/In Car audio setting, you will be able to toggle back and forth between two audio 
streams: the stream from the wireless microphone that’s connected to your Flashback’s VLP 1 port, and the 
stream from your in-car microphone. On your DVD player, the VLP1 audio stream is available on the left stereo 
channel, and the In Car audio stream is available on the right stereo channel. You can use the balance controls 
on your DVD player to switch back and forth between these two streams.

• If you choose the VLP2 audio setting, the audio stream from the wireless microphone that’s connected to your 
Flashback’s VLP 2 port will be available on your DVD player’s left stereo channel, and the right stereo channel 
will be mute.

4 . Go to the Action menu and click Save . The Export Options pop-up is displayed . 

5 . Follow steps 7 - 8, and then 10 - 15 of the Burning a Case to a Data DVD or an Uncompressed Format DVD section .

Burning a Case to an FOIA Redacted DVD via Your PC’s DVD Burner
This section describes how to burn selected videos from a case to an FOIA Redacted DVD using your PC’s DVD burner.  

 NOTE: Burning FOIA Redacted DVDs

• FOIA redacted DVDs can only be burned using your PC's DVD burner. 

 WARNING: Video authenticity

Once a video has been exported in FOIA Redacted format, its authenticity can no longer be verified. Such video can be 
edited and tampered with using commercial video editing software .

To burn a case to a FOIA Redacted DVD:
1 . Follow steps 1 - 3 of the Burning a Case to a Data DVD or an Uncompressed Format DVD procedure .
2 . Go to the Output Format field and select FOIA Redaction Format from the drop-down list . Three new columns are 

displayed: Video Source, Audio Source, and Redaction . See the screenshot on the next page . 
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3 . Follow step 3 of the Burning a Case to a Consumer DVD procedure .
4 . Go to the Redaction column and click one of the following buttons:

• Camera . Redact the video from a FOCUS H1, BodyVISION, BWX-100 or FOCUS X2 DVR . 
• Front. Redact the video from a Flashback’s Camera Channel 1. For in-car systems, this is the video captured with 

your forward facing zoom camera .
• Rear. Redact the video from a Flashback’s Camera Channel 2. For in-car systems, this is the video captured with 

your Backseat camera and/or Bullet cameras. 
The Redaction Settings pop-up is displayed. The fields on this pop-up are described in the corresponding table in 
Appendix 2 - Videos. See the screenshot on the next page . 

5 . To blur the entire video or video segment, select a Blur Level: Low, Med, or High .
6 . To export a video segment instead of the original full-length video, perform the following steps:

a. Select the Enable Trimming checkbox.
b. Enter the beginning of the video date/time range in the Trim Start field. 
c. Enter the end of the video date/time range in the Trim Stop field. 

7 . Click Save, and then, if desired, repeat steps 4 – 7 to redact other videos that are included with this case DVD .
8 . Go to the Action menu and click Save . The Export Options pop-up is displayed . 

9 . To export this data for the sole purpose of burning a DVD, select ISO; otherwise, select ZIP .  
NOTE: Selecting a ZIP radio button will copy your videos and any metadata to a folder first.

10 . Follow steps 8 - 15 of the Burning a Case to a Data DVD or an Uncompressed Format DVD procedure, ignoring the 
robotic DVD burner section in step 10 .
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Burning Videos to a DVD
This section describes how to burn video to a DVD. 

Burning Video to a Data DVD or an Uncompressed Format DVD
This section describes how to burn standalone video information to a Data DVD or to an Uncompressed Format DVD using 
your agency’s robotic DVD burner, or your PC's DVD burner. Standalone video is video that is not linked to a case. 
An Uncompressed Format DVD will include the same information found on a Data DVD . In addition, this type of DVD 
includes a button that allows you to convert the included videos into raw data format.

 WARNING: Video authenticity

Once a video has been downloaded in Uncompressed format and then converted to MP4 and DV files, its authenticity 
can no longer be verified. Such video can be edited and tampered with using commercial video editing software.

To burn video to a Data DVD or an Uncompressed Format DVD:
1 . If necessary, review Searching for Videos on page 27, and then perform one of the following tasks:

• To burn one video, search for and display the desired video . The Video Details page is displayed .
• To burn more than one video, search for the desired videos . The Video Search Results page is displayed .

2 . Go to the Action menu and click Export . The Select Video(s) for Export page is displayed .
3 . If in step 1 you have chosen to burn multiple videos, click each of the videos you want to include on this DVD; otherwise 

proceed to the next step . NOTE: You can click any part of the record except the thumbnail image, as that will launch the 
Flashback Player. 
As you select each video, it will appear in the Selected Videos list at the bottom of the page. 

4 . Go to the Action menu and click Export Video(s) . The Export Video(s) page is displayed as pictured on the next page . 



© Safe Fleet | September 2021 | All rights reserved

Digital Evidence Series Administrator's Guide

140 Part # 700-8006 R3

Burning DVDs

5 . Select Data DVD or Uncompressed Format as needed from the Output Format drop-down list .
6 . Go to the Action menu and click Save . The Export Options pop-up is displayed . 

 
7 . Perform one of the following tasks: 

If... Then...

You are using a robotic DVD burner 1 . Select the Backup PC radio button.
2 . Select a new backup PC from the drop-down list if your agency has more 

than one robotic DVD burner and you do not want to use the backup PC 
displayed in the Name field; otherwise, proceed to the next step.

3 . Enter the desired quantity in the Num Copies field.

You are using your PC's DVD burner 1 . Select the Manual Export radio button.
2 . To export this data for the sole purpose of burning a DVD, select ISO; 

otherwise, select ZIP .  
NOTE: Selecting a ZIP radio button will copy your videos and any metadata 
to a folder first.

This workflow continues on the next page.  

Depending on your
user permissions,

these checkboxes may
or may not be displayed
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 NOTE: Backup PC selection

Whenever you submit a request to burn an export disc, the system will automatically analyze your backup PC 
resources to determine which backup PC has the fewest number of jobs in its queue. It then is displayed that 
backup PC in the Name field on the Export Options pop-up . Although you can override this selection if desired, the 
system choice will typically give you the fastest burn time.

8 . Enter a description for this DVD in the Video Description field. This text will print on the surface of the DVD.
9 . Make your selection from the Chain of Custody Log Level drop-down list .
10 . If a Video Player Options section is displayed in the lower left corner of the Export Options pop-up:

• Select the Show GPS checkbox to include GPS data with the Flashback Player in this case/video export.
• Select the Show Speed checkbox to include vehicle speed data with the Flashback Player in this case/video export.

11 . Click Save. The system places your burn request in the burn queue and displays a status message on your Welcome 
Home page under Sent Messages . 

If... Then...

You are using a robotic DVD burner, it will automatically burn 
the DVD when your request reaches the top of the list . A status 
message will then appear on your Welcome Home page under 
Inbox Messages notifying you that the job is complete. 

• Once you see the Completed message in 
your Inbox, you may retrieve the disc from 
your burner’s output tray. End of procedure.

You are using your PC's DVD burner, a confirmation message will 
be displayed on your Welcome Home page under Inbox Messages, 
once the system finishes processing your request.

• Proceed to the next step .

12 . Go to your Inbox Messages and click the download icon next to the export confirmation message.  

 

 TIP: The Download icon 

If you do not see the download icon, the system is still processing your request . Go to Home Menu and click Home 
to refresh your screen . 

A Windows message is displayed . 

13 . Select Save As from the Save drop-down list . The Save As pop-up is displayed .
14 . Navigate to the disk drive location where you want to temporarily save this file, and then, if desired, enter a new name in 

the File name field.
15 . Click Save. The system copies your file to the selected location. When the download is complete, a confirmation 

message is displayed . 

16 . Use the Windows Disc Image Burner or other commercial disc burning software to burn the video to DVD.
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Burning Video to a Consumer DVD
This section describes how to burn selected standalone videos to a Consumer DVD using your agency’s robotic DVD burner. 
Standalone video is video that is not linked to a case.

 NOTE: Burning Consumer DVDs

• Consumer DVDs  can only be burned using your agency’s robotic DVD burner. 
• You can only create Consumer DVDs using single- or double-layer DVDs, not Blu-ray discs.

To burn video to a Consumer DVD:
1 . Follow steps 1 - 4 of the Burning Video to a Data DVD or an Uncompressed Format DVD procedure .
2 . Select Consumer DVD from the Output Format drop-down list. Two new columns are displayed: Video Source and 

Audio Source. (see no. 1 below). 

 
Notice the message in the upper right corner (see no. 2 above). This display indicates what the current and maximum 
length for your DVD is .

3 . Follow steps 3 - 8 of the Burning a Case to a Consumer DVD procedure .

Burning Video to an Interchange Format DVD 
This section describes how to burn selected standalone videos to an Interchange Format DVD using your agency’s robotic 
DVD burner, or your PC's DVD burner. Standalone video is video that is not linked to a case. 

 WARNING: Video authenticity

Once a video has been exported in Interchange format, its authenticity can no longer be verified. Such video can be 
edited and tampered with using commercial video editing software .

To burn video to an Interchange Format DVD:
1 . Follow steps 1 - 4 of the Burning Video to a Data DVD or an Uncompressed Format DVD procedure .
2 . Select Interchange Format from the Output Format drop-down list. Two new columns are displayed: Video Source and 

Audio Source . 
 
 

This workflow continues on the next page.
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3 . Perform one or more of the following tasks:

If... Then...

The word Camera is displayed in 
both the Video Source  and Audio 
Source columns

• Proceed to the next step .

Checkboxes are displayed in the 
Video Source column

• Select the camera views you want to include for each video, as follows: 

Copy only the video recorded from Camera Channel 1 
(forward facing zoom camera) .

Copy only the video recorded from Camera Channel 2 
(Backseat and/or Bullet cameras).

Copy the video that was recorded from both Camera 
Channel 1 and Camera Channel 2 . NOTE: When you choose 
this option, the system will burn two separate video files 
on the DVD that will appear as separate menu items . This 
doubles your DVD space requirement.

Checkboxes are displayed in the 
Audio Source column

• Select the audio sources that you want to include for each video . You may 
select up to two audio sources for each video. These audio tracks will play 
concurrently when watching the video .
• VLP1/In Car. The audio from the wireless microphone that’s connected 

to your Flashback’s VLP 1 port and the audio from your in-car 
microphone (default) . 

• VLP2. The audio from the wireless microphone that’s connected to your 
Flashback’s VLP 2 port, if applicable.

This workflow continues on the next page.
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 NOTE: Flashback audio playback

• If you choose the VLP1/In Car audio setting, you will be able to toggle back and forth between two audio 
streams: the stream from the wireless microphone that’s connected to your Flashback’s VLP 1 port, and the 
stream from your in-car microphone. On your DVD player, the VLP1 audio stream is available on the left stereo 
channel, and the In Car audio stream is available on the right stereo channel. You can use the balance controls 
on your DVD player to switch back and forth between these two streams.

• If you choose the VLP2 audio setting, the audio stream from the wireless microphone that’s connected to your 
Flashback’s VLP 2 port will be available on your DVD player’s left stereo channel, and the right stereo channel 
will be mute.

4 . Go to the Action menu and click Save . The Export Options pop-up is displayed .  

5 . Follow steps 7 - 9, and then 11 - 15 of the Burning Video to a Data DVD or an Uncompressed Format DVD procedure .

Burning Video to an FOIA Redacted DVD via Your PC’s DVD Burner
This section describes how to burn selected standalone videos to an FOIA Redacted DVD using your PC’s DVD burner. 
Standalone video is video that is not linked to a case

 NOTE: Burning FOIA Redacted DVDs

• FOIA redacted DVDs can only be burned using your PC's DVD burner. 

 WARNING: Video authenticity

Once a video has been exported in FOIA Redacted format, its authenticity can no longer be verified. Such video can be 
edited and tampered with using commercial video editing software .

To burn video to an FOIA Redacted DVD:
1 . Follow steps 1 - 4 of the Burning Video to a Data DVD or an Uncompressed Format DVD procedure .
2 . Select FOIA Redaction Format from the Output Format drop-down list. Three new columns are displayed: Video Source, 

Audio Source, and Redaction . See the screenshot on the next page . 
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3 . Follow steps 3 - 9 of the Burning a Case to an FOIA Redacted DVD via Your PC’s DVD Burner procedure .
4 . Follow steps 8 - 16 of the Burning Video to a Data DVD or an Uncompressed Format DVD procedure, ignoring the robotic 

DVD burner section in step 10 .
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Viewing the DVD Burn Queue and Deleting a Burn Request
After a user submits a request to burn selected video and/or case files to DVD, the system sends that burn request or “job” 
to the local burn queue. This section describes how to view the pending burn jobs in that queue. 
This section also describes how to delete a burn request, or burn job, that is in the DVD Queue. When you delete a system-
requested archive job as opposed to a user-requested export job, the system will reassign that job’s videos to the next 
archive disc. Also, that job’s intended CBD number will be skipped. 
In other words, the system will not reassign the job’s CBD number to the next sequential disc. Keep this in mind when you 
are searching for archive discs in the future. If there appears to be a disc number missing, it doesn’t necessary mean that a 
disc is lost. Rather, it’s likely that someone deleted an archive burn job at one point.
To view the DVD burn queue and delete a burn request:
1 . Go to Administration > System Status > Local Queue. A list of all system-requested and user-requested burn jobs is 

displayed. The columns on this page are described in the corresponding table in Appendix 4 - Evidence Backup and 
Sharing. 

  
2 . To view more detailed information on a burn job, click the record of interest. The Video tab is displayed at the bottom of 

your page. If the burn job you selected also has attached media, a Media tab will be displayed as well. The columns on 
this page are described in the corresponding table in Appendix 4 - Evidence Backup and Sharing. 
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3 . To view more information on the burn job’s media attachments (if applicable), click the Media tab . Detailed information 
on each of the media attachments is displayed. The columns on this page are described in the corresponding table in 
Appendix 4 - Evidence Backup and Sharing. 

4 . To delete a burn job, return to the Local Queue tab, right-click the burn job you want to delete, then select Delete from 
the pop-up menu. A confirmation pop-up is displayed. 

5 . Click Delete. The selected job is removed from the Local Queue.
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Viewing DVDs
This section describes how to view the videos and case information stored on your export discs, also referred to as user-
requested certified copies. You cannot view videos or case information on an archive disc (Certified Backup Disc). The latter 
is only used to restore videos and cases to the server if/when the need arises .
The manner in which you view videos and other data on a DVD depends on the DVD’s format.

Viewing a Data DVD
This section describes how to view information stored on an export disc (i.e., user requested certified copy) that is in Data 
DVD format .
To view a Data DVD:
1 . Insert the Data DVD into your PC’s DVD player. In most cases, the DVD menu will be displayed automatically. If it is not 

displayed, navigate to your PC’s DVD/CD drive and double-click the AutoPlay.exe icon . The appearance of this menu will 
differ slightly depending on whether this is a video or case DVD . 

  
 

 

Data DVD - Video

Data DVD - Case
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2 . To play a video, click the thumbnail image for that video. The Flashback Player launches. For more information, see 
Flashback Player on page 303. 

3 . To display other information, such as the Chain of Custody Report or an attached media file, click the appropriate 
hypertext link. The file will be displayed in the associated software application, such as Adobe Reader.

4 . When you are finished viewing the files on this DVD, click the  cross icon in the upper right corner of the menu to exit the 
DVD menu .

Viewing a Consumer DVD
This section describes how to view videos stored on an export disc (i.e., user requested certified copy) that is in Consumer 
DVD format .
To view a Consumer DVD:
1 . Insert the Consumer DVD into the input tray of a consumer DVD player . After you close the tray, the DVD main menu will 

automatically be displayed on your TV screen or monitor. 

2 . Click the button that corresponds to the video and camera view you are interested in. The Group menu is displayed. 

3 . Perform one of the following tasks:
• To play the entire video from start to finish, click the Chapter 1 button. The video begins playing on your TV screen 

or monitor . 
• To start viewing the video partway in, click the Chapter 2, Chapter 3, or Chapter 4 button. The video begins playing 

on your TV screen or monitor .
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Viewing an Interchange or FOIA Redacted Format DVD
This section describes how to view videos stored on an export disc (i.e., user re-quested certified copy) that is in Interchange 
or FOIA Redacted format .
To view an Interchange or FOIA Redacted format DVD:
1 . Insert the Interchange or FOIA Redacted DVD into your PC’s DVD drive.
2 . Using Windows Explorer, navigate to the DVD drive to locate the desired video file, which will have an extension of either 

MKV (BodyVISION videos), AVI (VIEVU videos), or MP4 (all other videos) .
3 . Right-click the video file, then select Open with > [player software] from the pop-up menu .  

 TIP: Viewing BodyVision files

If you are playing a BodyVISION video, select the VLC media player .

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The selected video player is displayed . 

4 . If the video does not launch automatically, click the Play button.
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Viewing an Uncompressed Format DVD
This section describes how to view information stored on an export disc (i.e., user requested certified copy) that is in 
Uncompressed format .
To view an Uncompressed format DVD:
1 . Insert the Uncompressed format DVD into your PC’s DVD player. In most cases, the DVD menu will be displayed 

automatically. If it is not displayed, navigate to your PC’s DVD/CD drive and double-click the AutoPlay.exe icon . The 
appearance of this menu is similar to that of a Data DVD disc, except that it includes links at the bottom of the screen 
that are used to convert selected .QBX files into DV and MP4 files. 

2 . Perform one of the following tasks: 

To... Do this...

Play a video • Click the thumbnail image for that video. The Flashback Player is launched. For 
a description of the Flashback Player and its various features, see Flashback 
Player on page 303.

Display other information, such 
as the Chain of Custody Report 
or an attached media file

• Click the appropriate hypertext link. The file will be displayed in the associated 
software application, such as Adobe Reader.

Convert a selected video to DV 
and MP4 files

1 . Click the HERE link to the left of the file you want to convert. 
2 . If a security message is displayed, click Run. A confirmation message is 

displayed . 

3 . Proceed to the next step .

3 . Read the on-screen message . If you are sure you want to proceed with the conversion, press Enter. The system begins 
converting the selected file. When the conversion is complete, the current screen closes and the system automatically 
opens a folder on your desktop called raw_video which contains the MP4 and DV files. 
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Performing Other Backup-Related Tasks
You can perform a number of tasks to define or edit backup-related settings, and to customize the appearance of DVD 
interfaces .
The tasks described in this section are performed from the either the System Setup or the System Status pages, as pictured 
below. To access these pages, go to the Administration column and click either System Setup or System Status as needed .

Setting Backup Options
This section describes how to designate which type of files the system will automatically back up using your agency’s 
robotic DVD burner or Blu-ray burner. Backups occur on a schedule according to video category. A video’s category deter-
mines how long it will remain online . For more information on video category settings, see Video Details Page on page 
292.
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To set your backup options:
1 . Go to Administration > System Setup >System > Backup/Export > Backup Options .  

2 . Go to the Action menu and click Edit . The Edit Backup Options pop-up is displayed . 

3 . Select an option from the Backup Mode drop-down list, as described below, and then click Save . 

Backup  Mode Description

ALL Before purging, the system will back up all videos, regardless of what the video categories’ 
individual backup settings are.

CASE Before purging, the system will back up cases only.

CASE & CATEGORY Before purging, the system will back up:
• All cases
• Videos with a video category that is backup enabled.

CASE & CATEGORY 
& TAGGED

Before purging, the system will back up:
• All cases
• Videos with a video category that is backup enabled.
• Videos that are tagged .

EXTERNAL Before purging, the system will use an external backup device, such as the Dell Power Vault 
124T (works in conjunction with the Barracuda Yosemite backup software), to back up all cases 
and videos .

NONE The system will not back up any media. Select this option if either of the following 
circumstances apply:
• Your agency does not have a robotic DVD burner or Blu-ray burner
• Your agency only wants to use your disc burner to generate export discs (i.e., user-

requested certified copies).
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Enabling Network Attached Storage
This section describes how to enable a Network Attached Storage (NAS) server. Once the NAS is connected to your agency's 
network and mounted to the file system, you must enable it in your DES application in order to make it available to the 
system for archiving evidence. To do so:
1 . Go to Administration > System Setup > System > Backup/Export > Network/Cloud Storage . 

2 . Go to the Action menu and click Edit . The Network/Cloud Storage pop-up is displayed . 

3 . Select the Enable NAS checkbox, and then enter the network location path in the NAS Location field.
4 . Click Save to close the pop-up . Your DES system will now archive all evidence to the NAS .
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Customizing the Consumer DVD Menus and DVD Labels
When you insert a Consumer DVD disc into a consumer DVD player, a menu is displayed . This menu, referred to as the DVD 
main menu, lists the videos and other files that are stored on that disc. There is a separate main menu for case and video 
DVDs. Both menus are customizable. There is also a customizable Group menu that divides each video into four viewing 
segments. You can customize the color and style, heading text, and button values. 
Altogether there are four Consumer DVD menus that you can customize to meet your agency’s needs:
• Case DVD Main Menu
• Case DVD Group Menu
• Video DVD Main Menu
• Video DVD Group Menu .

You can design a different label for five of the DVD formats:
• Archive – Certified Backup Disc
• Data DVD – Case
• Consumer DVD – Case
• Data DVD – Video
• Consumer DVD – Video

 NOTE: Interchange and Uncompressed DVD labels
Interchange format and Uncompressed format DVDs receive the Data DVD label. Therefore all customizations to the 
Data DVD label will affect those DVDs as well.

Changing the Color & Style of the Consumer DVD Menus
This section describes how to change the style and/or color of the various components on the four Consumer DVD menus.
Specifically, you can change each menu’s background colors, text colors, button style/color, and logo display. 
To change color and style:
1 . Go to Administration > System Setup > DVD . 
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2 . Review the available styles/colors for buttons and backgrounds. To do so, click the Buttons and Backgrounds tab.

      

 TIP: Taking notes

While you are reviewing styles/colors, it’s a good idea to jot down the names of the designs you like most. To do so, 
hover your mouse over a selected design until a yellow pop-up is displayed .

3 . Display the first menu you want to customize. To do so, click the appropriate tabs for a main or group menu, and then 
the radio button for a case or video DVD.

4 . Right-click the menu component you want to change (background, button, heading, etc.), then select the desired style 
and/or color from the drop-down list . 

 
The system automatically applies your changes to the selected menu component . See the screenshot on the next page . 
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5 . If desired, change the style/color of other menu components, as described in step 4 .
6 . Display the next menu you want to customize, as described in step 3 .
7 . Repeat steps 4 – 6 until you have made all desired changes to the four Consumer DVD menus .
8 . Go to the Action menu and click Save .

 NOTE: Removing the logo 
To remove the logo from a DVD menu, right-click the logo, then select NO-LOGO from the drop-down list .

Changing the Heading Text and Button Values for the Consumer DVD Main Menu
This section describes how to change the three lines of heading text that are displayed at the top of the Consumer DVD 
main menus. There are two versions of this menu: a video version and a case version. Default menu values are pictured 
below.
                        Consumer DVD Main Menu - Video version                                                              Consumer DVD Main Menu - Case version 
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This section also describes how to change the field values that are displayed on the video selection buttons located on the 
Consumer DVD main menu . 

To change the heading text and button values:
1 . Go to Administration > System Setup > DVD > Settings, and then select a Case or Video radio button, as desired. Your 

current menu settings for the selected DVD menu are displayed . 

Default button values: 
 Video number, camera 

number & date/time.

This workflow continues on the next page.
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2 . Select custom label values from the drop-down list for each of the desired heading lines. 

3 . If desired, repeat steps 1 - 2 for the other main menu .
4 . To change the main menu's button values, select a set of field values from the Main Menu Buttons Label drop-down list .  

 
The components of the heading values are as follows: 

Heading Description

System ID The video’s system identification number. This ID is assigned automatically by the system.

Cam (Flashback 
videos only)

The Camera Channel on which the Flashback video was recorded: Camera Channel 1 (forward 
facing zoom camera) or Camera Channel 2 (Backseat and/or Bullet cameras).

Date The date and time at which the video was recorded . Is displayed in yyyy/mm/dd hh:mm format .

Officer The name of the officer who was logged into the DVR at the time the video was recorded. If this 
value starts with an asterisk (*), it indicates that either no officer was logged into the DVR at the 
time of the recording, or an officer was logged in manually using an incorrect DVR Officer Name.

DVR The name of the DVR that recorded the video .

5 . Go to the Action menu and click Save .
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Customizing DVD Labels
To customize  a DVD label:
1 . Go to Administration > System Setup > DVD > DVD Label. A mock-up of a DVD label is displayed. 

2 . Select a DVD label type from the Select Export Type drop-down list in the upper right corner of the form .
3 . Using the other drop-down lists on this page, select values for each section of the DVD label. Note that the drop-down 

lists are in the exact same order and layout as the label itself. If you select one of the custom fields—Administrator 
Static or Administrator Prompt—you will be prompted to enter a corresponding value on the disc diagram.  

 

 NOTE: Administrator Static and Administrator Prompt
Administrator Static. This field enables you to enter a label value that will always be the same, such as “For internal 
use only .”
Administrator Prompt. This field enables you to enter a label value that will be different for every disc, such as 
“Requestor.” When you use this type of field, the system will prompt you to enter an associated field value every time 
you submit a burn request.

4 . Go to the Action menu and click Save .

Custom "Administrator 
Prompt" filed for DVD 

label
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Viewing the Certified Backups List and Generating the Video 
Deletion Roll-Up Report
This section describes how to view a list of the following:
• All of the prior backups made to an external backup device
• All of the prior DVD backups.
• All of the pending backups. These are the backup jobs that are in the queue but have not occurred yet (e.g., archive 

discs that are waiting to be burned).
This section also describes how to view, save, and/or print the Video Deletion Roll-Up Report. This report lists information on 
all archived videos and body-worn snapshots that the system has deleted from the server in the prior month.
This report will help you determine which archive DVDs you can safely dispose of, as the system only deletes those videos 
and snapshots that are too old to be restored (i.e., files that have “aged out”).
To view the list of backups and generate the video deletion roll-up report:
1 . Go to Administration > System Status > Backups . 

2 . Perform one of the following tasks:
• To view a list of tape backups, make sure the External Backups tab is selected.
– OR –
• To view a list of DVD backups, click the DVD Backups tab.
The columns on this page are described in the corresponding table in Appendix 4 - Evidence Backup and Sharing.

This workflow continues on the next page.
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3 . To access the list of reports, click the DVD Rollup tab. A list of reports is displayed. Each report is identified by a first-of-
the-month date, which lists all media that has aged-out in the previous month . For example, the 06/01/2018 report will 
include all videos, body-worn snapshots, and cases that have aged-out in May 2018. 

 
4 . Locate the date for which you want to view a report, then click the appropriate download icon. A Windows message is 

displayed .
5 . Click Open. The report is displayed in Adobe Acrobat. The columns on this report are described in the corresponding 

table in Appendix 4 - Evidence Backup and Sharing. 

  
6 . To print this report, click the printer icon. The Print pop-up is displayed .
7 . Select your printer options, then click Print . The report is directed to your active printer .
8 . When you are finished viewing/printing this report, click the cross icon in the upper right corner of the report to exit this 

window .
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Validating that a Disc is Unaltered
This section describes how to use the Disc Validator utility to verify that an evidence DVD has not been altered in any way.
To validate a disc:
1 . Place the DVD you want to validate in your PC’s DVD tray.
2 . Go to Administration > System Status > Tools, and then click the Disk Validator button. The system downloads the 

installation file to your PC’s Downloads folder . 

 
3 . Navigate to your Downloads folder, then right-click the verify.jar file, and select Open from the displayed menu . The Disk 

Validator screen is displayed . 

4 . Click the Load & Verify Disk Now button. The Validator begins checking the DVD for signs of tampering. This may take 
several minutes, depending on the size of the disc .
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5 . Perform one of the following tasks: 

If... Then...

You are prompted with a warning 
message

It means that the disc has been altered. 
• Throw it away and burn a new one. You may also want to evaluate your 

agency’s policies/procedures for burning and storing evidence DVDs.

Disk IS Valid pop-up is displayed It means that the disc has not been altered. 
• Click OK to close the pop-up .

6 . Click Quit to close the Validator application .

Changing the Default Output Format Type for DVDs
This section describes how to change the default value that is automatically displayed in the Output Format field on the 
Export Video(s) page and/or Export Case page .  
To change the default output format:
1 . Go to Administration > System Setup > DVD > Settings . 

 
2 . To change the default output format for case DVD, select the Case radio button. 

-OR-  
To change the default output format for video DVD, select the Video radio button.

3 . Go to the Default DVD Export Type field at the bottom of the page and select the desired export type radio button.
4 . To change the output format for other DVD type, repeat steps 2 - 3 .
5 . Go to the Action menu and click Save .

 NOTE: DEV users

This workflow is not 
applicable to user of the 
DEV application .



© Safe Fleet | September 2021 | All rights reserved

Digital Evidence Series Administrator's Guide

165 Part # 700-8006 R3

Performing Other Backup-Related Tasks

Changing the Default Values for the ‘Show GPS’ & ‘Show Speed’ 
Checkboxes
When you export a video or case file in Data DVD or Uncompressed format, you will see two checkboxes in the lower left 
corner: Show GPS and Show Speed. By default, these checkboxes are selected. However, if desired, you can change this 
default value to deselected, as described in this section.

 
To change the default values:
1 . Go to Administration > System Setup > System > Other, then go to the Action menu and click Edit . The Other pop-up is 

displayed . 

2 . Deselect the Speed/GPS Selected checkbox, and then click Save.

Factory default:
Checkboxes 

selected
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Backup PCs
A backup PC is a computer used to process DVD burn requests. Because the process of burning DVDs is resource-intensive, 
one PC is dedicated to this task. If you are using a Bravo robotic DVD burner, then the backup PC is a separate computer 
workstation connected to the disc burner. If you are using a Rimage DVD/Blu-ray burner that combines a disc burner with a 
computer, the backup PC refers to the computer component of the Rimage.
If your agency has more than one storage server, you can connect those servers to a single backup PC. However, if your 
agency has more than one Bravo DVD burner, each DVD burner must have its own Backup PC. Any time you add a new 
backup PC/DVD burner to your setup, you will have to enter a new backup PC record, as described in Adding a Backup PC 
on page 168.
Your System Implementation Specialist will initially install and configure your backup PC(s) during implementation. However, 
you may occasionally need to perform tasks related to this device, such as viewing the backup PC status page, which logs 
any backup PC errors that occur.

Viewing the Backup PC Status
You can view the current status of a backup PC workstation by going to Administration > System Status > Backup PC . If 
there are any error messages, they will be displayed here. The fields on this page are described in the corresponding table in 
Appendix 4 - Evidence Backup and Sharing.

Updating the Backup PC Software
Occasionally, you may need to update the software that controls your backup PC. Perform this task whenever you receive 
an update notification in your Inbox ("Update Required for your Backup PC"), or you are instructed to do so by a Mobile-
Vision Technical Support Engineer .
The backup PC update procedure needs to be performed on the backup PC itself, so you need to log out of your DES 
application now, then log back in from the backup PC, as described below.
To update a backup PC:
1 . Go to the top right of the Welcome Home page and click Logout .
2 . Walk to the backup PC, and the log in to your DES application again. (Make sure that you log in as an Administrator.)
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3 . Go to Administration > System Status > Tools, and then click the Backup PC Updater button. The Opening backup-
updater pop-up is displayed . 

4 . Click Save File. The system downloads the EXE installation file to your PC’s Downloads folder .
5 . Navigate to your Downloads folder, and then double-click the backup-updater file. A security warning is displayed. 

6 . Click Run. The system copies some files from the server to your PC. After a momentary delay, the Setup Wizard is 
launched . 

This workflow continues on the next page.
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7 . Click Next. A list of DVD burners is displayed. 

  
8 . Select the type of disc burner that your backup PC is connected to. 
9 . Click Next. The system begins updating your backup PC. Once the software has been installed on your PC, a 

confirmation message is displayed.
10 . Click Finish. The system prompts you to reboot your PC. 

11 . Close any files that you may have open on the backup PC, then click Yes .

Adding a Backup PC
This section describes how to enter a new record for a backup PC. This information will be used to control your robotic DVD 
burner. 

 NOTE: About Bravo DVD burners

Every Bravo DVD burner has one or two input bins and one output bin. The input bin is where the blank DVDs go. The 
output bin is where the robotic DVD burner places the completed DVDs.
There are two modes used to configure a Bravo DVD burner: regular mode and kiosk mode. 
In regular mode, the DVD burner’s right bin is used as the input bin and the left bin is used as the output bin. 
In kiosk mode, both the right and left bins are used as input bins, and a center “catch” tray is used as the output bin. If 
you prefer to configure your DVD burner in kiosk mode, ask a Mobile-Vision Technical Support Engineer to assist you.

To add a backup PC:
1 . Contact Mobile-Vision Service at 800-336-8475 (when prompted, select the phone option for “Service”, then “Back 

Office”). A Technical Service Engineer (TSE) will assist you with the preliminary setup tasks required to add a new 
burning station. This step is sometimes referred to as “pre-staging.”

2 . Obtain an IP address for the new backup PC. If the backup PC will be connected to the Mobile-Vision network, your TSE 
will provide you with this address. If the backup PC will be connected to your agency’s network, your agency’s Network 
Specialist will provide you with this address .

 WARNING: Selecting a DVD burner

Make sure you select only one burner. If 
you select more than one DVD burner or 
you select the wrong DVD burner, or it could 
render your backup PC system temporarily 
inoperable.



© Safe Fleet | September 2021 | All rights reserved

Digital Evidence Series Administrator's Guide

169 Part # 700-8006 R3

Backup PCs

3 . Go to Administration > System Setup > System > Backup/Export > Backup PC. The fields on this page are described in 
the corresponding table in Appendix 4 - Evidence Backup and Sharing. 

4 . Go to the Action menu and click New . The New Backup PC pop-up is displayed . 

5 . Enter a descriptive name for this backup PC in the Name field.
6 . Enter the IP Address for this backup PC in the IP Address field.
7 . Perform one of the following tasks: 

If... Then...

This record is for a Bravo 
burner that you plan to 
use in kiosk mode 
-OR-
This record is for a 
Rimage burner

• Go to the Left bin (bin 2) field and select the type of disc that you plan to place in the 
DVD burner’s left bin (Bravo units) or bin 2 (Rimage units):
• DVDR  . . . . . . . . . . . . . DVD single layer discs
• DVDRDL  . . . . . . . . DVD dual layer discs
• BD  . . . . . . . . . . . . . . . . . . Blu-ray single layer discs
• BDDL  . . . . . . . . . . . . . Blu-ray dual layer discs 

This record is for a Bravo 
burner that you plan to 
use in regular mode 

• Keep the Left bin (bin 2) field set to the default value (OUTPUT)
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8 . Go to the Right bin (bin 1) field and select the type of disc that you plan to place in the DVD burner’s right bin (for Bravo) 
or bin 1 (for Rimage), as listed in step 7 above.

9 . Go to the Archive field and select the type of disc that you want to use for your system-generated archive discs (i.e., 
Certified Backup Discs).

10 . Go to the Export field and select the type of disc that you want to use for your user-requested certified copies (i.e., 
export discs) .

11 . To use this backup PC as the default on the Export Options pop-up, select the Use as Export Default checkbox.
12 . Click Save. The new backup PC record is displayed on the Backup PC list .

Changing or Deleting a Backup PC
This section describes how to update an existing backup PC record. For example, if you decide to switch from using single 
layer DVDs to dual layer DVDs, you’d need to update the associated backup PC record. 
This section also describes how to delete an existing backup PC record. Perform this task after a backup PC/DVD burner 
has been decommissioned, or as directed by your Mobile-Vision Technical Support Engineer.
To change or delete a backup PC:
1 . Go to Administration > System Setup > System > Backup/Export > Backup PC . 
2 . Right-click the backup PC record you want to update, and then perform one of the following tasks: 

To... Do this...

Change a backup PC 1 . Select Edit from the pop-up menu . The Edit Backup PC pop-up is displayed . 

2 . Enter/select your changes in the appropriate field(s), then click Save .

Delete a backup PC 1 . Right-click the backup PC record you want to delete, then select Delete from the 
pop-up menu. A confirmation message is displayed. 

2 . Click Yes . The selected record is removed from the system .
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Using Cloud Courier to Share Digital Evidence
This section describes how to share digital evidence via the secure Safe Fleet Cloud using the Cloud Courier feature.

 NOTE: DEA Precinct, DEV, and DEF users

This feature is not available to users of the DEA Precinct, DEV, and DEF applications.

 NOTE: DES and Cloud Courier communication

In order for DES to communicate externally with Cloud Courier, TCP port 443 must be configured to allow inbound and 
outbound access through the agency's firewall.

Sharing Digital Evidence
You can share videos and case files with interested outside parties directly from your DES application using Cloud Courier.

 WARNING: Video authenticity

Once a video has been shared as part of shared evidence, its authenticity can no longer be verified. Such video can be 
edited and tampered with using commercial video editing software .

To share evidence:
1 . Select the files that you want to share. To do so, perform one of the following tasks:  

To select... Do this...

Videos 1 . If necessary, review Searching for Videos on page 27, and then perform one of the following 
tasks:
• To share one video, search for and display the desired video . The Video Details page is 

displayed .
• To share more than one video, search for the desired videos . The Video Search Results page is 

displayed .
2 . Go to the Action menu and click Export . The Select Video(s) for Export page is displayed . 
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To select... Do this...

Videos 
(cont .)

3 . If in step 1 you have chosen to share multiple videos, click each of the videos you want to include; 
otherwise proceed to the next step . NOTE: You can click any part of the record except the thumbnail 
image, as that will launch the Flashback Player. 
As you select each video, it will appear in the Selected Videos list at the bottom of the page.

4 . Go to the Action menu and click Export Video(s) . The Export Video(s) page is displayed . 

 

Case files 1 . If necessary, review Searching for Cases on page 98, and then find and display the case you want 
to share . The Case Details page is displayed .

2 . Go to the Action menu and click Export . The Export Case page is displayed . 

3 . Deselect the checkboxes beside videos you want to exclude from this download.

2 . Select the desired format from the Output Format drop-down list .  

 NOTE: Available formats
To review the differences between formats, click Help on the Action menu, or see Available File Formats for User-
Requested DVDs on page 127 . 

 
Depending on the format you selected, new columns may appear on the displayed screen . 
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3 . Perform one of the following tasks:  

If you selected... Then...

Consumer DVD • Follow step 3 of the Burning a Case to a Consumer DVD procedure .

Data DVD or Uncompressed Format • Proceed to the next step .

Interchange Format • Follow step 3 of the Burning a Case to an Interchange Format DVD 
procedure .

FOIA Redaction Format • Follow steps 3 - 7 of the Burning a Case to an FOIA Redacted DVD via 
Your PC’s DVD Burner procedure .

4 . Go to the Action menu and click Save . The Export Options pop-up is displayed . The appearance of the pop-up will 
differ, depending on the output format you selected in the previous step and the option you selected in step 1 of this 
procedure (videos or case files). 

 
5 . Select the Cloud Courier radio button. Additional options are displayed on the Export Options pop-up .  

Sender Information 
section is prepopulated 

with your login, email 
address and agency 

name .
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6 . Select one of the following options:
• ISO radio button to share evidence as a packaged ISO file
• ZIP radio button to share evidence as a compressed ZIP file 
• MEDIA radio button (if displayed)  to share individual evidence files. 

 NOTE: About shared evidence options

Depending on the option you select, the recipients will receive shared evidence in a different form .
• If you select ISO or ZIP, the recipients will receive shared evidence files packaged together with the Flashback 

Player and other system utility files that will enable the recipients to view the videos along with the attached 
metadata .  
Additionally, if you select ISO, the recipients may be able to burn shared evidence to a DVD that can be played 
on a compatible DVD player.

• If you select MEDIA, only individual files will be included with this shared evidence.

7 . If the Video Description box is displayed, enter a description for this shared 
evidence . 

8 . Make your selection from the Chain of Custody Log Level drop-down list .
9 . Enter a name for this shared evidence in the Export Name field.
10 . To limit the time during which this shared evidence will be accessible by the 

recipients, perform one of the following tasks:
• To set a period of time this shared evidence will be accessible, click the Share Period radio button, and then select 

the desired period from the drop-down menu . 
-OR-

• To set an expiration date of this shared evidence, click the Expiration Date radio button, and then enter the date in 
the field using the MM/DD/YYYY format, or click the calendar icon to select it from the calendar.  
NOTE: You can set the expiration date of up to 30 days. If you set the expiration date outside of the 30 days, an error 
message will be displayed after you click Save .

11 . Select the maximum allowed number of downloads from the Download Limit drop-down list .
12 . To include previews of supported files with this shared evidence, select the Include Preview Files checkbox (if 

displayed) .
13 . Enter the first and last name, and an email address of the person to whom you are sending this shared evidence in the 

corresponding fields of the Recipient Information section . 
14 . To share this evidence with another recipient, click the Add Recipient button and enter their information. Repeat for 

each additional recipient . 

 NOTE: Multiple recipients

If you choose to add more than one recipient, make sure you enter their information accurately the first time. If you 
make a mistake in the name or email address, you will not be able to go back to edit them. Instead you will have to 
close the Export Options form and start over .

15 . If a Video Player Options section is displayed, select the displayed checkboxes as needed: 
• Select the Show GPS checkbox to include GPS data.
• Select the Show Speed checkbox to include vehicle speed data.

 NOTE: Num Copies field

Ignore the Num Copies field for 
evidence sharing procedure .
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16 . Click Save . The system places your sharing request in the queue and displays a status message on your Welcome 
Home page under Sent Messages . Once the evidence is uploaded to the Safe Fleet Cloud, a Cloud Courier Success 
message is displayed under Inbox Messages .

Managing Shared Evidence
You can review, extend or cancel the active shared evidence .

 NOTE: Permissions

Only users with appropriate permissions will be able to follow the steps described in this workflow.

To manage shared evidence:
1 . Go to the Home Menu and click Cloud Courier to access the list of all shared evidence records . The Evidence Shares 

List page is displayed .  

2 . Sort or filter the displayed list as needed. To do so, either click the corresponding column heading or start typing in the 
corresponding field on the top row of the list.

3 . Click the shared evidence record of interest to highlight it, and then perform one or more of the following tasks:  

To... Do this...

Review the shared 
evidence record

1 . Go to the Action menu and click View Details . The Evidence Share Details pop-up is 
displayed . 

 

This table is continued on the next page.
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To... Do this...

Review the shared 
evidence record 
(cont .)

2 . Click each tab to review the details, the recipients, the media, and the case information (if 
displayed) of this shared evidence. You can click the information icon (where displayed) to 
review the media files or case details in your DES application.

3 . Once you have finished reviewing this shared evidence, click Close .

Extend the 
period of time 
during which the 
recipients will have 
access to this 
shared evidence
NOTE: Extensions 
affect all the 
recipients of this 
shared evidence .

1 . Go to the Action menu and click Extend. A confirmation message is displayed.
2 . Click Yes to confirm the extension.  

 
Once the shared evidence is extended, observe the following changes:
• The Extend button on the Action menu is grayed out
• The Extended checkbox on the Details tab is selected. 

 NOTE: About extensions

The default extension period is 30 days and only one extension is permitted . 

Cancel this shared 
evidence
NOTE: 
Cancellations 
affect all the 
recipients of this 
shared evidence .

1 . Go to the Action menu and click Cancel. A confirmation message is displayed.
2 . Click Yes to confirm the cancellation.  

 
Once the shared evidence is canceled, observe the following changes:
• The Cancel button on the Action menu is grayed out
• The status of this shared evidence changes to CANCELLED .

Limiting the Cloud Courier Bandwidth
Uploading shared evidence to Safe Fleet Cloud requires the use of your agency's Internet connection. Depending on the 
available bandwidth (the amount of data your agency's Internet connection is able to transmit per second), a slowing may 
occur in your regular Internet-dependent tasks while shared evidence is being uploaded. To prevent or reduce the slowing, 
you can limit the amount of bandwidth that Cloud Courier uses to upload shared evidence. To do so:
1 . Go to Administration > System Setup > System > Backup/Export > Network/Cloud Storage, then go to the Action 

menu and click Edit . The Network/Cloud Storage pop-up is displayed . 

2 . Select the Limit Cloud Courier bandwidth checkbox, and then enter the desired value (in megabytes) in the Maximum 
Bandwidth (MB/s) field. 

3 . Click Save to close the pop-up. Your Cloud Courier service will now use only the specified amount of bandwidth.
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About DVRs and 8-Bay Docks
This chapter describes the various procedures used to update and maintain your in-car and body-worn DVRs, as well as 
8-bay docks. For brevity, where practicable, in-car DVRs, body-worn DVRs, and 8-bay docks are referred to as devices in this 
chapter .

 NOTE: DEA Agency users

The contents of this chapter is not applicable to users of the DEA Agency application.

If you have an Extended Maintenance Agreement with Mobile-Vision, you will occasionally receive DVR firmware updates via  
your DES application. The procedure for updating the firmware is described later in this chapter.
Each of your in-car DVRs, body-worn DVRs, and 8-bay docks has corresponding information stored in your DES application 
and required for successful communication between your DVRs and the server.
After initial deployment, you will only have to make occasional changes to these devices as needed. For example, when you 
add a new in-car DVR to your fleet, you may need to enter a new DVR record in your DES application.
Procedures that do not reference a particular DVR type apply to both vehicle and body-worn DVRs.

Changing Discovery Methods and Download Options

 CAUTION: When to make this change 

Do not change these settings unless instructed to do so by your agency’s Network Administrator or by a Mobile-Vision 
Technical Support Engineer .

This section describes how to change system settings relevant to communication of your DES application with DVR and 
8-bay dock devices connected to the network. These settings determine the following system actions:
• Whether the system will automatically recognize devices on the network
• Which method of device discovery the system will use
• Whether the discovered device information will be automatically inserted into DES
• Whether the inserted devices will be enabled or disabled by default.

In-car DVR/8-bay dock settings

Body-worn DVR settings
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 NOTE: About initiating video downloads

Based on the settings you select, the system may or may not automatically initiate video downloads from DVRs 
connected to the network. To ensure the videos are automatically downloaded, do not change the default settings 
described below. For FOCUS X2 DVRs, inserted into 8-bay docks, videos will be automatically downloaded if the default 
settings remain unchanged for both in-car DVRs/8-bay docks and body-worn DVRs.

To change the communication settings:
1 . Log in as an Admin user and go to Administration > System Setup > System > Download Options . 

 
2 . Go to the Action menu and click Edit . The Download Options pop-up is displayed .
3 . To change the settings for in-car DVRs and 8-bay docks, perform the following tasks:  

To... Do this...

Enable the system to download the 
device information to DES

• Select the Enable FB2/FB3/FBHD/8 Bay/H1 DVR Downloads checkbox.  
(default) 

Change the device discovery 
method used by the system

• Go to the Discover FB2/FB3/FBHD/8 Bay/H1 DVR by field and select one 
of the following options from the drop-down list:
• Ping for ping-type method, or
• UDP for UDP broadcast method (default)

NOTE: A TCP “ping” command is used to test whether a specific DVR is 
reachable across the network.

Have the system automatically 
create a new device record 
whenever it is discovered

• Select the Auto Insert FB2/FB3/FBHD/8 Bay/H1 DVR Devices checkbox. 
(default)

NOTE: If you prefer to enter the new DVR or 8-bay dock information manually, 
leave this checkbox deselected.

This table is continued on the next page.
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To... Do this...

Select the default status of a newly 
discovered device

• Go to the Insert Devices As field at the bottom of the pop-up and select 
one of the following options from the drop-down list:
• Disabled, or
• Enabled (default)

4 . Unless otherwise instructed by a Mobile-Vision Support representative, select the following body-worn DVR settings: 

Field Suggested setting

Enable Body Worn Downloads Selected

Discover Body Worn by UDP

Auto Insert Body Worn Devices Selected

Insert Devices As Enabled

5 . Click Save .

Adding DVRs and 8-Bay Docks
There are three methods for adding DVRs and 8-bay docks to your DES application:
• Manually enter devices one at a time .
• Add multiple devices “en mass” by importing their information from a spreadsheet.
• Configure the system to automatically create a device whenever it discovers a new unit on the network 

Manually Adding a Single Device
This section describes how to manually add a new DVR or 8-bay dock.
Depending on your agency’s selected download options, you may or may not need to perform this procedure. 

If these options are selected, the 
system will automatically insert new 

in-car DVRs and 8-bay docks.

If these options are selected, the 
system will automatically insert new 

body-worn DVRs.
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Refer to the following table to discover which option you should use:  

If... Then...

Your agency is using the default “ping” method of device 
dock discovery
-OR-
• Your agency is using the UDP broadcast discovery 

method, AND
• The applicable “Auto Insert X Devices” checkbox on the 

Download Options form is NOT selected

• Perform this procedure whenever you add a new device 
to your fleet.

• Your agency is using the UDP broadcast discovery 
method,  AND

• The applicable “Auto Insert X Device” checkbox on the 
Download Options form is selected

• You don’t need to perform this procedure, as the system 
will automatically create a device record for each new 
device unit that it discovers on the network. 

To add a single device:
1 . Go to Administration > Manage DVRs, then go to the Action menu and click New DVR . The New DVR form is displayed . 

The fields on this form are described in the corresponding table in Appendix 5 - DVRs. 

 
2 . Enter a unique name for this device in the DVR Name field. For example, you may want to give a DVR the same name as 

the patrol car in which it will be installed (e.g., Unit 146).
3 . If your agency is not using USB Login Keys for in-car DVRs, enter a default officer name in the Officer Name field. Make 

sure this name is exactly the same as the Officer Name field on the officer’s user profile.
4 . To change this device’s download priority setting, select Low, Med or High from the Download Priority drop-down list . 
5 . If you want to activate this device right now so that it can begin transmitting videos to the server immediately (default), 

proceed to the next step . Otherwise, select Disabled from the Status drop-down list . 
6 . Select the type of device you are adding from the DVR Type drop-down list . NOTE: If this is an in-car DVR is installed in 

an interview room, select Interview Room from the DVR Type drop-down list . This only applies to customers who have 
purchased the Interview Room module . Otherwise proceed to the next step .

7 . If the Group Name field is displayed, select a group from the drop-down list to assign this device to a group. 

8 . Click Save. A confirmation message is displayed at the top of the page.

Importing Multiple Devices from a Spreadsheet
At system start-up, your System Implementation Specialist (SIS) will provide you with a spreadsheet that contains all your 
basic devices. You can import this information to your DES application to save data entry time. After that, you will typically 
add devices one at a time whenever you add a new vehicle/DVR to your fleet. (Exception: If your agency is using the UDP 
Broadcast discovery method with the “Auto-Insert DVRs” feature, the system will automatically create new DVRs for you .) 
This procedure can be used to copy device information from one server to another. 

 NOTE: New DVR form

Depending on the application 
you are using, some or all 
options will be available to you 
on the New DVR form .
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To import devices:
1 . Using Microsoft Excel, open the DVR spreadsheet provided by your System Implementation Specialist (SIS). 

2 . Save the spreadsheet in the CSV format .
3 . Go to Administration > Manage DVRs, then go to the Action menu and click Import DVRs . The Import DVRs pop-up is 

displayed . 

4 . Click Choose File, and then navigate to the spreadsheet that contains your device information (config_units.csv) .
5 . Double-click the spreadsheet file. A list of devices is displayed . 

 
6 . Click Save. A confirmation message is displayed at the top of the page. 

 NOTE: Imported device status

The default status of your imported devices will be set to Disabled. When you’re ready to start using the devices, 
make sure you change their status to Enabled .

 NOTE: Which devices will be imported?

• All devices that have a value of Insert Valid 
will be imported. 

• All devices that have a different value (such 
as Updating Existing Unit or No DVR ID 
found) will NOT be imported. 

You can try importing such “problem” devices 
again later. If you are still unable to import them, 
contact Mobile-Vision Support for assistance.
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Searching for an Existing DVR or 8-Bay Dock
This section describes how to search for an existing device by one or more of the following fields: DVR Name, Last Comm 
IP, DVR ID, Status, Type, Product Code, Group, and/or Version .
To search for a device:
1 . Go to Administration and click Manage DVRs . The Manage DVRs page is displayed . 

2 . Using the search fields at the top of the page, enter/select the field values you want to search on. These fields are 
described in the corresponding table in Appendix 5 - DVRs. After you enter a search value, the system will automatically 
display those devices that match your search criteria . 

 NOTE: About the Config Sync column

The Config Sync column displays the device’s configuration synchronicity.
• Pending. The system is in the process of synchronizing the server’s device configuration with the actual DVR 

unit’s or 8-bay dock's configuration. In other words, the server and the device are not yet synchronized.
• Complete. All previous changes to the server’s device configuration have already been copied to the actual DVR 

unit or 8-bay dock. The server and the device are fully synchronized.
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In-Car DVRs
This section describes how you can configure, and replace in-car DVRs.

Configuring In-Car DVRs
This section describes how to configure in-car DVRs. 

 NOTE: Server vs DVR

DVR changes made from the server will always override any changes made from the DVR unit itself .

To start configuring an in-car DVR: 
1 . Go to Administration > Manage DVRs, and then locate the DVR you want to update. If you have a large number of DVRs 

to scan through, see Searching for an Existing DVR or 8-Bay Dock on page 185.
2 . Right-click the DVR you want to update, then select Edit from the pop-up menu . 
3 . Perform one of the following tasks: 

If... Then...

Fleet Management is 
disabled

 NOTE: DEV 
users

Users of the DEV 
application must 
use this workflow 
to start configuring 
in-car DVRs .

The Edit DVR form is displayed. The fields on this form are described in the corresponding 
table in Appendix 5 - DVRs. 

 
1 . Enter/select your changes in the appropriate fields.
2 . Click Save. A confirmation message is displayed.

 NOTE: Additional configuration options 

As long as Fleet Management is disabled, all other DVR settings (audio/video 
settings, display options, triggers, etc.) must be configured from the DVR itself, as 
described in your DVR's User’s Guide.

This field will only be visible 
if this is an Interview Room 

DVR .

This table is continued on the next page.
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If... Then...

Fleet Management is 
enabled

The Edit DVR form is displayed . This form may appear slightly different depending on 
whether the DVR is “discovered” or not .

 NOTE: Discovered vs. Undiscovered DVRs. 
A discovered DVR is one that has been in communication with the server at least 
once . 
An undiscovered DVR is one that has not been in communication with the server yet 
(i .e ., a DVR unit for which you just created or uploaded information) . 
To determine if a DVR has been discovered yet, go to the Administration > Manage 
DVRs > DVR COM, and then look in the Last COM Date column . 
If a date and time are displayed, the DVR has been discovered. 
If the word Never is displayed, the DVR has not been discovered.

 

• Proceed to one of the following sections for further instructions:
• Configuring an In-Car DVR Assigned to a DVR Group
-OR-
• Configuring an In-Car DVR Not Assigned to a DVR Group.

Discovered 
DVR

Undiscovered 
DVR
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Configuring an In-Car DVR Assigned to a DVR Group
This section describes how to configure a Flashback2, Flashback3, FlashbackHD, or FOCUS H1 DVR that is currently 
assigned to a DVR group when the Fleet Management feature is enabled. To perform this procedure, the DVR must be 
discovered. To make global changes to a group of Flashback2, Flashback3/HD, or FOCUS H1 DVRs, see Configuring an In-
Car DVR Group on page 215 instead .

 NOTE: DEV users

The workflow described in this section does not apply to users of the DEV application.

To configure an in-car DVR:
1 . Follow steps 1 - 2 of the Configuring In-Car DVRs procedure . The Edit DVR form is displayed. The fields on this form are 

described in the corresponding table in Appendix 5 - DVRs. 

   
 

 
 

 NOTE: Grayed out Ethernet fields

If the Group Managed Ethernet 
checkbox is selected on the displayed 
Edit DVR form, then the three Ethernet 
fields will be grayed out here. To edit 
these fields at the group level, see 
Configuring IP Settings on page 215 .

Sample Flashback 
information

Sample FOCUS H1 
information
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2 . Enter/select your changes, and then click Save. A confirmation message is displayed. 

 NOTE: Group level changes

Some changes can only be made at the group level. To change a DVR setting that does not appear on the Edit DVR 
form, see Configuring an In-Car DVR Group on page 215.

Configuring an In-Car DVR Not Assigned to a DVR Group

 NOTE: DEV users

The workflows described in this section do not apply to users of the DEV application.

This section describes how to configure a discovered Flashback2, Flashback3, FlashbackHD, or FOCUS H1 DVR that is NOT 
currently assigned to a DVR group when the Fleet Management feature is enabled. To make global changes to a group of 
Flashback2, Flashback3/HD, or FOCUS H1 DVRs, see Configuring an In-Car DVR Group on page 215 instead .

 NOTE: Configuration settings

For detailed descriptions of available configuration settings, refer to the corresponding tables in Appendix 5 - DVRs.

Configuring General DVR Settings
1 . Search for and display the in-car DVR you want to change . The Edit DVR form is displayed. The fields on this form are 

described in the corresponding table in Appendix 5 - DVRs. 
 
                     Sample Flashback information                                                         Sample FOCUS H1 information 

        
2 . Make sure the DVR tab is selected, and then enter or select your changes. 
3 . To change additional DVR settings, click the DVR Settings tab, and then enter or select your changes.  

 
                    Sample Flashback information                                                         Sample FOCUS H1 information 

       
4 . Click Save. A confirmation message is displayed at the top of the page.
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Configuring IP Settings
Interview Room DVRs typically utilize an Ethernet connection, whereas in-car DVRs typically utilize a wireless connection . 
However, in-car units are still Ethernet-enabled to support Vehicle Viewer or Vehicle Viewer Live, which requires the use of 
the Ethernet port on the in-car DVR . An Ethernet connection is also required if you have the UMD Editor installed on your 
mobile data computer. To perform this procedure, the DVR must be discovered.
• To change the remote broadcast IP address, remote unicast IP address, and/or gateway type for an in-car DVR, 

configure general IP settings.(Flashback DVRs only)
• To configure an in-car DVR for use with Interview Room, Vehicle Viewer, Vehicle Viewer Live, and/or the UMD Editor, 

configure Ethernet settings .
• To configure an in-car DVR that does not interface with Vehicle Viewer, Vehicle Viewer Live, and/or the UMD Editor, 

configure wireless settings .
To configure IP settings:
1 . Search for and display the in-car DVR you want to change, and then click IP Setup on the displayed Edit DVR form . 

2 . Flashback DVRs only. To configure the general IP settings, perform the following steps:
i. Click the General tab if it's not already displayed. 
ii. To change the remote broadcast IP address(es), enter the new IP address(es) in the Remote Broadcast IP(s) field, 

separating multiple addresses with a space .
iii. To change the remote unicast IP address(es), enter the new IP address(es) in the Remote Unicast IP(s) field, 

separating multiple addresses with a space .
iv. To change the gateway type, select a new value from the Gateway Type drop-down list . 

 NOTE: About general IP settings
• Remote broadcast IP address(es).* An IP address range across which the Flashback DVR announces its 

identity so the server can locate them . System default is 255 .255 .255 .255 .
• Remote unicast IP address(es).* A list of unique IP address(es) to which the Flashback DVR announces its 

identity so that the server can locate them .
• Gateway type. The type of connection used to link this Flashback DVR to the server: wireless (for in-car DVRs 

that do not interface with Vehicle Viewer, Vehicle Viewer Live, or the UMD Editor), or Ethernet (for Interview 
Room DVRs and in-car DVRs that interface with Vehicle Viewer, Vehicle Viewer Live, and/or the UMD Editor) .

* Based on your department's network setup and security requirements, you would enter either remote broadcast 
IP address(es) (typical), or remote unicast IP address(es) .

3 . To configure the Ethernet settings, click the Ethernet tab. The Ethernet form is displayed .  
 
 
                                                  
             

 WARNING: Configuring Ethernet settings

Do not attempt the following step without the assistance of your agency’s network specialist OR a Mobile-Vision 
Technical Support Engineer . Entering incorrect data could cause wireless transmission to fail .
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Sample Flashback information                                                         Sample FOCUS H1 information 

      
4 . Perform one of the following tasks:  

To... Do this...

Configure a Flashback or 
FOCUS H1 DVR for use with 
Interview Room
NOTE: This configuration is 
typically used in conjunction 
with the UDP Broadcast 
discovery method .

 NOTE: DEA Precinct 
users

This workflow does not 
apply to users of the DEA 
Precinct application .

1 . Perform one of the following tasks: 

If... Then...

This DVR will be 
installed on a DHCP 
network

1 . Check the Ethernet DHCP checkbox at the top of 
the form . The system grays out the Ethernet IP, 
Ethernet Mask, and Ethernet Gateway IP fields. 

2 . Proceed as follows:
• For Flashback, skip to step 6 on page 192 to 

save the changes and exit the configuration 
procedure, or continue to step 5 on page 192 
to configure wireless settings. 

• For FOCUS H1, proceed to step 5 of this 
procedure .

This DVR will be 
installed on a non-
DHCP network

• Make sure the Ethernet DHCP checkbox is 
deselected, then proceed to the next step .

2 . Go to the Ethernet IP field and enter the Ethernet IP address that this DVR will 
use on your network.

3 . Go to the Ethernet Mask field and enter the Ethernet Mask IP address that this 
DVR will use on your network.

4 . Go to the Ethernet Gateway IP field and enter the Ethernet gateway IP address 
that this DVR will use on your network.

5 . FOCUS H1 only. Go to the Ethernet DNS Addresses field and enter the DNS IP 
address that this DVR will use on your network.

6 . FOCUS H1 only. Go to the Ethernet DHCP Host field and enter the DHCP Host IP 
address that this DVR will use on your network.

This table is continued on the next page.
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To... Do this...

Configure a Flashback DVR 
for use with Vehicle Viewer, 
Vehicle Viewer Live, or the 
UMD Editor

 NOTE: Flashback 
only

This workflow is 
applicable to Flashback 
DVRs only .

1 . Select the DHCP Enable checkbox.
2 . Go to the DHCP Starting Address field and enter the first IP address that can be 

assigned to a DVR by the DVR DHCP server.
3 . Go to the DHCP Ending Address field and enter the last IP address that can be 

assigned to a DVR by the DVR DHCP server.
NOTE: The IP range you specify in steps 2 and 3 must be outside the range of any 
existing DHCP servers .
4 . Go to the DHCP Lease Time (minutes) drop-down list and select a lease time for 

the IP Address . This is the amount of time that the DVR DHCP server will reserve 
the IP address it gives your DVR before it puts that address back onto the unused 
(i.e., available) list.

5 . To configure wireless settings, click the Wireless Settings tab, and then enter/select your changes. The fields on this 
form are described in the corresponding table in Appendix 5 - DVRs. 
 
                 Sample Flashback information                                                         Sample FOCUS H1 information 

         
 

 WARNING: Configuring wireless settings

In order for the automatic transmission process to work properly, the wireless settings must match those on the 
Wireless Access Points. Do not change any of these settings unless instructed to do so by your agency’s Network 
Administrator or a Mobile-Vision Technical Support Engineer.

6 . Click Save. A confirmation message is displayed.

Configuring Audio, Video, Trigger, and Display settings
1 . Search for and display the in-car DVR you want to change . The Edit DVR form is displayed . This form will appear slightly 

different for Flashback2s vs. Flashback3/HDs. The fields on this form are described in the corresponding table in 
Appendix 5 - DVRs.
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2 . To configure the audio settings, click the Audio/Video tab, then enter/select your changes on the displayed Audio form . 

  
 

 
3 . To configure the video settings, click the Video tab, and then enter/select your changes on the displayed Video form . 

   
 
 
This workflow continues on the next page.

 
 

Flashback2s only

Sample Flashback 
information

Sample FOCUS H1 
information

Flashback3s & 
FlashbackHDs 

only

Sample Flashback 
information
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4 . To configure triggers, click the Triggers/Display tab, and then enter/select your changes in the Triggers section of the 

displayed form . A trigger is the event that causes a DVR to automatically start recording . 

  
 

 

Sample FOCUS H1 
information

Sample Flashback 
information

Sample FOCUS H1 
information
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5 . To configure the display options, enter/select your changes in the Display section of the Triggers/Display form as 
follows: 

  
 

i. To change the format for your date display, select a new value from the Date Format drop-down list . 
ii. To change the format for your GPS display (permissions required), select a new value from the GPS Format drop-

down list . 
iii. To change the type of radar reading (target, lock, and/or patrol) that will be displayed during a video, select a new 

value from the Radar Info drop-down list . 
iv. Using the checkboxes provided, select those items you want to be displayed on the DVR's monitor, Flashback Player 

screen, and Vehicle Viewer/Vehicle Viewer Live screen .
6 . Click Save. A confirmation message is displayed.

Sample Flashback 
information

 NOTE: About display options
Display options are the status indicators 
that will be displayed on the following:
• The DVR's monitor during a recording
• The Vehicle Viewer or Vehicle Viewer 

Live application while the DVR is active
• The Flashback Player while you are 

viewing a video off the server or off an 
export disc .

Sample FOCUS H1 
information
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Replacing In-Car DVRs 
Occasionally, you may need to replace an in-car DVR that is lost, stolen, or damaged beyond repair. If you have an older 
model Flashback, you may also want to upgrade to a newer model, such as the FlashbackHD. This section describes how to 
perform a replacement procedure that will allow the new DVR unit to assume the name and video assignments of the old 
DVR unit . 

 NOTE: Serial numbers

In order to perform this procedure, you must know the serial numbers of both the old and the new DVRs.

To replace an in-car DVR:
1 . If the new unit is being installed in a vehicle, make sure that the vehicle is within 300 feet of your agency’s access point. 

This will enable the server to discover the DVR on the network.
2 . If Fleet Management is enabled, install the new in-car DVR in the appropriate vehicle or interview room. Otherwise, 

proceed to the next step .  
-OR- 
If Fleet Management is disabled, disconnect the old DVR.

3 . Log in to your DES application as an administrator .
4 . Go to Administration > Manage DVRs, and then enter the serial number for the old DVR unit in the DVR ID field. The old 

DVR information is displayed .
5 . Click the old DVR to highlight it, and then perform one of the following tasks: 

If... Then...

Fleet Management is enabled

 NOTE: DEV users

This workflow does not apply to users of the DEV 
application .

1 . Go to the Action menu and click Replace . The 
Replace DVR pop-up is displayed . 

2 . Select the name of the new DVR from the 
Replacement DVR drop-down list . To identify the 
correct DVR, look for the DVR’s Product Code (FB2, 
FB3, FBHD, or FBH1) followed by its 10-digit serial 
number.

3 . Click Save .

Fleet Management is disabled

 NOTE: Permissions for this procedure

By default, this feature is not accessible to any 
users. In order to perform this function, you first 
need to add the Can Reset DVR permission to your 
user profile as described in Assigning Permissions 
to a User on page 254 .

1 . Go to the Action menu and click Reset. A verification 
message is displayed . 

2 . Click Yes. A confirmation message is displayed.
3 . Wait ten minutes, then return to the vehicle or 

interview room and connect the new DVR .
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Generating a Flashback DVR Login Key for an Officer

 NOTE: Flashbacks only

This procedure is only applicable for Flashback in-car DVRs.

When more than one officer uses the same patrol car, you can use the DVR Login Key to identify each officer to the 
Flashback DVR at the beginning of each shift so that their videos will be linked to them. 
DVR Login Key is a file containing an officer’s user information that is copied from your DES application to a USB flash drive. 
The officer inserts the flash drive in the Flashback’s USB port and logs in at the beginning of each shift.
Officers can generate this file themselves, as described in Chapter 1 of the DES Officer’s Guide, or you can create it for 
them, as described in this section.
You typically need to perform this procedure only once at system start-up .
To generate a DVR login key:
1 . Insert the officer’s USB Login Key in one of your PC’s USB ports.
2 . Go to Administration > Manage Users . The User Search Results page is displayed . 

3 . Locate the user for whom you want to generate a DVR login key.  
4 . Click the user row to highlight it, then go to the Action menu and click Generate Key . The system downloads the userid.

dat file to your PC’s Downloads folder .
5 . Navigate to the Downloads folder, click the userid.dat file, and then press Ctrl + C to copy it to the clipboard. 
6 . Navigate to the USB drive, and then press Ctrl + V to insert the userid.dat file. 
7 . Remove the USB key from your PC and give it to the appropriate officer. They can then use it to log in to any Flashback 

DVR. For more information, see the relevant section in your Flashback's user documentation.
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Body-Worn DVRs
Body-worn DVRs are portable digital video recorders that can be used to capture high definition video with audio. After 
recording video, you upload it to your DES application by placing the DVR in a docking station connected to your server. 
There are three kinds of body-worn DVRs used by Mobile-Vision customers: BodyVISION, BWX-100, and FOCUS X2 . 

About the Mobile Devices Page 
You can view and configure body-worn DVRs from the Mobile Devices page .
Mobile Devices page lists the following information:
• Body-worn DVRs that are currently connected to the server
• Body-worn DVRs that have been in communication with the server at least once.

To access the page, go to Administration, and then click Mobile Devices . 

• The Mobile Devices tab displays all body-worn DVRs that are currently connected to the server via a docking station. If 
necessary, use the navigation arrows and/or search fields at the top of the form to scan the full list. The columns on the 
Mobile Devices tab are described in the corresponding table in Appendix 5 - DVRs.

• The Mobile Inventory tab displays all discovered body-worn DVRs, including those that are not currently connected 
to the server . These are all the body-worn DVRs that have been in communication with the server at least once. If 
necessary, use the navigation arrows and/or search fields at the top of the form to scan the full list. The columns on the 
Mobile Inventory tab are described in the corresponding table in Appendix 5 - DVRs. 
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Configuring Body-Worn DVRs
This section describes how to configure new body-worn DVRs. The configuration procedures slightly differ depending on 
whether the Fleet Management feature is enabled.

 NOTE: Is Fleet Management on? 
If you’re not sure whether your agency is using Fleet Management, go to Administration > System Setup > System 
> Download Options and examine the Enable Fleet Management for DVRs checkbox. Follow a procedure that is 
appropriate for your Agency's setting.

 

 NOTE: Before configuring DVRs

If you are starting out with new body-worn DVRs, perform the following steps first:
• Select the appropriate body-worn download options. Perform this step after you’ve purchased your first body-worn 

DVRs but before you begin using them. For instructions, see Changing Discovery Methods and Download Options 
on page 180. You only need to perform this task once.

• Make sure the new DVRs have been "discovered" by the system. To have the system discover DVRs, place each 
of your body-worn DVRs in one of the docking stations so that the DVR can charge and get discovered on the 
network. NOTE: If you haven’t set up a docking station yet, please review the relevant section in your body-worn 
DVR's user documentation.

Configuring a Body-Worn DVR when Fleet Management is Enabled

 NOTE: DEV users

This workflow does not apply to users of the DEV application. Use the Configuring a Body-Worn DVR when Fleet 
Management is Disabled procedure instead .

To start configuring a body-worn DVR when Fleet Management is on:
1 . Go to Administration > Manage DVRs, and then locate the DVR you want to view. If you have a large number of DVRs to 

scroll through, use the search fields and navigation arrows to find the desired DVR. 
Alternatively, you can:
• Enter BWX-100 in the Product Code field to display BWX-100 DVRs only.
• Enter FBBW1 in the Product Code field to display BodyVISION XV DVRs only. 
• Enter FBX2 in the Product Code field to display FOCUS X2 DVRs only. 

2 . Right-click the DVR you want to view, then select Edit from the pop-up menu. The body-worn DVR’s Edit DVR form is 
displayed as pictured on the next page. The fields on this form are described in the corresponding table in Appendix 5 - 
DVRs.  
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                                     BWX-100 form                                                                              BodyVISION form 

     
 
 
 
 
                                     FOCUS X2 form 

 
       

3 . Proceed to the procedures that follow to configure the DVR. 

 NOTE: BodyVISION form

If you are configuring a BodyVISION DVR, the Edit Device form will not have dedicated tabs for different 
configuration options. All configuration options will be available on a single untabbed form.

Configuring General DVR Settings 
To configure general DVR settings, perform the following steps:
1 . BWX-100 and FOCUS X2 only . Click the DVR tab.
2 . X2 only . Enter the name of the police department this DVR is assigned to .
3 . All DVRs . 

i. Enter a new value in the DVR Name field to change the DVR's system-assigned name.
ii. Optionally, you can immediately assign this DVR to an officer by selecting the officer's name from the DVR Officer 

Name drop-down list . For alternative instructions, see Assigning Body-Worn DVRs to Officers on page 207 .
iii. Select a value from the Group Name drop-down list to assign this DVR to a predefined DVR group.
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iv. Select the Enable WIFI Mode checkbox to allow this DVR to connect to a Wi-Fi network.
v. Enter a passwrod in the Wifi Router Password field.

vi. Select Enabled from the Status drop-down list to allow the system to upload videos from this DVR .
vii. Review the value in the Version field to check which firmware version is currently installed on this DVR.
viii. Select the desired version from the Assigned Firmware drop-down list to assign the firmware that will be 

automatically deployed to this DVR . 
ix. Select a desired value from the Time Zone drop-down list to set a time zone in which this DVR will be recording.

4 . BWX-100 and BodyVISION only . 
i. If your agency is not using the Officer Dispatch feature, deselect the Allow Officer Assignment checkbox. If you do 

so, you can immediately assign this DVR to an officer by selecting the officer's name from the DVR Officer Name 
drop-down list . For alternative instructions, see Assigning Body-Worn DVRs to Officers on page 207 .

ii. Review the value in the DVR ID field to check the system ID number of this DVR.
iii. Deselect the Mute Enabled checkbox to prevent officers from muting audio while the recording is in progress. 
iv. Depending on how your agency plans to use the Snap/Trace button, select the desired setting from the Snapshot/

Tracepoint drop-down list according to the following table: 

To... Do this...

Capture a snapshot still image and insert a tracepoint placemarker in recordings • Select Both . (default)

Capture a snapshot still image only • Select Snapshot .

Insert a tracepoint placemarker only • Select Tracepoint .

Disable the DVR’s Snap/Trace button • Select Off .

5 . Click Save .

Configuring Video Settings
1 . BWX-100 and FOCUS X2 only. Click the Video tab. The video settings are displayed. 

 NOTE: BodyVISION form
Use the universal Edit Device form displayed for BodyVISION DVRs to configure their available video settings. 

 
                                    
BWX-100 form                                                                                    FOCUS X2 form                      

                                                                                                              

2 . Select a numeric value from the Pre-Event Recording drop-down list to capture X number of seconds of prerecord 
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activity (i.e., the activity that occurs just before a recording is initiated).
3 . Select the desired video resolution from the Resolution drop-down list . 

4 . 

 NOTE: About video resolution
Video resolution is always a tradeoff between quality and storage capacity/battery runtime. When you select a 
resolution, keep the following guidelines in mind:
• Higher resolution recordings have the advantage of a better picture quality, but the disadvantage of an 

increased storage space requirement .
• Cropped views have the advantage of increased battery runtime, but the disadvantage of a decreased field 

of view .
Generally, it’s best to select the highest quality picture possible while still maintaining enough storage space 
and battery runtime to meet your agency’s needs. Review the following table before making your selection:

BWX-100 and BodyVISION resolution Description

720 x 480 cropped (480p cropped) Standard definition video with a reduced field of view.

1280 x 720 cropped (720p cropped) High definition video with a reduced field of view.

1280 x 720 (720p) High definition video with a full field of view.

1920 x 1080 (1080p) Full high definition video with a full field of view. (default) This is the 
highest and the most resource-intensive resolution available.

FOCUS X2 resolution Description

WVGAI Standard definition video.

HD-720p Standard high definition video with a full field of view.. 

HD-1080p Full high definition video with a full field of view. 

FHD-720p Full high definition video with a full field of view

FHD-1080p Full high definition video with a full field of view.

QHD - 2560x1440 Quad high definition video with a 16x9 aspect ratio. This is the highest resolution 
available for X2 video and the most resource intensive.

BWX-100 and BodyVISION only. Enter a number between 1 and 30 in the Recording Alert Time (minutes) field to 
configure a reminder vibration setting. The DVR will vibrate once every X minutes to remind the officer about the 
recording still in progress .

5 . BWX-100 only. Make the following selections in the Recording Properties section:
i. Select the GPS checkbox to enable this DVR's GPS tracker.
ii. Select the desired setting from the Audio/Video Mode drop-down list as follows: 

To record... Do this...

Both audio and video • Select 0 . (default)

Video only • Select 1 .

Audio only • Select 2 .
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iii. To configure Bluetooth communication settings, perform the following steps:
• Select Enabled from the Bluetooth Transmission drop-down list to enable Bluetooth transmission.  

 NOTE: About the Bluetooth transmission option

BWX-100s can only communicate with other BWX-100 DVRs or Flashback DVRs paired with a TB-100 
Bluetooth transmitter .

•  Enter a code in the Bluetooth ID field to assign it to this DVR as follows: 

To enable this DVR to communicate... Do this...

Only with DVRs that share the same 
Bluetooth ID

• Enter that code in the Bluetooth ID field. (It must be an numeric 
code 1 – 8 characters long, composed of numbers from 0 to 9 .)

NOTE: Be sure to assign the same Bluetooth ID to all the BWX-100s 
in the same sending/receiving group .

With any in-range in-car DVR whose 
TB-100 default settings are unchanged 
(even those from other agencies)

• Enter 0 .

iv. Select the Record LED checkbox to keep the red LED on the front of the DVR illuminated whenever a recording is in 
progress . 

6 . FOCUS X2 only. 
• Make the following selections in the Video Properties section:

i. Select the Pre-Event Audio checkbox to capture audio activity that occurred just before a recording was 
initiated . 

ii. Select the video quality from the Quality drop-down list .
iii. Select the frequency (in seconds) with which this DVR's location coordinates will be logged, from the GPS Log 

Frequency drop-down list . 
iv. Select the type of default event that will be attached to each recording.
v. Review the value in the VideoCodec field to check which video codec is used to compress the video recorded 

by this DVR.
vi. Select the GPS checkbox to enable this DVR's GPS tracker.
vii. Select the G-Sensor checkbox to enable the sensor that triggers a recording in the event of impact or sudden 

movement . 
viii. Select the Bluetooth checkbox to enable this DVR's Bluetooth connectivity. 
ix. The Enable LDC checkbox is used to activate lens distortion correction on this DVR. This setting is enabled by 

default and is not configurable in this release.
x. The Enable EIS checkbox is used to activate electronic image stabilization on this DVR. This setting is enabled 

by default and is not configurable in this release.
• Make the following selections in the Recording Properties section: 

i. Select the Clip On IR checkbox to enable the infrared LED on the clip-on 
USB camera. The LED will automatically illuminate depending on ambient 
light conditions .

ii. Select the Enable Clip Cam Front LED checkbox to keep the LED on the 
front of your FOCUS ClipCam illuminated whenever a recording is in 
progress . 

 NOTE: About FOCUS 
ClipCam
FOCUS ClipCam is a small, 
light-weight clip-on camera that 
connects to the X2 DVR and 
can be used to start or stop the 
X2 recordings . 
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iii. Select the Enable X2 Front LED checkbox to keep the LED on the front of this DVR illuminated whenever a 
recording is in progress .

iv. Select the MB Clip Cam checkbox to enable the record button on this DVR to trigger the FOCUS ClipCam.
v. Select the Enable Clip Cam Top LED checkbox to keep the LED on the top of your FOCUS ClipCam illuminated 

whenever a recording is in progress . 
vi. Select the Enable X2 Top LED checkbox to keep the LED on the top of this DVR illuminated whenever a 

recording is in progress .
7 . Click Save .

Configuring Ethernet settings

 NOTE: BodyVISION and BWX-100 DVRs only

This section applies to configuring BodyVISION and BWX-100 DVRs only.

1 . BWX-100 only. Сlick the Ethernet tab. The Ethernet settings are displayed.  

                                                                                                                     

 NOTE: About the Ethernet settings

The Ethernet settings should be changed only when the Mobile-Vision support team is assisting you.

2 .  Perform one of the following tasks: 

If your agency... Then...

Is running your DES product on a DHCP network (default) • Proceed to the next step .

Is NOT running your DES product on a DHCP network 1 . Deselect the Ethernet DHCP checkbox.
2 . Enter the appropriate IP addresses in the Ethernet IP, 

Ethernet Mask, and Ethernet Gateway IP fields.

3 . If your agency’s Uplink Station is connected to a network other than your DES server (such as a router between the 
Uplink Station and the Mobile-Vision server), enter your Mobile-Vision server IP address(es) in the Remote Broadcast 
IP(s) field. If there is more than one address, separate each address with a space.

4 . Click Save .

 NOTE: BodyVISION form
Use the universal Edit DVR form 
displayed for BodyVISION DVRs to 
configure their available Ethernet 
settings . 
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Configuring Recording settings

 NOTE: FOCUS X2 only

This section applies to configuring FOCUS X2 DVRs only.

1 . Click the Recording tab. The recording settings are dispalyed. 

2 . Select the desired option from the FnFunction drop-down list to assign a function to the Fn button on this DVR.
3 . Select the desired option from the Tag Event drop-down menu to select an event that will be attached to the recording 

when the Fn button is pressed (if the Fn button function is set to Tag) .
4 . Select Enabled from the Enable Auto Off drop-down list to force the docked DVR to automatically shut off once it is fully 

charged .
5 . Select the desired option from the Covert Mode drop-down list to either disable covert mode or configure this DVR's 

recording reminder when covert mode is enabled.
6 . Select the desired option from the G-Sensor Threshold drop-down list to set the impact level for G-Sensor to trigger 

recording. The higher the number, the greater the G-Force that is required.
7 . Select the Default Covert Mode checkbox to have this DVR enter covert mode by default every time it is powered up.
8 . Enter a number between 1 and 300 in the Recording Alert Time (seconds) field to configure a reminder vibration 

setting. The DVR will vibrate once every X seconds to remind the officer about the recording still in progress.
9 . Deselect the Mute Enabled checkbox to prevent officers from muting audio while the recording is in progress. 
10 . Select or deselect the Double Click Mode checkbox to configure the number of times the record button has to be 

pressed for this DVR to start recording. When the checkbox is selected, the officer has to press the record button twice 
within 1 second to initiate recording. Otherwise, the record button has to be pressed once to initiate recording.

11 . Select the Auto Upload In Car checkbox to enable the automatic upload of videos recorded by this DVR to an in-car DVR 
while this DVR is in the vehicle dock.

12 . Configure the OSD (on-screen display) settings as follows:
i. Select the OSDAudio Status checkbox to enable an on-screen audio status indicator that shows whether the audio 

on the current recording is muted .
ii. Select the OSDDate Time checkbox to enable an on-screen date and time indicator.
iii. Select the OSDFnKey checkbox to enable an on-screen indicator that shows the function currently assigned to the 

Fn button on this DVR.
iv. Select the OSDGPS checkbox to enable an on-screen GPS data indicator.
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v. Select the OSDIRStatus checkbox to enable an on-screen indicator that shows the current status of the infrared 
LED .

vi. Select the OSDOfficerID checkbox to enable the on-screen officer ID indicator.
vii. Select the OSDPDName checkbox to enable the on-screen police department name indicator.

Configuring a Body-Worn DVR when Fleet Management is Disabled
To configure a body-worn DVR when Fleet Management is disabled:
1 . Go to Administration > Mobile Devices . The Mobile Devices page is displayed .
2 . If the body-worn DVR of interest is not already displayed on-screen, search for it using navigation arrows and search 

criteria, then click the desired DVR to highlight it.
3 . Go to the Action menu and click Edit Configuration . The Edit Device pop-up is displayed as pictured on the next page . 

The fields on this form are described in the corresponding table in Appendix 5 - DVRs.  
                                        BWX-100 form                                                                           BodyVISION form 

              
                                      FOCUS X2 form 

4 . Follow the applicable steps described in the Configuring a Body-Worn DVR when Fleet Management is Enabled 
procedure .

5 . Click Save .
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Replacing Body-Worn DVRs
This section describes how to replace an existing body-worn DVR with a new DVR in your DES application. Specifically, this 
procedure will assign the old DVR unit’s settings and videos to the new DVR unit, then remove the old DVR from the system.
To replace a body-worn DVR:
1 . Write down the serial number for both the old body-worn DVR and the new one. You can find this number on the sticker 

located on each DVR .
2 . Place the new body-worn DVR in an available docking station at your agency’s Uplink Station. Once the DVR connects to 

the server, the system will be able to discover the DVR on the network.
3 . Go to Administration > Manage DVRs, and then enter the serial number for the old DVR unit in the DVR ID field. The 

associated information is displayed .
4 . Click the old DVR to highlight it.
5 . Go to the Action menu, and then perform one of the following tasks: 

If you are replacing... Then...

• A BWX-100 
DVR when Fleet 
Management is 
enabled
-OR- 

• A BodyVISION DVR
-OR-

• A FOCUS X2 DVR

1 . Click Replace . The Replace DVR pop-up is displayed . 

2 . Select the name of the new body-worn DVR from the Replacement DVR drop-down 
list. To identify this unit, look for the letters FBBW1 (for BodyVISIONs),  BWX-100 (for 
BWX-100s), or X2 (for FOCUS X2s), followed by the new DVR’s serial number.

3 . Click Save. The system assigns the old DVR unit’s settings and videos to the new DVR 
unit, then removes the old DVR from the system .

A BWX-100 DVR when 
Fleet Management is 
disabled

1 . Click Reset, and then click Yes in the verification message that is displayed.
2 . Wait ten minutes, then place the new BWX-100 in an available docking station at your 

agency’s Uplink Station. Once the BWX-100 connects to the server, the system will be 
able to discover the DVR on the network.

Assigning Body-Worn DVRs to Officers
This section describes how to assign an available body-worn DVR to a selected officer. 

 NOTE: About shared body-worn DVRs

If your agency uses shared body-worn DVRs, make sure to create a generic user for each of the shared DVR units 
before assigning shared DVRs to officers. 
For instructions on how to add generic users, follow the steps described in the note in step 1 of the  Adding a User 
procedure on page 243 .

To assign a body-worn DVR to an officer:
1 . Follow steps 1 - 2 of the Configuring a Body-Worn DVR when Fleet Management is Enabled procedure . 
2 . Perform one of the following tasks: 
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If the DVR unit you selected is... Do this...

Not a shared DVR • Select the desired officer's name from the DVR Officer Name drop-down list .

A shared DVR • Select the generic user that matches the selected shared body-worn DVR 
from the DVR Officer Name drop-down list . 

3 . Click Save . The user you just selected is now displayed in the DVR Officer Name field of the Mobile Devices page . 
4 . Optionally, you may want to activate an audio/visual alert that will help an officer identify their DVR unit if that officer 

happens to be in close proximity to the corresponding Uplink Station. To activate this alert, click the green notification 
icon in the Identify column for the desired DVR. The DVR unit’s alert will sound and the Status/Battery LED on the top of 
it will flash yellow/red.

About the Officer Dispatch Feature 
The Officer Dispatch feature allows you to assign different body-worn DVRs to different officers each shift. This allows 
multiple officers working different shifts to share a limited number of body-worn DVRs. Once an officer completes a shift 
and places the body-worn DVR back in its docking station, the system downloads that the files, flags the DVR as available, 
and unassigns it from the officer. You may then reassign that DVR to a different officer.
To activate the Officer Dispatch feature, select the Allow Officer Assignment checkbox on the corresponding Edit DVR form .                        

 NOTE: When not to use Officer Dispatch

The Officer Dispatch feature should not be used unless your agency has a dedicated dispatcher continually available to 
assign body-worn DVRs. If your agency does not have a dedicated dispatcher, you can give your officers an opportunity 
to sign out their own body-worn DVRs without dependency on a dispatcher. To do so, follow the steps described in the 
note in step 1 of the  Adding a User procedure on page 243, and then follow the steps for assigning a shared DVR 
described above.

8-Bay Docks
8-bay docks are used in conjunction with FOCUS X2 DVRs for a number of purposes. 

 NOTE: Before using 8-bay docks

8-bay docks must be installed and preconfigured at your organization prior to first use. For more information, refer to 
the 8-Bay Dock Configuration & User Guide available on Safe Fleet Community.

Each 8-bay dock can perform the following tasks:
• Simultaneously charge up to 8 X2 DVRs
• Automatically upload files from the docked X2 DVRs directly to the assigned server without the need of a PC interface
• Update the firmware of the docked X2 DVRs

Once the 8-bay docks have been deployed at your agency, they can be further configured in DES, both individually and as 
groups .
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Configuring 8-Bay Docks
This section describes how to configure 8-bay docks that have been deployed at your agency.
To configure an 8-bay dock: 
1 . Go to Administration > Manage DVRs, and then locate the 8-bay dock you want to view. If the displayed list is long, use 

the search fields and navigation arrows to find the desired 8-bay dock. 
Alternatively, you can enter FBX8D in the Product Code field to display 8-bay docks only.

2 . Right-click the 8-bay dock you want to view, then select Edit from the pop-up menu . The Edit DVR form is displayed . The 
fields on this form are described in the corresponding table in Appendix 5 - DVRs.

3 . To configure the general settings, click the DVR tab, and then enter/select the values as follows: 

i. Enter a new value in the DVR Name field to change the 8-bay dock's system-assigned name.
ii. Review the value in the Version field to check which firmware version is currently installed on this 8-bay dock.
iii. Select Enabled from the Status drop-down list to allow the system to upload videos from FOCUS X2 DVRs inserted 

in this 8-bay dock.
iv. Select the desired version from the Assigned Firmware drop-down list to assign the firmware that will be 

automatically deployed to this 8-bay dock.
v. Select a value from the Group Name drop-down list to assign this 8-bay dock to a predefined group.

4 . To configure the Ethernet settings, click the Ethernet tab, and then enter/select the values as follows: 

i. Perform one of the following tasks: 

If your agency... Then...

Is running your DES product on a DHCP network • Make sure the Ethernet DHCP checkbox is selected and 
then  proceed to the next step .

Is NOT running your DES product on a DHCP 
network

1 . Deselect the Ethernet DHCP checkbox.
2 . Enter the appropriate IP addresses in the Ethernet IP, 

Ethernet Mask, and Ethernet Gateway IP fields.

ii. Go to the Ethernet DNS Addresses fields and enter the DNS IP addresses that this 8-bay dock will use on your 
network.
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3 . To configure additional settings, click the Settings tab, and then enter/select values as follows: 

i. Select a desired value from the Time Zone drop-down list to set a time zone, which this 8-bay dock will be using.
ii. Select the Use DST checkbox if this 8-bay dock will be used in a region that observes daylight savings time.
iii. Enter the NTP server addresses in the NTP Server and Second NTP Server fields.  NOTE: NTP servers run the 

Network Time Protocol (NTP) software that maintains network time synchronization.
4 . Click Save .
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Fleet Management
 NOTE: DEV users

The contents of this section does not apply to users of the DEV application .

Fleet Management is a feature that, when enabled, allows you to group DVRs or 8-bay docks and then update these groups 
from the server. Each of the devices assigned to an updated group would, in turn, be updated during its next device-to-server 
transmission .

 NOTE: When to use DVR groups

When Fleet Management is enabled, the DVR settings on the server always override the in-car settings. You can still 
change DVR settings from the DVR itself, but it’s recommended that you select one method or the other: either use 
DVR groups to update your DVRs from the server, or use the Flashback menu to update DVRs from within the vehicles. 
Generally, the larger your vehicle/DVR fleet, the more sense it makes to use DVR groups.

Enabling or Disabling Fleet Management
To enable the Fleet Management feature:
1 . Go to Administration > System Setup > System > Download Options .
2 . Go to the Action menu and click Edit . The Download Options pop-up is displayed .  

3 . Go to the Enable Fleet Management for DVRs checkbox at the top of the form, and then select or deselect it to enable 
or  disable the Fleet Management feature, respectively.

4 . Click Save .
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Creating DVR and 8-Bay Dock Groups
You can create a DVR or 8-bay dock group using the settings of an existing device or an existing group, or using a 
configuration file. 

Creating a Group from an Existing Device or Existing  Group
When creating a new group you may simply use the existing device (or group) as a template and copy the settings to a new 
group, then edit the new group as desired .

 NOTE: Copying device settings

You can only copy information from a device that has been “discovered,” that is, a DVR or 8-bay dock that has been in 
communication with the server at least once. If you are a new customer, some of your devices may not be recognized 
by the server yet. If such is the case, follow the steps for Creating a Group from a config.xml File on page 213 .

To create a DVR or 8-bay dock group:
1 . Go to Administration > Manage DVRs > DVR Groups .  A list of existing groups is displayed . 

 

 NOTE: DVR 
Groups tab

If the DVR Groups 
tab is not displayed, 
it indicates that Fleet 
Management is 
currently disabled. 
For information on 
how to enable Fleet 
Management, see 
Enabling or Disabling 
Fleet Management 
on page 211 .

2 . Go to the Action menu and click New Group . The Create Group form is displayed . 
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3 . Enter a unique name for this group in the Group Name field, and the perform one of the following tasks: 

To... Do this...

Create a group from an existing 
device (recommended)

1 . Select From DVR from the Select Source drop-down list . 

2 . Go to the Select DVR drop-down list and select the device that you want to 
use as a template for your new group .

Create a group from an existing 
group

1 . Select From existing group from the Select Source drop-down list . 

2 . Go to the Select Group drop-down list and select the group that you want to 
use as a template for your new group .

Create a dock group from a config.
xml file (rarely used)

• See Creating a Group from a config.xml File. 

4 . Go to the Select Type drop-down list and select the new group’s type:
• FB2. This group will contain Flashback2 DVRs only.
• FB3/FBHD. This group will contain Flashback3 and/or FlashbackHD DVRs.
• FBH1 . This group will contain FOCUS H1 DVRs only .
• BodyVision . This group will contain BodyVISION DVRs only .
• BWX-100 . This group will contain BWX-100 DVRs only .
• X2 . This group will contain FOCUS X2 DVRs only .
• 8 Bay. This group will contain the 8-bay docks for FOCUS X2 DVRs.

5 . Click Save. A confirmation message is displayed. 

Creating a Group from a config.xml File 
The config.xml file contains information on an in-car DVR, a body-worn DVR, or an 8-bay dock. To create a group from a 
config.xml file,  you need to acquire it first and upload it to the server .  
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There are two ways in which you can acquire this file:
• Your Mobile-Vision Technical Support Engineer can give it to you.
• For in-car or BodyVISION DVRs you can copy the file from a DVR to a USB drive, as described in the relevant section 

of the DVR's user documentation.

 NOTE: Agencies with more than one server

If your agency has more than one server, there may be a circumstance where you want to use a device that exists on 
one server as a template for creating a new group on a different server .
To do so, first export the DVR’s config.xml file to a USB drive, as described in step 1 below.

To create a DVR or 8-bay dock group from a file:
1 . Perform one of the following tasks: 

To... Do this...

Use the config.xml file 
that is already on the 
desired server

• Proceed to step 3 below.

Use the config.xml file 
that is on a DVR (in-car 
and BodyVISION DVRs 
only)

• Copy the file from the DVR to a USB drive, as described in the relevant section of that 
DVR's user documentation.

Use a device that exists 
on one server as a 
template for creating a 
new group on a different 
server

• Export the config.xml file from the originating server to a USB drive. To do so:
i. Log in to the originating server .
ii. Go to Administration > Manage DVRs > DVRs .
iii. Find and click the device you want to export .
iv. Go to the Action menu and click Export Config . The system downloads the 

device’s config.xml file to your Downloads folder .
v. Navigate to the Downloads folder and drag or copy and paste the exported file to 

your USB drive .

2 . Log in to the destination server and insert the USB drive with the config.xml file into a USB port.
3 . Follow steps 1 - 2 of the Creating a Group from an Existing Device or Existing  Group procedure .
4 . Enter a unique name for this group in the Group Name field of the Create Group form, and then select From file from the 

Select Source drop-down list . 

5 . Click Choose File . The Choose File to Upload Pop-up is displayed .
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6 . Navigate to the disk drive location where the config.xml file is located, and the double-click the config.xml file to select it.
7 . Follow steps 4 - 5 of the Creating a Group from an Existing Device or Existing  Group procedure .

Configuring DVR or 8-Bay Dock Groups
This section describes how to change the settings for an existing group.
To start configuring a group:
1 . Go to Administration > Manage DVRs > DVR Groups . A list of existing groups is displayed .
2 . Right-click the group you want to update, then select Edit from the pop-up menu . The Edit Group form is displayed . The 

fields on this form are described in the corresponding Edit DVR table in Appendix 5 - DVRs. 

3 . Proceed to one of the following sections:
• Configuring an In-Car DVR Group on page 215
• Configuring a BodyVISION DVR Group on page 221
• Configuring a BWX-100 DVR Group on page 222
• Configuring a FOCUS X2 DVR Group on page 223
• Configuring an 8-Bay Dock Group on page 224

Configuring an In-Car DVR Group
This section describes how to change the attributes for an in-car DVR group. Any change you make to an in-car DVR group 
will automatically be applied to all of the DVRs assigned to that group during the next DVR-to-server transmission.

Configuring IP Settings
This section describes how to change the IP settings for an in-car DVR group. 
Interview Room DVRs typically utilize an Ethernet connection, whereas in-car DVRs typically utilize a wireless connection . 
However, in-car units are still Ethernet-enabled to support Vehicle Viewer, Vehicle Viewer Live, and the UMD Editor, which 
require the use of the Ethernet port on the in-car DVR .
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• To change the remote broadcast IP address, remote unicast IP address, and/or gateway type for a Flashback DVR, 
configure general IP settings .

• To configure an in-car DVR for use with Interview Room, Vehicle Viewer, Vehicle Viewer Live, and/or the UMD Editor, 
configure Ethernet settings. The following DVR groups use the Ethernet settings:
• Flashback2 groups,  Flashback3/FlashbackHD groups, and FOCUS H1 groups that are installed in an Interview 

Room
• Flashback2 groups and Flashback3/FlashbackHD groups, that are installed in a vehicle that is using Vehicle Viewer, 

Vehicle Viewer Live, or the UMD Editor .
• To configure an in-car DVR that does not interface with Vehicle Viewer, Vehicle Viewer Live, and/or the UMD Editor, 

configure wireless settings .
To configure the IP settings: 
1 . Search for and display the in-car DVR group you want to update, and then click the IP Setup tab on the displayed Edit 

Group form. The fields on this form are described in the corresponding Edit DVR table in Appendix 5 - DVRs. 

2 . Flashback DVR groups only. To configure the general IP settings, perform the following steps:
i. Click the General tab if it's not already displayed. The Remote Broadcast IP, Remote Unicast IP, and Gateway Type 

fields are displayed. 
ii. To change the group's remote broadcast IP addresses(es), enter the new IP address(es) in the Remote Broadcast 

IP(s) field, separating multiple addresses with a space.
iii. To change the group's remote unicast IP address(es), enter the new IP address(es) in the Remote Unicast IP(s) 

field, separating multiple addresses with a space.
iv. To change the group's gateway type, select a new value from the Gateway Type drop-down list . If you changed the 

gateway type, you may need to update your Ethernet or wireless settings . 

 NOTE: About general IP settings
• Remote broadcast IP address(es).* An IP address range across which the group's Flashback DVRs announce 

their identity so the se1ver can locate them . System default is 255 .255 .255 .255 .
• Remote unicast IP address(es).* A list of unique IP address(es) to which the group's Flashback DVRs 

announce their identity so that the server can locate them .
• Gateway type. The type of connection used to link a group's Flashback DVRs to the server: wireless (for in-

car DVRs that do not interface with Vehicle Viewer, Vehicle Viewer Live, or the UMD Editor), or Ethernet (for 
Interview Room DVRs and in-car DVRs that interface with Vehicle Viewer, Vehicle Viewer Live, and/or the UMD 
Editor) .

* Based on your department's network setup and security requirements, you would enter either remote broadcast 
IP address(es) (typical), or remote unicast IP address(es) .

3 . To configure the Ethernet settings, click the Ethernet tab. The Ethernet fields are displayed as pictured on the next page.  

This workflow continues on the next page.
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                Sample Flashback information                                                         Sample FOCUS H1 information 

        
4 . Perform one of the following tasks:  

To... Do this...

Configure a Flashback or FOCUS H1 
DVR group for use with Interview 
Room
NOTE: This configuration is typically 
used in conjunction with the UDP 
Broadcast discovery method .

WARNING: When using this 
feature, exercise extreme caution . 
Any incorrect entries could cause 
transmission problems for a group’s 
interview room cameras, and/or 
conflicts with in-car mobile data 
computers that have Vehicle Viewer, 
Vehicle Viewer Live, or the UMD 
Editor installed on them .

 NOTE: DEA Precinct users

This workflow does not apply 
to users of the DEA Precinct 
application .

1 . Perform one of the following tasks: 

If the DVRs in 
this group will be 
installed on a...

Then...

DHCP network 1 . Check the Group Managed Ethernet and 
Ethernet DHCP checkboxes at the top of the 
form . The system grays out the Ethernet IP, 
Ethernet Mask, and Ethernet Gateway IP fields. 

2 . Proceed as follows:
• For the Flashback DVR group, continue 

to step 5 on page 218 to configure the 
wireless settings . 

• For the FOCUS H1 DVR group, proceed to 
step 5 of this procedure .

Non-DHCP 
network

• Make sure the Group Managed Ethernet and 
Ethernet DHCP checkboxes are deselected, then 
proceed to the next step .

2 . Go to the Ethernet IP field and enter the Ethernet IP address that the DVRs 
in this group will use on your network.

3 . Go to the Ethernet Mask field and enter the Ethernet Mask IP address that 
the DVRs in this group will use on your network.

4 . Go to the Ethernet Gateway IP field and enter the Ethernet gateway IP 
address that the DVRs in this group will use on your network.

5 . FOCUS H1 only. Go to the Ethernet DNS Addresses field and enter the 
DNS IP address that the DVRs in this group will use on your network.

6 . FOCUS H1 only. Go to the Ethernet DHCP Host field and enter the DHCP 
Host IP address that the DVRs in this group will use on your network.

This table is continued on the next page.
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To... Do this...

Configure a Flashback DVR group 
for use with Vehicle Viewer, Vehicle 
Viewer Live, or the UMD Editor
NOTE: If you are using private 
network IPs in your vehicles, you may 
want to assign the same Ethernet 
IPs to all of the vehicles in your DVR 
Group in order to avoid potential 
IP conflicts with the wireless IP 
settings .

 NOTE: Flashback only

This workflow is applicable to 
Flashback DVRs only.

1 . Select the DHCP Enable checkbox.
2 . Go to the DHCP Starting Address field and enter the first IP address that 

can be assigned to a DVR by the DVR DHCP server.
3 . Go to the DHCP Ending Address field and enter the last IP address that 

can be assigned to a DVR by the DVR DHCP server.
NOTE: The IP range you specify in steps 2 and 3 must be outside the range of 
any existing DHCP servers .
4 . Go to the DHCP Lease Time (minutes) drop-down list and select a lease 

time for the IP Address . This is the amount of time that the DVR DHCP 
server will reserve the IP address it gives your DVR before it puts that 
address back onto the unused (i.e., available) list.

5 . To configure the wireless settings, click the Wireless Settings tab. The wireless settings fields are displayed.  
 
                    Sample Flashback information                                                         Sample FOCUS H1 information 

       
6 . Enter/select your changes. If you need to enter a wireless password or encryption key, be sure to review the password 

guidelines first, as described in Defining Password Policies on page 255 .
7 . Click Save. A confirmation message is displayed.

Configuring Audio, Video, Trigger, and Display settings
1 . To configure the audio settings, click the Audio/Video tab, and then enter/select your changes on the displayed Audio 

form, as pictured on the next page .  
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Sample Flashback information                                                         Sample FOCUS H1 information 

       
2 . To configure the video settings, click the Video tab, and then enter/select your changes on the displayed form.  

 
                     Sample Flashback information                                                         Sample FOCUS H1 information 

        
3 . To configure the triggers, click the Triggers/Display tab, and then enter/select your changes in the top section of the 

displayed form . A trigger is the event that causes a DVR to automatically start recording . 
 
                     Sample Flashback information                                                         Sample FOCUS H1 information 
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4 . To configure the display options, enter/select your changes in the Display section of the Triggers/Display form as 
follows: 
 
                    Sample Flashback information                                                         Sample FOCUS H1 information 

        

i. To change the format for your date display, select a new value from the Date Format drop-down list . 
ii. To change the format for your GPS display (permissions required), select a new value from the GPS Format 

drop-down list .  NOTE: If the GPS Format field is not displayed, it indicates that you lack the Player Display GPS 
permission required to display this field.

iii. To change the type of radar reading (target, lock, and/or patrol) that will be displayed during a video, select a new 
value from the Radar Info drop-down list . 

iv. Using the checkboxes provided, select those items you want to be displayed on the DVR's monitor, Flashback Player 
screen, and Vehicle Viewer/Vehicle Viewer Live screen .

 NOTE: About display options
Display options are the status indicators that will be displayed on the following:
• The DVR's monitor during a recording
• The Vehicle Viewer or Vehicle Viewer Live application while the DVR is active
• The Flashback Player while you are viewing a video off the server or off an export disc.

5 . To configure the general DVR group settings, click the DVR Settings tab, and then enter/select your changes on the 
displayed form. The fields on this form are described in the corresponding Edit DVR table in Appendix 5 - DVRs. 
 
                     Sample Flashback information                                                         Sample FOCUS H1 information 

       
6 . Click Save. A confirmation message is displayed.
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Configuring a BodyVISION DVR Group
This section describes how to change the settings for a selected BodyVISION DVR group. Any change you make to a 
BodyVISION group will automatically be applied to all of the BodyVISIONs that are assigned to that group during each 
BodyVISION’s next DVR-to-server download. Refer to the Configuring a Body-Worn DVR when Fleet Management is Enabled 
section for detailed instructions on configuring each setting.
To configure a BodyVISION DVR group:
1 . Go to Administration > Manage DVRs > DVR Groups . A list of existing groups is displayed .
2 . Right-click the BodyVISION group you want to update, then select Edit from the pop-up menu . The Edit Group form is 

displayed . The fields on this form are described in the corresponding table in Appendix 5 - DVRs. 

3 . Enter/select your changes .
4 . To add/remove BodyVISIONs from this group, click the DVRs tab. A list of available BodyVISIONs is displayed in the 

Available column . 

i. To add BodyVISIONs to this group, go to the Available column and click each of the BodyVISIONs you want to 
assign to this DVR group .

ii. Once you’ve highlighted the correct BodyVISIONs, click the  icon located between the two columns. The selected 
BodyVISIONs are displayed in the Assigned column .

iii. To remove BodyVISIONs from this group, go to the Assigned column and click each of the BodyVISIONs you want 
to remove from this DVR group .

iv. Once you’ve highlighted the correct BodyVISIONs, click the  icon located between the two columns. The selected 
BodyVISIONs are removed from the DVR group .

5 . Click Save. A confirmation message is displayed.
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Configuring a BWX-100 DVR Group
This section describes how to change the settings for a selected BWX-100 DVR group. Any change you make to a BWX-
100 group will automatically be applied to all of the BWX-100s that are assigned to that group during each BWX-100’s next 
DVR-to-server download . Refer to the Configuring a Body-Worn DVR when Fleet Management is Enabled section for detailed 
instructions on configuring each setting.
To configure a BWX-100 DVR group:
1 . Go to Administration > Manage DVRs > DVR Groups . A list of existing groups is displayed .
2 . Right-click the BWX-100 group you want to update, then select Edit from the pop-up menu . The Edit Group form is 

displayed . The fields on this form are described in the corresponding table in Appendix 5 - DVRs.  

3 . Enter/select your changes on the displayed Settings tab.
4 . To change the Ethernet settings for this BWX-100 group, click the IP Setup tab, and then select the desired checkboxes.

5 . To change the video settings for this BWX-100 group, click the Video tab, and then select the desired values. 

6 . To add/remove BWX-100s from this group, click the DVRs tab, and then follow step 4 of the Configuring a BodyVISION 
DVR Group procedure .

7 . Click Save. A confirmation message is displayed.
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Configuring a FOCUS X2 DVR Group
This section describes how to change the settings for a selected X2 DVR group. Any change you make to a X2 group will 
automatically be applied to all of the X2s that are assigned to that group during each X2’s next DVR-to-server download. 
Refer to the Configuring a Body-Worn DVR when Fleet Management is Enabled section for detailed instructions on 
configuring each setting.
To configure a FOCUS X2 DVR group:
1 . Go to Administration > Manage DVRs > DVR Groups . A list of existing groups is displayed .
2 . Right-click the X2 group you want to update, then select Edit from the pop-up menu . The Edit Group form is displayed . 

The fields on this form are described in the corresponding table in Appendix 5 - DVRs.  

3 . Select the time zone in which DVRs in this group will be recording from the Time Zone drop-down list .
4 . To change the video settings for this X2 group, click the Video tab, and then select the desired values.

5 . To change the recording settings for this X2 group, click the Recording tab, and then select the desired values. 
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6 . To add/remove X2s from this group, click the DVRs tab, and then follow step 4 of the Configuring a BodyVISION DVR 
Group procedure .

7 . Click Save. A confirmation message is displayed.

Configuring an 8-Bay Dock Group
This section describes how to change the settings for a selected 8-bay dock group. Any change you make to an 8-bay 
dock group will automatically be applied to all of the 8-bay docks that are assigned to that group during each of their next 
communication with the server . Refer to the Configuring 8-Bay Docks section for detailed instructions on configuring each 
setting .
To configure an 8-bay dock group:
1 . Go to Administration > Manage DVRs > DVR Groups . A list of existing groups is displayed .
2 . Right-click the 8-bay dock group you want to update, then select Edit from the pop-up menu . The Edit Group form is 

displayed . NOTE: 8-bay docks have a type of FBX8D. The fields on this form are described in the corresponding table in 
Appendix 5 - DVRs.  

3 . Enter/select your changes on the displayed Ethernet tab.
4 . To change other settings for this 8-bay dock group, click the Settings tab, and then select the desired checkboxes.

5 . To add/remove 8-bay docks to/from this group, click the DVRs tab, and then follow step 4 of the Configuring a 
BodyVISION DVR Group procedure .

6 . Click Save. A confirmation message is displayed.
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Assigning DVRs and 8-Bay Docks to Groups
This section describes how to identify devices that are not assigned to a group and how to assign them to an existing group. 
It also describes how to reassign a device to a different group.

 NOTE: Mixed fleet of DVRs

If you have a mixed fleet of DVRs, please note that only Flashback3s and FlashbackHDs may share the same group. All 
other DVRs must be in a group by themselves.

Identifying Devices That are Not Assigned to a Group
If desired, you can opt to have the system notify you whenever it detects a newly discovered device that is not assigned to a 
group yet .
We suggest that you select this function when the following circumstances apply:
• Your agency has decided to assign every device in your fleet to a group
• Your agency is using the “auto insert” function for its devices . For more information, refer to Auto insert DVR option on 

page 225 or Auto Insert Body Worn Devices on page 182.

To identify unassigned devices:
1 . Go to Administration > System Setup > System > Other, then go to the Action menu and click Edit . The Other pop-up is 

displayed . 

Auto insert DVR option 
for in-car DVRs  and 8-bay 

docks(top) and 
body-worn DVRs (bottom)
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2 . Select the DVR Missing Group Message checkbox.
3 . Click Save. The system will send a message to your Inbox whenever a new unassigned device is detected .

Assigning a New Device to an Existing Group
This section describes how to assign a newly discovered device to a group from the Inbox Messages list . Depending on 
your system settings, the system may deliver a message to your inbox when it discovers a new device on the network that is 
not yet assigned to a group .
To assign a new device:
1 . Make sure the Welcome Home page is displayed . (If necessary, go to Home Menu and click Home .)
2 . Locate the “…DVR…was inserted with no group assignment” message on your Inbox Messages list .  

3 . Click the edit icon  beside the message. The Assign to Group pop-up is displayed .
4 . Select a group from the Assign to Group drop-down list, and then click Save .

Assigning or Reassigning Existing Devices to Groups
This section describes how to add a device to a group or reassign it from one group to another.
To add or reassign a device:
1 . Go to Administration > Manage DVRs > DVR Groups . A list of existing groups is displayed .
2 . Right-click the group that you want to add or reassign the device to, then select Edit from the pop-up menu . The Edit 

Group form is displayed . 
3 . Click the DVRs tab. The devices that are currently assigned to this group are displayed in the Assigned column, and all 

other devices are displayed in the Available column . For any devices that are currently assigned to a different group, 
that group’s name will be in parentheses—e.g., NJSPFBHD(Traffic Patrol) . 
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4 . Go to the Available column and perform one of the following tasks: 

To... Do this...

Add devices to the newly-created group • Click each of the devices you want to add to this 
group. As you do so, keep in mind that Flashback3s 
and FlashbackHDs may be in the same group, but all 
other DVRs must be in a group by themselves.

Reassign a device to another group • Click the device you want to reassign .

5 . Click the  icon . The selected devices are now displayed in the Assigned column .
6 . Click Save. A confirmation message is displayed.

Deleting DVR and 8-Bay Dock Groups
This section describes how to delete a DVR or 8-bay dock group. You can only delete a group that has no devices currently 
assigned to it. If the DVR/8-bay dock group you want to delete does have devices assigned to it, you will first have to 
reassign those devices to another group or groups, or remove them from all groups . For more information, see Assigning or 
Reassigning Existing Devices to Groups on page 226.
To delete a DVR/8-bay dock group:
1 . Go to Administration > Manage DVRs > DVR Groups .
2 . Right-click the group you want to delete, and then select Delete from the pop-up menu. A confirmation message is 

displayed . 

3 . Click Yes . The selected group is removed from the Groups list .
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Managing DVRs and 8-Bay Docks
You can  perform a number of administrative tasks that will help you manage in-car and body-worn DVRs.

Deleting DVRs and 8-Bay Docks
This section describes how to permanently remove a DVR or 8-bay dock from the server. You can only delete a DVR that 
does not currently have any videos assigned to it. If the DVR you want to delete does have video(s) assigned to it, first 
reassign those videos to a different DVR, as described in Reassigning Videos to a Different Officer or DVR on page 43.
1 . Go to Administration > Manage DVRs, and then locate the device you want to delete . If you have a large list to scan 

through, see Searching for an Existing DVR or 8-Bay Dock on page 185, beginning with step 2 .
2 . Right-click the device you want to delete, then select Delete from the pop-up menu. A confirmation pop-up is displayed. 

3 . Click Yes . The system removes the selected unit from the list .

Exporting DVR or 8-Bay Dock Information to a Spreadsheet
This procedure describes how to copy the basic information about all of your devices to a CSV file, which you can use with 
spreadsheet software such as Excel. If your agency has more than one server, this procedure can be used to copy device 
information from one server to another . Refer to the Importing Multiple Devices from a Spreadsheet section for further 
instructions, beginning with step 3 . 

 NOTE: DEV users

This workflow does not apply to users of the DEV application.

This feature is only available when Fleet Management is enabled.
To export device information:
• Go to Administration > Manage DVRs, then go to the Action menu and click Export DVRs . The system automatically 

downloads the config_units.csv file to your PC’s Downloads folder.

Generating the DVR Fleet Communication Report
If your agency is forwarding video from multiple DEF precinct servers to one central DEP server and Fleet Management 
is enabled, you will see the DVR Fleet Com report name on the Reports tab. This report provides detailed information on 
device-to-server communications, such as the number of devices that have connected to each DEF server within a specified 
timeframe. You can generate this report for one device, all devices, or all devices at a specified Precinct.

 NOTE: DEF and DEV users

This workflow does not apply to users of the DEF and DEV applications.
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 NOTE: Windows users

This procedure is for Windows 10 users . If you have an earlier version of Windows, these steps may differ slightly . 

To generate the report:
1 . Go to Administration > System Status > Reports, and then click the DVR Fleet Com report to highlight it . 

2 . Go to the Action menu and click Generate Report . The New Report pop-up is displayed .
3 . Using the Start Date and End Date fields, specify a date range for this report. To do so, either click the icon to select the 

dates from a calendar pop-up or manually enter the dates in the mm/dd/yyyy format .
4 . Perform one of the following tasks: 

To... Do this...

Report on all devices at all precincts (default) • Proceed to the next step .

Report on all devices at a selected precinct 1 . Select the All DVRs at Precinct radio button.
2 . Select a precinct from the Precinct drop-down list .

Report on one device 1 . Select the DVR radio button.
2 . Select a device from the DVR drop-down list .

5 . Click Generate. The system downloads the report to your PC’s Downloads folder .
6 . Navigate to your Downloads folder, then double-click the PDF report file. The DVR Fleet Com Report is displayed in 

Adobe Acrobat. 
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7 . To print this report, go to the Acrobat menu bar and click the printer icon. The Print pop-up is displayed .
8 . Select your desired printer settings, then click Print . The report is directed to your active printer .
9 . When you are finished viewing/printing the report, click the cross icon in the upper right corner of the page to exit Adobe 

Reader .

Resolving Naming Conflicts
Whenever a DVR transmits video to the server for the first time, the system checks all existing DVRs for possible duplicates. 
If it finds another DVR on the system that has the same exact name but a different serial number, it does two things:
• Gives the newly discovered DVR a suffix of @[DVR serial number]. 
• Sends a message to the Administrators’ Inbox Messages list, indicating that there is a potential naming conflict. 

When you see this message, follow the procedure described in this section to resolve the naming conflict.

 NOTE: About naming conflicts
The naming conflict message does not necessary mean that something is wrong. Any time you replace a damaged 
DVR or decommission an older DVR, it makes sense that you would assign the replacement DVR the same name as the 
old one (after all, it is going in the same vehicle). The system only prompts you with the naming conflicts message to 
verify that the duplicate DVR is, indeed, an intentional replacement for an existing DVR, rather than a naming error .

To resolve a naming conflict:

1 . Locate the DVR naming conflict message on your Inbox Messages list, and then click the  icon to the right of the 
naming conflict message. The Edit Duplicate DVR form is displayed . 

 NOTE: Edit Duplicate DVR form

Depending on the application you are using, the Edit Duplicate DVR form may have different options available.
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 TIP: Is the newly discovered DVR a replacement for an existing DVR? 

• If one of your DVRs was destroyed in a car accident (SCP 58) and you had to purchase a new DVR to put in that 
vehicle (SCP 58@ 000000016), that would be considered a replacement. 

• If you recently upgraded from a Flashback2 (DVR SCP 58) to a FlashbackHD (SCP 58@000000029), that would 
also be considered a replacement. 

• If you purchased a DVR for a brand new vehicle but accidentally gave it the same name as an existing DVR, that 
would not be considered a replacement.

2 . Determine whether the newly discovered DVR is a replacement for an existing DVR in the system, and then perform one 
of the following tasks: 

If... Then...

The newly discovered DVR is a replacement for an 
existing DVR

1 . Select the Replace Existing radio button. 
2 . Select the DVR you want to replace from the Replace 

Existing drop-down field.
3 . Select a value from the Assign to Group drop-down list to 

assign the new or replacement DVR to a group . 

The newly discovered DVR is not a replacement 
for an existing DVR (i .e ., you gave the new DVR the 
same name as an existing DVR in error)

• Enter a new name in the DVR Name field.

3 . Click Save. If you chose the replacement option, several actions will occur automatically:
• All videos that were previously assigned to the original DVR will be reassigned to the replacement DVR
• The auto-created DVR NAME@[DVR serial number] will be deleted from the system
• The naming conflict message will be removed from the Administrators’ Inbox Messages list .

Turning the DVR Error Notification Feature On/Off
If desired, you can choose to have the system automatically notify you whenever one of your DVRs generates “problem” 
videos. This section describes how to turn this DVR error notification feature on or off.
In the example on the next page, the agency’s DVRs are set to generate 10 problem videos within a 24 hour period. 

This means that the system will automatically display a specific notification message on the Inbox Messages list of all 
users who have the Authorize Media Playback permission . 
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To turn the notifications on or off:
1 . Go to Administration > System Setup > System > Other, then go to the Action menu and click Edit . The Other pop-up is 

displayed . 

2 . Go to the Unit Error Count field and enter the number of DVR errors that should occur each day or week before the 
system sends a notification message to the appropriate users (i.e., all users who have the Authorize Media Playback 
permission). If you no longer want to receive notification messages, change this number to zero).

3 . If you entered 0 in the Unit Error Count field, skip to step 5 . Otherwise proceed to the next step .
4 . Select the appropriate value from the per drop-down list (e.g., 10 errors per day or 10 errors per week).
5 . Click Save .

Troubleshooting DVR Errors
If your agency has chosen to receive DVR error notifications, then when a particular DVR produces a predefined number of 
“problem” videos within a one day or one-week time period, a message will be displayed on the Inbox Messages list of all 
users who have the Authorize Media Playback permission . 
For example, if you have the Authorize Media Playback permission and the Unit Error Count field on the Other pop-up looks 
like this: , then, if a DVR generates 10 power failures in one 24 hour period, the system will 
automatically send a notification message to your Inbox Messages list . 

     

 NOTE: Troubleshooting 
DVR errors

Before you contact 
Mobile-Vision Support, we 
recommend that you try and 
troubleshoot the problem 
yourself, as described below.
The information below is 
also in the DES Online Help 
System, which you can 
access directly from the error 
message by clicking the help 
icon  .
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To troubleshoot DVR errors:
1 . Determine if the “problem” DVR is a an in-car or body-worn DVR. To do so, note the value of the DVR number, which is 

highlighted in green and verify it against the DVR ID on the Manage DVRs page . 
2 . If the "problem" DVR is a body-worn DVR, perform the following steps. Otherwise skip to step 4 .

a. Verify that the DVR has sufficient storage space and a sufficient battery charge. To do so:
• For BWX-100, refer to the relevant sections of the BWX-100 user documentation .
• For BodyVISION, refer to the to the relevant sections of the BodyVISION user documentation .
• For FOCUS X2, refer to the to the relevant sections of the FOCUS X2 user documentation .

b. If you determine that the body-worn DVR lacks sufficient storage space and/or a sufficient battery charge, 
immediately place it in your agency’s Uplink Station. The videos on the unit will automatically upload to the server, 
creating more storage space. The DVR’s battery will also begin to charge. You’ll know that charging is complete 
when:
• The word “CHARGED” is displayed on the LCD screen of a BWX-100 unit . 
• The battery indicator LED is solid green on BodyVISION or FOCUS X2 units.

c. If you determine that the body-worn DVR has both sufficient storage space and a sufficient battery charge, contact 
your Mobile-Vision Support professional for assistance. To do so, call 800-336-8475 and select option 3 (Service), 
followed by option 1 (In-Car Components) . End of procedure.

3 . For problem in-car DVRs, proceed to the error message on your Inbox Messages list . 

4 . Highlight the green unit number and press Ctrl + C to copy it to your clipboard.
5 . Go to Administration > Manage DVRs, then position your cursor in the DVR ID field and press Ctrl + V to insert the unit 

number you copied from the error message. The information for the “problem” DVR is displayed. 

6 . Write down the values displayed in the DVR Name and Product Code columns . This information will help you select the 
appropriate troubleshooting procedures later.

7 . If you are troubleshooting a FOCUS H1 DVR, contact Mobile-Vision Technical Support for assistance and give them the 
information you have written down . End of procedure. 

8 . Go to Home Menu and click Search Video . The Media Information pop-up is displayed .

9 . Select the unit’s DVR name from the DVR drop-down list (i .e ., the DVR Name that you wrote down earlier) .
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10 . Click Search. All videos that were recorded by the “problem” DVR are displayed.
11 . Look in the Category column to determine if any of the videos share a common system-assigned video category . For 

more information, see System-Assigned Video Categories on page 301.
• If any of the videos share one of the system-assigned categories, proceed to step 12 .
• If any of the videos do not share one of the system-assigned categories, contact Mobile-Vision Technical Support 

for assistance, End of procedure.
12 . Download the appropriate troubleshooting guide from the Mobile-Vision Online Support Center:

• Flashback3 & FlashbackHD Troubleshooting Guide
• Flashback2 Troubleshooting Guide

 NOTE:  Which Flashback?
If you’re not sure if the DVR is a Flashback2, Flashback3, or FlashbackHD, look at the product code that you jotted down 
earlier . 
• Flashback2s have a product code of FB2 .
• Flashback3s have a product code of FB3 .
• FlashbackHDs have a product code of FBHD .

13 . Once you’ve downloaded the appropriate troubleshooting guide, review the section(s) that relate to the video 
category(ies) you saw to find a solution.

Viewing the DVR Status List and Downloader Log
This section describes how to view the device downloader log. This log contains detailed information on each video 
transmitted to the server during a device’s most recent download.
To view the device status and log:
1 . Go to Administration > System Status > DVR COM . The status of each of your device is displayed, as described in the 

corresponding table in Appendix 5 - DVRs.
2 . To view a log for a device of interest, click that device, then go to the Action menu and click Get DVR Log . The DVR Log 

pop-up is displayed . The fields on this pop-up are described in the corresponding table in Appendix 5 - DVRs. 

3 . When you are finished viewing the DVR log, click Close .

Disabling/Enabling DVRs and 8-Bay Docks
This section describes how to disable or enable your in-car and/or body-worn DVRs. When you disable a group of DVRs, 
those DVRs will no longer be able to communicate with the server. 
To disable or enable DVRs:
1 . Go to Administration > System Setup > System > Download Options, then go to the Action menu and click Edit.  

The Download Options pop-up is displayed, as pictured on the next page . 
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2 . To enable/disable your Flashback2/3/HD, FOCUS H1 DVRs, or 8-bay docks, select or deselect the Enable FB2/FB3/
FBHD/8 Bay/H1 DVR Downloads checkbox accordingly.

3 . To enable/disable your body-worn DVRs (includes BodyVISIONs, BWX-100s, and FOCUS X2s), select or deselect the  
Enable Body Worn Downloads checkbox accordingly.

4 . Click Save .

Exporting DVR and 8-Bay Dock Activity to a Spreadsheet
This section describes how to export all your DVR or 8-bay dock activity to a spreadsheet for use with another application, 
such as a custom reporting tool . This is referred to as the DVR activity report . It includes information such as when a video 
was up-dated to the server, when a device setting was changed and by whom, when a device was added to or removed from 
a group, etc . The system automatically updates this report once every day .

 NOTE: Windows users

This procedure is for Windows 10 users . If you have an earlier version of Windows, these steps may differ slightly . 

To export the device activity:
1 . Go to Administration > System Status > Reports, click the DVR Activity report name to highlight it, then go to the Action 

menu and click Download Report. The system downloads the report file to your PC’s Downloads folder . 

 NOTE: Time of the report 

Note the date in the Last Refreshed Date column. The device activity report you are about to download will contain 
all system device activity up to this date/time . If you prefer to report on all device activity up to the current time, go 
to the Action menu and click Refresh Report first before proceeding.

2 . Navigate to your Downloads folder, and then double-click the CSV report file. The activity report is displayed in your 
default spreadsheet application, such as Microsoft Excel .
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Managing DVR and 8-Bay Dock Firmware
This section describes the procedures related to DVR and 8-bay dock firmware. Depending on your service agreement with 
Mobile-Vision, you may occasionally receive firmware updates via your DES application. If you qualify for upgrades, the 
upgraded firmware files will automatically appear on the DVR Firmware tab within the application.
It’s recommended that you upgrade your firmware from the server.

Updating Firmware from the Server
There are several methods for updating your device firmware from the server. You can update:
• All your devices at the same time
• One device at a time
• One group at a time .

Globally Updating Firmware for an Entire Fleet of DVRs
This section describes how to update the firmware on all of your in-car and/or body-worn DVRs, as well as 8-bay docks. This 
is the fastest and easiest method of updating your firmware. Perform this task whenever Mobile-Vision notifies you that 
there is a new firmware version available.

 TIP: Before a global update

Before you perform this procedure, you may want to test the new firmware on just one unit before pushing the firmware 
out to all of the devices in your fleet.

 
 
To perform a global update:
1 . Go to Administration > System Setup > DVR Firmware. A list of the current and past firmware versions is displayed. 
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2 . Perform one or more of the following tasks: 

To... Do this...

Update firmware for all Flashback3s 
and FlashbackHDs

• Click the row at the top of the firmware list (i.e., the most recent firmware 
version for Flashback3s and FlashbackHDs).

Update firmware for all Flashback2s • Click the highest firmware version that begins with 2.1 .

Update firmware for all FOCUS H1s • Click the highest firmware version that begins with the number 2.3 and 
has a file name that starts with H1 .

Update firmware for all BodyVISION 
DVRs

• Click the highest firmware version that begins with the number 1 and has 
a file name that starts with BodyVision .

Update firmware for all BWX-100 
DVRs

• Click the highest firmware version that begins with the number 1 and has 
a file name that starts with BV .

Update firmware for all FOCUS X2 
DVRs

• Click the highest firmware version that begins with a 4 and has a file name 
that starts with X2 .

Update firmware for all 8-bay docks • Click the highest firmware version that begins with a 2.3 and has a file 
name that starts with XD8 .

3 . Go to the Action menu and click Assign to All DVRs. A verification prompt is displayed: 

4 . Click Yes. A confirmation message is displayed. The system will automatically copy the most recent firmware version to 
each of your devices during the next server-to-device communication .

Updating the Firmware for a Single Device
This section describes how to update the firmware for a single device. That firmware will then be transmitted to the device 
during the next server-to-device transmission . If your agency is using the Fleet Management feature, you can perform this 
procedure for both in-car and body-worn DVRs, as well as 8-bay docks.  
To update firmware for a single device:
1 . Search for and display the device you want to update . 
2 . Right-click the device and then select Edit form the pop-up menu . The Edit DVR pop-up is displayed . 
3 . Locate the Assigned Firmware field and select the highest firmware version from the drop-down list.
4 . Click Save. A confirmation message is displayed.

Updating the Firmware for a Group
This section describes how to update the firmware for a selected group. That firmware will then be transmitted to the 
group’s devices during the next device-to-server transmission .
To update firmware for a group:
1 . Go to Administration > Manage DVRs > DVR Groups . A list of existing groups is displayed .
2 . Right-click the group you want to update, then select Edit from the pop-up menu . The Edit Group window is displayed . 
3 . Go to the Minimum Firmware field in the upper right corner of the screen and select the highest firmware version from 

the drop-down list .
4 . Click Save. A confirmation message is displayed.
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Viewing/Printing Firmware Release Notes
This section describes how to view and/or print firmware release notes for in-car and body-worn DVRs, as well as 8-bay 
docks. These notes describe the changes and enhancements to each new firmware version.

 NOTE: Windows users

This procedure is for Windows 10 users . If you have an earlier version of Windows, these steps may differ slightly . 

To view and print firmware release notes:
1 . Go to Administration > System Setup > DVR Firmware. A list of the current and past firmware versions is displayed.
2 . Perform one of the following tasks: 

To... Do this...

View the release notes for Flashback3/FlashbackHD DVRs • Click any version number that starts with a 3 .

View the release notes for Flashback2 DVRs • Click any version number that starts with a 2.1 .

View the release notes for FOCUS H1 DVRs • Click any version number that starts with a 2.3 
and has a file name that begins with H1 .

View the release notes for BodyVISION DVRs • Click any version number that starts with a 1 and 
has a file name that begins with BodyVision .

View the release notes for BWX-100 DVRs • Click any version number that starts with a 1 and 
has a file name that begins with BV .

View the release notes for FOCUS X2 DVRs • Click any version number that starts with a 4 and 
has a file name that begins with X2 .

View the release notes for 8-bay docks • Click any version number that starts with a 2.3 
and has a file name that begins with XD8 .

3 . Go to the Action menu and click Download Release Notes. The system downloads the firmware release notes to your 
PC’s Downloads folder .

4 . Navigate to your Downloads folder, and then double-click the release notes file. The firmware release notes are 
displayed in a separate window .  

5 . To print the release notes, press Ctrl + P . The Print form is displayed . 
6 . Select your printer options, then click Print. The print job is directed to your active printer.
7 . When you are finished viewing/printing the release notes, click the cross icon in the upper right corner of the page.
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About Users and Permissions
This chapter describes how to manage users and permissions.

About Users
There are two methods for entering and maintaining user records in DES applications: directly, or through your agency’s 
existing internal network.

About Active Directory
The Active Directory Integration feature enables you to integrate a DES application with your agency’s existing Windows 
Active Directory or Novell eDirectory. This feature allows for a single password authentication with your agency’s internal 
network, eliminating the need to maintain two sets of User IDs and passwords. It also allows you to import existing network 
users into the system . If you choose to use this feature, your System Implementation Specialist (SIS) will assist you in 
setting up your Active Directory . After that, you only have to update the user list periodically as needed .

Searching for a User
You can search for an existing user record by one or more of the following fields: Display Name, User Login, User Role, or 
Status . To do so, go to Administration and click Manage Users, and then enter/select the field values you want to search on 
in the displayed User Search Results page .  
The fields on this page are described in the corresponding table in Appendix 6 - Users and Permissions.

About Permissions
Users are granted access to various system functions by assigning them a user role. A user role is simply a group of 
permissions that you can assign to one or more users. There are two types of user roles: system-defined and custom. A 
user who logs in to a DES application will be granted access to the various system functions according to their assigned 
user role. If desired, you may also grant certain users access to additional permissions above and beyond what is included 
in their assigned user role. For example, if you want only one of your officers to be able to burn Consumer DVDs, you might 
assign that user the role of Officer and two additional permissions: Consumer DVD Format, and Burn to Disk .
For a complete list of available permissions for all user roles, see Appendix 6 - Users and Permissions.
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About System-Defined User Roles
System-Defined User Roles are the predefined user groups that come standard with a DES application. These include:
• Officer
• Display-only Case
• Display-only Video
• Supervisor Lvl 1
• Supervisor Lvl 2
• Internal Affairs
• Administrator . 

 NOTE: User role availability
Depending on the application you are 
using, some or all user roles will be 
available to you.

These roles are customizable. You can add or remove permissions from them as desired. However, the names of these 
roles cannot be changed, nor can they be deleted from the system.
For a complete list of default permissions for the system-defined user roles that come standard with DES see Appendix 6 - 
Users and Permissions.

About Custom User Roles
A custom user role is a group of permissions that has a unique name, that is, a name which differs from the seven default 
names of the system-defined user roles. As with system-defined user roles, you can add permissions to or remove them 
from custom user roles as desired .
As System Administrator, you need to determine which options you want each user role to have access to. If an officer’s 
assigned user role allows them to perform a particular task, they will have access to that function. 

About Passwords
To further enhance your application security, your DES application also allows you to define the rules that apply to a user 
password. These include password length, password complexity, and the number of logon attempts allowed before the 
system disables a password.
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Managing Users without Active Directory Integration
This section describes how to add, change, and/or delete user records in DES applications. These procedures only apply to 
those users who are not using the Active Directory Integration feature, which integrates a DES application with your agency’s 
existing internal network. If your agency is using the Active Directory Integration feature, see Managing Users with Active 
Directory Integration on page 247.

 NOTE: DEV application

Use the workflows in this section for managing users in the DEV application.

Adding a User
This section describes how to enter a new user record in a DES application.  Before you add users for the first time, it’s 
important to define your user roles. For more information, see Managing User Roles and Permissions on page 250.

 NOTE: Users uploading VIEVU Model LE2 videos

If the new user will be uploading VIEVU Model LE2 videos, they must be a non-Admin user (such as Supervisor Lvl 1 or 
Supervisor Lvl 2) whose DVR Officer Name field is populated and who is assigned the Media Reader permission .

To add a user:
1 . Go to Administration > Manage Users, then go to the Action menu and click New User . The New User pop-up is 

displayed . The fields on this form are described in the corresponding table in Appendix 6 - Users and Permissions. 

                               
2 . Enter the following information in the appropriate fields:

• An officer display name in the Display Name field. This is the name that will be displayed throughout the application.
• The user’s login ID in the User Login field.

  NOTE: Adding generic users for shared body-
worn DVRs

If you agency uses shared body-worn DVRs, create a 
generic user for each of them using the New User form 
as follows:
1 . Enter a name of a shared body-worn DVR in the 

Display Name and User Login fields. (e.g. BWX01)
2 . Enter and re-enter a generic password in the User 

Password and Repeat User Password fields.
3 . Select DVR Management from the User Roles 

drop-down list .
4 . Click Save .
Repeat this procedure for all shared body-worn DVRs.
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• The user’s email address in the Email Address field.
• The user’s initial login password in the User Password field. This is a password that the user will use to log in to the 

application for the first time.
3 . Re-enter the user’s initial login password in the Repeat User Password field.
4 . To prevent this user from being able to log in to the application immediately, select Disabled from the Status drop-down 

list. If you do so, remember that you must enable the account before the user will be allowed to log in. NOTE: For generic 
body-worn DVR users, always select Enabled from the Status drop-down list .

5 . Select a user role from the User Role drop-down list, and then perform one of the following tasks: 

If... Then...

The user role you selected 
includes the Can Own Video 
permission

The DVR Officer Name and Video Visibility fields will become accessible. 
• Perform one of the following tasks:

• For a user who will be using a USB login key to log in to a Flashback DVR each 
shift, enter a DVR officer name in the DVR Officer Name field, and then proceed 
to the next step .

• For a user who will not be using a USB login key to log in to a Flashback DVR 
each shift:
a. Go to the actual Flashback unit and jot down the display name located in 

the Flashback’s Officer Name field (see note below). 
b. Enter the Flashback Officer Name in the DVR Officer Name field (this is a 

required field), and then proceed to the next step.
• For a user who will be using any DVR other than a Flashback, proceed to the 

next step .

The user role you selected 
does not include the Can 
Own Video permission

The DVR Officer Name and Video Visibility fields will remain grayed-out.
• Proceed to the next step .

 

 NOTE: Obtaining the Officer Name from a Flashback DVR

Flashback2 Flashback3 or FlashbackHD

1 . Unlock the Flashback.

2 . Press the  button.

3 . Press the  button until Misc. Setup is 
highlighted .

4 . Press the  button.
5 . Jot down the value displayed in the Officer Name 

field.

1 . Unlock the Flashback.

2 . Press the  button.

3 . Press the  button until User is highlighted .

4 . Press the  button.
5 . Jot down the value displayed in the Officer Name 

field.

6 . If you want this user’s videos to be public (i.e., viewable by all users), select Public from the Visibility drop-down list . 
Otherwise, the video will remain private and be viewable only by this user and other users with edit permissions.
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7 . If the Permissions tab is displayed, you can review and assign permissions to this user. To do so:
a. Click  the Permissions tab. 

 

 NOTE: Available and assigned  
permissions
The grayed-out permissions displayed in the 
right column are associated with the user’s 
assigned user role (i .e ., the role you just 
selected from the User Role drop-down list) . 
You cannot remove any of these permissions . 
However, you can assign additional 
permissions .

b. Go to the Available Permissions column and click the new permissions you want to assign. If you don’t see a 
permission you’re looking for, use the Search field and/or navigation arrows at the top of the column to scan the list. 
NOTE: If this user will be uploading VIEVU videos, they must have the Media Reader permission .

c. Once you’ve highlighted the desired permissions, click the  icon located between the two columns. The selected 
permissions are displayed in the Assigned Permissions column .

8 . If the Users tab is displayed, you can assign a permission to this user to have access to other officers’ videos (typically 
the officers that they supervise). To do so:
a. Click the Users tab. 

b. Go to the Available Users column and click the appropriate users. If you don’t see a user you’re looking for, use the 
Search field and/or navigation arrows at the top of the column to scan the list.

c. Once you’ve highlighted the desired users, click the  icon located between the two columns. The selected users 
are displayed in the Assigned Users column .

9 . Click Save. The system analyzes your selections to make sure that they are logical. If there are any problems, the 
system will prompt you to make another selection. For example, if you selected Export Format-Consumer DVD but 
neglected to select Export to Disc as well, the system will prompt you to add the latter permission, as you can’t burn a 
Consumer DVD unless you have disc burning permission.  
Once you’ve saved the user record without any errors, a confirmation message is displayed.

User role 
permissions
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Changing a User
This section describes how to change an existing user record in a DES application. 
To change a user record: 
1 . Go to Administration > Manage Users . The User Search Results page is displayed .
2 . If the user record you want to update is not displayed in the Display Name column, use the navigation arrows at the top 

of the form to scroll through the user list. Alternatively, enter/select search criteria in the search field(s) provided. 
3 . Right-click the record of interest in the Display Name column, then select Edit from the pop-up menu . The Edit 

User form is displayed. The fields on this form are described in the corresponding table in Appendix 6 - Users and 
Permissions. 

4 . Enter/select your desired changes in the appropriate fields.
5 . To assign additional permissions to this user, follow step 7 of the Adding a User procedure .
6 . If the Users tab is displayed, you can assign or unassign officers to this user. NOTE: When an officer is assigned to you, 

it means that you have access to that officer’s videos. To do so, click the Users tab, and then perform one or more of the 
following tasks: 
a. To assign an officer to this user:

i. Go to the Available Officers column and click the appropriate users. If you don’t see a user you’re looking for, 
use the Search field and/or navigation arrows at the top of the column to scan the list.

ii. Once you’ve highlighted the desired users, click the  icon located between the two columns. The selected 
users are displayed in the Assigned Officers column .

b. To unassign one or more officers from this user: 
i. Go to the Assigned Officers column and click the appropriate users. If you don’t see a user you’re looking for, 

use the Search field and/or navigation arrows at the top of the column to scan the list.
ii. Once you’ve highlighted the desired users, click the  icon located between the two columns. The selected 

users are displayed in the Available Officers column .
7 . Click Save. The system analyzes your selections to make sure that they are logical. If there are any problems, the 

system will prompt you to make another selection. For example, if you selected Export Format-Consumer DVD but 
neglected to select Export to Disc as well, the system will prompt you to add the latter permission, as you can’t burn a 
Consumer DVD unless you have disc burning permission.  
Once you’ve saved the user record without any errors, a confirmation message is displayed.
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Deleting a User
This section describes how to delete an existing user record in a DES application. 

 NOTE: Users that cannot be deleted

Users who own video or have any activity logs cannot be deleted.

To delete a user:
1 . Go to Administration > Manage Users . The User Search Results page is displayed .
2 . If the user record you want to delete is not displayed in the Display Name column, use the navigation arrows at the top 

of the form to scroll through the user list. Alternatively, enter/select search criteria in the search field(s) provided. 
3 . Right-click the record of interest in the Display Name column, then select Delete from the pop-up menu. A confirmation 

message is displayed . 

4 . Click Delete . The selected user record is removed from the system .

Managing Users with Active Directory Integration
There are two methods for updating the Active Directory user list:
• Method 1: Auto-Create Users Upon Login . This method will automatically create a new user record in your DES 

application whenever a new user logs in to it for the first time. This method is fully automated. It is the “set it and forget 
it” option .

• Method 2: Manually Add Users En Mass. This method is used to manually update your user list on a periodic basis.
Your System Implementation Specialist (SIS) will assist you in setting up your Active Directory for the first time. After that, 
you only have to update the user list as needed .

Method 1: Auto-Creating Active Directory Users Upon Login
This section describes how to set up the system so that it automatically creates a new user record in your DES application 
whenever a new user logs in for the first time. 
To auto-create directory users:
1 . Go to Administration > System Setup > Security > Active Directory Settings . The Active Directory form is displayed . 
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2 . Go to the Action menu and click Edit . The Edit LDAP Active Directory Settings pop-up is displayed . The fields on this 
form are described in the corresponding table in Appendix 6 - Users and Permissions. 

3 . Select the Auto Create Users checkbox, and then click Save .

Method 2: Manually Adding Active Directory Users En Mass
This section describes how to manually update your user list on a periodic basis. 
To manually add users:
1 . Go to Administration > Manage Users, then go to the Action menu and click Add Active Dir User . The Active Directory 

Search pop-up is displayed . 

2 . Search for and select the active directory users that you want to add to the system. To do so: 
a. Go to the Top Level OU drop-down list and select the organization unit in which you want to search for users .
b. Go to the Search by drop-down list and select the field name you want to search by.
c. Go to the blank field to the right of the Search by field and enter the field value you want to search by. This value 

should correspond to the selected Search by value . For example, if you entered Department in the Search by field, 
you might enter Traffic Patrol in the blank search field.

d. Click Search . The system displays all user records that match your selection criteria .
3 . To select the users you want to add, perform one of the following tasks:

• Go to the Action menu and click Select All .
• Go to the Action menu and click Select All on Page .
• Go to the Add column and manually select the appropriate checkboxes.

4 . Go to the User Type column and select a role for each user from the drop-down list .
5 . Once the desired users are selected and their User Types are set to the correct values, go to the Action menu and click 

Add Selected. A confirmation message is displayed.

Updating the Active Directory Settings
This section describes how to update your Active Directory settings.
To update the settings:
1 . Go to Administration > System Setup > Security > Active Directory Settings . The Active Directory form is displayed .
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2 . Go to the Action menu and click Edit . The Edit LDAP Active Directory Settings pop-up is displayed . The fields on this 
form are described in the corresponding table in Appendix 6 - Users and Permissions. 

3 . Enter/select your changes in the appropriate field(s), and then click Save .

Exporting User Activity to a Spreadsheet
This section describes how to export all your user activity to a spreadsheet for use with another application, such as a 
custom reporting tool . This is referred to as the User Activity report . It includes information such as which users logged in/
out of the system, played video, edited a case, etc . The system automatically updates this report once every day .
To export a user activity report:
1 . Go to Administration > System Status > Reports, and then click the User Activity report to highlight it . 

 

 NOTE: Last refreshed date

Note the date in the Last Refreshed Date column. The User Activity report you are about to download will contain 
all system user activity up to this date/time . If you prefer to report on all user activity up to the current time, go to 
the Action menu and click Refresh Report first before proceeding.

2 . Go to the Action menu and click Download Report. The system downloads the report to your PC’s Downloads folder.
3 . Navigate to your Downloads folder, and then double-click the report file.  The User Activity information report is 

displayed in your default spreadsheet application .
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Managing System-Assigned User Roles
You can change or restore the settings for a system-defined user role.

Configuring a System-Defined User Role
This section describes how to change the default settings for one of the predefined user roles that come with DES 
applications:
• Officer
• View-only Case
• View-only Video
• Supervisor Lvl 1
• Supervisor Lvl 2

• Internal Affairs  

 NOTE: User role availability
Depending on the application you are 
using, some or all user roles will be 
available to you.

• System Administrator . 
You can change a user role’s session timeout setting and/or its permissions, as described below.
• Session Timeout. The session timeout setting is the number of idle-time minutes that must pass before the system 

automatically logs a user off the system. If a user type will be performing time-intensive tasks, such as restoring cases 
or manually uploading videos, it’s recommended that you set their session timeout to a minimum of 60 minutes.

• Permissions. A user role’s permissions determine what system functions a user will or will not be able to access. You 
can add/remove any number of permissions to/from a selected user role. For a list of permissions, see Appendix 6 - 
Users and Permissions.

 

 NOTE: What is affected by the changes you make?

Whenever you update a user role, your changes will affect all users who share that role . For example, if you add the Can 
Reset DVR permission to the Supervisor Lvl 1 user role, then all Supervisor Lvl 1 users will automatically be assigned 
the Can Reset DVR permission . 
Do I need to update my user records after I modify a user role? 
No. The new permissions will automatically be assigned to all users who share that user role. However, there are two 
circumstances where you should update a user’s permissions from within their user record:
You need to change a user’s assigned user role. For example, if an officer gets a promotion, you might want to change 
their user role from Officer to Supervisor Lvl 1 . For more information, see Changing a User on page 246.
You want to give a user a few extra permissions that are not included with their assigned user role . For more 
information, see Assigning Permissions to a User on page 254.
Please note that you cannot change the name of a system-defined user role. If the predefined names do not meet your 
agency’s needs, see Adding a Custom User Role on page 252.
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To change a user role:
1 . Go to Administration > System Setup > Security > User Roles . The User Roles form is displayed . The 

components on this form are described in the corresponding table in Appendix 6 - Users and Permissions.

2 . Right-click the predefined user role that you want to update, then select Edit from the pop-up menu . The Edit User Role 
pop-up is displayed . 

3 . To change the session timeout setting for this user role, enter a new value in the Session Timeouts (minutes) field.
4 . To add a permission to this user role, perform the following steps:

a. Go to the Available Permissions column and click each of the permissions you want to add. If a permission you’re 
looking for does not appear on-screen, use the Search field and/or navigation arrows at the top of the column to 
scroll through the permissions list .

b. Once you’ve highlighted the desired permissions, click the  icon located between the two columns. The selected 
permissions are displayed in the Assigned Permissions column .
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5 . To remove a permission from this user role, perform the following steps:
a. Go to the Assigned Permissions column and click each of the permissions you want to remove.
b. Once you’ve highlighted the desired permissions, click the  icon located between the two columns. The selected 

permissions are removed from the Assigned Permissions list .
6 . Click Save. The system analyzes your selections to make sure that they are logical. If there are any problems, the 

system will prompt you to make another selection. For example, if you selected Export Format-Consumer DVD but 
neglected to select Export to Disc as well, the system will prompt you to add the latter permission, as you can’t burn a 
Consumer DVD unless you have disc burning permission.  
Once you’ve saved the user role without any errors, a confirmation message is displayed.

Restoring a System-Defined User Role to its Default Settings
This section describes how to restore a system-defined user role to its original factory settings. Perform this task if you 
previously changed the settings for a system-defined user role, but you now want to restore that user role to its default 
settings .
To restore a user role:
1 . Go to Administration > System Setup > Security > User Roles . The User Roles form is displayed .
2 . Click the user role that you want to restore.
3 . Go to the Action menu and click Restore Defaults. A confirmation message is displayed.

Managing Custom User Roles
A custom user role is a group of permissions that has a unique name, which differs from the seven default names . You 
can add or remove permissions from custom user roles as desired . For a list of permissions, see Appendix 6 - Users and 
Permissions.

Adding a Custom User Role
This section describes how to create a new user that has a unique name. Otherwise you can simply customize the system-
defined user roles that come with your DES application as described in Configuring a System-Defined User Role on page 
250.
To add a custom user role:
1 . Go to Administration > System Setup > Security > User Roles, then go to the Action menu and click New . The New User 

Role form is displayed . 
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2 . Enter a unique name for the new user role in the Name field.
3 . If your agency is using the Active Directory Integration feature, go to the AD Group Name field and select the Active 

Directory group that is associated with this user role . Otherwise, proceed to the next step .
4 . To increase or decrease the session timeout setting, go to the Session Timeouts (minutes) field and enter a new value.
5 . To add a permission to this user role, perform the following steps: 

a. Go to the Available Permissions column and click each of the permissions you want to assign to this user role. If a 
permission you’re looking for does not appear on-screen, use the Search field and/or navigation arrows at the top of 
the column to scroll through the permissions list .

b. Once you’ve highlighted the desired permissions, click the  icon located between the two columns. The selected 
permissions are displayed in the Assigned Permissions column .

6 . Click Save. The system analyzes your selections to make sure that they are logical. If there are any problems, the 
system will prompt you to make another selection. For example, if you selected Export Format-Consumer DVD but 
neglected to select Export to Disc as well, the system will prompt you to add the latter permission, as you can’t burn a 
Consumer DVD unless you have disc burning permission.  
Once you’ve saved the user role without any errors, a confirmation message is displayed.

Configuring a Custom User Role
This section describes how to update a custom user role. You can change the following information:
• User Role Name
• Session Timeout. The session timeout setting is the number of idle-time minutes that must pass before the system 

automatically logs a user off the system .
• Permissions. A user role’s permissions determine what system functions a user will or will not be able to access. You 

can add/remove any number of permissions to/from a selected user role. For a list of permissions, see Appendix 6 - 
Users and Permissions.

 NOTE: What is affected by the changes you make?

Whenever you update a user role, your changes will affect all users who share that role . For example, if you add the Can 
Reset DVR permission to the Captain user role, then all Captain users will automatically be assigned the Can Reset DVR 
permission .
Do I need to update my user records after I modify a user role? 
No. The new permissions will automatically be assigned to all users who share that user role. However, there are two 
circumstances where you should update a user’s permissions from within their user record:
You need to change a user’s assigned user role. For more information, see Changing a User on page 246.
You want to give a user a few extra permissions that are not included with their assigned user role . For more 
information, see Assigning Permissions to a User on page 254.

To change a custom user role:
1 . Go to Administration > System Setup > Security > User Roles . The User Roles form is displayed . For a detailed 

description of this form, see Appendix 6 - Users and Permissions.
2 . Right-click the custom user role that you want to update, then select Edit from the pop-up menu . The Edit User Role 

pop-up is displayed .
3 . To change the name of this user role, enter a new value in the Name field. 
4 . To change the Active Directory group that is associated with this user role, select a new value from the AD Group Name 

field. 
5 . Follow steps 3 - 6 of the Configuring a System-Defined User Role procedure .
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Deleting a Custom User Role
This section describes how to delete a custom user role that is not currently assigned to any users. If the user role you want 
to delete is currently assigned to one or more users, you will have to change each user’s role assignment first before you can 
perform this procedure .
To delete a custom user role:
1 . Go to Administration > System Setup > Security > User Roles . The User Roles form is displayed .
2 . Right-click the custom user role that you want to delete, then select Delete from the pop-up menu. A confirmation 

message is displayed . 

3 . Click Yes . The selected user role is permanently removed from the User Roles list .

Assigning Permissions to a User
There are two ways in which you can assign permissions to a user . 
• You can assign permissions when you first create a user. This method is described in the Adding a User section .  
• You can assign permissions by changing an existing user’s role and/or granting additional permissions to a user on an 

ad-hoc basis, as described in this section.
To assign permissions:
1 . Go to Administration > Manage Users . The User Search Results page is displayed .
2 . If the user record you want to update is not displayed in the Display Name column, use the navigation arrows at the top 

of the form to scroll through the user list. Alternatively, enter/select search criteria in the search field(s) provided. 
3 . Right-click the record of interest in the Display Name column, then select Edit from the pop-up menu . The Edit 

User form is displayed. The fields on this form are described in the corresponding table in Appendix 6 - Users and 
Permissions. 

4 . To change this user’s user role, select a new role from the User Role drop-down list . 
5 . Follow step 7, and then step 9 of the Adding a User procedure . 
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Defining Password Policies
This section describes how to define the rules that apply to a user password. These include password length, password 
complexity, and the number of login attempts allowed before the system disables a password.
To define password policies:
1 . Go to Administration > System Setup > Security > Security Policy . 

2 . Go to the Action menu and click Edit . The Edit Security Policy pop-up is displayed. The options available on this form 
are described in the corresponding table in Appendix 6 - Users and Permissions. 

3 . Review the first six security options and select the checkboxes for those security features you want to use.
4 . To prevent users from reusing recent passwords, perform the following steps:

a. Select the checkbox beside Verify password has not been used recently .
b. Enter the number of passwords you want each of your users to have in The number of passwords to save in 

history per user field.
5 . To set a minimum required length for passwords:

a. Select the checkbox to the right of the Verify password length field.
b. Enter the minimum number of characters that your passwords must have in the Required number of characters for 

password field.
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6 . To allow any user to view videos that are owned by auto-created Officers, select Public from the Video Visibility for 
Auto-Created Officers drop-down list . Otherwise, only those users with the View Private Data or View All Data 
permission will be able to view videos owned by auto-created Officers. 
 

 NOTE: What is an auto-created officer? 
If the value of a video’s Owner field starts with *1, it indicates that it was auto-created by the system. 
There are two scenarios in which the system will automatically create an owner: 
• A user logs into a DVR using a User ID that does not reside on the server . After transmission occurs, the system 

recognizes that the DVR Officer Name does not match any existing records in the database, and so it creates 
a new owner name using the following naming convention: *1 [DVR login name] @ [date/time] . This name will 
be displayed in the video’s Owner field. 

• The Record feature on the DVR is activated when no officer is logged into the DVR. In this instance, the system 
will assign a default owner of *1 No Name @ [time at which default officer was created] to any videos that 
were recorded during that session .

7 . Click Save .
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About Utilities
This chapter describes how to perform administrative and system maintenance procedures that are not covered in any 
other part of this guide. Perform these procedures in response to agency needs, user requests, and/or Inbox messages 
received .

Viewing the System Status
The System Status page provides important information and statistics on videos, cases, DVRs, backups, storage space, and 
users. It also indicates what version of the application you’re running.

 NOTE: Searchable video
When a video is referred to as “searchable,” it means that the record for that video still resides on the server. 
Such records may have a status of either online or offline.

To view the system status:
1 . Go to Administration > System Status > System . The System Status page is displayed . The columns on this page are 

described in the corresponding table in Appendix 7 - Utilities. If necessary, use the navigation arrows at the top of the 
page to scroll through the complete logs list . 

2 . DEA Agency users can view the information on the daily data transfers that occur between the Precinct servers and the 
Agency server. To do so, click the Transfers tab, and then click the precinct of interest.  
The information on how many data fields and files (both video and media) have successfully transmitted from a 
Precinct server to the Agency server on a particular day is displayed in a new pop-up . The columns on this pop-up are 
described in the corresponding table in Appendix 7 - Utilities. 
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Viewing the System Logs
The system logs track changes and updates to the system settings.
To view the system logs:
• Go to Administration > System Status > Logs . The System Logs list is displayed . The columns on this page are 

described in the corresponding table in Appendix 7 - Utilities. If necessary, use the navigation arrows at the top of the 
page to scroll through the complete logs list . 

Viewing System Alerts from the ‘Messages’ Tab
Occasionally, the system may send alert messages to the System Administrator, informing you of a possible problem or 
error that may require some action on your part. You can view these messages from:
• Welcome Home page’s Inbox Messages list (listed individually)
• The Messages tab (grouped by type). 

If, for example, you have fifty different 404 errors, all 404 errors would show up on the Messages tab as one entry with the 
number 50 in the Quantity column . Any unique information associated with these errors (e .g ., the system path for the video 
file that threw the error) is masked out by brackets; therefore you lose any message-specific information. 
In contrast, on the Welcome Home page’s Inbox Messages list, you would see all fifty 404 errors, including the actual paths 
to the videos that caused the errors . The messages on the Welcome Home page may be mixed in with other non-urgent 
messages, such as burn requests.
As a System Administrator, you may want to review the combined system messages on the Messages tab first, and then 
review individual messages on the Welcome Home page if more information is required .
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To view the system alerts:
1 . Go to Administration > System Status > Messages . Any alert messages for the System Administrator are displayed . 

The columns on this page are described in the corresponding table in Appendix 7 - Utilities. 

2 . After you have resolved the issue associated with an alert message, click the cross icon  in the appropriate row to 
delete all messages related to that issue .

Managing Precinct and Agency Information and Communication

Adding, Registering, Updating and Deleting Agency or Precinct Records
During installation, your System Implementation Specialist (SIS) will enter your Precinct information into your DES 
application . For DEA users, the SIS will enter one record for your Agency server and one record for each of your Precinct 
servers . (These are called Precinct records even though they include one Agency record .) By default, the system prints some 
of this information on your archive DVDs, including your precinct’s name and phone number. This section describes how to 
manage your precinct and agency information .
Depending on the application you are using, you can perform the following administrative tasks:
• DEA Agency users can add, register, update and delete precinct records . 
• DEA Agency users can also updated the agency record .
• Users of all other DES applications can update precinct records .

To add, register, and delete precinct records and to update agency or precinct records:
1 . Go to Administration > System Setup > Precinct > Precinct Info. The columns on this screen are described in the 

corresponding table in Appendix 7 - Utilities. 
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2 . Perform one of the following tasks: 

To... Do this...

Add a new record for a 
remote Precinct server

1 . Go to the Action menu and click New . The New Precinct form is displayed . The 
fields on this form are described in the corresponding table in Appendix 7 - Utilities.

2 . Enter the relevant information in the precinct data fields, and then click Save . The 
system adds the new record to your Precinct list .

Register a new Precinct 
server to establish its 
communication with the 
Agency server

1 . Click the precinct record you wish to register. If you have a large number of 
precincts, use the navigation arrows at the top of the page to scroll through the list .

2 . Go to the Action menu and click Register .

Update a record for the 
Agency server or for a 
remote Precinct server

1 . Right-click the Agency record or a Precinct record you want to update, and then 
select Edit from the pop-up menu .  

 TIP: Identifying the Agency record

To identify the Agency record, look for the word “Local” in the FTP IP Address, 
Last Comm Date, and Status fields.

 
The Edit Precinct pop-up is displayed. The fields on this form are described in the 
corresponding table in Appendix 7 - Utilities. 

2 . Enter your changes in the appropriate field(s) of the Precinct Data section, and 
then click Save .

Delete a Precinct server 
record before it has been 
registered

1 . Right-click a precinct record you want to delete, and then select Delete from the 
pop-up menu. A confirmation message is  displayed.

2 . Click Yes . The selected record is removed from the Precinct list .

Managing the Precinct and Agency Server Communication
Every day, automatic communication occurs between the Agency server and the various Precinct servers. Videos, cases, 
system settings, and other system data all transmit to and from the various servers on a continual basis. However, different 
types of data transmit at variable times and speeds. For example, because video transfers require a lot of bandwidth, those 
transfers occur during night processing . Other data transfers, such as that of video metadata, occur much faster . To speed 
up the communication between a Precinct server and the Agency server, you have the option of performing a manual 
synchronization .



© Safe Fleet | September 2021 | All rights reserved

Digital Evidence Series Administrator's Guide

263 Part # 700-8006 R3

About Utilities

A “data flush” is a system maintenance procedure that is used to help correct a synchronization problem that sometimes 
occurs during server-to-server communications. Perform this task whenever you’re looking for, but cannot find, a video on 
the Agency server 24 hours or more after it was ingested into a Precinct server (see HINT below). 
This section describes how to perform a data flush and manually synchronize the servers to improve communication 
between them.

 NOTE: DEA Agency users only

The workflow described in this section applies only to users of the DEA Agency application.

To improve communication between the servers:
1 . Follow step 1 of the Adding, Registering, Updating and Deleting Agency or Precinct Records procedure . 
2 . Perform one or more of the following tasks: 

To... Do this...

Perform a data 
flush

1 . Click the precinct to which the missing video was downloaded. If you have a large number of 
precincts, use the navigation arrows at the top of the page to scroll through the list .

2 . Go to the Action menu and click Flush . The Flush Precinct Options pop-up is displayed . 
 

3 . To flush data for all dates since this precinct was first registered, select the Flush Everything 
checkbox. 
– OR – 
To flush data for a specific date range, select the beginning of that date range.

4 . Click Flush Now. A confirmation message is displayed.
5 . Wait 5 minutes, then check to see if the missing video is now accessible on your Agency 

server. If the video is not accessible, contact Mobile-Vision Support for assistance.

Manually 
synchronize 
servers

1 . Click the precinct you wish to synchronize with. If you have a large number of precincts, use 
the navigation arrows at the top of the page to scroll through the list .

2 . Go to the Action menu and click Synchronize. A confirmation message displays, stating that 
synchronization has started. Once the data transfer is complete, a notification message will 
be displayed in your Inbox.

Forwarding System Messages to Your Regular Mailbox

 NOTE: DEV users

The workflow described in this section does not apply to users of the DEV application.

By default, system messages are displayed in the Inbox Messages section of the Message Board, located on the Welcome 
Home page. However, if your precinct has its own SMTP mail server, you can configure the system so that your Inbox 
Messages are also copied to your regular email accounts, as described in this section.
To configure system message forwarding:
1 . Follow step 1 of the Adding, Registering, Updating and Deleting Agency or Precinct Records procedure . 
2 . Right-click the desired precinct record, then select Edit from the pop-up menu . The Edit Precinct pop-up is displayed . 

The fields on this form are described in the corresponding table in Appendix 7 - Utilities.
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3 . Enter the following information in the appropriate fields of the Mail Server section:
• User ID that has send-mail privileges in your mail system in the Mail Server Login field
• Security password for the Mail Server Login in the Mail Server Password field
• Email address to be displayed in the messages’ From field in the Sender Address field
• The name of the SMPT email host in the SMTP Host field
• Port number of the SMPT email host in the SMTP Port field

4 . Click Save .

Changing the Application Appearance
This section describes how to change the following attributes:
• The graphics file that is displayed in the upper left corner of your DES application. You may, for example, want to replace 

the default logo with your agency’s logo
• The application’s color scheme.

To change the application appearance:
1 . Go to Administration > System Setup > Precinct > Logos. If you previously uploaded any graphics files to your DES 

application, a thumbnail image of those file(s) will be displayed on-screen. Otherwise just the Mobile-Vision logo will be 
displayed . 

2 . Click the Choose File button beside the Logo File field, and then navigate to the disk drive location where the graphics 
file is located.

This workflow continues on the next page.
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3 . Double-click the graphics file you wish to upload, and then click Install. A thumbnail image of the graphic is displayed in 
the space above the Logo File field. 

4 . Click the thumbnail image of the graphic you wish to display. That graphic will appear in the upper left corner on every 
page of your DES application, not just on the Welcome Home page .

5 . To change the color scheme, select a new value from the Select Color Scheme drop-down list . The new color scheme 
will immediately take effect. 
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Managing Storage Devices
The Storage tab lists the settings that your DES application uses to determine where data is stored on the server and how to 
interact with client workstations. It also may contain information on additional storage devices, such as a RAID unit. RAID is 
an acronym for Redundant Array of Independent Disks—a storage device that contains multiple disk drive components.
Storage server data is configured by your System Implementation Specialist (SIS) during implementation. You do not need 
to modify this data unless the disk resources available to the server have changed.

 WARNING: Modifying storage device record

Do not modify any of the field values on a Storage Device record without the assistance of your agency’s network 
specialist OR a Mobile-Vision Technical Support Engineer. Entering incorrect data could have dire consequences. Some 
of your video could become inaccessible, wireless transmission could fail, and/or data could be permanently lost.

You can perform the following tasks:
• Add a new storage device . Your System Implementation Specialist (SIS) or Technical Support Engineer (TSE) may 

instruct you to perform this task when your agency acquires a new RAID storage unit or a hard drive.
• Change an existing storage device . Storage device records contain the settings that your DES application uses to 

determine where data is stored on the server and how to interact with client workstations. Storage device records also 
contain information on RAID units. Because storage server data is configured by your System Implementation Specialist 
(SIS) during implementation, you do not need to modify this data unless the disk resources available to the server have 
changed .

• Delete an existing storage device. Only perform this procedure when instructed to do so by a Mobile-Vision Technical 
Support Engineer .

To add, change, or delete a storage device:
1 . Go to Administration > System Setup > System > Storage . 

This workflow continues on the next page.
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2 . Perform one of the following tasks: 

To... Do this...

Add a new 
storage device

1 . Go to the Action menu and click New . The New Storage pop-up is displayed. The fields on this 
form are described in the corresponding table in Appendix 7 - Utilities. 

                       
2 . Enter the following information in the appropriate fields of the form:

• The top level path to data storage (/fbdata/xx) in the Internal Path field.
• The path by which the video files will be served (\exportxx\) in the External Media UNC 

field (if applicable)
• The path by which thumbnail images and user media will be served in the External Case 

URI field (if applicable)
• The FTP user account for this storage device in the FTP Username field
• The FTP password for this storage device in the FTP Password field
• The IP address for this storage device in the IP Address of RAID unit field (if applicable).

3 . If this storage device will not be immediately available to receive videos, select Disabled from 
the Status drop-down list . Otherwise, proceed to the next step .

4 . Click Save. A confirmation message is displayed at the top of your page.

Change an 
existing storage 
device

1 . Right-click the storage device you wish to view/edit, then select Edit from the pop-up menu . 
The Edit Storage pop-up is displayed. The fields on this form are described in the 
corresponding table in Appendix 7 - Utilities. 

             
2 . Enter your changes in the appropriate fields, and then click Save. A confirmation message is 

displayed at the top of the page .

 NOTE: Values 
must match!

The values entered on 
this form must match 
the actual configuration 
of the storage server .

 WARNING: Modifying  
storage device records

Do not modify any of the field 
values on this pop-up without 
the assistance of your agency’s 
network specialist OR a Mobile-
Vision Technical Support 
Engineer .

This table is continued on the next page.
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To... Do this...

Delete an existing 
storage device

1 . Right-click the storage device you wish to delete, and then select Delete from the pop-up 
menu. A confirmation pop-up is displayed. 

2 . Click Yes . The selected storage device is removed from the Storage list .

Changing the Online Lifecycle Settings
This section describes how to change the lifecycle settings for video, snapshot, and case files. These settings determine 
how long various files will stay online, when/if files will be purged, and when/if files can be restored to the server.
To change the lifecycle settings:
1 . Go to Administration > System Setup > System > Life-Cycle . 

2 . Go to the Action menu and click Edit . The Life-Cycle form is displayed. The fields on this form are described in the 
corresponding table in Appendix 7 - Utilities. 

                                           
3 . To change any of the online lifecycle settings, enter/select your changes in the appropriate field(s), and then click Save .

 NOTE: Life-Cycle form options

Depending on the application you are 
using, the options available on this 
form may be different.
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Activating a New Module
This section describes how to activate a software module, such as the Interview Room module, within your DES application.

 NOTE: About the Interview Room module
Interview Room allows you to set up an in-car DVR inside your precinct’s interview room(s) and record subject 
interviews. This module requires the purchase of additional equipment. If you’re interested in this add-on, contact your 
Mobile-Vision Sales Representative at 800-336-8475 before proceeding.

 
There are two procedures used to activate a new module:
• Procedure 1: Activating Interview Room via the Update Server function .
• Procedure 2: Activating Interview Room via the Modules Tab.

Typically, you would use Procedure 1. However, if there is a technical problem or security issue of some kind, your Mobile-
Vision Technical Support Engineer may instruct you to use Procedure 2 instead .

Procedure 1: Activating Interview Room via the Update Server
This section describes how to activate a new module via the Update Server function. After you perform this task, the system 
will automatically update the software license that is required to access Interview Room .
Please note that this procedure requires remote access to the Mobile-Vision update server. If this raises security concerns 
within your organization, you may wish to use Procedure 2 on page 269 instead .
Before performing this procedure, contact your Mobile-Vision Sales Representative.
To activate a new module:
1 . Go to Administration and click Update Server. 
2 . If a security pop-up is displayed, select the checkbox at the bottom of the pop-up, then click Allow . Next, select the 

checkbox at the bottom of the second pop-up, then click Run . The Update Server pop-up is displayed . 
3 . If our Service department provided you with an update CD, place that CD in your PC’s DVD/CD tray. Otherwise proceed 

to the next step .
4 . Click the Check for Update button. The system searches for the update. Once it’s discovered, the message Update 

Found is displayed in the Status field.
5 . Click Continue. The system begins updating the system. When the update is complete, the system logs you out of the 

application .
6 . Restart your browser, and then log back in to your DES application. If you encounter any problems or error messages, 

your Technical Support Engineer may instruct you to perform Procedure 2, as described in the next section.

Procedure 2: Activating Interview Room via the Modules Tab
This section describes how to activate a new module via the Modules tab.
Only use Procedure 2 when one of the following conditions applies:

• You already tried Procedure 1 and it resulted in an error message .
• Procedure 1 raises security concerns within your organization since it requires remote access to the Mobile-Vision 

update server .
• Your Mobile-Vision Technical Support Engineer instructed you to use Procedure 2.

To activate a new module:
1 . Call Mobile-Vision Technical Support at 800-336-8475 and ask the Technical Support Engineer to create and email a 

new license file for Interview Room.
2 . After you receive the email attachment, place the new license file on your PC’s desktop.
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3 . Go to Administration > System Setup > Modules . 

4 . Click the Choose File button, and then navigate to your desktop where the installation file resides.
5 . Double-click the installation file. The file name is displayed in the DES License File field.
6 . Click Install. The system begins installing Interview Room. When the installation is complete, a confirmation message 

will be displayed.
7 . Log out of your DES application and restart your browser.
8 . Log back in to your DES application.

Viewing/Printing Software Release Notes
This section describes how to view and/or print the technical release notes for the current software release.
To view and print the release notes:
1 . Go to Administration > System Status, and then click the link beside the Version field at the bottom of the page. The 

system downloads the release notes to your PC’s Downloads folder . 
2 . Navigate to your Downloads folder, and then double-click the DES technical release notes.html file. The release notes 

are displayed in a separate window . 

3 . To print the release notes, press Ctrl + P . The Print form is displayed . 
4 . Select your print options, then click Print. The print job is directed to your active printer.
5 . When you are finished viewing/printing the release notes, click the cross icon in the upper right corner of the page.
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Accessing Product Manuals & Training Videos
This section describes how to access Mobile-Vision’s product manuals and training videos via links to our Online Support 
Center .
To access training materials:
1 . Go to Administration > System Status > Tools. The video and documentation links are listed in the System 

Documentation section . 

 
2 . To view a list of training videos, click Online Training Videos . 

– OR – 
To view a list of manuals and quick reference guides, click Online Product Documentation List . 
The corresponding Safe Fleet Community login page opens . 

3 . Log in with customer credentials provided to you by the MVI Support team.
4 . Navigate to the desired video or document .

Updating Your DES Application
If your agency has an up-to-date Extended Maintenance Agreement (EMA) and your hardware/software configuration 
meets our system requirements, you qualify for software upgrades whenever one is available. This section describes how to 
update your DES application after you receive an upgrade notification in your Inbox (“There is an update available for your 
Server…”) .
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The following procedure requires that your server has Internet access to our Auto Update server . If you do not have 
direct access to our update server or your agency does not allow direct access to our server for security reasons, please 
contact Mobile-Vision Service at 973-263-1090. A Technical Support Engineer will provide you with an alternate method for 
upgrading your software .

 NOTE: Windows users

This procedure is for Windows 10 users . If you have an earlier version of Windows, these steps may differ slightly . 

    

 NOTE: Session timeout setting

Depending on the size of the update and speed 
of your network connection, the update process 
may take up to an hour. 
Before you begin an update, make sure that 
your user type has a session timeout setting of 
at least 60 minutes to prevent you from being 
logged out during the update process .
For instructions on changing this setting, see 
Managing User Roles and Permissions on page 
250.

To update your DES application:
1 . Make sure the Welcome Home page is displayed, then go to your Inbox Messages list and click the arrow icon to the 

right of the upgrade notification message ("There is an update available for your Server…") . 
– OR – 
Go to Administration and click Update Server .

2 . If a security pop-up is displayed, select the checkbox at the bottom of the pop-up, then click Allow . Next, select the 
checkbox at the bottom of the second pop-up, then click Run . The Update Server pop-up is displayed .

3 . Click the Check for Update button. The system searches for a new update.
4 . Perform one of the following tasks: 

If... Then...

An update is  not available The message No Update Found is displayed in the Status field. 
• Click the cross icon in the upper corner of the page to exit. End of procedure.

An update is available The message Update Found is displayed in the Status field. 
• Proceed to the next step .

5 . To review the release notes before beginning the update, click the Release Notes button. Otherwise proceed to the next 
step .

6 . Click Continue to begin the update. When the update is complete, the system will log you out of the application.
7 . Log in to your DES application again . NOTE: DEF users - End of procedure . Once the Welcome Home page is displayed, 

look for a new message in your Inbox that says: “A Required update is needed for the Backup Workstation...” . See the 
screenshot on the next page . 

Make 
sure that 
this field 

is set 
to 60 or 
higher .
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If you see the update message pictured above, it means that you have to update your backup PC(s) in order for the new 
DES update to work properly. Proceed to the next step. 

8 . Follow steps 1 - 10 of the Updating the Backup PC Software procedure . If you have more than one backup PC, repeat 
this procedure for each of them .

Downloading Support Logs
This section describes how to download the logs that are used by Mobile-Vision’s Technical Support Engineers to 
troubleshoot technical problems. This procedure is only used by those customers who have no remote access whatsoever 
(i.e., your agency is unable or unwilling to allow remote our technical staff access to the server). Perform this task when 
instructed to do so by a Technical Support Engineer.

 NOTE: Windows users

This procedure is for Windows 10 users . If you have an earlier version of Windows, these steps may differ slightly . 

To download support logs:
1 . Go to Administration > System Status > Tools, and then click the Download Support Logs button. The following 

message is displayed: 
Compressing logs. Please wait.

2 . After a delay of a few seconds to a few minutes, a Windows message is displayed . 
3 . Select Save As from the Save drop-down list . The Save As window is displayed .
4 . Navigate to the disk drive location where you wish to temporarily store the log file. (You will be emailing or uploading 

this file to Mobile-Vision.), and then click Save . The system copies the logs4u.mvi file to the selected location. When the 
process is complete, a confirmation message will be displayed.

5 . Click Open folder to display the file.
6 . Upload the file to Mobile-Vision, as per your Technical Service Engineer’s instructions.
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Managing Bookmarks
A bookmark is a link to a website. By default, your DES application comes with two bookmarks:
• Mobile-Vision. Takes you to the regular Mobile-Vision web site
• Online Support . Provides instructions on how to access our Safe Fleet Community .

These links are displayed under the Bookmarks column on the Main Menu .
If desired, you may wish to set up some agency-defined links as well. Doing so will provide you with quick and easy access 
to frequently used websites. You can display up to five links on the Main Menu .  
You can perform the following tasks:
• Add a new bookmark.
• Change or delete an existing bookmark.

To add, change, or delete a bookmark:
1 . Go to Administration > System Setup > Bookmarks. Your existing bookmarks are displayed. 

2 . Perform one of the following tasks: 

To... Do this...

Add a new 
bookmark

1 . Go to the Action menu and click New .  The New Bookmark form is displayed .

2 . Enter a descriptive name for the new bookmark in the Label field. This is the text that will be 
displayed in the Bookmarks column on the Main Menu .

3 . Enter the website’s web address in the URL field. The http:// portion of the URL is 
prepopulated for you, but you may need to insert an “s” if your web address begins with 
https:// .

4 . If you want this bookmark to be displayed in the Bookmarks column on the Main Menu, 
select the Visible checkbox. Otherwise proceed to the next step.

5 . Click Save. Your new bookmark is displayed on the Bookmarks list .

This table is continued on the next page.
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To... Do this...

Change an existing 
bookmark

1 . Go to the Action menu and click Edit . The Edit Bookmark form is displayed . 

2 . Enter/select your changes in the appropriate field(s), and then click Save .

Delete an existing 
bookmark

1 . Click the bookmark(s) you want to delete.
2 . Go to the Action menu and click Delete. A confirmation message is displayed. 

3 . Click Yes . The selected record(s) are removed from the Bookmarks list .

Configuring Search Results Display
Whenever you search for or display certain records (videos, cases, DVRs, etc.), a certain number of records will be displayed 
by default, such as six rows per page for videos. If desired, you may increase or decrease these defaults, as described in this 
section .
To configure the search results display:
1 . Go to Administration > System Setup > System > Other, then go to the Action menu and click Edit. The Other pop-up is 

displayed . 

2 . The rows per page settings are on the right side of the Other pop-up .
3 . Go to the right of the screen and enter the desired number of rows in the boxes provided. 
4 . Click Save .

Installing DHCP Server Software
This topic describes how to install DHCP Server Software on a 32-bit PC that is running Windows 7/8. Install this software 
on a PC that’s on the same network as your recording devices. This will provide those devices with IP addresses, If you are 
using multiple networks/subnets with your devices, install the software on one PC per network/subnet. 
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To install server software:
1 . Go to Administration > System Status > Tools, and then click the Win32 DHCP Server button. The following message is 

displayed: 

2 . Click Save File. The system copies the installation file to your PC’s Downloads folder .
3 . Navigate to your PC’s Downloads folder, and then double-click the DHCPSeverInstall file. A security warning is displayed. 

4 . Click Run, and then click Install in the displayed window.  The system begins installing the software. Once the 
installation is complete, a confirmation pop-up is displayed.

5 . Click Close .

Installing DES Client Software
This section describes how to install the PC software that is required to perform the following tasks:
• Play videos
• Use the media reader upload option
• Reactivate offline videos and cases
• Add media to cases
• Install product updates .

Install this software on each PC your officers use to access your DES application. 

This workflow continues on the next page.
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To install client software:
1 . Go to Administration > System Status > Tools, and then click the DES Client Software button. The following message is 

displayed: 

2 . Click Save File. The system copies the EXE installation file to your PC’s Downloads folder . 
3 . Navigate to your PC’s Downloads folder, and then double-click the launcher-1.0 file. A security warning is displayed. 

4 . Click Run . After a few seconds, the Launcher Setup pop-up is displayed .
5 . Click Next, then select the I accept the terms in the License Agreement checkbox in the displayed End-User License 

Agreement window, and click Next again . The Ready to Launch Installer pop-up is displayed .
6 . Click Install. The system begins installing the software. Once the installation is complete, a confirmation pop-up is 

displayed .
7 . Click Finish .
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Definitions
This section describes some of the key terms and concepts that are central to your DES application.

Hardware Components
This user guide focuses on the software component of the Mobile-Vision Digital Evidence System. However, our evidence 
collection system has several hardware components as well. These components interface with the DES software, so it’s 
important to understand what each hardware component is and how it relates to the evidence collection system as a whole .
DEP Server
The server is the network computer that hosts the DES application and stores all of your video and case data. Some larger 
agencies have more than one server . The DEP server is the “parent” server to which DEF forwards videos after they are 
ingested by DEF. 
Server PC
The server PC is the Windows computer that hosts the DEV application and stores all of your video data .
Agency Server
The Agency server is the network computer that hosts the DEA Agency application. The Agency server is the “server” side of 
the DEA client/server application . The Agency server does not ingest videos directly . Rather, the Precinct server(s) ingest the 
videos, then transmit them to the Agency server during night processing .
Precinct Server
The Precinct server is the network computer that hosts the DEA Precinct application, which ingests video evidence from 
the in-field DVRs. The Precinct servers are the “client” side of the DEA client/server application. During night processing, the 
Precinct servers transmit all newly recorded videos to the Agency server .
DEF Server
The DEF server is the network computer that hosts the DEF application and stores all of your video data.
In-Car DVRs
Flashback and FOCUS H1 DVRs are the digital video recorders that are installed inside your precinct’s patrol cars and/or 
interview room(s). These recorders collect video evidence and store it temporarily on a storage card until the video can be 
transmitted to the storage server . 
Body-Worn DVRs
A body-worn DVR is a small, wearable digital video recorder sold by Mobile-Vision. This device allows you to capture both 
high definition videos and JPG “snapshot” images, then upload them to the server via a docking station. Videos recorded 
using this device are assigned the category of Body Worn . .
Backup PC
A backup PC is a computer used to process DVD burn requests. Because the process of burning DVDs is resource-intensive, 
one PC is dedicated to this task. If you are using a Bravo robotic DVD burner, then the backup PC is a separate computer 
workstation connected to the disc burner. If you are using a Rimage DVD/Blu-ray burner that combines a disc burner with a 
computer, the backup PC refers to the computer component of the Rimage.
Robotic DVD Burner
A robotic DVD burner is a disc duplicator that burns and labels your Certified Backup Discs and User-Requested Certified 
Copies (see definitions below). Mobile-Vision sells two types of burners: the Bravo, a standalone unit, and the Rimage, a 
combination disc burner/computer. If you have a Rimage, you do not need a separate Backup PC.
Rimage units can burn CDs, DVDs, and Blu-ray discs. Most Bravo units can burn CDs and DVDs. The higher end Bravos can 
burn Blu-ray discs as well.
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Certified Backup Disc (CBD)
A Certified Backup Disc or “CBD” for short is an archive DVD used to restore videos and/or case files to the server. The 
system automatically sends CBD burn requests to the Backup PC without any action on your part. The number and type 
of files burned to CBD is determined by your system settings. Factors such as a file’s age, type, category, etc., all help 
determine what the system will back up. You define these backup parameters through DEP. 
If a video file is supposed to be backed up, the system will add it to an archive job shortly after the video transmits to the 
server (for more information, see Transmission on the next page). Once there are enough files to fill up an archive disc, the 
system automatically generates a CBD .
All CBDs are printed with an identification number that makes it easy for you to restore the files at a later date, should the 
need arise (permissions required) .
User-Requested Certified Copy
A DVD that you can, with the proper permissions, create yourself using either the robotic DVD burner or your PC’s DVD 
burner. Also referred to as an export disc. You create these discs as needed for evidential and/or backup purposes. For 
more on the different types of DVDs and how they are created, see Chapter 4. Evidence Backup and Sharing.
Access Point
An access point is a device used to transmit videos from your in-car DVRs to the storage server . This device is connected to 
a wireless network antenna mounted on the outside of the building that houses your server.
Some precincts have more than one access point to accommodate multiple vehicles that park in different areas outside the 
building.
Some smaller agencies do not use Access Points, as they download all their videos manually .

Transmission
Transmission refers to the process of transferring video files from your in-car DVR to the storage server. This transmission 
can occur either automatically (typical) or manually:
• Automatic transmission . Whenever a vehicle comes within approximately 300 feet of an access point, it triggers an 

automatic transmission . During this transmission, all videos that are currently stored on the DVR will wirelessly transfer 
to the storage server via the access point .

• Manual transmission. Each in-car DVR holds a temporary storage device called an SD card (Flashback3/FlashbackHD 
and FOCUS H1) or CF card (Flashback2). This card is used to temporarily store an officer’s videos until they can be 
transferred to the server. If necessary, an officer can use this card to manually transfer videos to their PC, assuming he 
has the proper permissions. An officer would typically use this procedure if he can’t wait for an automatic file transfer to 
occur, or a problem has occurred that interfered with the wireless file transfer. For more information, see Uploading and 
Downloading Videos on page 60.

Software Concepts
Automatic Archive
An automatic archive is a backup process that is triggered by the system based on predefined rules that you set in the 
application. When a video’s category is set to Backup Enabled and that video has been online for at least five minutes, 
the system will automatically back that video up during the next archive session. Once there are enough files to fill up an 
archive disc, the robotic DVD burner will burn a Certified Backup Disc. Aside from the initial system configuration, automatic 
archives do not require any action on your part .
Export
An export is the system process used to copy video, case files, and/or body-worn snapshots for the purpose of either 
burning them to DVD or downloading them to your PC.
Case
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A case is a record that contains data which pertains to one incident, such as a motor vehicle accident . Your DES 
application’s case feature allows you to conveniently gather all of an incident’s evidence in one record, allowing for easy 
viewing and archiving of evidence. A case may contain one or more videos, media files (such as photographs), subject 
names, comments, and/or general information relating to the incident, such as the incident date .
User Metadata (UMD)
User Metadata or “UMD” refers to custom data fields that you can link to a video. You define these fields through the 
application. Their purpose is to allow officers to annotate their videos with custom data, such as a subject description. If 
an officer has a mobile data computer with the UMD Editor installed on it, he has the option of attaching UMD to a video 
immediately after it is finished recording. Otherwise, he can attach UMD back at the precinct when he connects to the 
server . For more information, see Editing Media Files on page 42.
Reactivation
Reactivation is the process used to restore a video or case file that the system took offline after it was backed up to disc. 
There is a limited time period in which you can reactivate an archived video or case . This time period depends on the system 
settings chosen by your System Administrator. You must have the proper permissions to reactivate files.
Offline Files
If the status of a video or case is “offline,” it indicates that some, but not all, of that record’s data or functions are available on 
the server .
If a video is offline, you will be able to view that video’s thumbnail image and statistics (category, duration, record reason, 
etc.), but not the video itself. Also, you cannot export an offline video.
If a case is offline, you will be able to view the case record, but not its attached videos. Also, you cannot export an offline 
case .
You can, in some cases, reactivate an offline file. For more information, see Restoring Offline Videos on page 53 and 
Reactivating Offline Cases on page 108. .

License Agreements

Mobile-Vision End-User License Agreement
IMPORTANT-READ CAREFULLY: This License AGREEMENT (the "AGREEMENT") is a legal AGREEMENT between you 
(either an individual or single entity, including, but not limited to a Corporation, LLC, LLP, Partnership, Sole Proprietorship) 
("LICENSEE") and Mobile-Vision, Inc. ("LICENSOR").

By accepting delivery of the Mobile-Vision software you are agreeing to become bound by the terms of this agreement, 
which includes the software license, maintenance terms and software disclaimer of warranty . If licensee does not agree to 
these terms and conditions, do not accept delivery, copy, or use the software . This limited warranty does not cover any other 
system components sold or installed by Mobile-Vision, Inc. Please refer to applicable warranty documents for coverage 
details on related Mobile-Vision products.

Software License
The SOFTWARE is protected by copyright laws and international copyright treaties, as well as other intellectual property and 
trade-secret laws and treaties. The SOFTWARE is being licensed, not sold.

GRANT OF LICENSE. This License AGREEMENT grants Licensee the following non-exclusive rights:
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1 . In consideration of payment of the LICENSE fee, LICENSOR grants to you, the LICENSEE, a non-exclusive right 
to use and display this copy of the software program in object code form only (hereinafter called the SOFTWARE) as per 
the usage limitations specified by the invoice at a single location. LICENSOR reserves all rights not expressly granted to 
LICENSEE .
2 . As the LICENSEE, you own the magnetic or other physical media, on which the SOFTWARE is originally or 
subsequently recorded or fixed, but LICENSOR retains title and ownership of the SOFTWARE recorded on the original disk 
copy or copies, and all subsequent copies of the SOFTWARE, regardless of the form or media in or on which the original or 
other copies may exist . THIS LICENSE IS NOT A SALE OF THE ORIGINAL SOFTWARE OR ANY COPY OR COPIES OF IT .
3. Certain SOFTWARE licensed by LICENSOR to LICENSEE requires that LICENSEE must purchase one named 
user of SOFTWARE for each Digital Video Recorder, per physical location . Where named users are not utilized, the total 
number of licensed Digital Video Recorders cannot exceed the total number of licensed users of SOFTWARE per physical 
location. Non-compliance of this license restriction is strictly forbidden and shall be considered a material breach of this 
AGREEMENT and among all other remedies available to LICENSOR, including but not limited to immediate payment to 
LICENSOR for all license fees due and owing to LICENSOR, shall cause this AGREEMENT to immediately terminate in 
accordance with the TERMINATION provisions stated in this AGREEMENT .
4 . This SOFTWARE and the accompanying written materials are copyrighted . Unauthorized copying of the 
SOFTWARE, including SOFTWARE that has been modified, merged, or included with other software, or of the written 
materials, is expressly forbidden. You may be held legally responsible for any copyright infringement that is caused or 
encouraged by your failure to abide by the terms of this license. Subject to these restrictions, and if the SOFTWARE is not 
copy-protected, you may make one (1) copy of the SOFTWARE, solely for backup purposes. You must reproduce and include 
the copyright notice on the backup copy. The SOFTWARE is licensed as a single product. Its component parts may not be 
separated for use on more than one computer .
5 . As the LICENSEE, you may not physically transfer the SOFTWARE from one computer to another . The SOFTWARE is 
licensed for one computer only . You may not electronically transfer the SOFTWARE from one computer to another over an 
internal or external network of any kind. You may not distribute copies of the SOFTWARE or accompanying written materials 
to others or modify, adapt, translate, reverse engineer, decompile, disassemble or create derivative works based on the 
written materials accompanying the SOFTWARE without the prior written consent of LICENSOR .
6. LICENSEE may not use the SOFTWARE for the benefit of a third party, not rent, timeshare or use the SOFTWARE 
in service bureau processing. LICENSEE may not transfer, export, install or use the SOFTWARE without the prior written 
permission of LICENSOR .
7 . Without prejudice to any other rights, LICENSOR may terminate this License AGREEMENT if LICENSEE fails to 
comply with the terms and conditions of this License AGREEMENT . In such event, LICENSEE must destroy all copies of the 
SOFTWARE and all of its component parts .
8 . LICENSOR may create, from time to time, updated versions of the SOFTWARE . At its option LICENSOR will 
make such updates available to LICENSEE only if LICENSEE is covered under Annual Maintenance by paying the Annual 
Maintenance fee. Maintenance is mandatory for the first year and will be automatically invoiced to LICENSEE on an annual 
basis from the anniversary date of LICENSOR’S first maintenance invoice to LICENSEE. LICENSEE agrees to pay this 
fee, within the terms stated on the invoice, unless LICENSEE notifies LICENSOR in writing of its intention not to renew at 
least ninety (90) days in advance of being invoiced, or the anniversary date of the AGREEMENT, or purchase SOFTWARE. 
Should LICENSEE choose not to renew maintenance in any given year LICENSOR may terminate this License AGREEMENT 
pursuant to the provisions stated in this License Agreement. See the LICENSOR’S Maintenance Agreement for further 
details on Annual Maintenance . Should LICENSEE choose not to renew maintenance any given year, and then wishes to 
renew at a later date, and LICENSOR has elected not to terminate the License Agreement, LICENSEE shall be charged for 
all back maintenance, which was not renewed, plus the maintenance fee at current rate. In addition, 20% of the total sum of 
back maintenance and current maintenance fee may be added as a surcharge for an interruption in maintenance. A copy of 
the terms of the Annual Software Maintenance Agreement is included in this package.

Termination
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1 . Following termination of this Agreement for any reason, the LICENSEE shall pay LICENSOR all amounts due to 
LICENSOR within 15 days . Any amounts due LICENSOR which are not paid within this period shall accrue the highest 
applicable rates allowed by law up to 2% per month. LICENSEE SHALL BE SOLELY RESPONSIBLE TO REIMBURSE TO 
LICENSOR ALL FEES, INCLUDING, BUT NOT LIMITED TO, COLLECTION AGENCY, LICENSOR TIME AND EXPENSE, AND 
REASONABLE ATTORNEY FEES AND EXPENSES INCURRED BY LICENSOR IN THE COLLECTION OF ANY AMOUNTS NOT 
PAID TO LICENSOR UNDER THIS AGREEMENT .
2 . LICENSEE shall immediately discontinue all use of the SOFTWARE and shall remove SOFTWARE and any derivative 
works and/or computer code from LICENSEE’s computer systems. All copies of SOFTWARE must be destroyed, or returned 
to LICENSOR immediately at LICENSEE’s sole expense.
3. All of LICENSOR’S Proprietary Rights and the LICENSEE’S obligations regarding these Rights as detailed in this 
AGREEMENT shall survive the termination of this AGREEMENT .

Limited Warranty and Limitation of Liability
1. Limited Warranty. LICENSOR warrants that the SOFTWARE, when used in accordance with the procedures specified 
in the appropriate documentation (the “Documentation”), shall perform as specified therein.
2. Limited Warranty Term. This limited warranty as described in this Paragraph, shall be valid for any period during 
which LICENSEE has purchased and is a currently covered under maintenance services from LICENSOR for the SOFTWARE 
pursuant to terms and restrictions stated in LICENSOR’S maintenance agreement. This warranty shall apply only to the 
then-current release of the SOFTWARE for use on computer systems then recommended by LICENSOR. This limited 
warranty covers only the SOFTWARE installed by Mobile-Vision. This warranty does not cover defects or errors pertaining to 
customer supplied hardware up to and including operating systems and network configurations. This limited warranty does 
not cover any other components sold or installed by Mobile-Vision. 
3. Modifications Not Warranted. The limited warranty described in this Paragraph shall be limited in such a way that 
LICENSOR shall not be liable for any malfunction or error resulting from a modification made by any person or organization 
other than LICENSOR with or without the prior written explicit approval of LICENSOR . Should LICENSEE employ and/
or contract with any person and/or any business entity including but not limited to a third party individual, corporation, 
LLC, partnership, joint venture, sole proprietorships, not-for-profit organizations and/or former or current employees of 
LICENSOR, to work on and/or perform any services on, or with the Licensed SOFTWARE, LICENSOR can elect at its sole 
option to terminate this license AGREEMENT .
4. Limited Warranty Remedy. For a claim of breach of this limited warranty by the LICENSEE, LICENSEE’S sole 
and exclusive remedy, and LICENSOR’s sole and exclusive liability, will be for LICENSOR, at LICENSOR’s option, to either: 
(i) provide services to correct any inconsistencies between the SOFTWARE and the Documentation which cause the 
SOFTWARE to fail to conform to the limited warranty set forth in this Paragraph, which shall include LICENSOR’s right to 
add, modify, or delete portions of the SOFTWARE and/or the Documentation; or (ii) terminate the license, including all rights 
granted hereunder and refund the license fees, which shall be amortized over a five (5) year period from date of purchase.
5 . Disclaimer of Warranty . TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, EXCEPT AS OTHERWISE 
SET FORTH IN THIS AGREEMENT, THE SOFTWARE, DOCUMENTATION AND ANY SERVICES PROVIDED BY LICENSOR 
ARE PROVIDED “AS IS .” THE FOREGOING LIMITED WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES, EITHER ORAL OR 
WRITTEN, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR ANY PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT, EVEN IF LICENSOR OR ANY OF ITS 
PARENTS, AFFILIATES OR SUBSIDIARIES HAVE BEEN MADE AWARE OF SUCH PURPOSE, AND THE WARRANTY AGAINST 
INFRINGEMENT OF PATENTS OR OTHER INTELLECTUAL PROPERTY RIGHTS . 
6. Limitation of Liability. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL 
LICENSOR, ITS PARENTS, AFFILIATES AND SUBSIDIARIES OR THEIR DISTRIBUTORS BE LIABLE FOR ANY DAMAGES 
WHATSOEVER, INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS 
INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER PECUNIARY LOSS OR CONSEQUENTIAL, SPECIAL 
OR INCIDENTAL DAMAGES, ARISING OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE, EVEN IF LICENSOR 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES . NOTWITHSTANDING ANY DAMAGES THAT LICENSEE 
MAY INCUR FOR ANY REASON WHATSOEVER (INCLUDING, WITHOUT LIMITATION, ALL DAMAGES REFERENCED ABOVE 
AND ALL DIRECT OR GENERAL DAMAGES), THE ENTIRE LIABILITY OF LICENSOR AND ITS PARENTS, AFFILIATES AND 
SUBSIDIARIES UNDER ANY PROVISION OF THIS AGREEMENT AND LICENSEE'S EXCLUSIVE REMEDY FOR ALL OF THE 
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FOREGOING SHALL BE LIMITED TO AN AMOUNT EQUAL TO THE LICENSE FEES ACTUALLY PAID BY LICENSEE FOR THE 
SOFTWARE . THE FOREGOING LIMITATIONS, EXCLUSIONS AND DISCLAIMERS SHALL APPLY TO THE MAXIMUM EXTENT 
PERMITTED BY APPLICABLE LAW, EVEN IF ANY REMEDY FAILS ITS ESSENTIAL PURPOSE .
7. Miscellaneous. This License AGREEMENT is the entire AGREEMENT between LICENSEE and LICENSOR and 
supersedes any other communications, advertisements or understandings, whether oral or written, with respect to 
the SOFTWARE. This License AGREEMENT is not assignable by LICENSEE in whole or in part without the prior written 
permission of LICENSOR; LICENSOR may assign this License AGREEMENT or any obligation thereof. This License 
AGREEMENT may be amended only in writing, signed by both parties. The construction, interpretation and enforcement of 
this License AGREEMENT, as well as any and all tort claims arising from this License AGREEMENT or arising from any of 
the proposals, negotiations, communications or understandings regarding this License AGREEMENT, shall be governed by 
and construed in accordance with the laws of the State of New Jersey, applicable to contracts made entirely within New 
Jersey, without regard to the conflict of laws provisions thereto. The sole jurisdiction and venue for any litigation arising out 
of this License AGREEMENT shall be an appropriate federal or state court located in the State of New Jersey, except that 
LICENSOR may seek injunctive relief in any venue of its choosing. All remedies available to either party f
or breach of this License AGREEMENT are cumulative and may be exercised concurrently or separately, and the exercise 
of any one remedy shall not be deemed an election of such remedy to the exclusion of other remedies. The failure of either 
party at any time to require performance by the other party of any provision hereof shall not affect the full right to require 
such performance at any time thereafter, nor shall the waiver by either party of a breach of any provision hereof be taken 
or held to be a waiver of any succeeding breach of such provision or as a waiver of the provision itself. If any provision or 
portion thereof of this License AGREEMENT is found by a court of competent jurisdiction to be invalid or unenforceable, the 
License AGREEMENT shall be construed in all respects as if the invalid or unenforceable provision or portion thereof had 
been omitted and all other terms and conditions are fully enforceable, and in such case this License AGREEMENT may be 
modified, amended, and limited, reflecting the intentions of the parties, if and only if such changes are necessary to render 
the License AGREEMENT valid and enforceable. The headings or titles of the Paragraphs or Subparagraphs of this License 
AGREEMENT are for convenience only and shall not be used as an aid in construction of any provision hereof. If LICENSEE 
breaches this License AGREEMENT, LICENSOR shall be entitled, in addition to any other rights available at law or in equity, 
to immediate injunctive relief without any requirement to post a bond or other security. LICENSEE acknowledges and agrees 
that LICENSEE had a full and ample opportunity to consult legal counsel regarding this License AGREEMENT, has freely 
and voluntarily entered into this License AGREEMENT, has read, understood, agreed with and acknowledged each and every 
provision, including, but not limited to, LICENSEE’S rights, obligations, and applicable terms and conditions as set forth 
herein. The parties agree that the United Nations Convention on Contracts for the International Sale of Goods is specifically 
excluded from application to this License AGREEMENT . The SOFTWARE and documentation are provided with RESTRICTED 
RIGHTS. Use, duplication, or disclosure by the Government is subject to restrictions as set forth in the Rights in Technical 
Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer 
Software-Restricted Rights at 48 CFR 52.227-19, as applicable. Manufacturer Mobile-Vision, Inc, 400 Commons Way, Suite F, 
Rockaway, NJ 07866.

Third Party Software Licenses
For a list of third party software licenses, please click on the following link:
https://community.safefleet.net/mvi-third-party-software-licenses/

https://community.safefleet.net/mvi-third-party-software-licenses/
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Basic Search Media Information Form

Search field Limits your search to...

Date Videos that began recording on this date. Select this date from the calendar popup OR 
enter directly in mm/dd/yyyy format .

DVR Videos that were captured by this DVR unit. 

System ID Video in which the System ID is equal to this value . 

Officer Videos that are owned by this officer. 

Precinct Videos that originated from this Precinct .

Category Videos that fall within this category . 

Button Description

Search Execute your search .

Advanced Search/ Basic Search Toggle back and forth between the Basic Search form and the Advanced Search form .

Clear Remove all entries and selections from the search form . 

Advanced Search Media Information Form

Search field Limits your search to...

After Date Videos that began recording after this date. To search for a date range, use this field in combination 
with the Before Date field. Select this date from the calendar popup OR enter directly in mm/dd/
yyyy format .

Before Date Videos that began recording before this date. To search for a date range, use this field in 
combination with the After Date field. Select this date from the calendar popup OR enter directly in 
mm/dd/yyyy format .

DVR Videos that were captured by this DVR unit. 

DVR Type Videos that were captured by one of these DVR types:
• Vehicle . A DVR that is installed inside a vehicle, such as a police cruiser .
• Interview Room . A DVR that is installed inside an interview room . This type of DVR is used in 

conjunction with the optional Interview Room module .
• Body Worn. A BodyVISION, BWX-100, or FOCUS X2 body-worn DVR.
• VieVu. A VIEVU body-worn DVR.

System ID Video in which the System ID is equal to this value . 

Body Worn Mode Body-worn videos, body-worn snapshots, or both. This field will only be displayed if you select a 
DVR Type of Body Worn .

Category Videos that fall within this category . 

The table is continued on the next page.
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Search field Limits your search to...

Officer Videos that are owned by this officer. 

Precinct Videos that originated from this precinct .

Status Videos with a status of online or offline. If a video is online, it means that it is still stored on the  
server and you can play it directly off of the server. If a video is offline, it means that it has been 
purged from the server due to its age, category, and/or other system settings . You can still view 
that video’s thumbnail image and statistics (owner, category, duration, etc.), but not the video itself. 

Assigned to Case A checkbox that, when selected, limits your search to only videos assigned to a case.

Latitude Videos in which the latitudinal coordinate contains this text. Must be used in conjunction with the 
Longitude field. The Player Display GPS permission is required to search on this field.

Tagged Videos that are either tagged or not tagged . 

Longitude Videos in which the longitudinal coordinate contains this text. Must be used in conjunction with the 
Latitude field. The Player Display GPS permission is required to search on this field.

Record Trigger Videos with this record trigger . 

Incident # Videos in which the Incident number contains these digits.

Speed Greater Than Videos whose recorded maximum vehicle speed during a recording was greater than this value . 
The Player Display Speed permission is required to search on this field.

UMD Videos that contain this user metadata . 

Button Description

Search Execute your search .

Advanced Search/ 
Basic Search

Toggle back and forth between the Basic Search form and the Advanced Search form .

Clear Remove all entries and selections from the search form . 

Video Search Results Page

Navigation buttons*

Button Description

 Next Page/Previous Page . Used to scroll through the search results one page at a time .

 Fast forward/fast rewind . Used to scroll through the search results ten pages at a time .

 First Page/Last Page. Used to advance to the first page or last page of the search results, respectively.

* If the navigation buttons are grayed out, it indicates that there is only one page of search results.

Quick search fields

Search field Limits your search to...

Owner Those videos that are owned by a particular officer. 

DVR Name Those videos that were recorded by a specific DVR unit. 

The table is continued on the next page.
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Quick search fields

Search field Limits your search to...

DVR Type Those videos that were captured by a particular type of DVR:
• Vehicle . An in-car DVR that is installed inside a vehicle, such as a police cruiser .
• Interview Room . An in-car DVR that is installed inside a precinct interview room . This type of DVR 

is used in conjunction with the optional Interview Room module .
• VieVu. A VIEVU body-worn DVR.
• Body Worn . A BodyVISION, BWX-100, or FOCUS X2 body-worn DVR.

Category Those videos that fall within a selected category . 

Default video information

Column Description

Details The View Video Details icon . Used to display the Video Details page .

Play A thumbnail image of video. Used to launch the Flashback Player and watch the video (online videos 
only) or display a larger view of the body-worn DVR snapshot, if applicable.

Owner The name of the officer who owns this video. 

DVR Name The name of the DVR unit on which this video was recorded . 

DVR Type Limits your search to those videos that were captured by a particular type of DVR:
• Vehicle . An in-car DVR that is installed inside a vehicle, such as a police cruiser .
• Interview Room . An in-car DVR that is installed inside a precinct interview room . This type of DVR 

is used in conjunction with the optional Interview Room module .
• VieVu. A VIEVU body-worn DVR.
• Body Worn . A BodyVISION, BWX-100, or FOCUS X2 body-worn DVR.

Duration The video’s length, in minutes. If a line is displayed in this field rather than a number, it indicates that 
this record is a body-worn DVR snapshot.

Category The category assigned to this video . 

Video Start The date and time at which this video began recording. It is displayed in mm/dd/yyyy hh:mm format .

Notes Status icons used to provide details on each video .

 The video file has been tagged by a user. 

 The video file is online.

 The video file is offline and has not been backed up to an archive disc.

The video file is part online and part offline. This typically means that the video’s metadata has 
transferred from a Precinct server to the Agency server, but the video itself has not transferred yet. In this 
case, you will usually be able to view the video the following day after night processing has occurred.

 The video file has been burned to an archive disc.

 The video is being burned to an archive disk (burn job in progress)

 The video file belongs to a video group. 

 The video file is assigned to a case. 

 The video record includes one or more snapshot still images. Applies to body-worn videos only.
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Custom video information

If your agency has chosen to customize the Video list, some of the following columns may also appear .

Column Description

System ID The unique identification number that the system assigned to this video.

DVR Officer 
Name

The name of the officer who was logged into the DVR at the time this video was recorded. This person 
may or may not be the same as the video Owner. If no one was logged into the DVR at the time of the 
recording, the system will assign a default DVR Officer Name of *1 No name@[time at which default 
officer name was created].

Incident # The agency incident number associated with this video.

Ingest Date The date and time at which this video file transmitted to the server from the DVR unit. It is displayed in 
mm/dd/yyyy hh:mm format .

Record Trigger The event that caused your in-car DVR to start recording . 

Video End The date and time at which this video stopped recording . It is displayed in mm/dd/yyyy hh:mm format .

Available actions

Action Description

New Search Return to the Media Information pop-up and clear the search form .

Export Select videos to download and/or burn to DVD. 

Back to Video Display the Video Details of the last video you viewed or played . If you have not viewed or played a 
video since you logged on, this action will not be displayed.

Back to Case Display the Case Details of the last case you viewed . If you have not viewed a case since you logged 
on, this action will not be displayed.
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Video Details Page

Status tab
Field Description

System ID The unique identification number that the system assigned to this video.

Owner The name of the officer who owns this video. By default, the owner of a video file is the officer who was 
logged into the DVR unit during the recording .
If an owner name starts with *1, it means that it was auto-created by the system. There are two 
scenarios in which the system will auto-create an owner:
1 . An officer logs into a DVR using a User ID that does not reside on the server. After transmission 

occurs, the system recognizes that the User ID does not match any existing records in the 
database, and so it creates a new owner name using the following naming convention: *1 [DVR 
login name] @ [date/time]. This name will be displayed in the video’s Owner field. 
NOTE: When officers login to Flashback DVRs using a DVR Login Key, it eliminates the possibility 
of typos, thus reducing the number of *1 Owners that are auto-created by the system.

2 . The Record feature on the DVR is activated when no officer is logged into or assigned to the DVR. 
In this instance, the system will assign a default owner of *1 No Name@ [time at which default 
officer name was created] to any videos that were recorded during that session .

If necessary, you can reassign a *1 video to its proper owner.

DVR Officer 
Name

The name of the officer who was logged into or assigned to the DVR at the time this video was 
recorded. This person may or may not be the same as the video Owner. If no one was logged into or 
assigned to the DVR at the time of the recording, the system will assign a default DVR Officer Name of 
*1 No name@[time at which default officer name was created].

DVR Name The name of the DVR unit that recorded this video . In-car DVRs are typically associated with a vehicle, 
such as a police cruiser (e .g ., unit 146) . If your agency is using the Interview Room module, an in-car 
DVR may also be associated with an interview room.
For in-car DVRs, Vehicle or Interview Room will be displayed here. If the DVR is a VIEVU, VieVu will be 
displayed . If the DVR is a BodyVISION, BWX-100, or FOCUS X2, Body Worn will be displayed.
If the DVR is newly discovered  (a DVR that has been in communication with the server for the first 
time ) and has a name that is identical to an existing DVR on the server, the system will give the newly 
discovered DVR a suffix of @[DVR serial number]. When you see this naming convention, it means that 
there is a potential conflict between a new and existing DVR record. 
Some DVR records are entered by your SIS or System Administrator (typical), and some are created 
automatically by the system.

DVR Type The type of DVR that captured this video:
• Vehicle . An in-car DVR that is installed inside a vehicle, such as a police cruiser .
• Interview Room . An in-car DVR that is installed inside a precinct interview room . This type of DVR 

is used in conjunction with the optional Interview Room module .
• Body Worn . A BodyVISION, BWX-100, or FOCUS X2 body-worn DVR.
• VieVu. A VIEVU body-worn DVR.

The table is continued on the next page.
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Status tab
Field Description

Category The category assigned to this video. A video’s category determines the order in which it transmits 
to the server . Videos will transmit in the order in which they are listed on the Categories tab, as 
demonstrated here .

A video’s category also determines its online life. You or your System Administrator can assign a 
number of online days to each category. If an option called Strict Purger is selected, then after a video 
reaches its category’s predetermined age, the system will automatically purge that file from your 
DES application . If the Strict Purger option is not selected, the system will purge a video after two 
conditions are met: 1) the video reaches its category’s predetermined age, and 2) the server needs the 
extra disk space to store other, higher priority data. 
Most video categories are assigned by the officer immediately after a video is done recording. 
However, you can also assign categories back at the precinct after you’ve logged onto the server. The 
default video categories that you can assign to a video are: No Citation, Citation, Search, Arrest, Other 
1 – 5 . You or your System Administrator have the option of customizing these default category names 
to meet your agency’s needs.
The following categories are assigned automatically by the system:
• Background Mode . An in-car recording session occurred when the Background Mode option 

was set to ON . When Background Mode is ON, it means that the in-car DVR records continuously 
whenever the vehicle’s ignition is on, and for X number of minutes after the ignition is turned off, 
where X = the Ignition Timer setting .

• Power Failure . An in-car recording session was interrupted after a power failure occurred .
• Interrupted Recording. A recording session was interrupted because the storage card was full.
• Interview . The in-car video was captured using the optional Interview Room module, which is used 

to record interviews at your precinct .
• Body Worn. The video was captured using a BodyVISION, BWX-100, or FOCUS X2 body-worn DVR.
• VieVu. The video was captured using a VIEVU body-worn DVR.
• Firmware Upgrade. An officer requested an in-car DVR firmware upgrade in the middle of a 

recording session (highly unlikely scenario).
• Card Format. An officer began formatting the DVR’s storage card in the middle of a recording 

session (highly unlikely scenario).

The table is continued on the next page.
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Status tab
Field Description

Category 
(continued)

• Corrupt QBX. The system detected a possible file corruption in an in-car video (highly unlikely 
scenario) .

• Crash Battery Died. The CrashBat battery failed during an in-car recording session. The CrashBat 
is an optional piece of hardware used to trigger the RECORD function when a car crash occurs .

• Aggressive Driving . The optional “Aggressive Driving” add-on detected aggressive driving in the 
officer’s vehicle during an in-car recording session. The Aggressive Driving module includes both a 
hardware and firmware component. 

• Unknown . An in-car recording session was interrupted after an unrecognized event occurred, that 
is, an event that did not fall into any of the other system-assigned categories .

• Non Playable. A problem occurred during the recording process or video ingestion process that 
rendered the video unplayable.

• Purged. The system recharacterized a video as “restorable” after it reached the end of its online 
lifecycle . This occurs when the Enable Re-categorization of Media on Delete checkbox on the 
Life-Cycle tab is selected.

NOTE: System-assigned categories cannot be changed.

Incident # The agency incident number associated with this video, if applicable.

Ingest Date The date and time at which this video file was transmitted to the server from the DVR unit. It is 
displayed in mm/dd/yyyy hh:mm format .

Record Trigger The event that caused your in-car DVR to start recording . Record triggers include automatic and 
manual triggers . For descriptions of automatic triggers, refer to the relevant sections of Appendix 5 
DVRs. [cross-ref] Manual triggesr include:
• Microphone 1. An officer activated the Record switch on the wireless mic that’s plugged into the 

DVR's VLP 1 port. 
• Microphone 2. An officer activated the Record switch on the wireless mic that’s plugged into the 

DVR’s VLP 2 port. 

• Record button. An officer pressed the  button on the DVR's monitor, DVR, or Vehicle Viewer 
screen . 

Video Start The date and time at which the DVR began recording this video. It is displayed in mm/dd/yyyy hh:mm 
format .

Video End The date and time at which the DVR stopped recording this video . It is displayed in mm/dd/yyyy hh:mm 
format .

Duration 
(minutes)

The length of this video, rounded down to the nearest minute . If the word “Image” is displayed in this 
field, it indicates that this record is a body-worn snapshot.

Purge Date The date on which the video is scheduled to be removed (i.e., purged) from the server.

Maximum Speed The highest vehicle speed that was reached during this in-car recording . If you do not have the Display 
MAX Speed permission, this field will not be displayed.
If the video was recorded by a body-worn DVR, this field will not be displayed.

Assigned To 
Case(s)

The name of the case or cases that this video is assigned to, if applicable. 

The table is continued on the next page.
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Status tab
Field Description

Video Notation(s) The name of any video notations that are assigned to this video. Video notations are agency-defined 
checkboxes used to categorize videos.

Video group information (displayed only if the video is part of a Video Group)

Video Start The date and time at which the DVR began recording the first video in this group. It is displayed in mm/
dd/yyyy hh:mm format .

Video End The date and time at which the DVR stopped recording the last video in this group . It is displayed in 
mm/dd/yyyy hh:mm format .

Duration 
(minutes)

The length of this group, in minutes (i .e ., the sum of minutes for all the videos in the group) .

Total Number 
Videos

The total number of video files in this group.

Video Logs tab
Column Description

Date The date and time at which the action was performed on this video . It is displayed in mm/dd/yyyy 
hh:mm format .

User The name of the user who performed the action. If this column is blank, it indicates that the system 
performed this action .

Action A description of the action performed on this video .

IP Address The IP address of the device from which the activity was executed. For example, if an officer played the 
video on a PC with an IP address of 192.168.250.10, that number will be displayed here.

Group Detail tab
For burning purposes, videos cannot be any larger than one gigabyte in size. If an original video is too big, the system will 
automatically subdivide it into multiple video files. If you see a Group Detail tab on the Video Details page, it indicates that 
the system divided the original video file into two or more files.

Field Description

Owner The name of the officer who was logged into or assigned to the DVR that recorded the original full-
length video .

DVR Name The name of the DVR that recorded the original full-length video .

Category The video category assigned to the original full-length video .

Video Start The date and time at which the DVR began recording the original full-length video. It is displayed in 
mm/dd/yyyy hh:mm format .

Video End The date and time at which the DVR stopped recording the original full-length video . It is displayed in 
mm/dd/yyyy hh:mm format .

Duration 
(minutes)

The length of the original video, in minutes . This is the sum of all minutes for all videos in the group .
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Group Detail tab - Continuation Videos

Column Description

Details The Video Details icon . Used to display the Video Details page for this video segment .

Play A thumbnail image of the video segment. Used to launch the Flashback Player and watch this video 
segment .

Owner The name of the officer who owns this video. When the system divides the original video file into 
multiple files, it gives each file the same owner as the original file.

Video Number The sequence of this video segment in the total group . For example, 2 of 6 means that this is the 
second video in a group of six .

Duration The length of this video segment, in minutes .

Video Start The date and time at which this segment of the video began recording. It is displayed in mm/dd/yyyy 
hh:mm format .

Notes Status icons used to provide details on each video. When the system divides the original video file into 
multiple files, it gives each file the same status icons as the original.

Available video actions
These actions are available when the Status tab is open on the Video Details page . Depending on the DES application you 
are using, some or all of the actions may be available to you.

Action Description

Play Play the video .

Google Earth If you have the Google Earth application installed on your PC, this option will display an aerial view of a 
video’s route and its tracepoints, if applicable.
If you do not have Google Earth installed on your PC, this action will not be displayed. 

Edit Change the category, user metadata, and/or video notations saved with this video .

Available video actions
These actions are available when the Status tab is open on the Video Details page . Depending on the DES application you 
are using, some or all of the actions may be available to you.

Action Description

Tag Video/ 
Untag Video

Tag: Add extra days to the video’s online life. The specific number of days depends on your system 
settings . 
Untag: Remove the “tagged” flag from a video. 

Export Select videos to download and/or burn to DVD.

Add To Case Add this video to a new or existing case .

Request 
Activation 
(Offline videos 
only)

Submit a request to restore this video from a backup disc or external backup device to the server. After 
you click this option, your request will be displayed on the Inbox Messages list of all users who have 
reactivation privileges . 
This action will only be displayed if the video is offline.

The table is continued on the next page.
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Action Description

Reactivate Now 
(Offline videos 
only)

Restore this video from a backup disc or external backup device to the server.  
This action will only be displayed if the video is offline and you have the Reactivate Video permission .

Chain of Custody Generate a Chain of Custody report for this video .

Previous Results Return to the previous Video Search Results page .

Back to Case Return to the last case that you viewed . If you have not viewed a case since you logged on, this action 
will not be displayed.

Back to Video Return to the last video that you viewed . If you have not viewed a video since you logged on, this action 
will not be displayed.

Snapshots tab
Column Description

Play Thumbnail image of the snapshot. When you click on this image, the system will display the image in a 
larger format .

Owner The name of the officer who owns this snapshot. By default, this is the officer to whom the associated 
body-worn DVR was assigned to at the time the snapshot was captured. 

DVR Name The name of the body-worn DVR that captured this snapshot.

Category The video category that is assigned to this snapshot. The system automatically assigns all body-worn 
DVR snapshots a category of Body Worn .

Video Start The date and time at which the associated body-worn DVR captured this snapshot image. It is 
displayed in mm/dd/yyyy hh:mm:ss format .

Notes Status icons used to provide details on this snapshot .

Snapshots Details Page

Status tab
Field Description

System ID The unique identification number that the system assigned to this snapshot.

Owner The name of the officer who owns this snapshot.

DVR Officer 
Name

The name of the officer to whom the associated body-worn DVR was assigned to at the time this 
snapshot was captured .

DVR Name The name of the body-worn DVR from which this snapshot was captured.

DVR Type The type of DVR that captured this snapshot. Because snapshot images are captured from body-worn 
DVRs, the default value of the field will always be Body Worn .

Category The video category that is assigned to this snapshot. The system automatically assigns all body-worn 
DVR snapshots a category of Body Worn .

The table is continued on the next page.
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Field Description

Video Tagged A yes/no indicator that tells you whether or not this snapshot has been tagged. Tagging is a procedure 
used to add extra days to the online life of a media file.

Assigned to 
Case(s)

The name of the case or cases that this snapshot is assigned to, if applicable.

Incident # The agency incident number associated with this snapshot.

Ingest Date The date and time at which this snapshot was uploaded to the server . It is displayed in mm/dd/yyyy 
hh:mm format .

Record Trigger The manner in which this body-worn snapshot was captured. A snapshot image is captured by 
manually pressing the unit’s Snapshot/Tracepoint button. Therefore the value of this field will always 
be Manual Record .

Capture Date The date and time at which this snapshot was captured from a body-worn DVR while a recording was 
in progress . It is displayed in mm/dd/yyyy hh:mm format .

Video Notation(s) The name of any video notations that are assigned to this snapshot . Video notations are agency-
defined checkboxes used to categorize video and snapshot files.

Snapshot Logs tab
Column Description

Date The date and time at which the action was performed on this snapshot file. It is displayed in mm/dd/
yyyy hh:mm format .

User The name of the user who performed the action. If this column is blank, it indicates that the system 
performed this action .

Action A description of the action performed on this snapshot file.

IP Address The IP address of the device from which the activity was executed. For example, if an officer viewed 
the snapshot on a PC with an IP address of 192.168.250.10, that number will be displayed here.

Available snapshot actions
These actions are available when the Status tab is open on the Snapshot Details page .

Action Description

View Display the snapshot image in a larger format .

Edit Change the category, user metadata, and/or video notations saved with this snapshot .

Tag Snapshot/ 
Untag Snapshot

Tag: Add extra days to the snapshot’s online life. The specific number of days depends on your system 
settings .
Untag: Remove the “tagged” flag from a snapshot.

Export Submit a request to burn this snapshot to DVD or down-load it to your PC as a JPG file.  
If you prefer to export a snapshot to a PDF file, select the Export Image to PDF option instead .

Add to Case Add this snapshot to a new or existing case .

Chain of Custody Generate a Chain of Custody report for this snapshot .

The table is continued on the next page.
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Action Description

Export Image to 
PDF

Export this image to a PDF file.  
If you prefer to export a snapshot as a JPG file, select the Export option instead .

Previous Results Return to the previous Video Search Results page .

Assign Videos Page

Column Description

Video A thumbnail image of the video.

Owner The name of the officer who currently owns this video. 

Category The category assigned to this video . 

DVR Type The type of DVR that captured this video:
• Vehicle . A DVR that is installed inside a vehicle .
• Interview Room . A DVR that is installed inside an interview room . This type of DVR is used in 

conjunction with the optional Interview Room module .
• Body Worn . A BodyVISION, BWX-100, or FOCUS X2 body-worn DVR.
• VieVu. A VIEVU body-worn DVR.

DVR Name The name of the DVR that captured this video . 

Video Start The date and time at which this video began recording. Displays in mm/dd/yyyy hh:mm format .

Duration The video’s length, in minutes. If the word “Image” displays in this field, it indicates that this record is 
a body-worn DVR snapshot.

Available Actions

Action Description

Select All on Page Highlight the videos that are currently displayed on-screen .

Assign Selected Assign all selected (i.e., highlighted) videos to the officer shown in the Assign to Officer field.

Assign All # Videos Assign all the videos in your search results to the officer shown in the Assign to Officer field.

Deselect Deselect all videos that are currently selected. You can also click on a video to deselect it.

New UMD Type Form

Field Description

Unique ID The internal identification code for this field. This code does not display on the videos’ UMD tab. It is 
used for system tracking purposes only.

Label The field name that will display on the videos’ UMD tab.

The table is continued on the next page.
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Field Description

Mask The allowable entry for each character of the UMD field, as defined in the on-screen character 
descriptions. A mask allows the system to perform checks, or edits, on a particular field to make 
sure that the user enters the field in a predefined format. For example, you might use a mask of ##-
##-#### for a date field. 

Input Type The input type for this field: Single line text (default) or Text box . 

Max size The maximum number of characters that the user is allowed to enter in a single line text

Edit Video Category Form

Field Description

Priority A system-defined number that determines the order in which a video with this 
category will be transmitted from DVR to server. Videos will transmit in the order in 
which they are listed on the Categories tab.

Description
NOTE: DEF users should only change 
this field value in coordination with 
the DEP System Administrator . Field 
values should match on both servers.

A descriptive name for this category .

Day(s) Online The number of days that a video or snapshot with this category will remain online 
before it can be purged (i.e., moved offline) from the server. 
NOTE: Just because a file can be purged after a certain number of days doesn’t 
necessarily mean that it will be purged at that time. The exact purge date depends 
on other factors, such as the amount of storage space available on your server, 
and/or whether or not the Strict Purger setting is selected . 

Backup Enabled
NOTE: DEF users should not  change 
this field value unless instructed to do 
so by the DEF System Administrator

A system indicator that determines whether or not a video or snapshot with this 
category will be auto-archived: 
• ENABLED. Any video or snapshot with this category will be auto-archived, 

unless one of the following conditions applies: 1) the designated backup PC is 
disabled for some reason, or 2) the Backup Mode field on the Backup Options 
tab is set to NONE .

• DISABLED. Any video or snapshot with this category will not be auto-archived 
unless the Backup Mode field on the Backup Options tab is set to ALL.

The table is continued on the next page.
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Field Description

In Use
NOTE: DEF users should only change 
this field value in coordination with 
the DEP System Administrator . Field 
values should match on both servers.

A system indicator that determines whether or not this category is currently being 
used .
• Yes. This category is currently in use and can be assigned to a video or 

snapshot from the DVR (in-car videos only) or server .
• No. This category is not currently in use (i.e., it’s disabled) and cannot be 

assigned to a video or snapshot .

Auto Transfer Enabled • A system indicator that determines whether or not a video or snapshot with 
this category will automatically transfer to the DEA Agency server during the 
next server-to-server communication:

• ENABLED . Any video or snapshot with this category will transfer to the DEA 
Agency server .

• DISABLED . Any video or snapshot with this category will not transfer to the 
DEA Agency server .

System-Assigned Video Categories

Category Description

Background Mode A recording session occurred when the Background Mode option was set to ON . When 
Background Mode is ON, it means that the in-car DVR records continuously whenever the 
vehicle’s ignition is on, and for X, where X = the Ignition Timer setting .

Power Failure An in-car recording session was interrupted after a power failure occurred .

Interrupted Recording A recording session was interrupted because the storage card was full.

Corrupt QBX The system detected a possible file corruption in an in-car video.

Video Playback Options

Method Description

Download and Play 
– No Cache (SMB)

Download the video file to the user’s PC via the SMB Internet protocol. Once the user exits the 
Flashback Player, the system will remove the video file from the user’s PC.

Download and Play 
– No Cache (HTTP)

Download the video file to the user’s PC via the HTTP Internet protocol. Once the user exits the 
Flashback Player, the system will remove the video file from the user’s PC.

Download and Play 
– No Cache (FTP)

Download the video file to the user’s PC via the FTP Internet protocol. Once the user exits the Flash-
back Player, the system will remove the video file from the user’s PC.

Download and 
Play – With Cache 
(SMB)

Download the video file to the user’s PC via the SMB Internet protocol. Once the user exits the 
Flashback Player, the system will leave the video file on the user’s PC for immediate playback later.

Download and 
Play – With Cache 
(HTTP)

Download the video file to the user’s PC via the HTTP Internet protocol. Once the user exits the 
Flashback Player, the system will leave the video file on the user’s PC for immediate playback later.

The table is continued on the next page.
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Method Description

Download and Play 
– With Cache (FTP)

Download the video file to the user’s PC via the FTP Internet protocol. Once the user exits the 
Flashback Player, the system will leave the video file on the user’s PC for immediate playback later.

Stream – No Cache 
(SMB)

Play the video file directly from the server via the SMB Internet protocol. In this option, the video file 
is not stored temporarily or permanently on the user’s PC. This method requires approximately 6MB 
of network bandwidth to provide smooth playback. System default.

Redaction Settings

Setting Description

Blur Level The degree to which you wish to blur the video or video segment you are exporting. By default, the 
system does not blur the video at all (Blur Level = None) . However, if you select any of the other 
settings (Low, Med, or High), the system will blur every frame of the video or video segment.

                                      
      Low                              Medium                             High

Enable Trimming A checkbox used to indicate whether you wish to export all of the video or a selected segment of the 
video .
    Export the entire full-length video
 Export a segment of the full-length video
If you select Enable Trimming, you will have to select a date/time range using Trim Start and Trim Stop 
fields.

Trim Start The beginning of the date/time range you wish to excerpt from the original full-length video. 

Trim Stop The end of the date/time range you wish to excerpt from the original full-length video . 

The table is continued on the next page.
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Flashback Player
Audio

VLP1 A checkbox used to mute () or unmute () the audio from the wireless microphone that’s connected 
to the Flashback’s VLP 1 port. 

VLP2 A checkbox used to mute () or unmute () the audio from the wireless microphone that’s connected 
to the Flashback’s VLP 2 port.

In-Car Audio A checkbox used to mute () or unmute () the audio from the in-car microphone .

Volume The volume control bar.

Audio On indicator. To turn all audio off, click this button.

Audio Off indicator. To turn all audio back on, click this button.

Audio

Audio Enabled indicator. Indicates that the audio channel was enabled at the DVR.

Audio Disabled indicator. Indicates that the audio channel was disabled at the DVR.

Audio Indeterminate indicator. Indicates that the audio channel status at the DVR (enabled or disabled) 
is indeterminate .

Triggers

As you watch a video, some of the boxes in the Triggers column may turn red, indicating when a particular trigger or 
triggers were engaged . A trigger is the event that causes a DVR to start recording . For example, if the siren is one of your 
triggers and the Siren box remains red for the first five minutes of the video, it indicates that the driver had his siren on 
during that 5-minute time period .

Lights This box turns red when the vehicle’s emergency lights were on during the course of the video.

Siren This box turns red when the vehicle’s siren was on during the course of the video.

Brakes If brakes are one of your “triggers”, this box turns red when the vehicle’s breaks were activated during 
the course of the video .
NOTE: Brakes are technically a display option rather than a trigger.

Aux 1 If the Auxiliary 1 device is one of your triggers (actual device may vary), this box turns red whenever the 
device is triggered. For example, if your Auxiliary 1 device is the CrashBat2 crash detector, this box will 
turn red at the point in the video when the CrashBat2’s G-force meter detected a crash.
If the Auxiliary 1 device is not one of your triggers, this box will remain blank during the entire video 
regardless of whether the device was triggered or not .

Aux 2 If the Auxiliary 2 device is one of your triggers (actual device may vary), this box turns red whenever the 
device is triggered. If the Auxiliary 2 device is not one of your triggers, this box will remain blank during 
the entire video regardless of whether the device was triggered or not .

Cameras

A control button used to switch to the viewpoint of Camera Channel 2, which includes the Backseat 
camera and/or Bullet camera(s) .

The table is continued on the next page.
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Cameras

A control button used to switch to the viewpoint of Camera Channel 1—typically the forward facing 
zoom camera .

Enable PIP A checkbox used to display () or hide () a “picture in picture” (PIP) . A PIP is a small video display for 
video captured from the opposite Camera Channel .

Large PIP A checkbox used to enlarge () or reduce () the size of the picture-in-picture (PIP) image .

Move the picture-in-picture (PIP) image to the upper left corner of the video display . 

Move the picture-in-picture (PIP) image to the upper right corner of the video display .

Move the picture-in-picture (PIP) image to the lower left corner of the video display .

Move the picture-in-picture (PIP) image to the lower right corner of the video display .

GPS

The GPS display indicates the exact speed and location of the vehicle during each segment of the video . The Player 
Display Speed permission is required to view the Speed field, and the Player Display GPS permission is required to view 
the Latitude, Longitude, and Heading fields.

Latitude The GPS latitude coordinate .

Longitude The GPS longitude coordinate .

Speed The vehicle’s speed, as determined by the GPS coordinates.

Heading The direction in which the vehicle is moving .

General

Cause The trigger event that started the recording (lights, siren, etc .)

Officer The name of the officer who was logged into the DVR at the time this video was recorded.

DVR Name The name of the DVR that recorded this video .

Radar

If your department is using the Radar interface module, the following fields will be populated.

Target The MPH or KPH reading that an officer obtained after the radar device was aimed at a speeding 
vehicle .

Patrol The MPH or KPH reading of the officer’s patrol car at the time a radar reading was obtained.

Lock The minimum MPH or KPH reading that the officer was looking for when the radar device was aimed 
at a speeding vehicle .

The table is continued on the next page.
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Flashback Player

Media Time

Current Time The time at which the video was recorded. This display changes constantly during playback to indicate 
the exact time of day that each video frame was recorded . It is displayed in hh:mm:ss format .

Available Time The amount of time remaining on the video . It is displayed in hh:mm:ss format .

Date/Time

Start The date and time at which the video began recording. It is displayed in yyyy-mm-dd hh:mm:ss format .

End The date and time at which the video stopped recording . It is displayed in yyyy-mm-dd hh:mm:ss 
format .

Play Controls

Go to beginning

Pause/Unpause

Play

Stop

Play Controls

Advance one frame at a time

Advance to a tracepoint. A tracepoint is a placemarker that an officer can add to a video while it’s 
recording .

Go to end
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Cases

New Case Form

Field Description

Owner The name of the case’s owner. By default, the owner is the person who creates the case (i.e., you), but 
you can change this name if desired . 

Visibility The visibility status for this case: private (default) or public. If you mark a case as private, it can only be 
viewed by the case’s owner and users who have edit permissions. If you mark a case as public, it can 
be viewed by any user. 

Restricted 
Viewing

A checkbox used to specify whether or not you want to make this a restricted case. A restricted case is 
one that can only be accessed by a specified list of users. 
 This is a restricted case
 This is not a restricted case

Display Name The case name . This is the name that will appear on the Case Search Results page after you search 
for the case. It is also the default label value for case DVDs.

Incident Date The date on which the incident occurred . The incident is the event that the case pertains to, such as 
a motor vehicle accident . Select this date from the calendar pop-up OR enter directly in mm/dd/yyyy 
format. Required field.

Case Number Your agency’s case number.

Citation Number The citation number associated with this case, if applicable.

Vehicle 
Registration #

The vehicle registration number associated with this case, if applicable.

Vehicle Plate # The vehicle license plate number associated with this case, if applicable.

Do Not Dispose A checkbox used to indicate whether or not you want the system to keep this case online even after 
the Auto Dispose Time has expired . Auto Dispose Time is a period of inactivity after which the system 
automatically changes a case’s status from online to offline (videos that are attached to the case will 
remain online as long as their categories allow) . If, for example, you set the Auto Dispose Time to 
90 days, then if that case has not been touched in 90 days, the system will automatically change the 
case’s status to offline. If you have ‘archiving’ enabled for your case files, the system will archive the 
case first. The default setting for Auto Dispose is 60 days. However, you may change this default.
 Keep this case’s status as online even after the Auto Dispose Time expires .
 Change this case’s status to offline after the Auto Dispose Time expires .

Notations User-defined checkboxes used to notate a case. Select all that apply.

Button Description

Save Save the new case record .

Reset Clear the New Case form and return the Owner and Visibility fields to their default values.

Cancel Exit the New Case form without saving your changes .
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Basic Search Form

Case/Subject Information

Search criterion Limits your search to...

Incident Date Cases that involve an incident that occurred on this date . Select this date from the calendar 
pop-up OR enter directly in mm/dd/yyyy format .

Citation Number Cases in which the Citation Number field contains this text.

Case Number Cases in which the Case Number field contains this text.

Case Display Name Cases in which the Display Name field contains this text.

Vehicle Registration # Cases in which the Vehicle Registration # field contains this text.

Owner Cases that are owned by a particular officer. 

Precinct The precinct or agency server from which this case record originated . 

First Name Cases in which the subject’s first name contains this text.

Last Name Cases in which the subject’s last name contains this text.

Advanced Search Form

Case/Subject Information

Search criterion Limits your search to...

Creation Date Cases that were created on this date . Select this date from the calendar pop-up OR enter directly in 
mm/dd/yyyy format .

After Incident Date Cases that involve an incident that occurred after this date. To search for a date range, use this field 
in combination with the Before Incident Date field. Select this date from the calendar pop-up OR enter 
directly in mm/dd/yyyy format .

Before Incident 
Date

Cases that occurred before this date. To search for a date range, use this field in combination with the 
After Incident Date field. Select this date from the calendar pop-up OR enter directly in mm/dd/yyyy 
format .

Citation Number Cases in which the Citation Number field contains this text.

Case Number Cases in which the Case Number field contains this text.

Case Display 
Name

Cases in which the Display Name field contains this text.

Vehicle 
Registration #

Cases in which the Vehicle Registration # field contains this text.

Owner Cases that are owned by a particular officer. 

Vehicle Plate # Cases in which the Vehicle Plate # field contains this text.

Comments Cases in which the comments entered on the Comments tab contain this text.

Notations Cases that are marked with a specific checkbox notation. 

The table is continued on the next page.
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Cases

Case/Subject Information

Search criterion Limits your search to...

Precinct The precinct or agency server from which this case record originated . 

First Name Cases in which the subject’s first name contains this text.

Last name Cases in which the subject’s last name contains this text.

Driver’s License # Cases in which the subject’s driver’s license number contains this text.

Race Cases that involve a subject of this race. Select this value from the Race drop-down list .

Gender Cases that involve a subject of this gender. Select this value from the Gender drop-down list .

Date of Birth Cases that involve a subject with this date of birth. Select this date from the calendar pop-up OR enter 
directly in mm/dd/yyyy format .

Case Search Results

Navigation buttons*

Button Description

 Next Page/Previous Page . Used to scroll through the search results one page at a time .

 Fast forward/fast rewind . Used to scroll through the search results ten pages at a time .

 First Page/Last Page. Used to advance to the first page or last page of the search results, respectively.

* If the navigation buttons are grayed out, it indicates that there is only one page of search results.

Case information

Column Description

Details View Case Details icon . Used to open the Case Details page .

Display Name The name of this case .

Case Number The agency-assigned ID number for this case.

Subject The name of the individual associated with this case. If there is more than one subject associated with 
this case, the word multiple will be displayed here.

Incident Date The date on which the case-related incident occurred (i .e ., car accident, crime, etc .) It is displayed in 
mm/dd/yyyy format .

Status The current status of this case: online (green bar), or permanently offline (red bar).

Available actions

Action Description

New Case Display the New Case form used to enter a new case .

New Search Return to the Search Case page and clear the search form .

Back to Case Display the Case Details of the last case you viewed, if applicable. If you have not viewed a case since 
you logged on, this action will not be displayed.

Back to Video Display the Video Details of the last video you viewed or played, if applicable. If you have not viewed or 
played a video since you logged on, this action will not be displayed.
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Case Details

Case Details tab
Field Description

Display Name The name of this case .

Status The current status of this case:
• Online. The case is still stored on the server; you can add new videos, media files, subjects, and/or 

comments to the case .
• Offline. Some, but not all, of the case functions are available on the server. You can still view the 

case record, but you can’t view its media attachments. Also, you can’t export the case or add any 
new attachments to it (i.e., videos, media files, subjects, and/or comments). If desired, you can 
restore an offline case to online status within a limited time period. 

Owner The individual to whom this case is assigned .

Visible The visibility status of this case:
• No. This case is marked as private; therefore it can only be viewed by its owner or users with edit 

permissions .
• Yes. This case is marked as public; therefore it can be viewed by all users.

If this is a restricted case, this field will not be displayed.

Locked 
(DEA only)

A yes/no indicator used to denote whether or not this case can be updated from the Precinct server. 
• Yes. This case is controlled by the Agency server. You cannot update it from the Precinct server.
• No. This case is controlled by the Precinct server. You can update it as long as you have the proper 

permissions .

Restricted 
Viewing (yes)

The Restricted Case Indicator. If this field is displayed, it indicates that this case is marked as 
“restricted” and can only be viewed by a select group of users.

Creation Date The date and time at which this case record was created . It is displayed in mm/dd/yyyy hh:mm format .

Incident Date The date on which the case-related incident occurred (i .e ., car accident, crime, etc .) . It is displayed in 
mm/dd/yyyy hh:mm format .

Case Number The agency-assigned case number.

Citation Number The agency-assigned citation number, if applicable.

Vehicle 
Registration #

The vehicle registration number associated with this case, if applicable.

Vehicle Plate # The license plate number associated with this case, if applicable.

Do Not Dispose A checkbox that indicates whether or not the system will keep this case’s data available online after the 
Auto Dispose Time has expired .

Notations Agency-specific checkboxes used to notate a case. 
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System Video tab
Column Description

Details View Video Details icon . Used to open the Video Details page .

Play Play button. Used to launch the Flashback Player and view the video recording.

Video A thumbnail image of the beginning of this video.

Owner The officer who owns this video. By default, the owner of a video file is the officer who was logged on 
to the DVR unit during the recording . However, you may, in some circumstances, reassign a video to 
another officer.
NOTE: If the value of the Owner field begins with *1 No Name@, it means one of two things: 1) no 
officer was logged in to the DVR unit when the recording began, or 2) an officer was manually logged 
in to the unit* when the recording began, but they logged in using a DVR Officer Name that was not an 
exact match to the one on the server .

Category The category assigned to this video .

DVR Type The type of DVR that captured this video:
• Vehicle . A DVR that is installed inside a vehicle, such as a police cruiser .
• Interview Room . A DVR that is installed inside an interview room . This type of DVR is used in 

conjunction with the optional Interview Room module .
• Body Worn. A BodyVISION, BWX-100, or FOCUS X2 body-worn DVR.
• VieVu. A VIEVU body-worn DVR.

DVR Name The name of the DVR unit that recorded this video .

Duration The length of this video, in minutes .

Video Start The date and time at which this video began recording. It is displayed in mm/dd/yyyy hh:mm:ss format.

Remove Unlink this video from the case record.

Attached Media tab
Field Description

Open View the attached media file.

Preview View the thumbnail image of an attached photo or graphic, if applicable. Text files will read No Preview 
Available.

Uploaded By The User ID of the officer who attached this media file to the case.

Collected By The name of the officer who is responsible for collecting this evidence.

File Name The name of the media file.

Date / Time The date and time at which this media file was attached to the case. It is displayed in mm/dd/yyyy 
hh:mm:ss format.

Delete Remove this media file from the case record.
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Subjects tab
Field Description

Full Name The subject’s first and last name.

Date of Birth The subject’s date of birth.

Gender The subject’s gender.

Race The subject’s race. This field’s values are defined by the System Administrator. 

Type The type of subject (e.g., Witness, Victim, Defendant, etc.). This field’s values are defined by the System 
Administrator .

Edit Update this subject record.

Delete Permanently delete this subject record.

Comments tab
Field Description

Date The date and time at which this comment was added to the case . It is displayed in mm/dd/yyyy hh:mm 
format .

User The user name of the officer who entered this comment.

Text The comment itself .

Edit Update this comment .

Delete Permanently delete this comment .

Logs tab
Field Description

Date The date and time at which this action occurred . It is displayed in mm/dd/yyyy hh:mm format .

User The user name of the individual who performed this action .

Action The specific action that was performed on this case.

IP Address The IP address of the PC on which this case action was performed .

Available case actions
Action Description

Edit Update information stored in this case record .

Dispose Change this case’s status from online to offline. If the case is already offline or it’s too young to 
dispose of, this action will not be displayed.

Add Video Add a video to this case .

Add Media Add a media file attachment to this case.

Add Subject Add a subject name or names to this case. 

The table is continued on the next page.
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Available case actions
Action Description

Add Comment Add a comment to this case .

Export Open the Export page in order to burn a case to DVD or download it to your PC. If this case is 
currently offline, this action will not be displayed.

Request Control 
(DEA Agency only)

Request control of the case from the source* Precinct.

Request Media 
(DEA Agency only)

Request the case’s media files from the source* Precinct.

Add to Favorites Add this case to your Favorite Cases list . 

Request Activation Submit a request to restore this case from a backup disc or tape to the server. After you click 
this option, your request will be displayed on the Inbox Messages list for all users who have 
reactivation privileges. This action will only be displayed if the case is offline.

Reactivate Now Restore this case from a backup disc or external backup device to the server. This action will only 
be displayed if the case is offline and you have the Reactivate Video permission .

Chain of Custody Generate a Chain of Custody report . 

Previous Results Return to the Case Search Results page .

Back to Video Display the Video Details of the last video you viewed or played, if applicable. If you have not 
viewed or played a video since you logged on, this action will not be displayed.
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DVDs 

DVDs 

DVD File Formats
Depending on your permissions, there are several file formats that may be available to you as an administrative user: Data 
DVD, Consumer DVD, Interchange Format, Uncompressed Format, and FOIA Redacted Format . Each of these formats has 
advantages and disadvantages, as outlined below.

* Special software required, such as Power DVD.
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Disc Capacity
The storage capacity of your discs will vary depending on the type of disc you select . 

 NOTE: Blu-ray discs

• Blu-ray discs store the most data, but they also require a special Blu-ray disc burner. 
• Blu-ray discs require a Blu-ray disc reader or burner to read the discs. 
• You can’t put a Blu-ray disc in a DVD drive and read the disc. 
• If you are burning archives to Blu-ray disc and the only Blu-ray disc drive you have is in your Bravo robotic disc 

burner, you’ll have to use that Bravo drive to perform all of your restores.

Type of disc Maximum storage capacity Time to burn

Single-layer DVD disc 4.7 gigabytes Approximately 30 minutes for a full disc

Double-layer DVD disc 8.5 gigabytes Approximately 45 minutes for a full disc

Single-layer Blu-ray disc 25 gigabytes Variable, depending on your backup
PC’s processor speedDouble-layer Blu-ray disc 50 gigabytes

 NOTE: Burn times

The burn times listed above refer to the time it takes to burn a disc once the job’s status changes from Queued to 
Working. If your server has a high maximum queue size and there are a number of queued DVD jobs ahead of your job, 
it could take hours for your job to even start.

Backup Modes

Backup  Mode Description

ALL Before purging, the system will back up all videos, regardless of what the video categories’ individual 
backup settings are.

CASE Before purging, the system will back up cases only.

CASE & 
CATEGORY

Before purging, the system will back up:
• All cases
• Videos with a video category that is backup enabled.

CASE & 
CATEGORY & 
TAGGED

Before purging, the system will back up:
• All cases
• Videos with a video category that is backup enabled.
• Videos that are tagged .

EXTERNAL Before purging, the system will use an external backup device, such as the Dell Power Vault 124T 
(works in conjunction with the Barracuda Yosemite backup software), to back up all cases and videos.

The table is continued on the next page.



© Safe Fleet | September 2021 | All rights reserved

Digital Evidence Series Administrator's Guide

319 Part # 700-8006 R3

DVDs 

Backup  Mode Description

NONE The system will not back up any media. Select this option if either of the following circumstances 
apply:
• Your agency does not have a robotic DVD burner or Blu-ray burner
• Your agency only wants to use your disc burner to generate export discs (i.e., user-requested 

certified copies).

External Backups and DVD Backups

Column Description

Label The number of the Certified Backup. Backup numbers are assigned automatically by the system in 
sequential order, beginning with no. 1. The highest number on this list is the most recent backup. 
NOTE: If a backup job is canceled for some reason, that number will not be used again. This 
explains why the backup list occasionally "skips" a number. If you see a 15 followed by a 17, for 
example, it just means that archive disc 16 was canceled .

Completion Time The date and time at which the backup was completed. It is displayed in mm/dd/yyyy hh:mm 
format. If a backup is in the queue but has not been performed yet, the word Pending will be 
displayed here .

Purgable A yes/no indicator that tells you whether or not you can safety discard a backup tape or DVD based 
on your Online Lifecycle settings:
• No. You can still use the Backup tape or DVD to reactivate a case or video; therefore you should 

not discard it yet .
• Yes. The Backup tape or DVD is “expired” and can no longer be used to reactivate a case or 

video; therefore you may discard or destroy it according to your agency’s policies.

Precinct • The Precinct or Agency at which this backup tape or DVD was generated.

Video Deletion Roll-up Report

Column Description

Start Date The date and time at which this video began recording. It is displayed in mm/dd/yyyy hh:mm format .

Officer Name The name of the officer who was logged into the DVR unit at the time the recording was made.

Unit Name The name of the DVR that recorded this video .

DVD Label The number of the archive disc to which this video file was copied.

Media File Name The name of the video file that was deleted. The file’s extension can help you identify the type of media:

.avd VIEVU video

.qbx Flashback video

.mkv BodyVISION video

.mp4 FOCUS H1, BWX-100, or FOCUS X2 video

.jpg Body-worn DVR snapshot
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Local Burn Queue Tab

Column Description

Sequence A system-assigned sequential number for the burn job. For example, if the value of this field is 89, it 
means that this is the eighty-ninth burn job that has been sent to the Burn Queue from this server.

Destination The name of the backup PC workstation to which this burn job is directed.

Disc Type The type of disc that will be used to create this backup:

DVDR DVD single layer disc

DVDRDL DVD dual layer disc

BD Blu-ray single layer disc*

BDDL Blu-ray dual layer disc*

.jpg Body-worn DVR snapshot

*You must have a Blu-ray burner to use this type of disc.

Export Type The file format for this disc: Archive (CBD), Data DVD, Consumer DVD, Interchange Format, 
Decompressed (a.k.a. Uncompressed), or FOIA Redacted. 

Priority A number between 1 and 9 that represents the system-assigned priority code for this burn job. By 
default, the system assigns a code of 5 or 9 to each burn job:
• 5  . . . . . . . . . . . . . . . . . . . . . .User-requested export—medium priority
• 9  . . . . . . . . . . . . . . . . . . . . . .System-requested archive—low priority .

Most DVDs burn in the order in which they are submitted to the burn queue. However, in the event 
that the backup PC processes an archive job and an export job at the same time, the export disc 
(code 5) will be burned first.
The remaining priority codes (1-4 and 6-8) are used by your Technical Support Engineer to prioritize 
a backlog of DVD jobs in the event that your DVD burner is out of order for an extended period of 
time .

Copies The total number of discs included in this burn job.

Status The current status of this burn job. The status codes will differ slightly depending on the type of job 
that is being processed.

Archive jobs:
NEW. The system has begun processing (i.e., compiling) an archive job.
LOCAL PREPPING. The system is waiting for enough video to come in to fill an archive disc.
LOCAL PREPPED. Enough video has come in to fill an archive disc; the archive job is now waiting its 
turn to be transferred to the backup PC.
TRANSFERRING. The system is downloading the archive job from the server to the backup PC.
BUILDING. The backup PC is merging the video and/or case files into one single burn job.
BUILT. The backup PC has finished building the burn job; the file is now waiting its turn to be 
burned.
BURNING. The backup PC has submitted the burn job to the robotic DVD burner. The archive disc is 
in the process of being burned.
COMPLETE. The archive job is complete; you may retrieve the disc from your burner’s output tray.

The table is continued on the next page.
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Column Description

Status (cont .) Export jobs:
LOCAL PREPPED. The system has prepared (i.e., compiled) the export job for transfer to the backup 
PC, but the backup PC is not ready to receive it due to a problem of some kind (e.g., backup PC’s 
queue is full, backup PC’s hard drive is full, backup PC is offline, etc.).
SUBMITTED. The system has processed (i.e., compiled) the export job on the server, then 
submitted a Job ID to the backup PC. The backup PC then performed several tasks in preparation 
for receipt of the archive job. (These preparatory tasks are sometimes referred to as ticketing.) The 
export job is now waiting its turn to be transferred to the backup PC.
TRANSFERRING. The system is in the process of downloading the export job to the backup PC.
TRANSCODING (applies to Consumer Exports, Interchange Exports, and/or Decompressed* 
Exports only). The backup PC is converting video into Consumer DVD format, Interchange DVD 
format, or Decompressed* DVD format.
BUILDING. The backup PC is merging the video and/or case files into one single burn job.
BUILT. The backup PC has finished building the burn job; the file is now waiting its turn to be 
burned.
BURNING. The backup PC has submitted the burn job to the robotic DVD burner. The export disc is 
in the process of being burned.
COMPLETE. The export job is complete; you may retrieve the disc from your burner’s output tray.

Failed A True/False indicator that denotes whether or not the burn job failed:
• TRUE. An error occurred while processing this burn request. The DVD will not be burned.
• FALSE. No errors occurred while processing this burn request. The DVD will be burned in the 

appropriate order .

Requested By The requestor of this burn job. If this is an archive DVD, the word System will be displayed in 
this field. If this is a user-requested DVD, this field will display the User ID of the individual who 
submitted the burn request.

Local Burn Queue: Video Tab
Column Description

Media ID The unique identification number that the system assigned to this video. This number is also 
referred to as the System ID or System Video # .

DVR The name of the DVR unit that recorded this video . 
• If the video was recorded by a VIEVU, the word VieVu will be displayed in this column.
• If the video was recorded by a body-worn DVR, the words Body Worn will be displayed here.

Start Date The date and time at which the DVR began recording this video. It is displayed in mm/dd/yyyy 
hh:mm format .

Officer The name of the officer who was logged into the DVR when this video was recorded. If no one was 
logged into the DVR at the time of the recording, the system will assign a default Officer Name of *1 
No name@[time at which this officer ID was created].
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Local Burn Queue: Media Tab
Column Description

Media ID The unique identification number that the system assigned to the associated video (i.e., the video to 
which this media file is attached). Also referred to as the System ID .

Filename The name of this media file, including extension.

Download Date The date and time at which this media file was attached to the burn job. It is displayed in mm/dd/
yyyy hh:mm format .

Owner The name of the individual who is responsible for collecting this evidence.

Backup PCs

Adding a New Backup PC: Backup PC Tab

Column Description

Export Default If your agency is using more than one backup PC/DVD burner, this checkbox is used to indicate 
whether or not the system will default to this backup PC when you display the Export Options pop-
up:
 Use this backup PC as the default on the Export Options pop-up
 Do not use this backup PC as the default on the Export Options pop-up

Name The name of this backup PC.

IP The IP address of this backup PC. If the Backup PC will be connected to the Mobile-Vision network, 
your TSE will provide you with this address. If the Backup PC will be connected to your agency’s 
network, your agency’s Network Specialist will provide you with this address.

Exports If your agency is using more than one backup PC/DVD burner, this checkbox is used to indicate 
whether or not you wish to enable this device to process user-requested burn jobs:
 Allow this backup PC to process user-requested burn jobs
 Do not allow this backup PC to process user-requested burn jobs

Archives If your agency is using more than one backup PC/DVD burner, this checkbox is used to indicate 
whether or not you wish to enable this device to process system-requested burn jobs (i.e., archives 
on Certified Backup Discs):
 Allow this backup PC to process system-requested burn jobs
 Do not allow this backup PC to process system-requested burn jobs
NOTE: If you have more than one robotic DVD burner, it’s recommended that you allocate only one 
DVD burner for system archives.
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Viewing Backup PC Status: Backup PC Tab

Column Description

Name The name of this backup PC.

State The current state of this backup PC:
• READY. Backup PC is up and running; DVD burner is ready to burn
• ERROR. A problem has occurred that is preventing the backup PC from processing burn 

request(s) .
• OFFLINE. The backup PC and/or robotic DVD burner is turned off.

Error Message A description of the error that has occurred, if applicable. You can fix many of these problems 
yourself (for example, The color cartridge is in the black cartridge holder, or The cover on the unit 
has been open for an extended period of time). However, if you encounter a problem that you can’t 
fix on your own, feel free to contact Mobile-Vision Support for assistance.

Discs The number of discs that are left in the DVD burner’s input bin(s). When this number gets low, you 
need to add more discs to the input tray(s) .

Ribbon Count 
(Rimage units only)

The exact number of disc labels that can still be printed using the Rimage’s heat transfer printing 
mechanism .

Black Color %  
(Bravo units only)

The percentage of remaining ink left in the Bravo’s ink jet cartridges.

Version This field is used by Mobile-Vision employees only.
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DVR/8-Bay Dock Units

Manage DVRs Page: Quick Search Fields

Field/Column Limits your search to...

DVR Name The DVR unit that has this name .

Last Comm IP The DVR unit that last used this IP address .

DVR ID The DVR unit that has this serial number. If you are searching for a body-worn DVR, this is the 
external DVR hardware serial number. If you are searching for an in-car DVR, this is the internal DVR 
software serial number.

Status Those DVR units that have a status of either Enabled or Disabled . Select the appropriate status 
from the drop-down list .

Type Those videos that were captured by one of these DVR types:
• Vehicle . A DVR that is installed inside a vehicle, such as a police cruiser
• Interview Room . A DVR that is installed inside an interview room .
• Body Worn. A body-worn DVR.
• VieVu. A VIEVU  body-worn DVR.

Select the appropriate DVR type from the drop-down list .

Product Code Those DVR units that have this Product Code (enter one):
FB2 ....................Flashback2
FB3 ....................Flashback3
FBHD .................FlashbackHD
FBH1 . . . . . . . . . . . . . . . . . FOCUS H1
FBBW1  . . . . . . . . . . . . .BodyVISION
BWX-100  . . . . . . . . . .BWX-100
FBX2 . . . . . . . . . . . . . . . . . .FOCUS X2

Group Those DVR units that are assigned to this DVR group .

Version Those DVR units that have this firmware version. Select the appropriate version number from the 
drop-down list .

Config Sync The Config Sync field displays the DVR’s configuration synchronicity for in-car and body-worn 
DVRs .
• Pending. The system is in the process of synchronizing the server’s DVR configuration with the 

actual DVR unit’s configuration. In other words, the server and DVR are not yet synchronized.
• Complete. All previous changes to the server’s DVR configuration have already been copied to 

the actual DVR . The server and DVR are fully synchronized .
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New DVR

Field Description

DVR Name A unique name for the DVR . You may, for example, want to give the DVR the same name as the 
patrol car in which it is installed (e .g ., Unit 146) .

DVR Officer Name 
(for agencies not 
using USB Login 
Keys)

The default officer who will be associated with this DVR’s video recordings. This value must match 
the value in the Officer Name field on the officer’s user record. If your agency is using USB login 
keys, leave this field blank.

Download Priority The download priority for the DVR’s video transmissions: low, medium, or high. The system uses 
this setting to determine the order in which videos will transmit to the server in the event that 
multiple patrol cars come into transmission range at the same time . DVRs with a Download Priority 
of high will transmit first; DVRs with a Download Priority of med will transmit second; and DVRs 
with a Download Priority of low (default) will transmit last . 

Status A system setting that determines whether or not automatic video transmissions are allowed for 
this DVR:
• Enabled . The system is allowed to automatically download video off of this DVR .
• Disabled . The system is not allowed to automatically download video off of this DVR . However, 

users can still download video manually .
System defaults to Enabled . 

DVR Type The type of DVR this is:
• Vehicle . A DVR that is installed inside a vehicle, such as a police cruiser .
• Interview Room . A DVR that is installed inside an interview room . This type of DVR is used in 

conjunction with the Interview Room module .
• Body Worn. A body-worn DVR.

Group Name The DVR group to which you want to assign this DVR. If Fleet Management is disabled, this field 
will not be displayed.

Edit DVR: for Flashback DVRs Assigned to a DVR Group

Field Description

DVR Name The name of this DVR. If this field is grayed out, it indicates that there is a naming conflict 
associated with the DVR . 

DVR Officer Name The default officer who is associated with this DVR’s video recordings. This is the officer to whom 
the videos recorded on this DVR will be linked. If your agency is using USB Login Keys, this field will 
be grayed out.

Download Priority The download priority for the DVR’s video transmissions: low, medium, or high. The system uses 
this setting to determine the order in which videos will be transmitted to the server in the event that 
multiple patrol cars come into transmission range at the same time . DVRs with a Download Priority 
of High will transmit first; DVRs with a Download Priority of Medium will transmit second; and 
DVRs with a Download Priority of Low (default) will transmit last . 

This table is continued on the next page.
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Field Description

DVR Type The type of DVR:
• Vehicle. A Flashback DVR that is installed inside a vehicle, such as a police cruiser.
• Interview Room. A Flashback DVR that is installed inside a precinct interview room. This type 

of DVR is used in conjunction with the optional Interview Room module .
• Body Worn. A body-worn DVR.

This field will only be visible if your agency is using the Interview Room module.

Group Name A drop-down list used to assign this DVR to an existing DVR group . 

Version The firmware version that is currently loaded on this DVR. Display-only field.

Assigned Firmware The new firmware version that you want to assign to this DVR during the next DVR-to-server 
transmission. If the value of this field is None, the firmware version will remain the same. 

Status A system setting that determines whether or not video transmissions are allowed for this DVR:
• Enabled . The system is allowed to download video off of this DVR
• Disabled . The system is not allowed to download video off of this DVR .

System defaults to Enabled . 

Recategorize Video A checkbox used to recategorize all video recorded from this DVR as Interview Room.
• Yes . Recategorize all existing videos recorded from this DVR as Interview Room . Select this 

option if this DVR is installed in an interview room rather than in a vehicle .
• No . Do not categorize all videos recorded from this DVR as Interview Room (default) .

This field will only be visible if your agency is using the Interview Room module.

Main Board The DVR’s Main Board ID. For internal use only. Applies to Flashback3s and FlashbackHDs.

Video Board The DVR’s Video Board ID. For internal use only. Applies to Flashback3s and FlashbackHDs.

Ethernet DHCP A checkbox used to indicate whether or not a DHCP server will automatically provide the wireless 
IP address to this DVR .
 DHCP server will automatically assign an IP address to the DVR
 User will manually assign an IP address to the DVR
If your agency does not have a DHCP server, leave this checkbox deselected.

Ethernet IP The same Ethernet IP address that you use on your private Ethernet network.

Ethernet Mask The same Ethernet Mask address that you use on your private Ethernet network.

Ethernet Gateway IP The same Ethernet gateway IP address that you use on your private Ethernet network.

Wireless IP The wireless IP address for this DVR .



© Safe Fleet | September 2021 | All rights reserved

Digital Evidence Series Administrator's Guide

329 Part # 700-8006 R3

DVR/8-Bay Dock Units

Edit DVR: for Flashback DVRs NOT Assigned to a DVR Group

DVR tab
Field Description

DVR Name A unique name for the DVR . You may, for example, want to give the DVR the same name as the 
patrol car in which it is installed (e.g., Unit 146). If this field is grayed out, it indicates that there is a 
naming conflict associated with the DVR. Version The firmware version that is currently loaded on 
this DVR. System-generated field.

DVR Officer Name The default officer associated with this video. This is the officer to whom the videos recorded on 
this DVR will be linked. If the Allow USB Logins checkbox is selected, this field will be grayed out.

Assigned Firmware The new firmware version that you want to assign to this DVR during the next DVR-to-server 
transmission. If the value of this field is None (default), the firmware version will remain the same 
as the value in the Version field. 

Allow USB Logins A checkbox used to indicate whether or not an officer will be able to use a USB login key to access 
this DVR .
• Different officers will be able to log in and out of this DVR using a USB login key.
• No officers will be able to log in and out of this DVR using a USB login key. Select this option if 

1) this DVR is used by only one officer (i.e., the officer whose name appears in the DVR Officer 
Name field), or 2) your agency has chosen not to use USB Login Keys.

Status A system setting that determines whether or not automatic video transmissions are allowed for 
this DVR:
• Enabled . The system is allowed to automatically download video off of this DVR
• Disabled . The system is not allowed to automatically download video off of this DVR .

System defaults to Enabled . 

Download Priority The download priority for the DVR’s video transmissions: low, medium, or high. The system uses 
this setting to determine the order in which videos will be transmitted to the server in the event that 
multiple patrol cars come into transmission range at the same time . DVRs with a Download Priority 
of High will transmit first; DVRs with a Download Priority of Medium will transmit second; and 
DVRs with a Download Priority of Low (default) will transmit last . 

DVR Type The type of DVR:
• Vehicle. A Flashback DVR that is installed inside a vehicle, such as a police cruiser.
• Interview Room. A Flashback DVR that is installed inside a precinct interview room.
• Body Worn. A body-worn DVR.

Group Name A drop-down list used to assign this DVR to a DVR group .

Recategorize Video A checkbox used to recategorize all video recorded from this DVR as Interview Room.
• Yes . Recategorize all existing videos recorded from this DVR as Interview Room . Select this 

option if this DVR is installed in an interview room rather than in a vehicle .
• No . Do not recategorize all videos recorded from this DVR as Interview Room (default), as this 

DVR is installed in a vehicle .
This field will only be visible if your agency is using the Interview Room module.

Main Board The DVR’s Main Board ID. For internal use only. Does not apply to Flashback2s.

Video Board The DVR’s Video Board ID. For internal use only. Does not apply to Flashback2s.
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DVR Settings tab
Field Description

Admin Login Name The Flashback User ID. The system uses this ID in combination with the Admin Login Password 
to 1) wirelessly transmit videos to the server and 2) download configuration changes from the 
server to the DVR. Do not change this value unless instructed to do so by a Mobile-Vision Technical 
Support Engineer .

Admin Login 
Password

The Flashback login password. The system uses this ID in combination with the Admin Login 
Name to 1) wirelessly transmit videos to the server and 2) download configuration changes from 
the server to the DVR. Do not change this value unless instructed to do so by a Mobile-Vision 
Technical Support Engineer .

Time Zone The time zone in which this DVR will be recording. 

Ignition Timer A setting which determines how many minutes this DVR will remain on in idle mode after a 
vehicle’s ignition has been turned off. 

Wireless Settings tab
Setting Description

Wireless IP Address The IP address of the DVR’s wireless NIC.* 

Wireless IP Mask The wireless subnet mask address of the DVR’s wireless NIC.* Usually 255.255.255.0 if using the 
default 192.168.10.X network.

Wireless Gateway IP The gateway address for the DVR’s wireless NIC.* Usually set to the IP of the server.

Wireless Mode The wireless security mode that you want to use . 

Wireless 
Authentication

The authentication type used by the wireless mode displayed in the Wireless Mode field: NONE, 
OPEN, or SHARED . 

Wireless Encryption The wireless security type that you want to use . 

Wireless Interface The 802.11 mode that you are using on your wireless network. 

Wireless DHCP A checkbox used to indicate whether or not you want your DHCP server to provide the wireless IP 
addresses to this DVR. When this checkbox is selected, the system will automatically override the 
values in the Wireless IP Address and Wireless IP Mask fields. NOTE: If your agency does not have 
a DHCP server, leave this checkbox deselected.
 DHCP server automatically assigns an IP address to this DVR via the Wireless IP Address and 
Wireless IP Mask fields
 User manually assigns an IP address to this DVR

Wireless SSL 
(Secure Socket 
Layer)

A checkbox used to indicate whether or not you are using the SSL (Secure Socket Layer) type 
encryption to authenticate on your wireless network.
 Using SSL
 Not using SSL

Validate Certificate A checkbox used to indicate whether or not you are providing valid certificates for communication.
 Providing valid certificates for communication
 Not providing valid certificates for communication

*Network Interface Controller, sometimes referred to as a “network card”.

This table is continued on the next page.
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Wireless Settings tab
Setting Description

Wireless SSID The name of your wireless network, also referred to as a wireless service set identifier.
This field is required for all wireless modes.

Wireless Name Your wireless username. Used in combination with the Wireless Password field to login to the 
wireless network. This field is required for wireless modes WPA-PSK and WPA2-PSK.

Wireless Password Your wireless password. This field is used in combination with the Wireless Name field. This field is 
required for wireless modes WPA-PSK and WPA2-PSK .
Your password may contain any combination of the following characters: 

Wireless Encryption 
Key

Your wireless encryption password. Only enter this field if the Wireless Mode is WEP-PSK. Your 
encryption key can be either 10 digits long (64 bits/ascii) or 26 digits long (128 bits/hex). It may 
include any combination of the characters listed above.

Audio tab - Audio Feedback
Setting Description

VLP1 A checkbox used to indicate whether or not you want to include the audio from the wireless 
microphone that’s connected to the Flashback’s VLP 1 port.
 Include audio from the VLP 1 port microphone
 Do not include audio from the VLP 1 port microphone

VLP2 A checkbox used to indicate whether or not you want to include the audio from the wireless 
microphone that’s connected to the Flashback’s VLP 2 port, if applicable.
 Include audio from the VLP 2 port microphone
 Do not include audio from the VLP 2 port microphone

Keyboard Beep A checkbox used to indicate whether or not you want the DVR to beep every time you press one of 
the buttons on the DVR or DVR monitor.
 Make DVR beep every time a button is pressed
 Do not make DVR beep every time a button is pressed

Record Beep A checkbox used to indicate whether or not you want the DVR to beep every 30 seconds when the 
DVR is recording .
 Make DVR beep every 30 seconds when recording
 Do not make DVR beep every 30 seconds when recording

In-Car Mic A checkbox used to indicate whether or not you want to include the audio from the in-car 
microphone .
 Include audio from in-car microphone
 Do not include audio from in-car microphone

This table is continued on the next page.
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Audio tab - Audio Feedback
Setting Description

Recycle Record
(Flashback2s only)

A checkbox used to indicate whether or not you want to continue recording even after the space 
on your CF card is used up. When this feature is selected, the Flashback will record over existing 
files after the CF card is full, beginning with the oldest file. When this feature is off (default), the 
Flashback will automatically stop recording as soon as the CF card is full.
 Continue recording after space on CF card is used up
 Stop recording after space on CF card is used up

Audio tab - Audio Properties
Setting Description

Pre/Post Audio 
Control

A checkbox used to indicate whether or not you want to include audio in your pre- and post- 
recordings. Including audio in these recordings will increase your file size; omitting audio from 
these recordings will reduce your file size.
 Include audio in pre- and post-recordings
 Exclude audio from pre- and post-recordings

Background Record 
(Flashback2s only)

A checkbox used to indicate whether or not you want to use your wireless microphone (see Note 
below) to capture audio for Background Record videos.
 Use wireless microphone to capture audio for Background Record videos.
 Use wireless microphone to capture audio for regular (foreground) videos only .
NOTE: If you have two wireless mics, only the one that’s connected to the VLP 1 port on the back of 
your DVR will be used to capture Background Record audio.

VLP 1 Gain The strength of the audio line level signal into the DVR for the wireless microphone that’s 
connected to your Flashback’s VLP 1 port. This signal has an effect on volume:
• Increasing the numeric value of the VLP1 Gain field will result in decreased volume
• Decreasing the numeric value of the VLP1 Gain field will result in increased volume.

System default is 4 . 
NOTE: If you notice increased distortion after changing this setting, increase the numeric value of 
this field.

VLP 2 Gain The strength of the audio line level signal into the DVR for the wireless microphone that’s 
connected to your Flashback’s VLP 2 port. This signal has an effect on volume:
• Increasing the numeric value of the VLP2 Gain field will result in decreased volume
• Decreasing the numeric value of the VLP2 Gain field will result in increased volume.

System default is 4 .
NOTE: If you notice increased distortion after changing this setting, increase the numeric value of 
this field.

In-Car Mic Gain The strength of the audio line level signal into the DVR for your in-car microphone . This signal has 
an effect on volume:
• Increasing the numeric value of the In-Car Mic Gain field will result in decreased volume
• Decreasing the numeric value of the In-Car Mic Gain field will result in increased volume.

System default is 2 .
NOTE: If you notice increased distortion after changing this setting, increase the numeric value of 
the In-Car Mic Gain field.
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Video tab - Video Properties
Setting Description

(Channel 1) Frame 
Rate

The frame rate for your forward facing zoom camera videos. This is the number of frames that will 
be displayed every second. The higher the number, the smoother the video’s picture and the larger 
the video’s file size. 

(Channel 1) Quality A number that indicates how high the quality of your forward facing zoom camera videos will be. 
This setting denotes the video’s bitrates in megabits-per-second (Mbps). The higher the quality 
setting, the better the video quality and the larger the video’s file size. 

Flashback2/3 Settings FlashbackHD Settings

1 ............. 1.5 Mbps
2 ............. 2.0 Mbps
3 ............. 2.5 Mbps

4 ............. 3.0 Mbps
6 ............. 4.0 Mbps
8 ............. 5.0 Mbps

(Channel 1) 
Resolution

The display resolution (pixels per inch) for your forward facing zoom camera videos . The higher the 
number, the clearer the video’s picture and the larger the video’s file size. 

Channel 2 A checkbox used to indicate whether or not there is a Backseat camera and/or Bullet camera(s) 
installed on this DVR’s second camera channel.
 There is at least one camera installed on camera Channel 2
 There are no cameras installed on camera Channel 2

(Channel 2) Frame 
Rate

The frame rate for your Backseat camera videos and/or Bullet camera videos. This is the number of 
frames that will be displayed every second. The higher the number, the smoother the video’s picture 
and the larger the video’s file size. 

(Channel 2) Quality A number that indicates how high the quality of your Backseat camera videos and/or Bullet camera 
videos will be. This setting denotes the video’s bitrates in either kilobits-per-second (Kbps) or 
megabits-per-second (Mbps). The higher the quality setting, the better the video quality and the 
larger the video’s file size. 
1 ............. 250 Kbps
2 ............. 500 Kbps
3 ............. 750 Kbps
4 ............. 1.0 Mbps
5 ............. 1.25 Mbps

(Channel 2) 
Resolution

The display resolution (pixels per inch) for your Backseat camera videos and/or Bullet camera 
videos. The higher the number, the clearer the video’s picture and the larger the video’s file size. 

Active Cameras 
(Flashback3s & 
FlashbackHDs only)

The number of cameras that will be recording on Channel 2. You can have up to four cameras 
recording on this channel: the Backseat camera and 1 – 3 Bullet cameras. If there will be no 
cameras recording on Channel 2, set the value of this field to OFF .
This field will only be displayed on Flashback3 and FlashbackHD DVR records.

Background Record A checkbox used to indicate whether or not you want the Flashback2, Flashback3, or FlashbackHD 
to record continuously whenever the vehicle’s ignition is on. Keep in mind that the use of 
Background Record requires a lot of disc space. 
 Turn Background Record on
 Turn Background Record off

This table is continued on the next page.
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Video tab - Video Properties
Setting Description

Frame Rate
(for Background 
Record)

The frame rate for videos recorded when Background Record is on. This is the number of frames 
that will dis-play every second. The higher the number, the smoother the video’s picture and the 
larger the video’s file size. 

Stealth Record A checkbox used to indicate whether or not you want the Background Record indicator ( ) to be 
hidden from view when the DVR is in Background Record mode. By default,  is displayed on the 
Flashback monitor whenever Background Record is ON.
 Hide  when Background Record mode is on
 Show  when Background Record mode is on

Unit Shutdown A checkbox used to indicate whether or not you want to continue recording after the vehicle’s 
ignition is turned off but before the DVR automatically shuts down. The Ignition Timer setting will 
determine the exact length of this post-ignition recording . For more information on this feature, see 
Programming the Ignition Timer in your Flashback User’s Guide .
 Continue recording after the vehicle’s ignition is turned off
 Stop recording after the vehicle’s ignition is turned off

Video tab - Recording Properties
Setting Description

Pre Record Time The number of seconds of recording that you want to capture prior to pressing the Record button 
on your DVR . Select a value from 0 – 60 from the drop-down list . To include audio on your pre-
recordings, make sure the Pre/Post Audio Control checkbox on the Audio tab is selected.

Post Record Time The number of seconds of recording that you want to capture after pressing the Stop button on 
your DVR . Select a value from 0 – 60 from the drop-down list . If you want to include audio on your 
post-recordings, make sure the Pre/Post Audio Control checkbox on the Audio tab is selected. 
NOTE: To continue recording for more than 60 seconds, use the Delay Stop feature instead.

Delay Stop A checkbox used to indicate whether or not you want to use the Delay Stop feature, which enables 
you to continue recording for a specified number of minutes after pressing the Stop button on your 
DVR . This feature is used in conjunction with the Aux2 trigger .
 Use Delay Stop feature
 Do not use Delay Stop feature
If you select this checkbox, you must enter a value in the Delay Minutes field.

Delay Minutes The number of minutes that you want to continue recording after pressing the Stop button on your 
DVR . Used in conjunction with the Delay Stop field above. 

Triggers/Display tab - trigger options
Setting Description

Aux 1 Trigger A checkbox used to indicate whether or not a recording will begin if the Auxiliary 1 device detects 
an event, such as a vehicle crash on vehicles equipped with the CrashBat2 .
 Start recording when Aux 1 device is engaged
 Do not start recording when Aux 1 device is engaged

This table is continued on the next page.
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Triggers/Display tab - trigger options
Setting Description

Aux 2 Trigger A checkbox used to indicate whether or not a recording will begin if the Auxiliary 2 trigger device 
detects an event, such as the opening of a door or other triggering event .
 Start recording when Aux 2 device is engaged
 Do not start recording when Aux 2 device is engaged

MPH/KPH Trigger A checkbox used to indicate whether or not a recording will begin if the police vehicle reaches the 
speed entered in the Trigger Speed field.
 Start recording when police vehicle reaches Trigger Speed
 Do not start recording when police vehicle reaches Trigger Speed

Lights Trigger A checkbox used to indicate whether or not a recording will begin if the vehicle’s emergency lights 
go on .
 Start recording when emergency lights go on
 Do not start recording when emergency lights go on

Stop Overrides 
Trigger

A checkbox used to indicate what will happen when the emergency lights are on and an officer 
tries to manually stop a lights-triggered recording. By default, officers are not allowed to stop a 
recording while the emergency lights are still on . If they press , nothing will happen . However, 
you can override this default by checking the Stop Overrides Trigger checkbox.

 Pressing the  button when the emergency lights are on will stop a lights-triggered recording

 Pressing the  button when the emergency lights are on will not stop a lights-triggered 
recording

Trigger Speed The miles-per-hour or kilometers-per-hour speed that the vehicle must reach before a recording will 
begin. Used in conjunction with the MPH/KPH Trigger field.

Siren Trigger A checkbox used to indicate whether or not a recording will begin if the vehicle’s siren goes on.
 Start recording when siren goes on
 Do not start recording when siren goes on

VLP Trigger A checkbox used to indicate whether or not a recording will begin if the officer presses the Record 
button on his wireless microphone.
 Start recording when wireless mic is engaged
 Do not start recording when wireless mic is engaged

Triggers/Display tab - display options
Setting Description

Date Format The format in which the video’s start date will be displayed on the Flashback monitor, 
Flashback2/3/HD/BV Player, and Vehicle Viewer or Vehicle Viewer Live be displayed. 

This table is continued on the next page.
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Triggers/Display tab - display options
Setting Description

Daylight Savings 
Time

A checkbox used to indicate whether or not this DVR will be recording in a region that observes 
Daylight Savings Time .
 Daylight Savings Time is observed in this recording region
 Daylight Savings Time is not observed in this recording region
When this checkbox is selected, the DVR will automatically adjust its videos’ recording start/end 
times to reflect daylight savings time.

Lights Display A checkbox used to indicate whether or not you want to show the Lights Display during videos (see 
sample pictured left). This display indicates when the vehicle’s emergency lights are engaged.
 Show Lights display
 Do not show Lights display

Temperature Display A checkbox used to indicate whether or not you want to show the Temperature Display during 
videos . This display indicates what the temperature was inside the DVR at each point in the video .
 Show Temperature display
 Do not show Temperature display

Metric Units A checkbox used to indicate whether or not you want to display readings in metric units, such as 
kilometers-per-hour.
 Use metric units for on-screen displays
 Do not use metric units for on-screen displays

Category Display A checkbox used to indicate whether or not you want the Category Selection List to be displayed 
after an officer presses the  button. If you choose to display this list, the officer will be able to 
assign a category to his videos immediately after stopping a recording . If you choose not to display 
this list, the officer will not be able to assign a category to his videos immediately after stopping a 
recording; instead, the system will automatically assign all videos the first category listed on the 
Video Categories tab, such as “No Citation”.

 Display the Category Selection List after an officer presses the  button.

 Do not display the Category Selection List after an officer presses the  button.

GPS Format The format in which the video’s GPS coordinates will be displayed on the Flashback monitor. This 
field will only be displayed if you have the Player Display GPS permission . Select this value from the 
drop-down list provided .

Aux 1 Display A checkbox used to indicate whether or not you want to show the Aux 1 Display during a video (see 
sample pictured left) . This display indicates when the Aux 1 Trigger device detected an event . For 
example, if your Aux 1 Trigger device is the Crashbat2 crash detector, then this display will indicate 
the precise time at which a vehicle crash occurred .
 Show Aux 1 display
 Do not show Aux 1 display

Aux 2 Display A checkbox used to indicate whether or not you want to show the Aux 2 Display during a video (see 
sample pictured left) . This display indicates when the Aux 2 Trigger device detected an event, such 
as the opening of a vehicle door .
 Show Aux 2 display
 Do not show Aux 2 display

This table is continued on the next page.
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Triggers/Display tab - display options
Setting Description

GPS Display A checkbox used to indicate whether or not you want to show the GPS Display during a video. This 
display indicates what the vehicle’s longitudinal and latitudinal coordinates are at each point in the 
video .
 Show GPS display
 Do not show GPS display
To access this field, you must have the Player Display GPS permission .

Brakes Display A checkbox used to indicate whether or not you want to show the Brakes Display during a video 
(see sample pictured left). This display indicates when the vehicle’s brakes are engaged during a 
video .
 Show Brakes display
 Do not show Brakes display

Radar Info The type of radar reading (target, lock, and/or patrol) that will be displayed during a video. 
T  . . . . . . . . . . . . . .Target speed
L ...............Lock speed
T/L ..........Target and lock speed
T/L/P ......Target, lock, and patrol speed (default).
This field is used in conjunction with the Radar Box field.

MPH/KPH Display A checkbox used to indicate whether or not you want to show a vehicle’s current speed during 
videos. The speed will be displayed in either miles-per-hour (default) or kilometers-per-hour (if 
Metric Units checkbox is selected).
 Show MPH/KPH display
 Do not show MPH/KPH display

Siren Display A checkbox used to indicate whether or not you want to show the Siren Display during videos (see 
sample pictured left). This display indicates when a vehicle’s siren is engaged.
 Show siren display
 Do not show siren display

WLAN Display A checkbox used to indicate whether or not you want to show the WLAN Display during videos (see 
Flashback3/HD sample pictured left). This display indicates when a vehicle is within range of the 
wireless local area network (WLAN).
 Show WLAN display
 Do not show WLAN display

Radar Box A checkbox used to indicate whether or not your radar device’s target, lock, and/or patrol speeds 
will be displayed during a video. In order for this feature to work, your radar device must be wired to 
the radar trigger on your Flashback DVR.
 Show Radar display
 Do not show Radar display
This field is used in conjunction with the Radar Info field.
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Edit DVR: for FOCUS H1 DVRs Assigned to a DVR Group

Field Description

DVR Name The name of this DVR. If this field is grayed out, it indicates that there is a naming conflict 
associated with the DVR . 

Status A system setting that determines whether or not video transmissions are allowed for this DVR:
• Enabled . The system is allowed to download video off of this DVR
• Disabled . The system is not allowed to download video off of this DVR .

System defaults to Enabled . 

Download Priority The download priority for the DVR’s video transmissions: low, medium, or high. The system uses 
this setting to determine the order in which videos will be transmitted to the server in the event that 
multiple patrol cars come into transmission range at the same time . DVRs with a High Download 
Priority will transmit first; DVRs with a Medium Download Priority will transmit second; and DVRs 
with a Low Download Priority will transmit last . System default is low . 

Group Name A drop-down list used to assign this DVR to an existing DVR group . 

Ethernet DHCP A checkbox used to indicate whether or not a DHCP server will automatically provide the wireless 
IP address to this DVR .
 DHCP server will automatically assign an IP address to the DVR
 User will manually assign an IP address to the DVR
If your agency does not have a DHCP server, leave this checkbox deselected.

Ethernet IP The same Ethernet IP address that you use on your private Ethernet network.

Ethernet Mask The same Ethernet Mask address that you use on your private Ethernet network.

Ethernet Gateway IP The same Ethernet gateway IP address that you use on your private Ethernet network.

Wireless IP The wireless IP address for this DVR .

Version The firmware version that is currently loaded on this DVR. Display-only field.

Assigned Firmware The new firmware version that you want to assign to this DVR during the next DVR-to-server 
transmission. If the value of this field is None, the firmware version will remain the same. 

DVR Type The type of DVR:
• Vehicle . An in-car DVR that is installed inside a vehicle, such as a police cruiser .
• Interview Room. A Flashback DVR that is installed inside a precinct interview room. This type 

of DVR is used in conjunction with the optional Interview Room module .
• Body Worn. A body-worn DVR.

Recategorize Video A checkbox used to recategorize all video recorded from this DVR as Interview Room.
• Yes . Recategorize all existing videos recorded from this DVR as Interview Room . Select this 

option if this DVR is installed in an interview room rather than in a vehicle .
• No . Do not categorize all videos recorded from this DVR as Interview Room (default) .

This field will only be visible if your agency is using the Interview Room module.
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Edit DVR: for FOCUS H1 DVRs NOT Assigned to a DVR Group

DVR tab
Field Description

DVR Name A unique name for the DVR . You may, for example, want to give the DVR the same name as the 
patrol car in which it is installed (e.g., Unit 146). If this field is grayed out, it indicates that there is a 
naming conflict associated with the DVR. Version The firmware version that is currently loaded on 
this DVR. System-generated field.

Status A system setting that determines whether or not automatic video transmissions are allowed for 
this DVR:
• Enabled . The system is allowed to automatically download video off of this DVR
• Disabled . The system is not allowed to automatically download video off of this DVR .

System defaults to Enabled . 

Download Priority The download priority for the DVR’s video transmissions: low, medium, or high. The system uses 
this setting to determine the order in which videos will be transmitted to the server in the event that 
multiple patrol cars come into transmission range at the same time . DVRs with a Download Priority 
of High will transmit first; DVRs with a Download Priority of Medium will transmit second; and 
DVRs with a Download Priority of Low (default) will transmit last . 

Group Name A drop-down list used to assign this DVR to a DVR group .

Version The firmware version that is currently loaded on this DVR. Display-only field.

Assigned Firmware The new firmware version that you want to assign to this DVR during the next DVR-to-server 
transmission. If the value of this field is None (default), the firmware version will remain the same 
as the value in the Version field. 

DVR Type The type of DVR:
• Vehicle . An in-car DVR that is installed inside a vehicle, such as a police cruiser .
• Interview Room . An in-car DVR that is installed inside a precinct interview room .
• Body Worn. A body-worn DVR.

Recategorize Video A checkbox used to recategorize all video recorded from this DVR as Interview Room.
• Yes . Recategorize all existing videos recorded from this DVR as Interview Room . Select this 

option if this DVR is installed in an interview room rather than in a vehicle .
• No . Do not recategorize all videos recorded from this DVR as Interview Room (default), as this 

DVR is installed in a vehicle .
This field will only be visible if your agency is using the Interview Room module.

DVR Settings tab
Field Description

Admin Login Name The FOCUS H1 User ID. The system uses this ID in combination with the Admin Login Password 
to 1) wirelessly transmit videos to the server and 2) download configuration changes from the 
server to the DVR. Do not change this value unless instructed to do so by a Mobile-Vision Technical 
Support Engineer .

This table is continued on the next page.
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DVR Settings tab
Field Description

Admin Login 
Password

The FOCUS H1 login password. The system uses this ID in combination with the Admin Login 
Name to 1) wirelessly transmit videos to the server and 2) download configuration changes from 
the server to the DVR. Do not change this value unless instructed to do so by a Mobile-Vision 
Technical Support Engineer .

Time Zone The time zone in which this DVR will be recording. 

Turn on H1 A checkbox used to indicate whether or not FOCUS H1 will turn on when the vehicle is turned on.
 H1 1 will automatically turn on when the vehicle is turned on .
 User manually turns on H1 .

Remember Logins A checkbox used to enable FOCUS H1 to remember previous login credentials.
 H1 remembers previous login credentials.
 User manually enters login credentials .

GS_X Crash sensor G value. The amount of acceleration (deceleration) that must be detected by the 
DVR to trigger a crash event . Default setting is 10 . 10 is approximately 1 G, which is approximately 
equivalent to the impact of a crash .
NOTE: Setting the Crash Sensor G Value to less than 50 risks a lot of false triggers from the car 
passing over a pothole or railroad track, for example.

Wireless Settings tab
Setting Description

Wireless IP Address The IP address of the DVR’s wireless NIC.* 

Wireless IP Mask The wireless subnet mask address of the DVR’s wireless NIC.* Usually 255.255.255.0 if using the 
default 192.168.10.X network.

Wireless Gateway IP The gateway address for the DVR’s wireless NIC.* Usually set to the IP of the server.

*Network Interface Controller, sometimes referred to as a “network card”.

Wireless DHCP A checkbox used to indicate whether or not you want your DHCP server to provide the wireless IP 
addresses to this DVR. When this checkbox is selected, the system will automatically override the 
values in the Wireless IP Address and Wireless IP Mask fields. NOTE: If your agency does not have 
a DHCP server, leave this checkbox deselected.
 DHCP server automatically assigns an IP address to this DVR via the Wireless IP Address and 
Wireless IP Mask fields
 User manually assigns an IP address to this DVR

WirelessDNS IPs DNS IP addresses for this DVR .

Wireless Upload 
Chunk Size (KB)

The size, in Kilobytes, of a segment of information being wirelessly uploaded to the server. 

Wireless HTTP 
Upload URI

A Uniform Resource Identifier string that identifies the addresses for wireless uploads.

This table is continued on the next page.
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Wireless Settings tab
Setting Description

Wireless HTTP 
download URI

A Uniform Resource Identifier string that identifies the addresses for wireless downloads.

Wireless SSID The name of your wireless network, also referred to as a wireless service set identifier.
This field is required for all wireless modes.

Wireless Password Your wireless password. This field is used in combination with the Wireless Name field. This field is 
required for wireless modes WPA-PSK and WPA2-PSK .
Your password may contain any combination of the following characters: 

Audio tab - Audio Properties
Setting Description

Pre/Post Audio 
Control

A checkbox used to indicate whether or not you want to include audio in your pre- and post- 
recordings. Including audio in these recordings will increase your file size; omitting audio from 
these recordings will reduce your file size.
 Include audio in pre- and post-recordings
 Exclude audio from pre- and post-recordings .

Wireless Mic PB1 
Function

A setting that assigns the selected function to the first programmable button on the microphone. 
Select from Mute, Tracepoint, Covert Interview, Trigger Camera 2 Recording, and Snapshot .

Wireless Mic PB1 
Function

A setting that assigns the selected function to second programmable button on the microphone. 
Select from Mute, Tracepoint, Covert Interview, Trigger Camera 2 Recording, and Snapshot .

Left A source of the left channel audio . Select a value from the drop-down list .

Cameras Prefilled camera number. Not configurable.

Right A source of the right channel audio .  Select a value from the drop-down list .

Video tab - Video Properties
Setting Description

Camera (1,2,3) Checkboxes used to select active cameras.

Quality Recorded video quality setting for the corresponding camera . Select either Standard or High .

Resolution Recorded video resolution setting for the corresponding camera . Select from SD–480p, HD–720p, 
or HD–1080p .

Active Cameras Auto-filled checkbox that updates when camera checkboxes are selected. Not configurable.

This table is continued on the next page.
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Video tab - Recording Properties
Setting Description

Pre Record Time The number of seconds of recording that you want to capture prior to pressing the Record button 
on your DVR . Select a value from 0 – 60 from the drop-down list . To include audio on your pre-
recordings, make sure the Pre/Post Audio Control checkbox on the Audio tab is selected.

Post Record Time The number of seconds of recording that you want to capture after pressing the Stop button on 
your DVR . Select a value from 0 – 60 from the drop-down list . If you want to include audio on your 
post-recordings, make sure the Pre/Post Audio Control checkbox on the Audio tab is selected. 
NOTE: To continue recording for more than 60 seconds, use the Delay Stop feature instead.

Triggers/Display tab - trigger options
Setting Description

Code Preconfigured code names for events that will trigger the recording. 

Description Preconfigured descriptions of the corresponding codes. 

Camera 1, 2, 3 Сheckboxes for available cameras. Select the checkboxes to choose which events will trigger the 
recording for each camera .

Delay (Sec) The number of seconds the system will delay each trigger. 

Trigger Speed The miles-per-hour or kilometers-per-hour speed that the vehicle must reach before a recording will 
begin. 

Triggers/Display tab - display options
Setting Description

OSD Display Mode On-screen display setting for displaying metadata over video (time . date, etc .) . Select from Do Not 
Display, Solid, or Flash .

Radar Info The name of the radar that will be used. Select from Decatur, MPH. This name will be displayed on 
the video .

Daylight Savings 
Time

A checkbox used to indicate whether or not this DVR will be recording in a region that observes 
Daylight Savings Time .
 Daylight Savings Time is observed in this recording region
 Daylight Savings Time is not observed in this recording region
When this checkbox is selected, the DVR will automatically adjust its videos’ recording start/end 
times to reflect daylight savings time.

GPS Speed on Video A checkbox  used to indicate whether the speed will be displayed on the video when recording.
 GPS speed will be displayed
 GPS speed will not be displayed

Officer ID Display A checkbox used to indicate whether the Officer ID will be displayed on the video.
 Officer ID will be displayed
 Officer ID will not be displayed

This table is continued on the next page.



© Safe Fleet | September 2021 | All rights reserved

Digital Evidence Series Administrator's Guide

343 Part # 700-8006 R3

DVR/8-Bay Dock Units

Triggers/Display tab - display options
Setting Description

Record Indicator A checkbox used to enable or disable a flashing "recording" indicator.  
 The flashing indicator will be displayed while a video is being recorded
 The flashing indicator will not be displayed while a video is being recorded

GPS Display A checkbox used to indicate whether or not you want to show the GPS Display during a video. This 
display indicates what the vehicle’s longitudinal and latitudinal coordinates are at each point in the 
video .
 Show GPS display
 Do not show GPS display
To access this field, you must have the Player Display GPS permission .

Mobile Devices Page

Mobile Devices tab
Column Description

Assign A button used to assign this body-worn DVR to an officer. This button will only be displayed when 
the following conditions apply: 1) the Allow Officer Assignment checkbox on the unit's DVR 
record or DVR Group record is selected, and 2) the DVR is currently available for assignment. A 
DVR is considered “available” when it is connected to the server via a docking station, uploading/
downloading is complete, and the DVR is not currently assigned to another officer.

Identify An icon used to activate an audio/visual alert on the body-worn DVR, making it easy for an officer 
or evidence clerk to locate the DVR. This alert varies slightly depending on what model of body-
worn DVR you have .

Display Name The name of this body-worn unit, as displayed on its DVR record.

Serial # The body-worn DVR’s 10-digit serial number. The system obtains this number from the DVR during 
the first DVR-to-server communication.

Battery Level (%) The percentage of battery power remaining on this body-worn DVR.
• If the Battery Level bar is solid green, it indicates that the DVR is fully charged.
• If the Battery Level bar is partially yellow, it indicates that this DVR has 1 – 3 hours of recording 

time left .
• If the Battery Level bar is partially red, it indicates that this DVR has less than one hour of 

recording time left. In this case, you should leave the DVR in the docking station until the 
Battery Level % is either solid green (preferred) or at least yellow.

Free Space (%) The percentage of storage space remaining on this body-worn DVR.
• If the Free Space bar is solid green, it indicates that there is 100% recording time available on 

this DVR
• If the Free Space bar is partially red or yellow, it indicates that there is less than 100% recording 

time available on this DVR
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Mobile Devices tab
Column Description

Status The current status of this body-worn DVR:
• Idle. The DVR's media files (video and snapshots) have finished uploading to the server
• Downloading . The DVR is currently uploading media to the server .
• Upgrading. The server is currently downloading a firmware update to the DVR.

Revision The current firmware version loaded on this body-worn DVR.

DVR Officer Name The name of the officer to whom this body-worn DVR is currently assigned. If No Name is 
displayed here, it indicates that this DVR is not assigned to anyone .

Mobile Inventory tab
Column Description

Display Name The name of this body-worn DVR, as displayed on its DVR record.

Serial # The body-worn DVR's 10-digit serial number. The system obtains this number from the DVR during 
the first DVR-to-server communication.

Revision The current firmware version loaded on this body-worn DVR.

DVR Officer Name The name of the officer to whom this body-worn DVR is currently assigned. If No Name is 
displayed here, it indicates that this body-worn DVR is not assigned to anyone.

Last Comm Date The date and time of the most recent communication between this body-worn DVR and the server. 
It is displayed in mm/dd/yyyy hh:mm format .

In/Out An indicator used to denote whether or not this body-worn DVR is currently connected to the server 
via a docking station.
• In. The body-worn DVR is connected to the server
• Out. The body-worn DVR is not connected to the server.

Edit DVR/Edit Device: for BodyVISION DVRs when Fleet 
Management is ON/OFF

Setting Description

DVR Name The name of this BodyVISION DVR . By default, the system assigns the following name to a newly 
discovered DVR: [product code]_[serial number] . For example, if this is a BodyVISION XV, the DVR 
Name would begin with FBBW1_, followed by the DVR’s 10-digit serial number.
If this field is grayed out, it indicates that there is a naming conflict associated with the DVR. 

DVR Officer Name The name of the officer to whom this BodyVISION is currently assigned, if applicable. If the Allow 
Officer Assignment checkbox is selected, this field will be grayed out. 
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Setting Description

Allow Officer 
Assignment

A checkbox used to turn the Officer Dispatch feature on/off. 
 Officer Dispatch feature is on (activated)
 Officer Dispatch feature is off (deactivated)

Status A system setting that determines whether or not video uploads are allowed for this DVR:
• Enabled . The system is allowed to upload video from this BodyVISION when the DVR is 

connected to the server .
• Disabled . The system is not allowed to upload video from this BodyVISION when the DVR is 

connected to the server . NOTE: If you select this option, disabled BodyVISION DVRs will not be 
displayed on the Manage DVRs list unless you change the value of the Status search field to 
Disabled .

Group Name The name of the BodyVISION DVR group to which this DVR is currently assigned, if applicable. 

Resolution The video resolution for this DVR’s recordings. The system defaults to high definition (1280 x 720). 

Ethernet DHCP A checkbox used to indicate whether or not a DHCP server will automatically provide the IP address 
to this BodyVISION DVR .
 DHCP server will automatically assign an IP address to this DVR
 User will manually assign an IP address to this DVR

Ethernet IP The unique IP address that is assigned to this BodyVISION. This field is only required when the 
Ethernet DHCP checkbox is deselected.

Ethernet Mask The same Ethernet mask address that you use on your private Ethernet network. This field is only 
required when the Ethernet DHCP checkbox is deselected.

Ethernet Gateway IP The same Ethernet gateway IP address that you use on your private Ethernet network. This field is 
only required when the Ethernet DHCP checkbox is deselected.

Remote Broadcast 
IP(s)

An IP address range across which the BodyVISION DVRs announce their identity so the server can 
locate them . System default is 255.255.255.255 . Separate multiple IP addresses with a space . 

Version The current firmware version loaded on this DVR. Display-only field.

Assigned Firmware The new firmware version that you want to assign to this BodyVISION DVR. 

DVR ID The BodyVISION’s 10-digit serial number. The system obtains this number from the DVR during the 
first DVR-to-server communication. Display-only field.

Main Board The DVR’s Main Board ID. Display-only field. For internal use only.

Time Zone The time zone in which this BodyVISION DVR will be recording. System default is Eastern Time.

Daylight Savings 
Time

A checkbox used to indicate whether or not this BodyVISION will be recording in a region that 
observes Daylight Savings Time. When this checkbox is selected, BodyVISION will automatically 
adjust its videos’ recording start/end times to reflect daylight savings time.
 Daylight Savings Time is observed in this DVR’s recording region
 Daylight Savings Time is not observed in this DVR’s recording region
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Setting Description

Snapshot/Tracepoint A field used to program the BodyVISION to capture a JPG still image and/or insert a “tracepoint” 
placemarker in a video whenever a user presses the Snapshot/Tracepoint button on the top of the 
DVR while a recording is in progress. Select a value from the drop-down list:
• Snapshot. Capture a JPG still image
• Tracepoint. Insert a “tracepoint” placemarker in a video
• Both (default). Perform both actions—Capture a JPG still image and insert a “tracepoint” 

placemarker in a video.
• Off . Do not perform either action .

Recording Alert Time 
(minutes)  
(available for 
BodyVISIONs with 
firmware version 
1 .5 .2 and higher)

Enable the recording-in-progress alert, which causes the BodyVISION DVR to vibrate every X 
number of minutes after a recording is initiated.
System defaults to 0 (alert feature disabled). To enable recording alerts, enter a number between 1 
and 30; to disable recording alerts, enter 0 .

Mute enabled 
(available for 
BodyVISIONs with 
firmware version 
1 .5 .2 and higher)

Enable/disable the recording mute button.
 User can mute audio on this DVR while a recording is in progress (default)
 User cannot mute audio on this DVR while a recording is in progress

Pre-Event Recording
(BodyVision XVs 
only)

NOTE: Feature 
available for 
BodyVISIONs with 
firmware version 
1 .5 .2 and higher

If you have a BodyVISION XV, you may capture 10, 30, 60, or 90 seconds of video before a recording 
session is initiated. The reason that the BodyVISION XV is able to capture video before a recording 
session even begins is because the DVR is, in fact, recording all the time—it just doesn’t save all 
that data to the DVR’s internal storage drive unless you choose to do so. Pre-event recordings are 
similar to the short-term memory on a computer .
Before you ever click Save (or in this case, the record switch), there is still some data stored in the 
computer’s short-term memory.
Select a value from the drop-down list:
0 Omit pre-event recording
10 Capture 10 seconds of pre-event recording
30 Capture 30 seconds of pre-event recording
60 Capture 60 seconds of pre-event recording
90 Capture 90 seconds of pre-event recording

Edit DVR: for BWX-100 DVRs when Fleet Management is ON

DVR tab
Setting Description

DVR Name The name assigned to this BWX-100 . By default, the system assigns the following name to a newly 
discovered DVR: [product code]_[serial number].
If this field is grayed out, it indicates that there is a naming conflict associated with the DVR.
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DVR tab
Setting Description

DVR Officer Name The name of the officer to whom this BWX-100 is currently assigned, if applicable. If the Allow 
Officer Assignment checkbox is selected, this field will be grayed out. 

Allow Officer 
Assignment

A checkbox used to turn the Officer Dispatch feature on/off. 
 Officer Dispatch feature is on (activated)
 Officer Dispatch feature is off (deactivated)

Status A system setting that determines whether or not video downloads are allowed for this DVR:
• Enabled . The system is allowed to upload video off of this BWX-100 when the DVR is 

connected to the server
• Disabled . The system is not allowed to upload video off of this BWX-100 when the DVR is 

connected to the server. If you select this option, disabled BWX-100 DVRs will not be displayed 
on the Manage DVRs list unless you change the value of the Status search field to Disabled .

Group Name The name of the BWX-100 DVR group to which this DVR is currently assigned, if applicable. 

Mute Enabled A checkbox used to enable/disable the recording mute button.
 Officer can mute audio while a recording is in progress (default)
 Officer cannot mute audio while a recording is in progress

Version The current firmware version loaded on this DVR. Display-only field.

Assigned Firmware The new firmware version that you want to assign this BWX-100. 

DVR ID The BWX-100’s serial number. The system obtains this number from the DVR during the first DVR-
to-server communication .

Time Zone The time zone in which this BWX-100 will be recording. System default is Eastern Time. 

Daylight Savings 
Time

A checkbox used to indicate whether or not this DVR will be recording in a region that observes 
Daylight Savings Time. When this checkbox is selected, the BWX-100 will automatically adjust its 
videos’ recording start/end times to reflect daylight savings time.
 Daylight Savings Time is observed in this DVR’s recording region (default)
 Daylight Savings Time is not observed in this DVR’s recording region

Snapshot/Tracepoint A field used to program the BWX-100 to capture a JPG still image and/or insert a “tracepoint” place 
marker in a video whenever a user presses the Snap/Trace button on the side of the DVR while a 
recording is in progress. Select a value from the drop-down list: 
• Snapshot. Capture a JPG still image
• Tracepoint. Insert a “tracepoint” placemarker
• Both (default) Perform both actions. Capture a JPG still image and insert a “tracepoint” 

placemarker
• Off . Do not perform either action .
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Video tab - video properties
Setting Description

Pre-Event Recording If desired, you may capture 10, 30, 60, or 90 seconds of video before a recording session is 
initiated. The reason that the BWX-100 is able to capture video before a recording session even 
begins is because the DVR is, in fact, recording all the time—it just doesn’t save all that data to the 
DVR’s internal storage drive unless you choose to do so. Pre-event recordings are similar to the 
short-term memory on a computer. Before you ever click Save (or in this case, the Record button), 
there is still data stored in the computer’s short-term memory.
Select a value from the drop-down list:
0 Omit pre-event recording
10 Capture 10 seconds of pre-event recording
30 Capture 30 seconds of pre-event recording
60 Capture 60 seconds of pre-event recording
90 Capture 90 seconds of pre-event recording

Resolution The video resolution for this DVR. Select a value from the drop-down list:
• 720 x 480 cropped. Standard definition video with a reduced field of view. Also referred to as 

“480p cropped .”
• 1280 x 720 cropped. High definition video with a reduced field of view. Also referred to as “720p 

cropped .”
• 1280 x 720. High definition video with a full field of view. Also referred to as “720p.”
• 1920 x 1080 (default). Full high definition video with a full field of view. This is the highest 

resolution available for BWX-100 video and the most resource intensive. Also referred to as 
“1080p .”

Video tab - recording properties
Setting Description

GPS Runtime This feature will be available in a future release.

GPS Tracking This feature will be available in a future release.

Audio/Video Mode The type of data this BWX-100 will capture:
0 Audio and video (default)
1 Video only
2 Audio only

Recording Alert Time 
(minutes)

When a value higher of 1 or higher is entered in this field, it activates the recording-in-progress 
alert, which causes the BWX-100 to vibrate every X number of minutes after a recording is initiated. 
System default is 0 (alert feature disabled).
To enable recording alerts, enter a number between 1 and 30; to disable recording alerts, enter 0 .
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Video tab - recording properties
Setting Description

Bluetooth 
Transmission

The BWX-100’s Bluetooth transmission status:
• Enabled. Automatically initiate a recording on remote device(s) whenever an officer manually 

starts a BWX-100 recording within line sight of in-range BWX-100(s)—assuming those device(s) 
are configured for Bluetooth transmission.

• Disabled. Do not broadcast or receive Bluetooth transmission messages.
For more on this feature, see Remotely Starting a Recording in the BWX-100 User’s Guide .

Bluetooth ID A code used to identify a device group . When you assign a Bluetooth ID to a BWX-100, that DVR will 
only communicate with devices that share the same Bluetooth ID .
ID Requirements: 1 - 12 characters, with a combination of numbers from 1 - 9 and/or letters from 
a - f .

Record LED A checkbox used to indicate whether or not you want the red LEDs on the front and top of the BWX-
100 to illuminate whenever a recording is in progress .
 Enable LED recording-in-progress lights (default).
 Disable LED recording-in-progress lights.

Ethernet tab
Setting Description

Ethernet DHCP A checkbox used to indicate whether or not a DHCP server will automatically provide the IP address 
to this BWX-100 .
 DHCP server will automatically assign an IP address to this DVR
 User will manually assign an IP address to this DVR

Ethernet IP The unique IP address that is assigned to this DVR. This field is only required when the Ethernet 
DHCP checkbox is not selected.

Ethernet Mask The same Ethernet mask address that you use on your private Ethernet network. This field is only 
required when the Ethernet DHCP checkbox is not selected.

Ethernet Gateway IP The same Ethernet gateway IP address that you use on your private Ethernet network. This field 
is only required when the Ethernet DHCP checkbox is not selected.

Remote Broadcast 
IP(s)

An IP address range across which the BWX-100 DVRs announce their identity so the server can 
locate them . System default is 255.255.255.255 . Separate multiple IP addresses with a space .

Edit Device: for BWX-100 DVRs when Fleet Management is OFF

Edit BWX-100 DVR
Setting Description

DVR Name The name assigned to this BWX-100. If this field is grayed out, it indicates that there is a naming 
conflict associated with the DVR. 
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Edit BWX-100 DVR
Setting Description

Serial # The BWX-100’s serial number. The system obtains this number from the DVR during the first DVR-
to-server communication .

Allow Officer 
Assignment

A checkbox used to turn the Officer Dispatch feature on/off. 
 Officer Dispatch feature is on (activated)
 Officer Dispatch feature is off (deactivated) 

GPS Tracking This feature will be available in a future release.

Snapshot/Tracepoint A field used to program the BWX-100 to capture a JPG still image and/or insert a “tracepoint” 
placemarker in a video whenever a user presses the Snap/ Trace button on the side of the DVR 
while a recording is in progress .
Select a value from the drop-down list:
• Snapshot. Capture a JPG still image
• Tracepoint. Insert a placemarker in a video
• Both (default) Capture a JPG still image and insert a placemarker in a video.
• Off . Do not perform either action .

Bluetooth 
Transmission

The BWX-100’s Bluetooth transmission status:
• Enabled. Automatically trigger a recording on remote device(s) whenever an officer manually 

starts a BWX-100 recording within line sight of in-range BWX-100(s)—assuming those device(s) 
are configured for Bluetooth transmission.

• Disabled. Do not broadcast or receive Bluetooth transmissions.

Ethernet DHCP A checkbox used to indicate whether or not a DHCP server will automatically provide the IP address 
to this BWX-100 .
 DHCP server will automatically assign an IP address to this DVR
 User will manually assign an IP address to this DVR

Ethernet IP The unique IP address that is assigned to this BWX-100. This field is only required when the 
Ethernet DHCP checkbox is not selected.

Ethernet Mask The same Ethernet mask address that you use on your private Ethernet network. This field is only 
required when the Ethernet DHCP checkbox is not selected.

Ethernet Gateway IP The same Ethernet gateway IP address that you use on your private Ethernet network. This field is 
only required when the Ethernet DHCP checkbox is not selected.

Remote Broadcast 
IP(s)

An IP address range across which the BWX-100 DVRs announce their identity so the server can 
locate them . System default is 255.255.255.255 . Separate multiple IP addresses with a space .

Daylight Savings 
Time

A checkbox used to indicate whether or not this DVR will be recording in a region that observes 
Daylight Savings Time. When this checkbox is selected, the BWX-100 will automatically adjust its 
videos’ recording start/end times to reflect daylight savings time.
 Daylight Savings Time is observed in this DVR’s recording region (default)
 Daylight Savings Time is not observed in this DVR’s recording region

Time Zone The time zone in which this BWX-100 will be recording. System default is EASTERN time. 
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Edit BWX-100 DVR
Setting Description

DVR Officer Name The name of the officer to whom this BWX-100 is currently assigned, if applicable. If the Allow 
Officer Assignment checkbox is selected, this field will be grayed out. 

GPS Run Time This feature will be available in a future release.

Audio/Video Mode The type of data this BWX-100 will capture:
0 Audio and video (default)
1 Video only
2 Audio only

Bluetooth ID A code used to identify a device group . When you assign a Bluetooth ID to a BWX-100, that camera 
will only communicate with devices that share the same Bluetooth ID . 
ID Requirements: 1 - 12 characters, with a combination of numbers from 1 - 9 and/or letters from 
a - f .

Resolution The video resolution for this DVR:
• 720 x 480 cropped. Standard definition video with a reduced field of view. Also referred to as 

“480p cropped .”
• 1280 x 720 cropped. High definition video with a reduced field of view. Also referred to as “720p 

cropped .”
• 1280 x 720. High definition video with a full field of view. Also referred to as “720p.”
• 1920 x 1080 (default). Full high definition video with a full field of view. This is the highest 

resolution available for BWX-100 video and the most resource intensive. Also referred to as 
“1080p .”

Recording Alert Time 
(minutes)

When a value higher of 1 or higher is entered in this field, it activates the recording-in-progress 
alert, which causes the BWX-100 to vibrate every X number of minutes after a recording is initiated. 
System default is 0 (alert feature disabled).
To enable recording alerts, enter a number between 1 and 30; to disable recording alerts, enter 0 .

Mute Enabled A checkbox used to enable/disable the recording mute button.
 Officer can mute audio while a recording is in progress (default)
 Officer cannot mute audio while a recording is in progress

Pre-Event Recording If desired, you may capture 10, 30, 60, or 90 seconds of video before a recording session is 
initiated. The reason that the BWX-100 is able to capture video before a recording session even 
begins is because the DVR is, in fact, recording all the time—it just doesn’t save all that data to the 
DVR’s internal storage drive unless you choose to do so. Pre-event recordings are similar to the 
short-term memory on a computer. Before you ever click Save (or in this case, the Record button), 
there is still some data stored in the computer’s short-term memory.
Select a value from the drop-down list:
0 Omit pre-event recording
10 Capture 10 seconds of pre-event recording
30 Capture 30 seconds of pre-event recording
60 Capture 60 seconds of pre-event recording
90 Capture 90 seconds of pre-event recording
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Edit BWX-100 DVR
Setting Description

Record LED A checkbox used to indicate whether or not you want the red LEDs on the front and top of the BWX-
100 to illuminate whenever a recording is in progress .
 Enable LED recording-in-progress lights (default).
 Disable LED recording-in-progress lights.

Edit DVR/Edit Device: for FOCUS X2 DVRs when Fleet Management 
is ON/OFF

DVR tab
Setting Description

DVR Name The name assigned to this X2 . By default, the system assigns the following name to a newly 
discovered DVR: [product code]_[serial number].
If this field is grayed out, it indicates that there is a naming conflict associated with the DVR.

Police Department The name of the police department this DVR is assigned to .

DVR Officer Name The name of the officer to whom this X2 is currently assigned, if applicable. If the Allow Officer 
Assignment checkbox is selected, this field will be grayed out. 

Group Name The name of the FOCUS X2 DVR group to which this DVR is currently assigned, if applicable. 

Enable WIFI Mode A checkbox used to enable/disable this DVR's ability to connect to a Wi-Fi network.
 Allow this DVR to connect to Wi-Fi .
 Prevent this DVR from being able to connect to Wi-Fi.

Wifi Router 
Password

The password used to log in to the Wi-Fi router at your agency . 

Version The current firmware version loaded on this DVR. Display-only field.

Assigned Firmware The new firmware version that you want to assign this X2. 

Status A system setting that determines whether or not video downloads are allowed for this DVR:
• Enabled . The system is allowed to upload video off of this X2 when the DVR is connected to 

the server
• Disabled . The system is not allowed to upload video off of this X2 when the DVR is connected 

to the server. If you select this option, disabled X2 DVRs will not be displayed on the Manage 
DVRs list unless you change the value of the Status search field to Disabled .

Time Zone The time zone in which this X2 will be recording. System default is Eastern Time. 
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Video tab - video properties
Setting Description

Pre-Event Audio A checkbox used to enable/disable pre-recording of audio activity that occurred before the 
recording was initiated .
 Audio activity will be pre-recorded
 Audio activity will not be pre-recorded

Pre-Event Recording If desired, you may capture 10, 30, 60, or 90 seconds of video before a recording session is 
initiated. The reason that the X2 is able to capture video before a recording session even begins 
is because the DVR is, in fact, recording all the time—it just doesn’t save all that data to the DVR’s 
internal storage drive unless you choose to do so . Pre-event recordings are similar to the short-
term memory on a computer. Before you ever click Save (or in this case, the Record button), there 
is still data stored in the computer’s short-term memory.
Select a value from the drop-down list:
• 0   Omit pre-event recording
• 10 Capture 10 seconds of pre-event recording
• 30 Capture 30 seconds of pre-event recording
• 60 Capture 60 seconds of pre-event recording
• 90 Capture 90 seconds of pre-event recording

Resolution The video resolution for this DVR. Select a value from the drop-down list:
• WVGAI. Standard definition video.
• HD-720p. Standard high definition video with a full field of view. 
• HD-1080p. Full high definition video with a full field of view. 
• FHD-720p. Full high definition video with a full field of view. This resolution is more resource-

intensive than HD-720p .
• FHD-1080p. Full high definition video with a full field of view. This resolution is more resource-

intensive than HD-1080p .
• QHD - 2560x1440. Quad high definition video with a 16x9 aspect ratio. This is the highest 

resolution available for X2 video and the most resource intensive

Quality A setting that refers to the bitrate of the recorded video. The higher the bitrate (in megabits, or 
Mbps) per second, the larger the file size, but the higher the video quality. Select a value from the 
drop-down list. Refer to the following table for the available values and the corresponding bitrates:

Value 480p video 720p video 1080p video

Basic 2.5 Mbps 3 Mbps 6 Mbps

Normal 3 Mbps 4 Mbps 8 Mbps

Fine 4 Mbps 5 Mbps 10 Mbps

High 5 Mbps 6 Mbps 12 Mbps

GPS Log Frequency Frequency (in seconds) with which this X2's location coordinates will be logged. Use the up and 
down arrows to select a value between 20 and 120 seconds . Default is 60 .
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Video tab - video properties
Setting Description

Default Event The type of event that will be attached by default to each new video recorded by this DVR. Select a 
value from the drop-down list:
• No Citation
• Citation
• Search
• Arrest
• Other

VideoCodec A pre-configured value that defines which video codec will be used to compress or decompress 
video recorded by this DVR. H.264 is the only video codec currently supported .

GPS A checkbox used to enable/disable the GPS tracker in this X2.
 GPS tracker will be enabled
 GPS tracker will not be enabled

G-Sensor A checkbox used to enable/disable the sensor that triggers a recording in the event of impact or 
sudden movement. When enabled, the G-sensor will run in the background during standby mode.
 G-Sensor will be enabled
 G-Sensor will not be enabled

Bluetooth A checkbox used to enable/disable the Bluetooth connectivity of this X2. X2 connects via Bluetooth 
to the vehicle dock. The purpose of this connection is for the recording to be triggered when the 
vehicle's lightbar is activated.
 Bluetooth will be enabled
 Bluetooth will not be enabled

Enable LDC A checkbox used to enable/disable the lens distortion correction on this DVR. 
 Lens distortion correction will be enabled. This s default setting that cannot be changed in this 
release .
 Lens distortion correction will be enabled

Enable EIS A checkbox used to enable/disable the electronic image stabilization on this DVR. 
 Electronic image stabilization will be enabled. This s default setting that cannot be changed in 
this release .
 Electronic image stabilization will be enabled

Video tab - recording properties
Setting Description

Clip On IR A checkbox used to enable/disable the infrared LED on the clip-on USB camera (ClipCam). The LED 
will automatically illuminate depending on ambient light conditions.
 Infrared LED will be enabled
 Infrared LED will not be enabled

This table is continued on the next page.
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Video tab - recording properties
Setting Description

MB Clip Cam A checkbox used to enable/disable the record button trigger setting on this X2. When enabled, the 
ClipCam will be triggered when the record button is pressed.
 Infrared LED will be enabled
 Infrared LED will not be enabled

Enable Clip Cam 
Front LED

A checkbox used to enable/disable the LED on the front of the ClipCam while a recording is in 
progress . .
 Front ClipCam LED will be enabled
 Front ClipCam LED will not be enabled

Enable Clip Cam Top 
LED

A checkbox used to enable/disable the LED on the top of the ClipCam while a recording is in 
progress . .
 Top ClipCam LED will be enabled
 Top ClipCam LED will not be enabled

Enable X2 Front LED A checkbox used to enable/disable the LED on the front of this X2 while a recording is in progress..
 Front X2 LED will be enabled
 Front X2 LED will not be enabled

Enable X2 Top LED A checkbox used to enable/disable the LED on the top of  this X2 while a recording is in progress..
 Top X2 LED will be enabled
 Top X2 LED will not be enabled

Recording tab
Setting Description

FnFunction A field used to assign a function to the Fn button on this X2. Select a value from the drop-down list:
• Tag . Attach a default event to the recording .
• Bookmark. Insert a placemarker in a video.
• Snapshot. Capture a JPG still image.

Tag Event A field used to select an event that will be attached to the recording when the Fn button is pressed 
on this X2 . The Fn button must be set to Tag for this to work. Otherwise, a default tag event will be 
attached. Select a value from the drop-down list:
• No Citation
• Citation
• Search
• Arrest
• Other

This table is continued on the next page.
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Recording tab
Setting Description

Enable Auto Off A field used to enable/disable an automatic shut off of a FOCUS X2 inserted into a dock when its 
battery is fully charged. Select a value from the drop-down list:
• Enabled. X2 will shut off automatically after its battery is fully charged
• Disabled. X2 will not shut off automatically after its battery is fully charged

Covert Mode A field used to either disable this X2's covert mode, or configure the recording reminder this X2 will 
produce if covert mode is enabled. Select a value from the drop-down list:
• Disable. Covert mode will be disabled.
• Vibrate Only. X2 will vibrate.
• LED Only . The record LED will illuminate .
• Vibrate and LED. X2 will vibrate and the record LED will illuminate.
• No indication. There will be no indication of this X2 entering a covert mode.

G-Sensor Threshold A field used to select the impact level for G-Sensor to trigger recording. The higher the number, the 
greater the G-Force is required to activate. Use the up and down arrows to select a value between 2 
and 10. Default: 10

Default Covert Mode A checkbox used to enable/disable the covert mode at the time this X2 is powered up. If default 
covert mode is disabled, the officer can manually enable it by pressing and holding this X2's mute 
button for 3 seconds.
 Covert mode will be enabled
 Covert mode will not be enabled

Recording Alert Time 
(seconds)

When a value higher of 1 or higher is entered in this field, it activates the recording-in-progress alert, 
which causes the X2 to vibrate every X number of seconds after a recording is initiated. System 
default is 0 (alert feature disabled).
To enable recording alerts, enter a number between 1 and 300; to disable recording alerts, enter 0 .

Mute Enabled A checkbox used to enable/disable the recording mute button.
 Officer can mute audio while a recording is in progress (default)
 Officer cannot mute audio while a recording is in progress

Double Click Mode A checkbox used to configure the number of times the record button has to be pressed for this X2 
to start recording. When the checkbox is selected, the officer has to press the record button twice 
within 1 second to initiate recording. Otherwise, the record button has to be pressed once to initiate 
recording .
 Officer has to press the record button twice within 1 second to initiate recording
 Officer has to press the record button once to initiate recording

Auto Upload In Car A checkbox used to enable/disable the automatic upload of videos recorded by this X2 to an in-car 
DVR while this X2 is in the vehicle dock.
 X2 videos will be automatically uploaded to in-car DVR
 X2 videos will not be automatically uploaded to in-car DVR
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Recording tab
Setting Description

The following OSD (on-screen display) settings have to do with enabling or disabling various on-screen indicators. 
 When a corresponding checkbox is selected, the on-screen indicator will be displayed on the recorded video.
 When a corresponding checkbox is selected, the on-screen indicator will not be displayed on the recorded video.

OSDAudio Status Displays the audio mute status of the current recording

OSDDateTime Displays the current date and time

OSDFnKey Displays the function currently assigned to the Fn button on this X2

OSDGPS Displays GPS data (latitude and longitude of the current location)

OSDIRStatus Displays the current status of the infrared LED

OSDOfficerID Displays the ID of the officer this X2 is assigned to

OSDPDName Displays the name of the police department this X2 belongs to

Edit DVR: for 8-Bay Docks

DVR tab
Setting Description

DVR Name The name assigned to this 8-bay dock. By default, the system assigns the following name to a 
newly discovered DVR: [product code]_[serial number].
If this field is grayed out, it indicates that there is a naming conflict associated with the 8-bay dock.

Status A system setting that determines whether or not video downloads are allowed for this 8-bay dock:
• Enabled . The system is allowed to upload video off of this BWX-100 when the DVR is 

connected to the server
• Disabled. The system is not allowed to upload video off of docked DVRs when the 8-bay dock 

is connected to the server. If you select this option, disabled 8-bay docks will not be displayed 
on the Manage DVRs list unless you change the value of the Status search field to Disabled .

Group Name The name of the 8-bay dock DVR group to which this 8-bay dock is currently assigned, if applicable. 

Version The current firmware version loaded on this 8-bay dock. Display-only field.

Assigned Firmware The new firmware version that you want to assign this 8-bay dock. 

Ethernet tab
Setting Description

Ethernet DHCP A checkbox used to indicate whether or not a DHCP server will automatically provide the IP address 
to this 8-bay dock.
 DHCP server will automatically assign an IP address to this 8-bay dock
 User will manually assign an IP address to this 8-bay dock

This table is continued on the next page.
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Ethernet tab
Setting Description

Ethernet IP The unique IP address that is assigned to this 8-bay dock. This field is only required when the 
Ethernet DHCP checkbox is not selected.

Ethernet Mask The same Ethernet mask address that you use on your private Ethernet network. This field is only 
required when the Ethernet DHCP checkbox is not selected.

Ethernet Gateway IP IP The same Ethernet gateway IP address that you use on your private Ethernet network. This field 
is only required when the Ethernet DHCP checkbox is not selected.

Ethernet DNS 
Addresses

The DNS IP addresses that this 8-bay dock will use on your network.

Settings tab
Setting Description

Time Zone The time zone in which this 8-bay dock will be operating. System default is Eastern Time. 

Use DST A checkbox used to indicate whether or not this 8-bay dock will be used in a region that observes 
Daylight Savings Time . 
 Daylight Savings Time is observed in this 8-bay dock’s region
 Daylight Savings Time is not observed in this 8-bay dock’s recording region

NTP Server An IP address of your network's NTP Server. *

Second NTP Server An IP address of your network's second NTP Server.*

* NTP servers run the Network Time Protocol (NTP) software that maintains network time synchronization.

DVR Status by Last Contact Date

Setting Description

DVR Name The name of the DVR. If a DVR name is followed by @[DVR serial number], it indicates that the DVR 
has an unresolved naming conflict. 

IP Address The IP Address for this DVR. An IP Address is a numerical label that identifies the DVR to the 
network.

DL Status
(To update status, 
click Refresh Page)

The current download status for this DVR, which updates after you click Refresh Page:
• Idle . Download is not currently in progress .
• Downloading . Download is currently in progress .

Last COM Date The date and time at which the last communication occurred between this DVR and the server. It is 
displayed in mm/dd/yyyy hh:mm format . If this DVR has not communicated with the server for 48 
hours or longer, this field will be displayed in red.
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DVR Name Pop-up

Column Description

System ID The system-assigned video identification number for each video clip included in this download.

Download Date The date and time at which this video clip was transmitted to the server . It is displayed in mm/dd/
yyyy hh:mm format .

DL Speed (Kbps) The download speed for this video clip, in kilobits per second.

Size (MB) The size of this video clip, in megabytes.

DVR/8-Bay Dock Groups

Edit Group: for In-Car DVRs

DVR Settings Tab

Edit In-Car DVR Group - DVR Settings tab
Setting Description

Admin login name 
and password

The in-car DVR User ID and password used by the system to:
• Wirelessly transmit videos to the server
• Download configuration changes from the server to the group’s DVRs. 

Do not change this value unless instructed to do so by a Mobile-Vision Technical Support Engineer.

Time zone The time zone in which the group’s DVRs will be recording.

Ignition timer setting The number of minutes the group’s DVRs will remain on in idle mode after a vehicle’s ignition has 
been turned off.

Allow USB Logins A checkbox used to indicate whether or not an officer will be able to use a USB login key to access 
the DVRs in this group. If this checkbox is selected, different officers will be able to log in and out of 
the group’s DVRs using a USB login key. If this checkbox is not selected, no officers will be able to 
log in and out of the group’s DVRs using a USB login key. Select the latter option if:
• Each DVR in a group is used by only one officer,  

-OR-
• Your agency has chosen not to use DVR Login Keys .
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 NOTE: Configuration settings for in-car DVR groups

To review the configuration settings for your Flashback or FOCUS H1 DVR group, refer to the relevant sections in this 
chapter that describe the settings for DVRs not assigned to a DVR group: 
• Edit DVR: for Flashback DVRs NOT Assigned to a DVR Group
• Edit DVR: for FOCUS H1 DVRs NOT Assigned to a DVR Group

Edit Group: for BodyVISION DVRs

 NOTE: Configuration settings for BodyVISION DVR groups

To review the configuration settings for your BodyVISION DVR group, refer to the following section in this chapter: Edit 
DVR/Edit Device: for BodyVISION DVRs when Fleet Management is ON/OFF

Edit Group: for BWX-100 DVRs

Settings Tab

 NOTE: General configuration settings for BWX-100 DVR groups

To review the general configuration settings for your BWX-100 DVR group, refer to the DVR tab table of the following 
section in this chapter: Edit DVR: for BWX-100 DVRs when Fleet Management is ON

IP Setup Tab

Edit BWX-100 DVR Group - IP Setup tab
Setting Description

Group Managed 
Ethernet

A checkbox used to determine whether your agency will manage Ethernet settings within the 
individual BWX-100 DVR records or within the parent DVR Group record .
 Allow changes to the Ethernet settings within the parent DVR Group record only (that is, the 
group to which the individual BWX-100 records are assigned). If the DVRs in this group will be 
installed on a DHCP network, choose this setting.
 Allow changes to Ethernet settings within each individual DVR record

Ethernet DHCP A checkbox used to indicate whether or not a DHCP server will automatically provide the wireless 
IP address to the DVRs in this DVR group .
 DHCP server will automatically assign an IP address to the DVRs in this DVR group
 Individual users will manually assign an IP address to their DVRs
If your agency does not have a DHCP server, leave this checkbox deselected.
If the Group Managed Ethernet setting is deselected, this field will be grayed out.

The table is continued on the next page.
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Edit BWX-100 DVR Group - IP Setup tab
Setting Description

Ethernet IP The Ethernet IP address that the DVRs in this group will use on their private Ethernet networks.
If the Group Managed Ethernet setting is deselected, this field will be grayed out.

Ethernet Mask The Ethernet mask IP address that the DVRs in this group will use on their Ethernet network.
If the Group Managed Ethernet setting is deselected, this field will be grayed out.

Ethernet Gateway IP The Ethernet gateway IP address that the DVRs in this group will use on their Ethernet network.
If the Group Managed Ethernet setting is deselected, this field will be grayed out.

Remote Broadcast 
IP(s)

An IP address range across which the Group’s BWX-100s announce their identity so the server can 
locate them . System default is 255.255.255.255 . Separate multiple IP addresses with a space .

Video Tab

 NOTE: Video configuration settings BWX-100 DVR groups

To review the video configuration settings for your BWX-100 DVR group, refer to the Video tab table of the following 
section in this chapter: Edit DVR: for BWX-100 DVRs when Fleet Management is ON

Edit Group: for FOCUS X2 DVRs

Settings Tab

Edit FOCUS X2 DVR Group - Settings tab
Setting Description

Time Zone The time zone in which the X2s in this group will be recording.

 NOTE: Other configuration settings for FOCUS X2 DVR groups

To review all other configuration settings for your FOCUS X2 DVR group, refer to the following section in this chapter:
• Edit DVR/Edit Device: for FOCUS X2 DVRs when Fleet Management is ON/OFF

Edit Group: for 8-Bay Docks

 NOTE: Configuration settings for 8-bay dock groups

To review the configuration settings for your 8-bay dock group, refer to the following section in this chapter: 
• Edit DVR: for 8-Bay Docks.



© Safe Fleet | September 2021 | All rights reserved

Digital Evidence Series Administrator's Guide

362 Part # 700-8006 R3
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Users

Adding a New User - New/Edit User Form

Field Description

Display Name The name used to represent this user throughout your DES application . This name will appear 
on application pages, drop-down lists, reports, etc .

User Name The user’s login ID. This is the text that the user enters in the User Name field to login to the 
application .

Email Address The user’s email address.

User Password The user’s login password. This is the text that the user enters in the Password field to login 
to the application . For security reasons, this value does not display on screen as you type it . 
NOTE: After a new user logs into the application for the first time, they should change their user 
password .

Repeat User Password Same as User Password above. The system requires that you type the password a second 
time to verify your entry .

Status The current status of this user:
• Enabled . The user is allowed to login to the application .
• Disabled . The user is not allowed to login to the application .

User Role The name of the permissions group that is assigned to this user . This designation determines 
what system features the user will or will not be able to access. 

DVR Officer Name

NOTE: The name you 
enter here should match 
the Officer Name entered 
on the Flashback2’s 
Misc. Setup menu or the 
Flashback3/HD’s User 
menu .

The officer name associated with the DVR device. If this user logs into a Flashback DVR using 
a USB login key, the system will automatically populate the Flashback’s Officer Name field 
with the DVR Officer Name value. This ensures that all videos recorded during that officer’s 
shift will be linked to the correct officer. If an officer uses the same patrol car every day, the 
Flashback’s Officer Name field will typically be entered manually during system start-up. In 
this circumstance, it’s important that the DVR Officer Name in your DES application match the 
Officer Name in Flashback. 
• If these names match exactly, the system will automatically link the videos recorded on 

that DVR with the correct officer. If the names do not match exactly, the system will assign 
a default DVR Officer Name of *1 [No Name]@[time at which default officer name was 
created] to any videos that are recorded on that device .

• If the new user will be uploading VIEVU Model LE2 videos, this field must be populated.
• This field can only be configured on user accounts with the Can Own Video permission .

Video Visibility A flag that determines which users will be able to access this user’s videos:
• Public. The videos owned by this user will be viewable by all users.
• Private. The videos owned by this user will be viewable by the user and other users who 

have the proper edit permissions (i .e ., the Edit Private Data or Edit All Data permission) .
This field can only be accessed by users with the Can Own Video permission .
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User Search Results Page: Quick Search Fields

Field Description

Display Name Limits your search to those users who have this text in their display name .

User Login Limits your search to those users who have this text in their User ID .

User Role Limits your search to those users who are assigned this user role . Select the appropriate role from 
the drop-down list .

Status Limits your search to those users who have a status of either Enabled or Disabled . Select the 
appropriate status from the drop-down list .

Edit LDAP Active Directory Settings

Field Description

Host The address of the host active directory server .

Port The port to use when connecting to the Active Directory server. Default values are:
• No encryption – 389
• SSL encryption – 636

LDAP Base Name The LDAP string which represents the base distinguished name of the Active Directory server. This 
is usually a full distinguished name path, such as: DC=MVI,DC=MyCompany,DC=com

User The name of the user to connect to the Active Directory server . If you use our setup 
instructions to create the user (recommended), you may use the user’s name, 
such  as “Mark Jones.” Otherwise you MUST use a full distinguished name, such as: 
CN=CraigReinen,OU=Florida,DC=MVI,DC=MyCompany,DC=com

Password The security password that matches the User name above.

Encryption The type of encryption used on the Active Directory server: None or SSL . 

Auto Create Users A checkbox used to indicate whether or not the system will automatically create users. If this 
box is selected, the system will automatically create users at login time if the user’s credentials 
authenticate against the Active Directory server .
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User Roles and Permissions

User Role Permissions

User Role Permissions
Permission Allows the user to...

Admin Messages Send administrator messages to the user’s Inbox Messages list .

Allow Restricted Case Enter a restricted case record (i.e., a case that can only be accessed by a select group of 
users) .

Authorize Media Playback Grant or deny user access to  body-worn videos.

Assign Videos Access the Assign Video menu .

Can Own Video Own system video .

Can Reset DVR Remove a non-operational DVR’s serial number from the server.

Can View Body Worn Videos View body-worn videos/ snapshots without having to submit a viewing request.

Case—Do not Dispose Select the Do Not Dispose checkbox, therefore preventing a case from going offline.

Create Case Enter a new case record .

Display MAX Speed View the Maximum Speed field on the Video Details page .

Edit All Data View/edit all video and cases, including restricted cases .

Edit Private Data View/edit video and cases that are marked as private.

Export Display GPS Include a Show GPS checkbox on the Export Options pop-up, which, when selected, will 
allow user to view the Latitude, Longitude, and Heading fields while playing exported 
Data DVD videos .

Export Display Speed Include a Show Speed checkbox on the Export Options pop-up, which, when selected, 
will allow user to view the Speed field while playing exported Data DVD videos.

Export Format—Consumer DVD Export video to a Consumer DVD disc .

Export Format—Data DVD Export video and cases to a Data DVD disc .

Export Format—FOIA Export video to your PC in FOIA Redacted format .

Export Format—Interchange Export video to an MP4 or AVI file.

Export Format—Uncompressed Export video to MP4 and digital video (DV) format .

Export to Cloud Share Export videos and case files in order to share evidence with outside parties.

Export To Disc Export video and cases to a DVD disc .

Export To File Export video and cases to a ZIP or ISO file.

Export Without Case Export video that is not linked to any case.

Generate Reports Access the Advanced Reporting feature .

Google Earth Download GPS data in a KML file format for use with Google Earth.

The table is continued on the next page.
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User Role Permissions
Permission Allows the user to...

Manage DVRS Access the Manage DVRs menu .

Manage Users Access the Manage Users menu .

Media Reader Upload video via the Media Reader option .

Mobile Devices Access the Mobile Devices menu, which is used to track  body-worn DVRs.

Player Display GPS View the Latitude, Longitude, and Heading fields while playing videos on the server; 
search on the Latitude and Longitude fields.

Player Display Speed View the Speed field while playing videos on the server; search on the Speed Greater 
Than field.

Reactivate Video Restore videos and cases from DVD backups.

Search Cases Search case records .

Search Videos Search video records .

Select COC Logs Select the type of information that will display on the Chain of Custody Report .

System Setup Access the System Setup menu. This permission should only be given to System 
Administrators .

System Status Access the System Status menu .

User Group Have other users assigned to this user. This limits this user's video searches to 1) public 
videos and 2) videos owned by users in the user's group.

View All Cloud Exports View details about all shared evidence.

View Data Logs View video and case logs .

View Only View, but not edit, system data.

Adding Custom User Roles: User Roles Tab

Column Description

Display Name The name of this user role. The system-defined user role names never change. They are:
• Administrator
• Display Only – Case
• Display Only – Video
• Internal Affairs
• Officer
• Supervisor Lvl 1
• Supervisor Lvl 2

AD Group Name
(Active Directory 
users only)

The Active Directory Group that this user role belongs to, if applicable. This field will only display if 
your agency is using the Active Directory Integration feature, which links your DES application to 
your agency’s existing internal network.

The table is continued on the next page.
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Column Description

Session Timeouts 
(minutes)

The number of idle-time minutes that must pass before the system automatically logs a user with 
this user role off the system .

System Defined A true/false indicator that denotes whether or not this user role is system defined:
• True ...........The user role is system-defined
• False...........The user role is not system-defined (i.e., it is user-defined)

Defining Password Policies: Security Policy Pop-up

Security option Description

Verify password has a 
numeric character

When you select this checkbox, the system will check to make sure all new passwords contain 
at least one numeric character (e .g ., 1 – 9) .

Verify password has an 
alpha character

When you select this checkbox, the system will check to make sure all new passwords contain 
at least one alpha character (e .g ., a – z) .

Verify password has an 
uppercase character

When you select this checkbox, the system will check to make sure all new passwords contain 
at least one uppercase character (e .g ., A – Z) .

Verify password has a 
special character

When you select this checkbox, the system will check to make sure all new passwords contain 
at least one special character (e.g., ! @ # $ % &, etc.)

Verify password is 
not a commonly used 
password

When you select this checkbox, the system will check to make sure all new passwords do not 
match any of the passwords on the “common passwords” list . A copy of this list is found in the 
/fb/conf/word_list.txt file on the server. You can add more passwords to this file, if desired.

Disable account on the 
3rd failed login attempt

When you select this checkbox, the system will lock a user out of the system after they 
have tried to login to the system three consecutive times using invalid User ID(s) and/or 
password(s) .

Verify password has not 
been used recently

This password function works in conjunction with the number of passwords to save in history 
per user field. When you select this checkbox, the system will check to make sure that a 
password has not been used in X number of times, with X being the number entered in the 
number of passwords to save in history per user field.

The number of 
passwords to save in 
history per user

This password function works in conjunction with the Verify password has not been used 
recently field. It indicates the number of passwords to save in history per user. When a user is 
required to change their password, they will not be able to reuse any of the same passwords 
they have used since the last x number of times their password was changed, with x being the 
number entered in this field.

Verify password length This password function works in conjunction with the Required number of characters for 
password field. When you select this checkbox, the system will check to make sure that a 
password is a minimum of X number of characters in length, with X being the number entered 
in the Required number of characters for password field.

Required number of 
characters for password

This password function works in conjunction with the Verify password length field. It indicates 
the required minimum length for each password. When you enter a number in this field, it 
means that all passwords must be a minimum of X characters in length, with X being the 
number entered in this field.

The table is continued on the next page.
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User Roles and Permissions

Security option Description

Video visibility for auto 
created officers

The default visibility to use for videos that are owned by auto-created Officers.
• Public. Allow any user to view videos that are owned by auto-created Officers.
• Private . Allow only those users who have the View Private Data or View All Data 

permissions to view videos owned by auto-created Officers.
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Default Permissions for System-Defined User Roles
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Appendix 7 - Utilities.
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System Status Page: System Tab

System Status Settings
Field Description

Storage Capacity The total amount of usable space allotted for storing videos on the server.

Available Disk Space The amount of storage space that is currently available to store videos.

Enabled DVRs The number of active DVRs in your fleet. Active DVRs have a status of Enabled .

Disabled DVRs The number of inactive DVRs in your fleet. Inactive DVRs have a status of Disabled . They 
cannot be used to record videos.

Total Video Count The total number of searchable videos on the server.

Non-archived Video Count The number of searchable videos on the server that have not been backed up to a Certified 
Backup Disc or external backup device.

Last 24 Hours Video Count The number of videos that have been uploaded from DVRs to the server in the last 24 hours.

Last 7 Days Video Count The number of videos that have been uploaded from DVRs to the server in the last seven 
days .

Last 30 Days Video Count The number of videos that have been uploaded from DVRs to the server in the last 30 days.

Body Worn Video Count The number of searchable  body-worn videos that are currently on the server.

Body Worn Hours The number of recorded hours from searchable  body-worn videos that are currently on the 
server .

Average Body Worn Video 
Length

The average length, in minutes, of the searchable body-worn videos that are currently on the 
server .

VieVu Video Count The number of searchable VIEVU videos that are currently on the server.

Oldest Non-case Video The oldest video on the server that is not attached to a case .

Oldest Case Video The oldest video on the server that is attached to a case .

Number of Active Cases The number of cases on the server that have a status of online.

Number of Backup DVDs The total number of archive DVDs (i.e., Certified Backup Discs) that the system has burned 
since your DES application was installed. This type of disc is burned automatically on a 
schedule .

Number of Exported DVDs The total number of export DVDs (i.e., user requested certified copies) that users have 
requested since your DES application was installed. This type of disc is burned manually as 
needed .

Archiver Errored Out A true/false display that indicates whether or not there is currently a problem with the 
archive service. Problems can occur either on the software side (your DES application) or 
hardware side (DVD burner).
• True . There is an error with the archive service .
• False . There is no error with the archive service .

The table is continued on the next page.
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System Status Settings
Field Description

Downloader Errored Out A true/false display that indicates whether or not there is currently a problem with the 
transmission of video files from DVR to server:
• True. There is a video transmission problem.
• False. There is no video transmission problem.

Simultaneous Users 
Allowed

The number of users that are allowed on the application at the same time. The value of this 
field will always be unlimited for DEP users.

Backup Scheme The current backup scheme:
• NONE. Do not backup anything
• ALL. Backup everything. If you select this option, the system will backup ALL videos, 

even if some of those videos have categories that are backup disabled.
• EXTERNAL. Backup everything to an external backup device
• CASE. Backup any case video and media
• CATEGORY. Backup any video that has a video category that is Backup Enabled
• TAGGED. Backup any video that is tagged by a user. If you select this option, the system 

will backup ALL tagged videos, even if some of those videos have categories that are 
backup disabled.

For assistance in creating a custom backup plan, contact Mobile-Vision Support.

Untagging Allowed A true/false display that indicates whether or not users are allowed to remove a tag from a 
previously tagged video .
• True. Untagging is allowed. This value will be displayed if the Enable Un-tagging 

checkbox on the Life-Cycle tab is selected.
• False. Untagging is not allowed. This value will be displayed if the Enable Un-tagging 

checkbox on the Life-Cycle tab is deselected.

Last Update Check The last date and time at which the your DES application update service connected to the 
Mobile-Vision update server.

Version The version of the DES application that you currently have installed . Whenever you call 
Mobile-Vision Technical Support, please have the current version number on hand.
This field also includes a link to the technical Release Notes.

Active Users Information on the user who is currently logged into your DES application:
• User ID
• IP address of the PC from which the user logged in
• Date and time at which the user last logged in . It is displayed in mm/dd/yyyy hh:mm 

format .

Available Actions
Action Description

Refresh Page Redisplay the System Status page so that you can see any changes that have occurred 
since you first displayed the page. The system updates screen information every 15 minutes.
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Data Transfer Records between Precinct and Agency Servers

Column Description

Server The Precinct server from which the transfer occurred or is occurring .

Date The date on which the data transfer was initiated .

Date Inserted The number of metadata fields (owner, category, duration, etc.) that have transferred from this Precinct 
server to the Agency server since this transfer was initiated .

Media 
Transfers

The number of video and media files that have transferred from this Precinct server to the Agency server 
since this transfer was initiated .

Online Lifecycle Settings page: Life-Cycle Tab

Life-Cycle Tab
Field Description

Days to enable restore of 
backed-up media

The minimum number of days that a video or snapshot will stay in an offline and restorable 
state before the system permanently removes it from the database. Default is 720 days.

Days to enable restore of 
Disposed Case

The minimum number of days that a case will stay in an offline and restorable state before 
the system permanently removes it from the database. Default is 720 days.

Days until case is auto-
disposed if inactive

The minimum number of days that a case will stay online after it is last viewed. Default is 
60 days. For example, if 30 is entered here, then at least 30 days must elapse between the 
time that a user last viewed a case and the time that the system changes the case’s status 
to offline.

Days to extend the life of 
tagged video

The number of additional days that a tagged video or snapshot will stay online beyond its 
original life expectancy . Default is 60 days . 

Enable Un-tagging  If this checkbox is selected, then users are allowed to remove the “tagged” designation 
from a video or snapshot (i .e ., “untag” a previously tagged record) .
 If this checkbox is not selected, then users are not allowed to remove the “tagged” 
designation from a video or snapshot .

Enable Strict Purger  If this checkbox is selected, the system will move videos and snapshots offline as soon 
as 1) the video or snapshot ages out, and 2) the video or snapshot has been archived, 
assuming that it is a backup-enabled record.
 If this checkbox is not selected, the system will move aged-out videos and snapshots 
offline only when space is needed on the server. Until then, they will remain online.

Enable Re-categorization of 
Media on Delete

 If this checkbox is selected, the system will reassign expired videos and snapshots the 
category of “Purged”, which will keep that media in an offline but restorable state on the 
server indefinitely.
 If this checkbox is not selected, the system will permanently purge expired videos and 
snapshots from the server .

The table is continued on the next page.
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Life-Cycle Tab
Field Description

Enable Media Deletion Roll-
up Report

 If this checkbox is selected, the system will generate a Media Deletion Roll-Up Report, 
also referred to as a Video Deletion Roll-Up Report, which lists details of all media that has 
become “unrestorable” each month. Unrestorable media includes videos, snapshots, and 
cases that can no longer be restored, according to your system settings. 
 If this checkbox is not selected, the system will not generate a Media Deletion Roll-Up 
Report each month .

Enable Quarantine  If this checkbox is selected, the system will set aside all quarantine files (see definition on 
the next page) so that they can either be reviewed or automatically deleted. If you want to 
review these files, make sure the Auto Reject Quarantine Files checkbox is deselected. If you 
want the system to automatically delete these files, make sure the Auto Reject Quarantine 
Files checkbox is selected.
 If the Enable Quarantine checkbox is not selected, the system will download all video files 
to the server, regardless of their duration .
What is a quarantine file? A quarantine file is a video that is shorter than the Minimum File 
Duration value. Typically, a quarantine file is a small “test” video that an officer makes at the 
beginning of each shift to test his equipment before going out into the field.

Auto Reject Quarantined 
Files

 If this checkbox is selected, the system will automatically delete quarantine files (see 
definition above) without giving you the opportunity to review them first.
 If this checkbox is not selected, the system will send all quarantine files to your Home 
Page, where you will have the opportunity to accept or reject each file.
Note: If you previously deselected the Enable Quarantine checkbox, the Auto Reject 
Quarantined Files checkbox will not appear on the Life-cycle tab.

Minimum File Duration The minimum length (in seconds) that a video must be before it will be classified as a 
quarantine file (see definition above). Default is 60 seconds. The system treats these files in 
one of several ways depending on whether or not the Enable Quarantine and Auto Reject 
Quarantined Files checkboxes are selected:
If the Enable Quarantine checkbox is deselected, the system will automatically transfer files 
shorter than X seconds to the server .
If the Enable Quarantine checkbox is selected and the Auto Reject Quarantined Files 
checkbox is deselected, the system will send files shorter than X seconds to your Welcome 
Home page, where you will have the opportunity to accept or reject each file.
If the Enable Quarantine checkbox is selected and the Auto Reject Quarantined Files 
checkbox is also selected, the system will automatically delete files shorter than X seconds .

Forwarding IP Address 
(DEF only)

The IP address of the “parent” server to which the system will forward all newly ingested DEF 
videos during night processing .

Forwarding User Name 
(DEF only)

The Admin User Name that will be used to access the server.

Forwarding Password 
(DEF only)

The password associated with the Forwarding User Name above.
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System Logs

Column Description

Date The date and time at which this event occurred . It is displayed in mm/dd/yyyy hh:mm format .

IP Address The IP address of the machine from which the change was made .

Event The type of change that was made to the system .

Description A detailed description of the change that was made, including:
• Name and ID number of field changed
• Old field value
• New field value
• User who made the change

System Alerts

Column Description

Quantity The number of messages related to the issue described in the Message Type column .

State The current status of the issue described in the Message Type column .

Message Type A description of the system issue. Because system messages are grouped by type, any information 
that is specific to an individual message is replaced by {0}. If you want to review the specific message 
content, you will have to view the message from your Inbox Messages list on the Welcome Home page .

Action An icon used to delete all messages related to the issue described in the Message Type column .

New Precinct/Edit Precinct (DEA Agency users)

Field Description

Organization Name The name of your agency. By default, the system will print this field on your archive DVDs.

Precinct Name The name of the precinct that this server is installed at, if applicable. If you don’t need this field to 
specify precinct information, you can use it to enter default text that you wish to print on archive/
export discs, such as “For Official Use Only.”

Address Your precinct’s mailing address.

Phone Number Your precinct’s phone number. By default, the system will print this field on your archive DVDs. 

Support Expiration The date on which your service contract with Mobile-Vision expires. Display-only field. 

Registration Key Your DES product identification code. Display-only field.

FTP IP Address The FTP IP address required to move data to and from this remote server .

FTP User Name The FTP User Name required to move data to and from this remote server .

FTP User Password The FTP User Password required to move data to and from this remote server .

Status The current status of this Precinct server: Enabled (in use) or Disabled (not in use).

Last Comm Date The date and time of the most recent communication between this Precinct server and the Agency 
server. System-generated field.



© Safe Fleet | September 2021 | All rights reserved

Digital Evidence Series Administrator's Guide

378 Part # 700-8006 R3

 

Precinct Info Tab

Field Description

Precinct Name The name of the Agency or Precinct server .

FTP IP Address If this is a Precinct server, this field displays the FTP IP address used to move data to and from this 
server . If this is the Agency server, the word Local will display here .

Last Comm Date If this is a Precinct server, this field displays the last date and time at which that server 
communicated with the Agency server . If this is the Agency server, the word Local will display here .

Status If this is a Precinct server, this field displays the current status of that server: Enabled (in use) or 
Disabled (not in use). If this is the Agency server, the word Local will display here.

Registration Key Your DES product identification code. Display-only field.

Edit Precinct
NOTE: This form is used by DEA Agency users to edit Agency information or by users of all other DES applications to edit 
Precinct information .

Field Description

Organization Name The name of your agency. By default, the system will print this field on your archive DVDs.

Precinct Name The name of the precinct that this server is installed at, if applicable. If you don’t need this field to 
specify precinct information, you can use it to enter default text that you wish to print on archive/
export discs, such as “For Official Use Only.”

Address Your precinct’s mailing address.

Phone Number Your precinct’s phone number. By default, the system will print this field on your archive DVDs. 

Support Expiration The date on which your service contract with Mobile-Vision expires. Display-only field. 

Registration Key Your DES product identification code. Display-only field.

Mail Server Information

Field Description

Mail Server Login A User ID that has send-mail privileges in your mail system .

Mail Server Password The security password for the Mail Server Login above.

From Address The email address that will be displayed in the From Address field of the forwarded emails (e.g., 
System_Admin@ safefleet.net).

SMTP host The SMTP email host .

SMTP port The SMTP email port .
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Ports & Protocols

MDC to DVR
Vehicle Viewer:
• TCP port 9003
• TCP port 9004

UMD Editor (Notes):
• Need write permission to C:\Program Files\MobileVision\FB2UMD\
• TCP port 80 (HTTP)

DVR to Server Downloading
UDP 54771 (if using UDP)
Server to DVR:
• TCP port 80 (HTTP)
• ICMP Echo-Reply (if using discover by ping)

Agency Server to Precinct Server
• TCP Port 80 (HTTP)
• TCP port 22 (FTP Passive Mode)

Servers to Backup Workstation
• TCP port 21 (FTP Passive Mode)
• TCP port 9000 (HTTP)

Workstations to Servers
• TCP port 80 (if using HTTP Playback)
• TCP port 21 (if using FTP Playback)
• TCP port 139 (if using SMB playback)
• TCP port 445 (if using SMB playback)
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Access Point
A device used to transmit videos from your in-car DVR to your server. The access point is connected to a wireless network 
antenna mounted on the outside of the building that houses your server.
Some precincts have more than one access point to accommodate multiple vehicles that park in different areas outside 
the building. Some smaller agencies do not use Access Points, as they download all their videos manually. See also 
Transmission .
Auto Dispose Time
A period of inactivity after which the system automatically changes a case’s status from online to offline. NOTE: Videos that 
are attached to the case will remain online as long as their categories allow . 
If, for example, you set the Auto Dispose Time to 90 days, then if that case has not been touched in 90 days, the system will 
automatically change the case’s status to offline. If you have archiving enabled for your case files, the system will archive 
the case first.
The default setting for Auto Dispose is 60 days. However, you may change this default, as described in Changing the Online 
Lifecycle Settings on page 268 .
Automatic Archive
A backup process that is triggered by the system based on predefined rules that you set in the application. When a video’s 
category is set to Backup Enabled and that video has been online for at least five minutes, the system will automatically 
back that video up during the next archive session. Once there are enough files to fill up an archive disc, the robotic DVD 
burner will burn a Certified Backup Disc. Aside from the initial system configuration, automatic archives do not require any 
action on your part .
Backup PC
A computer used to process DVD burn requests. Because the process of burning DVDs is resource-intensive, one PC is 
dedicated to this task. If you are using a Bravo robotic DVD burner, the backup PC is a separate computer workstation 
connected to the disc burner. If you are using a Rimage DVD/Blu-ray burner that combines a disc burner with a computer, 
the backup PC refers to the computer component of the Rimage.
Body-worn Video Tracking
A system feature that restricts the viewing of body-worn videos to users who have the Authorize Media Playback and/or Can 
View Body Worn Videos permission. All other users who are interested in viewing a body-worn video are required to submit a 
viewing request to their supervisor, which includes a “need to know” reason, referred to as a viewing request reason.
BodyVISION
A small, wearable digital video recorder sold by Mobile-Vision. This device allows officers to capture both high definition 
videos and JPG snapshot images, then upload them to your server via a BodyVISION docking station. Videos recorded using 
this device are assigned the category of Body Worn .
Bookmark
An agency-defined link to a website. These links are displayed in the Bookmarks column on the Main Menu. The default link 
will take you to the Mobile-Vision Online Support Center.
Burn Request
A request to generate a user-requested certified copy, also referred to as an export disc. When you submit a burn request 
and you have burning privileges, the system will place your burn job in the backup PC’s burn queue. When you submit a burn 
request and you don’t have burning privileges, the system will place your burn request in the Inbox Messages list of all DEP 
users who have burning privileges. If one of those users approves your request, they will place your burn job in the backup 
PC's burn queue.
BWX-100
A small, wearable digital video recorder sold by Mobile-Vision. This device allows you to capture both full high definition 
videos and JPG “snapshot” images, then upload them to the server via a BWX-100 docking station. Videos recorded using 
this device are assigned the category of Body Worn .
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Case
A record that contains data that pertains to one incident, such as a motor vehicle accident. DEP’s case feature allows you to 
conveniently gather all of an incident’s evidence in one record, allowing for easy viewing and archiving of evidence.
A case may contain one or more videos, media files (such as photographs), subject names, comments, and/or general 
information relating to the incident, such as the incident date .
Certified Backup Disc (CBD)
An archive DVD used to restore videos and/or case files to the server. Also referred to as a “CBD.” The system automatically 
sends CBD burn requests to the backup PC without any action on your part. The number and type of files burned to CBD 
is determined by your system settings. Factors such as a file’s age, type, category, etc., all help determine what data the 
system will back up. You define these backup parameters through DEP. If a video file is supposed to be backed up, the 
system will add it to an archive job shortly after the video transmits to the server (see also transmission). Once there are 
enough files to fill up an archive disc, the system automatically generates a CBD.
All CBDs are printed with an identification number that makes it easy for you to restore the files at a later date, should the 
need arise (permissions required) .
CF Card
The temporary storage device that stores your Flashback2 videos until they can be transmitted to your agency’s server.
Chain of Custody Report
A log of all operations that have been performed on a particular video, body-worn snapshot, or case (e.g., System Media 
Uploaded from Unit) . This report shows the date and time at which each activity occurred, as well as the user name of the 
officer who performed the action, if applicable.
Consumer DVD
An MP4 disc format that you can play on any standard consumer DVD player. Includes a customizable DVD menu.
Data DVD
A disc format that you can play on any PC DVD player using the Flashback Player. When you burn a case in Data DVD 
format, the disc will include selected videos from the case, any user metadata attached to the case’s videos, the Chain of 
Custody Report, selected media files attached to the case (if applicable), and a copy of the Flashback Player. When you burn 
videos in Data DVD format, the disc will include selected videos, general information about the videos, the Chain of Custody 
Report, and a copy of the Flashback Player.
DEP
An acronym for Digital Evidence PRO, the software component of Mobile-Vision’s Digital Evidence Collection System.
Digital Evidence Collection System
A Mobile-Vision product that is used by law enforcement personnel to collect digital evidence. It includes the following 
hardware and software components:
• In-car DVRs
• Body-worn DVRs
• Access point(s)
• Storage server(s)
• DEP software
• Backup PC(s)
• Robotic DVD burner(s)
• RAID storage device (optional) .

Discovered DVR
A DVR that has been in communication with the server at least once.
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Download Request
A request to copy, or export, a selected video file or case file to your PC. This type of request is sent from you to the system. 
Once the system processes your request, a confirmation message and download icon will appear on your Inbox Messages 
list .
DVR Login Key
A file on a USB drive that contains your Flashback user information. You insert this flash drive in your Flashback’s USB port 
at the beginning of each shift, then log in. This identifies you as the owner of all videos recorded on that DVR while you are 
logged in .
Export
The system process used to copy video files, case files, and/or body-worn snapshots for the purpose of either burning them 
to DVD or downloading them to your PC. You must have the proper permissions to export files.
Flashback Player
A software application used to play video files. When you select an online video from within DES, the Flashback Player 
launches automatically. When you burn a user requested certified copy of a case or video in Data DVD format, that disc will 
include a copy of the Flashback Player.
FOIA Redacted Format
An export format that allows you to redact a video prior to downloading it to your PC or external storage device . The 
exported video will have an extension of MP4, allowing you to play it using any MP4 player. You can also burn exported video 
to DVD using your PC’s DVD burner.
In-Car DVR
A digital video recorder that is installed inside a vehicle or interview room . This recorder collects video evidence and stores it 
temporarily on an SD card or CF card until the video can be transmitted to the server. 
Incident
An event, such as a motor vehicle accident, that has digital evidence associated with it . In DEP, data that pertains to an 
incident is stored in a case record .
Ingest Date
The date and time at which a video file was transmitted to the server from the DVR unit.
Interchange Format
A disc format that allows you to import videos into various third-party applications, such as video editing software . If your 
agency has any VIEVU body-worn DVRs, your Interchange videos will have an extension of AVI. If your agency has any 
BodyVISION body-worn DVRs, your Interchange videos will have an extension of MKV. All other Interchange videos will have 
an extension of MP4 .
LEC Mobile
A Mobile-Vision app used to view BWX-100 videos from a smart phone or tablet in the field.
Manual Export
The system process used to download video and/or case files to your PC. You must have the proper permissions to perform 
a manual export .
Offline
A status for a video or case which indicates that some, but not all, of that record’s data or functions are available on the 
server .
Online
A status for a video or case file which indicates that all of the file’s information is currently available for viewing on the 
server .
• If a video is offline, you will be able to view that video’s thumbnail image and statistics (category, duration, record 
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reason, etc.), but not the video itself. Also, you cannot export an offline video.
• If a case is offline, you will be able to view the case record, but not its attached videos. Also, you cannot export an offline 

case . 
You can, in some cases, reactivate an offline file. See also Reactivation.
Private File
A video, case, or snapshot that can only be viewed by its owner or a user with one of the following permissions: Edit Private 
Data or Edit All Data .
Public File
A video, case, or snapshot that can be viewed by all DEP users.
Quarantined File
A video that is shorter than the Minimum File Duration value entered on the Life-Cycle tab. Typically, a quarantine file is a 
small “test” video that an officer makes at the beginning of each shift to test his equipment before going out into the field. 
The system automatically marks these short videos for review or disposal, depending on your system settings.
RAID
An acronym for Redundant Array of Independent Disks, a storage device that contains multiple disk drives but is treated by 
the system as one device .
Reactivation
The process used to restore a video or case file that the system took offline after it was backed up to disc. There is a limited 
time period in which you can reactivate an archived video or case . This time period depends on a setting that you enter on 
the Life-Cycle tab.
Record Reason

The event or “trigger” that caused a DVR to start recording . Common record reasons include pressing the  button, 
turning the emergency lights on, activating the siren, or reaching a particular speed, such as 90 miles per hour .
Redaction 
The process of editing a video prior to downloading it to your PC. In DES, the redaction feature gives you the ability to:
• Export a portion of a video rather than the entire full-length video
• Blur a video’s picture
• Remove a video’s audio track(s).

Restricted Case
A case that can only be accessed by a predefined list of users.
Robotic DVD Burner
A disc duplicator that burns and labels your Certified Backup Discs and User Requested Certified Copies. Mobile-Vision 
sells two types of burners: the Bravo, a standalone unit, and the Rimage, a combination disc burner/computer. If you have a 
Rimage, you do not need a separate backup PC. Rimage units can burn CDs, DVDs, and Blu-ray discs. Most Bravo units can 
burn CDs and DVDs. The higher-end Bravos can burn Blu-ray discs as well.
SD Card
The temporary storage device that stores Flashback3, FlashbackHD, or FOCUS H1 videos until they can be transmitted to 
the storage server .
Server
The network computer that hosts the DEP application and stores all of your video and case data. Some larger agencies have 
more than one server .
Snapshot
A JPG still image captured with a body-worn DVR. These images are uploaded to the server along with the device’s videos.
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Standalone Video
Video that is not currently linked to any cases.
System Implementation Specialist (SIS)
A Mobile-Vision representative who assists with the installation and configuration of the “back office” components of the 
Digital Evidence Collection System .
Tagging
A procedure used to add extra days to the online life of a media file. By tagging a video or snapshot, you extend that file’s 
online life by a certain number of days. The exact number of days is defined by a setting on the Life-Cycle tab.
Tracepoint
A placemarker that an officer can add to a video while it’s recording. If you are using a Flashback, this is accomplished 

by pressing the  button on the Flashback menu or the  button on the DVR. If you are using a BodyVISION, 
this is accomplished by pressing the Snapshot/Tracepoint button on the top of the unit. If you are using a BWX-100, 
this is accomplished by pressing the Snap/Trace button on the side of the unit. If you are using a FOCUS DVR, this is 
accomplished by pressing the Fn button on the front of the unit, provided it has been assigned the Bookmark function . By 
marking a video with a Tracepoint, it allows you to quickly advance to an important segment in that video during playback.
Transmission
The process of transferring video files from your in-car DVR to the server. This transmission can occur either automatically 
(typical) or manually .
• Automatic transmission . Whenever a vehicle comes within approximately 300 feet of an access point, it triggers an 

automatic transmission . During this transmission, all videos that are currently stored on the in-car DVR will wirelessly 
transfer to the server via the access point .

• Manual transmission . Your in-car DVR holds a temporary storage device called a CF card or SD Card . This card is 
used to temporarily store your videos until they can be transferred to the server. If necessary, you can use this card to 
manually transfer videos to your PC, assuming you have the proper permissions . You would typically use this procedure 
if you can’t wait for an automatic file transfer to occur, or if a problem has occurred that interfered with the wireless file 
transfer . For more information, see Uploading and Downloading Videos on page 60.

Trigger
See Record Reason .
Uncompressed DVD
A Data DVD disc that includes a link to two raw video files: an MP4 file and a DV (digital video) file. You can import MP4 and 
DV files into third party software, such as video editing or redaction software. Uncompressed DVDs are available for in-car 
videos only .
Undiscovered DVR
A DVR that has not been in communication with the server yet, that is, a DVR for which you just created or uploaded a 
record .
User Metadata (UMD)
Custom data fields that an officer can link to a video. You define these fields on the UMD Types tab. Their purpose is to 
allow officers to annotate their videos with custom data, such as a subject description. If you have a mobile data computer 
with the UMD Editor installed on it, you have the option of attaching UMD to a video immediately after it is finished 
recording. Otherwise you can attach UMD back at the precinct when you connect to the server. For more information, 
Editing Media Files on page 42.
User Requested Certified Copy
A DVD that you can, with the proper permissions, create yourself using either the robotic DVD burner or your PC’s DVD 
burner. This type of DVD is, as its name implies, requested by the user. You create these discs as needed for evidential and/
or backup purposes. Also referred to as an export disc.
For more on the different types of DVDs and how they are created, see Chapter 4. Evidence Backup and Sharing.
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User Role
A group of permissions that determines what system functions a user will have access to . Whenever you login to DEP, the 
system will grant you access to various system functions according to the user role that is assigned to your User ID . As 
System Administrator, you are responsible for assigning permissions to each user role.
Video Notation
A custom checkbox used to notate video records and snapshots. These checkboxes are defined by your agency.
VIEVU
A small, wearable digital video recorder. Videos recorded using this device are assigned the category of VieVu.
Viewing Request
A request to view a body-worn video. Users who lack the Can View Body Worn Videos permission are required to submit 
viewing requests to their supervisor, who will then review each request and either approve or deny it .
Viewing Request Reason
The reason why a user wants or needs to view a particular body-worn video. When a user submits a body-worn viewing 
request to their supervisor, they are required to select a reason for that request from a drop-down list . These reasons are 
defined by your agency.
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Service & Support

Service & Support
If your DES application is to be returned for service, please visit the Safe Fleet Repair and RMA Procedures page https://
community.safefleet.net/sfle/support/repair/ and follow the Mobile-Vision RMA procedure. An RMA # allows the support 
team to better track your product when it comes in for service. Please show the RMA # on the outside of the package. 

ANY PRODUCT SENT WITHOUT AN RMA # MAY BE REFUSED!

Documentation and Warranty
Additional copies of this guide along with other documentation and product warranty can be found on the Safe Fleet 
Community website: https://community.safefleet.net

Technical Support
Phone: 1 .800 .336 .8475, option 3

Email: mvisupport@safefleet.net

https://community.safefleet.net/sfle/support/repair/
https://community.safefleet.net/sfle/support/repair/
mailto:mvisupport%40safefleet.net?subject=
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